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Using This Online Manual

= Symbols Used in This Document
= Touch-enabled Device Users (Windows)

Symbols Used in This Document

A\ Warning
Instructions that, if ignored, could result in death or serious personal injury caused by incorrect
operation of the equipment. These must be observed for safe operation.

/A Caution
Instructions that, if ignored, could result in personal injury or material damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

32 Important
Instructions including important information. To avoid damage and injury or improper use of the
product, be sure to read these indications.

»>» Note

Instructions including notes for operation and additional explanations.

Instructions explaining basic operations of your product.

»>» Note

* |cons may vary depending on your product.

Touch-enabled Device Users (Windows)

For touch actions, you need to replace "right-click" in this document with the action set on the operating
system. For example, if the action is set to "press and hold" on your operating system, replace "right-click"
with "press and hold."
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Trademarks and Licenses

» Microsoft is a registered trademark of Microsoft Corporation.

» Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

» Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

* Internet Explorer is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or
other countries.

* Mac, Mac OS, AirPort, Safari, Bonjour, iPad, iPhone and iPod touch are trademarks of Apple Inc.,
registered in the U.S. and other countries. App Store, AirPrint and the AirPrint logo are trademarks of
Apple Inc.

* 10S is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under
license.

» Google Cloud Print, Google Chrome, Chrome OS, Chromebook, Android, Google Play, Google Drive,
Google Apps and Picasa are either registered trademarks or trademarks of Google Inc.

» Adobe, Flash, Photoshop, Photoshop Elements, Lightroom, Adobe RGB and Adobe RGB (1998) are
either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or
other countries.

* Bluetooth is a trademark of Bluetooth SIG, Inc., U.S.A. and licensed to Canon Inc.

» Autodesk and AutoCAD are registered trademarks or trademarks of Autodesk, Inc., and/or its
subsidiaries and/or affiliates in the USA and/or other countries.

»» Note

» The formal name of Windows Vista is Microsoft Windows Vista operating system.

Copyright (c) 2003-2004, Apple Computer, Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Computer, Inc. ("Apple") nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS I1S" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.
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Apache License
Version 2.0, January 2004

http://www.apache.org/licenses/
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled
by, or are under common control with that entity. For the purposes of this definition, "control" means
(i) the power, direct or indirect, to cause the direction or management of such entity, whether by
contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii)
beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source
form, including but not limited to compiled object code, generated documentation, and conversions to
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under
the License, as indicated by a copyright notice that is included in or attached to the work (an example
is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or
derived from) the Work and for which the editorial revisions, annotations, elaborations, or other
modifications represent, as a whole, an original work of authorship. For the purposes of this License,
Derivative Works shall not include works that remain separable from, or merely link (or bind by name)
to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity
authorized to submit on behalf of the copyright owner. For the purposes of this definition, "submitted"
means any form of electronic, verbal, or written communication sent to the Licensor or its
representatives, including but not limited to communication on electronic mailing lists, source code
control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor for the
purpose of discussing and improving the Work, but excluding communication that is conspicuously
marked or otherwise designated in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
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copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise
transfer the Work, where such license applies only to those patent claims licensable by such
Contributor that are necessarily infringed by their Contribution(s) alone or by combination of their
Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent
litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the
Work or a Contribution incorporated within the Work constitutes direct or contributory patent
infringement, then any patent licenses granted to You under this License for that Work shall terminate
as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in
any medium, with or without modifications, and in Source or Object form, provided that You meet the
following conditions:

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and

2. You must cause any modified files to carry prominent notices stating that You changed the files;
and

3. You must retain, in the Source form of any Derivative Works that You distribute, all copyright,
patent, trademark, and attribution notices from the Source form of the Work, excluding those
notices that do not pertain to any part of the Derivative Works; and

4. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that
You distribute must include a readable copy of the attribution notices contained within such
NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in at
least one of the following places: within a NOTICE text file distributed as part of the Derivative
Works; within the Source form or documentation, if provided along with the Derivative Works; or,
within a display generated by the Derivative Works, if and wherever such third-party notices
normally appear. The contents of the NOTICE file are for informational purposes only and do not
modify the License. You may add Your own attribution notices within Derivative Works that You
distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such
additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or
different license terms and conditions for use, reproduction, or distribution of Your modifications,
or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of
the Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of
this License, without any additional terms or conditions. Notwithstanding the above, nothing herein
shall supersede or modify the terms of any separate license agreement you may have executed with
Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides
the Work (and each Contributor provides its Contributions) on an "AS I1S" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without
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limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or
FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any risks associated with Your
exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,
indirect, special, incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use the Work (including but not limited to damages for loss of
goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages
or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof,
You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other
liability obligations and/or rights consistent with this License. However, in accepting such obligations,
You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any
liability incurred by, or claims asserted against, such Contributor by reason of your accepting any
such warranty or additional liability.

END OF TERMS AND CONDITIONS

---- Part 1: CMU/UCD copyright notice: (BSD like) -----

Copyright 1989, 1991, 1992 by Carnegie Mellon University

Derivative Work - 1996, 1998-2000

Copyright 1996, 1998-2000 The Regents of the University of California
All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose and
without fee is hereby granted, provided that the above copyright notice appears in all copies and that both
that copyright notice and this permission notice appear in supporting documentation, and that the name of
CMU and The Regents of the University of California not be used in advertising or publicity pertaining to
distribution of the software without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES
WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL CMU OR THE REGENTS OF THE
UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE LOSS OF USE, DATA OR
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION,
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

---- Part 2: Networks Associates Technology, Inc copyright notice (BSD) -----
Copyright (c) 2001-2003, Networks Associates Technology, Inc
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:
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* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may be
used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS TAS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) -----
Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* The name of Cambridge Broadband Ltd. may not be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER "AS I1S" AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

--—-- Part 4: Sun Microsystems, Inc. copyright notice (BSD) -----

Copyright ¢ 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054, U.S.A. All
rights reserved.

Use is subject to license terms below.
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This distribution may include materials developed by third parties.

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun
Microsystems, Inc. in the U.S. and other countries.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 5: Sparta, Inc copyright notice (BSD) -----
Copyright (c) 2003-2009, Sparta, Inc
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Sparta, Inc nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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---- Part 6: Cisco/BUPTNIC copyright notice (BSD) -----

Copyright (c) 2004, Cisco, Inc and Information Network Center of Beijing University of Posts and
Telecommunications.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Cisco, Inc, Beijing University of Posts and Telecommunications, nor the names of
their contributors may be used to endorse or promote products derived from this software without specific
prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS TAS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 7: Fabasoft R&D Software GmbH & Co KG copyright notice (BSD) -----
Copyright (c) Fabasoft R&D Software GmbH & Co KG, 2003 oss@fabasoft.com
Author: Bernhard Penz

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* The name of Fabasoft R&D Software GmbH & Co KG or any of its subsidiaries, brand or product names
may not be used to endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ""AS IS" AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
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IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

LEADTOOLS
Copyright (C) 1991-2009 LEAD Technologies, Inc.

CMap Resources

Copyright 1990-2009 Adobe Systems Incorporated.
All rights reserved.

Copyright 1990-2010 Adobe Systems Incorporated.
All rights reserved.

Redistribution and use in source and binary forms, with or
without modification, are permitted provided that the
following conditions are met:

Redistributions of source code must retain the above
copyright notice, this list of conditions and the following
disclaimer.

Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials
provided with the distribution.

Neither the name of Adobe Systems Incorporated nor the names
of its contributors may be used to endorse or promote

products derived from this software without specific prior

written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS "AS I1S" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

MIT License
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Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER
IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

The following applies only to products supporting Wi-Fi.
(c) 2009-2013 by Jeff Mott. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions, and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the
following disclaimer in the documentation or other materials provided with the distribution.

* Neither the name CryptoJS nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS,"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

32



Enter keywords in the search window and click E (Search).

You can search for target pages in this guide.

Entry example: "(your product's model name) load paper"

Search Tips

You can search for target pages by entering keywords in the search window.

Canon

Contents | > MNotes on Site Usage and Cookies

Online Manual

- series -

E Satug | E Change Preduct

&) Featured Topics

32 Important

+ This function may not be available in some countries/regions.

»» Note

The displayed screen may vary.
When searching from this page without entering your product's model name or your application's name,
all products supported by this guide will be considered for the search.

If you want to narrow down the search results, add your product's model name or your application's
name to the keywords.

Searching for Functions

Enter your product's model name and a keyword for the function you want to learn about
Example: When you want to learn how to load paper

Enter "(your product's model name) load paper" in the search window and perform a search
Troubleshooting Errors

Enter your product's model name and a support code

Example: When the following error screen appears
Enter "(your product's model name) 1003" in the search window and perform a search
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Media Type : Flain Faper
Page Size - Letter 857017 Zacdiem

Start

»>» Note

» The displayed screen varies depending on your product.

» Searching for Application Functions
Enter your application's name and a keyword for the function you want to learn about
Example: When you want to learn how to print collages with My Image Garden
Enter "My Image Garden collage" in the search window and perform a search

» Searching for Reference Pages

Enter your model name and a reference page title*
* You can find reference pages more easily by entering the function name as well.

Example: When you want to browse the page referred to by the following sentence on a scanning
procedure page

Refer to "Color Settings Tab" for your model from Home of the Online Manual for details.

Enter "(your product's model name) scan Color Settings Tab" in the search window and perform a
search
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Using the Machine
» Printing Documents from Your Computer (Windows)
» Printing Documents from Your Computer (Mac OS)
» Copying

» Faxing
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Printing Documents from Your Computer (Windows)

Print documents from applications on a computer or other device as follows.

1. Pull out a cassette.

4

2. Load paper printing-side DOWN.

3. Align the paper guides with the paper length and width.

4. Insert the cassette.

After you insert the cassette, a screen for registering paper information for the cassette is displayed on
the touch screen.

5. Select the size and type of paper in the cassette in Page size and Type, and then tap
Register.
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Cassette 1 paper information

Select the paper loaded in
cassette 1.

Plain paper

Register
Follow the instructions of any messages displayed to register the paper information.

6. Pull out the output tray extension (A) and open the paper output support (B).

7. In the application, select Print.

You can often access the Print dialog box by selecting Print in the File menu.

8. Select the model name and click Preferences (or Properties).

Printer driver settings are displayed.

»» Note

+ Command and menu names vary by application, and printing may involve more steps. For
detailed instructions, refer to the application user manual.

9. Select a typical printing profile.

In Commonly Used Settings on the Quick Setup tab, select a profile that suits the purpose of printing.

Once you select a printing profile, preset values are automatically applied to Additional Features,
Media Type, and Printer Paper Size settings.
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10. Select the paper source.

In Paper Source, select the cassette where the paper is loaded.
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11. Once the print settings are complete, click OK to print.

13> Note

» A variety of print settings can be configured with the printer driver.

= Printing from Application Software (Windows Printer Driver)

38



Printing Documents from Your Computer (Mac OS)

Print documents from applications on a computer or other device as follows.

1. Pull out a cassette.

2. Load paper printing-side DOWN.

3. Align the paper guides with the paper length and width.

4. Insert the cassette.

After you insert the cassette, a screen for registering paper information for the cassette is displayed on
the touch screen.

5. Select the size and type of paper in the cassette in Page size and Type, and then tap
Register.
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Cassette 1 paper information

Select the paper loaded in
cassette 1.

Plain paper

Register
Follow the instructions of any messages displayed to register the paper information.

6. Pull out the output tray extension (A) and open the paper output support (B).

7. In the application, select Print.

You can often access the Print dialog by selecting Print... in the File menu.

»» Note

» For detailed instructions on operation, refer to the application user manual.

8. Select the model name and click Printer list.

Click Show Details to switch the Setup window to the detailed display.
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9. Select the paper size.

In Paper Size, select the paper size you use.
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10. Select Quality & Media from the pop-up menu.
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11. Select the media type.

In Media Type, select the same media type loaded in the machine.

12. Select the paper source.

In Paper Source, select the cassette where the paper is loaded.
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13. Once the print settings are complete, click Print to print.

»» Note

A variety of print settings can be configured with the printer driver.

= Printing from Application Software (Mac OS Printer Driver)
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Copying

Load originals and copy them on plain paper as follows.

1. Pull out a cassette.

2. Load paper printing-side DOWN.

3. Align the paper guides with the paper length and width.

4. Insert the cassette.

After you insert the cassette, a screen for registering paper information for the cassette is displayed on
the touch screen.

5. Select the size and type of paper in the cassette in Page size and Type, and then tap
Register.
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Cassette 1 paper information

Select the paper loaded in
cassette 1.

Page size Ad
Type Plain paper

Register

Follow the instructions of any messages displayed to register the paper information.

6. Pull out the output tray extension (A) and open the paper output support (B).

9. Open the document cover (E).

10. Load the original face-DOWN, aligned with the alignment mark (F).
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12> Note

» For continuous copying of multiple originals, use the ADF (Auto Document Feeder).

o

A

11. Close the document cover.

12. Check the paper settings, and then press the Black or Color button (G).

32 Important

» Do not open the document cover until copying is finished.

13> Note

* The machine offers many other convenient copying features.

= Copyin
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Faxing

Fax multiple documents in black and white as follows.

e

1. Open the document tray (A).

2. Insert the documents face-UP.

3. Adjust the document guides as needed.

4. Press the HOME button (B).

5. Tap E FAX (C).



6. Tap Enter the number (D).

7. Tap in the fax number (E), and then tap OK (F).

8. Press the Black button (G).

»» Note

* Many other convenient faxing features are available.

= Faxing
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Printer Functions
» Connect Wirelessly in "Direct Connection"
» Download a Variety of Content Materials
» Print Items with Easy-PhotoPrint+ (Web Application)
» Managing Printer Conveniently Using Quick Utility Toolbox
» Available Connection Methods
» Scan Originals Larger than the Platen
» Scan Multiple Originals at One Time
» Using PIXMA/MAXIFY Cloud Link
» Print Easily from a Smartphone or Tablet with Canon PRINT Inkjet/SELPHY
» Printing with Windows RT

» Online Storage Integration Function

48



Printing from an AirPrint-enabled Printer
» Printing from an AirPrint-enabled Printer with Mac

» Printing from an AirPrint-enabled Printer with iOS Device
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Printing from an AirPrint-enabled Printer with Mac

Using AirPrint to print from your iPhone, iPad, iPod touch, or Mac.

AirPrint enables you to print photos, email, Web pages and documents from iPhone, iPad, iPod touch, and
Mac without the need to install drivers, or download apps or software.

»» Note

+ If you want to print using AirPrint from iOS device, see below.

= Printing from an AirPrint-enabled Printer with iOS Device

AirPrint

Checking Your Environment

First, check your environment.

* AirPrint Operation Environment
> iPhone, iPad, and iPod touch running the latest version of iOS

o Mac running the latest version of Mac OS

* Requirement

The iOS device or Mac and the printer must be connected to the same network over a LAN or
connected directly without wireless router.

Adding Printer as AirPrint Printer to Your Mac

1. Open System Preferences, and select Printers & Scanners (Print & Scan) on your
Mac.

2. Select + to display the printer list.

3. Select the printer's name listed as Bonjour Multifunction.
4. Select Secure AirPrint or AirPrint from Use.

5. Select Add.

Printing with AirPrint from Mac

1. Make sure printer is turned on.
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»» Note

« If the printer's Auto Power On function is enabled, the printer is turned on automatically when it
receives the print data.

2. Load paper.

3. Perform printing on your application software.

Print dialog appears.
4. Select your model name added as AirPrint printer from the Printer list in the Print Dialog.
5. Set the paper size, media type, and other settings as needed.

6. Select Print.

When you execute printing, the printer prints according to the specified settings.

»>» Note

« For wireless LAN connection:

« After you turn on the printer, it may take few minutes before the printer can communicate through
a wireless LAN connection. Make sure the printer is connected to the wireless LAN and try
printing.

« If Bonjour on the printer is disabled, AirPrint cannot be used. Check the LAN settings on the
printer, and enable Bonjour.

» For other AirPrint troubleshooting, see below.

= Cannot Print Using AirPrint

Checking Print Status

= Display the Printing Status Screen

Deleting Print Job

To delete a print job with AirPrint, use one of the following two methods:

» From printer: Use Stop button to cancel the print job.

» From iOS device: Deleting the Undesired Print Job
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Printing from an AirPrint-enabled Printer with iOS Device

Using AirPrint to print from your iPhone, iPad, iPod touch, or Mac.

AirPrint enables you to print photos, email, Web pages and documents from iPhone, iPad, iPod touch, and
Mac without the need to install drivers, or download apps or software.

»» Note

« If you want to print using AirPrint from Mac, see below.

= Printing from an AirPrint-enabled Printer with Mac

AirPrint

Checking Your Environment

First, check your environment.

* AirPrint Operation Environment
> iPhone, iPad, and iPod touch running the latest version of iOS

o Mac running the latest version of Mac OS

* Requirement

The iOS device or Mac and the printer must be connected to the same network over a LAN or
connected directly without wireless router.

Printing with AirPrint from iOS Device

1. Make sure printer is turned on.

»» Note

« If the printer's Auto Power On function is enabled, the printer is turned on automatically when it
receives the print data.

2. Load paper.

3. Tap operation icon to display menu options from applications of your iOS device.

The figure below is an example of when printing from the iPad web browser. The screen differs
depending on the devices or applications.
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5. Select your model name from Printer on Printer Options.

3% Important

» Because some applications do not support AirPrint, Printer Options may not be displayed. If
an application does not let you use printer options, you cannot print from that application.
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»» Note

 Printer Options differ depending on the application that you are using.

6. When printing file type that has multiple pages, such as PDF file, tap Range and tap All

Pages or select range of pages to be printed.

7. For 1 Copy, tap + or - to set number of required copies.

8. For Duplex Printing, tap On to enable duplex printing or tap Off to disable function.

9. Tap Print.

When you execute printing, the printer prints according to the specified settings.

»>» Note

¢ For wireless LAN connection:

« After you turn on the printer, it may take few minutes before the printer can communicate through
a wireless LAN connection. Make sure the printer is connected to the wireless LAN and try

printing.

« If Bonjour on the printer is disabled, AirPrint cannot be used. Check the LAN settings on the
printer, and enable Bonjour.

» For other AirPrint troubleshooting, see below.

= Cannot Print Using AirPrint

Paper Size

With AirPrint, the paper size is selected automatically according to the application being used on the iOS

device and the region in which AirPrint is used.

When you use the photo application, the default paper size is L size in Japan, and 4"x6" or KG in other
countries and regions.

When you use the document application, the default paper size is letter size in the U.S. region, and A4 in

Japan and Europe.

2% Important

» Depending on the device or operation system, the default paper size is different from above size.

We recommend you perform test printing.

* Your application may support different paper sizes.

Printing of Envelopes

For printing on the envelope from iOS device with AirPrint, refer to the following.

Print result image

Orientation of print data

Orientation of loading envelope
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Al |

Load the envelope in vertically with the address side facing down so
that the folded flap of the envelope will be faced up on the right side.

Checking Print Status

During printing, a Print Center icon is displayed in the list of recently used applications and you can use it
to check the print progress.

Press the Home button on the iOS device twice to set the Multitasking mode. Then swipe to the right to
display the Print Center icon and a Print Summary.

Deleting Print Job

To delete a print job with AirPrint, use one of the following two methods:

» From printer: Use Stop button to cancel the print job.

* From iOS device: Press the Home button on the iOS device twice to set the Multitasking mode and
swipe to the right. Tap the Print Center icon to display a Print Summary. Tap the print job to be
canceled and tap Cancel Printing.
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Connect Wirelessly in "Direct Connection"

The printer supports "direct connection" in which you can connect to the printer wirelessly from a computer
or smartphone without a wireless router.

Switch to "direct connection" to print or scan wirelessly.

= Using Machine with Direct Connection
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Download a Variety of Content Materials

CREATIVE PARK

A "printing materials site" where you can download all the printing materials for free.
Various types of content such as seasonal cards and paper crafts that can be made by assembling paper
parts are provided.

CREATIVE PARK PREMIUM

A service where customers using models that support PREMIUM Contents can download exclusive
printing materials.

PREMIUM Contents can be downloaded easily via Easy-PhotoPrint+. Downloaded PREMIUM Contents
can be printed directly with Easy-PhotoPrint+.

To download PREMIUM Contents, make sure that genuine Canon ink tanks/ink cartridges are installed for
all colors on a supported printer.

FORE5

»» Note

» The designs of PREMIUM Contents provided in this page are subject to change without prior notice.
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Print Items with Easy-PhotoPrint+ (Web Application)

You can easily create and print personalized items such as calendars and collages, anytime and anywhere,
by simply accessing Easy-PhotoPrint+ on the web from a computer or tablet.

By using Easy-PhotoPrint+, you can create items in the latest environment without going through the trouble
of installation.

Moreover, you can use various photos for your item through integration with social networks such as
Facebook, or with online storage, web albums, etc.

Refer to "Easy-PhotoPrint+ Guide" for details.
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Managing Printer Conveniently Using Quick Utility Toolbox

Quick Utility Toolbox is a shortcut menu that lets you access the functions you want to use with one click.
After installing utilities compatible with Quick Utility Toolbox, they will be added to this menu. The Quick
Utility Toolbox provides a convenient way to quickly launch added utilities for making printer settings and
doing other management tasks.

Refer to the following for details.

= Quick Utility Toolbox Guide (Windows)
= Quick Utility Toolbox Guide (Mac OS)

L
A
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Available Connection Methods

The following connection methods are available on the printer.

(tp)

Wireless Connection

* With a wireless router

'

* Without a wireless router

Wired Connection ﬁ

USB Connection

o™

Wireless Connection

There are two methods for connecting the printer to your device (e.g. smartphone or tablet). One method
is to connect using a wireless router, and the other method is to connect without using a wireless router.

The two connection methods cannot be used at the same time.

If you have a wireless router, we recommend you use the method described in Connection Using a
Wireless Router.

When connecting another device while a device is already connected to the printer, connect it using the
same connection method as the connected device.

If you connect using a different connection method, the connection to the device in use will be disabled.
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» Connection Using a Wireless Router

ﬁ N

o Connect the printer and a device using a wireless router.
o Connection methods vary depending on the wireless router type.
> You can change network settings such as the SSID and security protocol on the printer.

o

> When the connection between a device and a wireless router is completed and = (Wi-Fi icon) is
displayed in the device's screen, you can connect the device to the printer using the wireless
router.

» Connection without Using a Wireless Router

o

o Connect the printer and a device without using a wireless router. Connect a device and the printer
directly using the printer's direct connection.

> While you are using the printer with direct connection, Internet connection from the printer
becomes unavailable. In that case, web services for the printer cannot be used.

o If you connect a device connected to the Internet via a wireless router to the printer that is in the
direct connection, the connection between the device and wireless router will be disabled. In that
case, the connection of the device may switch to a mobile data connection automatically
depending on your device. Transmission fees for connecting to the Internet using a mobile data
connection apply.

o In the direct connection, you can connect up to five devices at the same time. If you try to connect
a sixth device while five devices are already connected, an error will appear. If an error appears,
disconnect a device you do not use and configure settings again.

o Network settings such as the SSID and security protocol are specified automatically.

Wired Connection

Connect the printer and a hub or router with an Ethernet cable. Prepare an Ethernet cable.

USB Connection

Connect the printer and a computer with a USB cable. Prepare a USB cable.

Restrictions

(Appears in a new window)
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Scan Originals Larger than the Platen

By using the stitch function of IJ Scan Utility, you can scan the left and right halves of an item larger than the
platen and combine them back into one image. Items up to approximately twice as large as the platen are
supported.

Refer to the following for details.

= Scanning Originals Larger than the Platen (Image Stitch) (Windows)
= Scanning Originals Larger than the Platen (Image Stitch) (Mac OS)
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Scan Multiple Originals at One Time

By using IJ Scan Ultility, you can scan two or more photos (small items) placed on the platen at one time and
save each image individually.

Refer to the following for details.

= Scanning Multiple Originals at One Time (Windows)
= Scanning Multiple Originals at One Time (Mac OS)
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Using PIXMA/MAXIFY Cloud Link

By using PIXMA/MAXIFY Cloud Link, you can connect your printer to a cloud service, such as CANON
iIMAGE GATEWAY, Evernote, or Twitter, and use the following functions without using a computer:

* Print images from a photo-sharing service

* Print documents from a data management service

» Save scanned images to a data management service.

+ Use Twitter to report the printer status, such as no paper or low ink levels.

In addition, you can use various functions by adding and registering apps that are linked with various cloud

services.

= Using PIXMA/MAXIFY Cloud Link from Your Printer
= Using PIXMA/MAXIFY Cloud Link from Your Smartphone, Tablet, or Computer

32 Important

* In certain countries, PIXMA/MAXIFY Cloud Link may not be available or the available apps may be
different.

+ Some apps require that you have an account before you use those apps. For such apps, please set up
an account beforehand.

+ To find out which models support PIXMA/MAXIFY Cloud Link check the Canon homepage.

» The screen display may change without prior notice.
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Notice for Web Service Printing

When Using Web Service

Canon does not guarantee the continuity and reliability of the web services provided, the availability of
site access, or permission to download the materials.

Canon may at any time update, change, or delete the information provided through the web service,
or may suspend or discontinue the service without prior notice. Canon shall not be held responsible
for any damages resulting from such actions.

In no event shall Canon be liable for any damages whatsoever resulting from the use of the web
services.

User registration is necessary before you can use the external link site.

When you use the external link site, observe the conditions of use of the site and use the service
within your own responsibility.

All or part of the web service may not be available depending on the country or region you live in.
Depending on your network environment, some functions on web service are not available. Even if
they are available, it may take a while to print or display the contents, or communication may be
interrupted while operation is in progress.

When you use web service, your machine's name, information of your region or country, your selected
language, and what kind of service you use (e.g. photo sharing site) are sent to and saved in our
server. Canon is unable to identify specific customers using this information.

Before you transfer ownership or dispose of a printer that supports a color LCD monitor, select
Device settings -> Reset setting -> Reset all and delete your login name and password.

For details, contact a Canon-authorized sales representative in the country or region you live in.

To Those Living in Mainland China

PIXMA/MAXIFY Cloud Link, Easy-PhotoPrint+, and some functions of Canon PRINT Inkjet/SELPHY,
which are included with this machine, are provided by Canon Inc.

However, as the server is installed outside of mainland China, some of these services may not be
available yet.

Copyrights and Rights of Publicity

When printing using a service provided by Canon

1.

2.

The copyright of each material (photos, illustrations, logos, or documents: hereinafter referred to as
"the materials") provided on the printing service belongs to their respective owners. Issues pertaining
to Rights of Publicity may arise regarding the use of any of people or characters displayed on the
printing service.

Except as otherwise permitted (please see "2" below), copying, modifying or distributing all or a
portion of any of the materials contained on the web template printing service without prior consent of
the respective rights (Rights of Publicity and Copyright) holder is strictly prohibited.

All of the materials provided on the web template printing service can be freely used for personal and
non-commercial purposes.
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Using PIXMA/MAXIFY Cloud Link from Your Printer
» Before Using PIXMA/MAXIFY Cloud Link
» Registering Printer Information to PIXMA/MAXIFY Cloud Link
» Using PIXMA/MAXIFY Cloud Link

» Cloud Troubleshooting
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Before Using PIXMA/MAXIFY Cloud Link

First, check the following content:

* Precautions

If you plan to use the web service to print documents, be sure to check these precautions beforehand.

 Printer Specifications

o The printer must support a color LCD monitor.
To check whether your model supports this function, see "Models that Support PIXMA/MAXIFY
Cloud Link from Your Printer".

> Your printer may not support the scan function.

o The printer must support the Canon Inkjet Cloud Printing Center.
To check whether your model supports this function, see "Models that Support Canon Inkjet Cloud
Printing Center".

* Network environment

The printer must be connected to a LAN and to the Internet.

If your printer is not connected to a LAN, see here and set one up.

For information on the LAN and Internet settings, see the manual of your network devices or contact the
manufacturer.

32 Important

* The user will bear the cost of Internet access.

= Registering Printer Information to PIXMA/MAXIFY Cloud Link

Copyright ¢ 1991-2015 Unicode, Inc. All rights reserved. Distributed under the Terms of Use in http://
www.unicode.org/copyright.html.

This software is based in part on the work of the Independent JPEG Group.

THE BASIC LIBRARY FUNCTIONS

Written by: Philip Hazel

Email local part: ph10

Email domain: cam.ac.uk

University of Cambridge Computing Service, Cambridge, England.
Copyright (c) 1997-2008 University of Cambridge All rights reserved.

THE "BSD" LICENCE

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
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following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the University of Cambridge nor the name of Google Inc. nor the names of their
contributors may be used to endorse or promote products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

68



Registering Printer Information to PIXMA/MAXIFY Cloud Link

Follow the steps described below to register the printer information to the cloud service server.

1. Check that the printer is connected to the Internet

2. From the printer home screen, select Cloud

»» Note

+ If multiple users will be using the printer after the initial registration, select the login user name
from the Switch user screen, enter the Security code, and proceed with the registration.

If the Security code is incorrect, use your smartphone, tablet, or computer, and change the
setting from the My account of the Canon Inkjet Cloud Printing Center.

3. When the registration preparation completed screen appears, select OK

Ready to register with 1] Cloud
Printing Center. Follow the
on-screen instructions to
register,

4. On the confirmation screen, select Next

Make registration for using
applications.

Mext

5. In the License agreement and Privacy statement windows, read the statements, and then
select Agree if you agree

<License agreement>
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Important: Please read this before
using this service

Service Terms of Use

These Service Terms of Use (the
[ [Start] Print

Do not agree Agree

<Privacy statement>

Important: Please read this before
using this service

Privacy Statement

This Privacy Statement (the
[ [Start] Print

Do not agree Agree

»» Note

* If you select Do not agree, a confirmation screen asking whether you want to cancel Register My
account appears. If you select Yes, then Register My account is canceled, and you return to the
Home screen.

Even if you select Do not agree, you can still use this service by selecting Agree from the
registration screen later.

* You can print the displayed information by pressing the Start button.

6. On the Current time check screen, select the time closest to the current time, and then
select Next

You can set the time in 10-minute units.

Current time check

Select the time closest to the
current time.

0o : 00

7. In the time zones list, select the region closest to you

For some regions, a screen for applying the daylight saving time setting may appear.
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Time zane

(UTC+09:00) Tokyo
(UTC+09:30) Adelaide
(UTC+09:30) Darwin

{UTC#+10:00) Brishane

The registration of printer information is completed, and a list of apps is displayed.
See here for the description of the apps list screen.

After you complete the registration, you can print photos and documents that have been uploaded to apps
on the linked cloud service and add/delete/sort apps.

= Using PIXMA/MAXIFY Cloud Link
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Application Management

This section explains how to add, delete, and sort apps.

32 Important

» Select how to manage allows you to change which users can use this service.
For details, see "Canon Inkjet Cloud Printing Center window".

Add apps

You can add your favorite apps to the printer.
Follow the steps described below to add apps.

1. From the printer home screen, select Cloud

2. On the cloud's Main screen, select Add/delete

ICARSDA

mase  CANON IMAGE GATEWAY

Picasa Web Albums

E OneDrive

Add/ delete Manage

3. Select Register apps

Register apps
Delete apps
Sort

4. From the list, select the category of the app

Reaqister apps
All
Photoaraphy

Productivity

Creativity
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5. From the displayed apps list, select the app that you want to register

Register apps

L”“"""“ Creative Park

paper craft

J ® CREATIVE PARK PREMIUM
| Christmas card

— Craativa Darl
Back

3> Note
» Description of displayed icons

u : Can be used with genuine Canon ink.
If you are using a G3000 series model, you cannot use this service because the model is not

supported.

6. Select Register

® CREATIVE PARK PREMIUM
areeting card

This app is available exclusively
to users of genuine Canon inks.
You can print various greeting

Register

The registration is completed and the app is added to the apps list.

To register another app, repeat the procedure from step 5.
To end the app registration, select Back and return to the cloud's Main screen.

2% Important
» Some apps may require a linked app account before you can use the app. If this is the case, set up

an account beforehand.

Delete apps

You can delete unnecessary apps from the apps list.
Follow the steps described below to delete apps.

1. From the printer home screen, select Cloud

2. On the cloud's Main screen, select Add/delete
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WhSE  CANON IMAGE GATEWAY

Picasa Web Albums

E OneDrive

Add/ delete Manage

3. Select Delete apps

Register apps
Delete apps
Sort

4. From the apps list, select the app that you want to delete
Delete apps

WAGE  CANON iIMAGE GATEWAY

.";_ Picasa Web Albums
)

P

P e i e
Back

»>» Note

» Description of displayed icons
: Cannot be used because it is not yet released or does not support your region, model, or
language.

n : Can be used with genuine Canon ink.
If you are using a G3000 series model, you cannot use this service because the model is not

supported.

5. Select Delete
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Sl * CREATIVE PARK PREMIUM
A paper craft

This app is available exclusively
to users of genuine Canaon inks.
You can print various paper

Delate

When the deletion is finished, the app will be deleted from the apps list on the main screen.

To delete another app, repeat the procedure from step 4.
To end the app deletion, select Back and return to the cloud's Main screen.

»>» Note

» Config allows you to re-register deleted apps.

Sort apps

You can sort apps displayed on the apps list.
Follow the steps described below to sort apps.

1. From the printer home screen, select Cloud

2. On the cloud's Main screen, select Add/delete

ITAROR

it CANON IMAGE GATEWAY

Picasa Web Albums

E OneDrive

Add/delete Manage

3. Select Sort

Register apps

Delete apps

Sort

4. On the apps list, select the app that you want to sort
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ﬁi.‘ére CANON iMAGE GATEWAY

Picasa Web Albums

»» Note

» Description of displayed icons
: Cannot be used because it is not yet released or does not support your region, model, or
language.

n : Can be used with genuine Canon ink.
If you are using a G3000 series model, you cannot use this service because the model is not

supported.

5. Use & / ¥ buttons to move the app

k- ® CREATIVE PARK PREMIUM
¥ paper craft

b

6. Select Done

® CREATIVE PARK PREMIUM
it paper craft

x

Sorting is complete.
To continue the sorting, repeat the procedure from step 4.
To end the sorting, select Back and return to the cloud's Main screen.
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Using PIXMA/MAXIFY Cloud Link

This section introduces the photo printing procedure by using CANON iMAGE GATEWAY as an example.

3% Important

» The available functions differ depending on the app.

 The printing procedure differs depending on the app.

* You need to get the account and register photo and other data beforehand.

 The following file formats can be printed: jpg, jpeg, pdf, docx, doc, xIsx, xls, pptx, ppt, and rtf.
The file formats that can be printed differ depending on the app.

» Before you print, check that printer is on and is connected to the network. Then start.

»» Note

* You can use CANON iMAGE GATEWAY to print jpg and jpeg file formats.

1. On the Main screen, select the app to be used

2. Enter the information according to the instructions on the authentication screen, and then
select Log in

Country/Region:

Japan
User ID

Password

2% Important

+ Some apps may not be fully displayed in the display area. If this is the case, scroll up, down, right,
and left to change the display area.

: Visible area

» The Login screen may vary between apps.

+ After logging in, you may be asked from an external service to agree to use their app. Agree if you
are using the app.

3. In the displayed album list, select the album of your choice
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T
Sample00

%- Sample0
e

" " -j Sample?

Henu

4. In the displayed image list, select the image that you want to print, and then select Next

5. Make the necessary print settings, and then select Color

A message that indicates the completion of issuing print job appears, and printing starts.

Selected : 1

L 3.5"%x5"(89x127mm)
Media type  Plus Glossy ||

Print guality  Standard

To continue printing, select Continue, and perform the operation from Step 3.

To end the printing, select Apps. The screen returns to the apps list screen.

The print data has been sent.

Continue

Apps

32 Important

« If a print job is not printed within 24 hours after the print job is issued, the print job will expire and cannot

be printed.
» With premium apps that limit the number of print jobs, print jobs that cannot be printed due to expiration

and other reasons are also included in the print count.
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»» Note

+ To leave a usage history of this service, from the Home window on the operation panel, select m
-

\

Setup -> =8 Web service setup -> Web service connection setup -> IJ Cloud Printing Center
setup -> History setting for this service -> Save.

= Cloud Troubleshooting
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Cloud Windows

This section describes the Main screen of Cloud and the services available on the Main screen.

32 Important

» Select how to manage allows you to change which users can use this service.
For details, see "Canon Inkjet Cloud Printing Center window".

When you select Cloud from the printer home screen, the cloud's Main screen appears.

You can use the areas shown below to perform various functions, including adding, starting, and managing

apps.
You can also print photos and documents by starting the appropriate app.

WAGE CANON IMAGE GATEWAY

Picasa Web Albums

E OneDrive

Add/delete ETER
(2) (3)

(1) Applications
(2) Add/delete button

(3) Manage button
22 Important

» Depending on the apps you plan to use, you may need to have an account beforehand. If this is the
case, get an account for each of those apps.

« After selecting the app, some apps may not be fully displayed in the display area. If this is the case,
scroll up, down, right, and left to change the display area.

I : Visible area

« If an app is not yet released or does not support your model, language, or region, you will not be able to
start that app.

(1) Applications

Immediately after the cloud's Main screen appears, a list of the registered apps appears.
To start an app, select the app that you want to use on the list.
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> Note

» Description of displayed icons
: Cannot be used because it is not yet released or does not support your region, model, or
language.

u : Can be used with genuine Canon ink.
If you are using a G3000 series model, you cannot use this service because the model is not
supported.

(2) Add/delete button

Use this button to add, delete, and sort apps.

Register apps

Delete apps
Sort

Register apps

Select this to add your favorite apps.

= See here for details on how to add apps

Delete apps

Select this to delete registered apps.

= See here for details on how to delete apps

Sort
Select this to sort the apps list.

= See here for details on how to sort the apps list

(3) Manage button

Use this button to manage jobs, log out of an app, show the license agreement and privacy statement,
and set the time zone.

81



Manage jobs
Settings

Legal information

Log out of all apps

Manage jobs

From the Status list window, you can check the status of a job.

Settings

Select this to set the Time zone.
Select your region on the list. For some regions, you can set whether or not to apply the daylight saving
time setting.

32 Important

« If you cannot find your region on the list, select the one closest to your region.

Legal information

This shows the License agreement and Privacy statement.
Press the Start button to print the displayed information.

Log out of all apps

You can log out at the same time from all apps that you are logged into.

»» Note

» Some apps may keep you logged in even after the app ends. Therefore if you want to log in again
with a different account, select Log out of all apps to log out first.
» Once you log out, you need to log in again. You may lose the settings with some apps.
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Cloud Troubleshooting

If you cannot print

Check the following if you cannot print.

» Check that the printer is connected to the Internet.
» Check that the printer is connected to a LAN and the LAN environment is connected to the Internet.
» Check that no error message is displayed on the printer's LCD monitor.

« If printing does not start even after you wait awhile, go to the printer's home screen, and select m
Setup -> Web service inquiry.

If the problem is not resolved, use the printer driver from your computer to perform the print job and check
whether the data can be printed normally on the printer.
If you still cannot print, see the troubleshooting page for your model on the Home of the Online Manual.

»>» Note

» With a wireless LAN connection, after the printer is turned on, it may take several minutes before
communication is possible. Check that your printer is connected to the wireless network, and wait a
while before you start printing.

« If the printer is not turned on or is not connected to the Internet, and consequently a print job is not
processed within 24 hours after it was submitted, the print job is automatically canceled. If this
happens, check the printer power and the Internet connection, and then re-submit the print job.
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Using PIXMA/MAXIFY Cloud Link from Your Smartphone, Tablet, or
Computer

» Before Using Canon Inkjet Cloud Printing Center

¥

Registering User Information to Canon Inkjet Cloud Printing Center

¥

Using Canon Inkjet Cloud Printing Center

¥

Adding a Printer

¥

Adding a PIXMA/MAXIFY Cloud Link User

¥

Troubleshooting Canon Inkjet Cloud Printing Center
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Before Using Canon Inkjet Cloud Printing Center

Canon Inkjet Cloud Printing Center is a service that links with the cloud function of the printer and allows you
to perform operations such as registering and managing apps from your smartphone or tablet device, and
checking the print status, print error, and ink status of the printer. You can also print app photos and
documents from your smartphone or tablet.

First, check the following content:

* Precautions

If you plan to use the web service to print documents, be sure to check these precautions beforehand.

* Printer specification
Check that Canon Inkjet Cloud Printing Center supports the printer.
Some models do not support this function. To check whether your model supports this function, see
"Models that Support Canon Inkjet Cloud Printing Center".

* Network environment

The printer must be connected to a LAN and to the Internet.

22 Important

» The user will bear the cost of Internet access.

» Operating requirements
For computers, smartphones, and tablet devices, see "Requirements for Canon Inkjet Cloud Printing
Center operation".

32 Important

» This service may not be available in certain countries or regions. Also even if the service is available,
there are apps that cannot be used in certain regions.

= Registering User Information to Canon Inkjet Cloud Printing Center
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Requirements for Canon Inkjet Cloud Printing Center operation

Computer
CPU x86 or x64 1.6 GHz or higher
RAM 2 GB or higher

Resolution 1024 x 768 pixels or higher

Monitor displa
Y Number of display colors 24 bits (true-color) or higher

(013 Browser

Internet Explorer 9
Windows Vista SP2 Mozilla Firefox
Google Chrome

Internet Explorer 9, 10, 11
Windows 7 Mozilla Firefox
Google Chrome

Internet Explorer 10, 11
Windows 8 Mozilla Firefox
Google Chrome

Internet Explorer 11
Windows 8.1 Mozilla Firefox
Google Chrome

Internet Explorer 11
Microsoft Edge
Mozilla Firefox
Google Chrome

Windows 10

Mac OS X v10.6-OS X Yosemite v10.10 | Safari 5.1, 6, 7, 8

Smartphone or tablet

(013 Browser Resolution
iOS 7 or later 320 x 480 or higher
OS standard browser
Android 4 or later 480 x 800 or higher

The operation requirements may change without prior notice. If this happens, you may no longer be able to
use this service from your computer, smartphone, or tablet.

22 Important

» On the browser you are using, enable JavaScript and cookies.
« If you use the zoom function or change the font size on your browser, the web pages may not display
correctly.

« If you use the translation function of Google Chrome, the web pages may not display correctly.

» The service does not support the use of its provided services through a proxy server outside of your
country.
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* In an in-house network environment, the 5222 port must be released. For confirmation instructions,
contact the network administrator.
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Registering User Information to Canon Inkjet Cloud Printing Center

To use the Canon Inkjet Cloud Printing Center, you need to follow the steps described below and register
My account information.

= |f your model has color LCD monitor
= |f your model has monochrome LCD monitor
= |f your model has no LCD monitor/If you are using PRO-1000 series or PRO-500 series
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Registering User Information to Canon Inkjet Cloud Printing Center
(Color LCD Monitor)

To use the Canon Inkjet Cloud Printing Center, you need to follow the steps described below and register
My account information.

Registering from Printer

1. Check that the printer is connected to the Internet

2. From the printer home screen, select Cloud

If printer information has not been registered to the cloud service server, the Registration Preparation
Completion Screen appears.

3. From cloud main screen, select Use from Smartphone or Mobile Integration Guide

Mobile Integration
Guide
.
q Scan to E-mail

WAE  CANON iMAGE GATEWAY

Add/delete Manage

4. Follow instructions appearing in screen, and select Next

5. In user registration screen, select Show QR Code

You can also access the URL manually from you smartphone, tablet, or computer.

Access the URL below from a
smartphone or tablet to perform
user registration.

cl-ev1.c-ij.com/join/ZV 3UPX

¥ Show QR Code

6. Read displayed QR code by using your smartphone or tablet
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To return to the cloud main screen, select Exit.

»» Note

* You must have a special app to read QR codes from your smartphone or tablet. If you do not
have an app that reads QR codes on your smartphone or tablet, install one from App Store or
Google Play.

. In Preparation for registration screen, select Send blank e-mail
Preparation for registration

As praparation for registration, send a
blank e-mail. When you end blank
e-mail], a blank e-mail will be sent to this
service and an e-mail containing the URL
for completing the registration work will be
sant to your e-mail address later.

If you want o register with a different e-
mail address th he one set on the e-
mail client, select [Do not send].

Note that the e-mail for completing the
on work will be sent fram
eply @mail.cs.c-ij.com”. If you use a-
mail filters, be sure to allow e-mail from
this address.

Send blank e-mail

Do not send

»» Note

* When you select Send blank e-mail, the "destination entry completed" mailer starts up
automatically.
After the blank e-mail is created, send that e-mail without making any changes.

If you want to register a different e-mail address, select Do not send to display the E-mail address
entry screen.
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Preparation for registration

Enter the e-mail address you want to
register below, then select [Continue
registration].
-Ij.com” will be sent
I yoru ail
m this address.

E-mail address:

Continue registration

In the displayed screen, enter the E-mail address that you want to register, and then select Continue
registration.

»» Note

« If you enter an e-mail address that has already been registered, you will receive an "already
registered" e-mail. Follow the instructions in the e-mail, and register a different e-mail address.

3% Important

* There are character restrictions for the e-mail address, as shown below.

 Up to 255 characters consisting of single-byte alphanumeric characters and symbols (!$"/
A {}|~.-@). (Uppercase and lowercase letters are differentiated.)

» Multibyte characters cannot be used.
You will get an error if the e-mail address you enter contains a character that cannot be
used.

« If you registered a different e-mail address by mistake, you can cancel the registration by going
to the printer's Home screen and selecting Setup -> Web service setup -> Web service
connection setup -> IJ Cloud Printing Center setup -> Delete from this service.

* You may not be able to receive the notification if you are using a spam filter. If you have a
setting to receive only the e-mails from certain domains, be sure to change the setting to allow
receiving e-mails from "noreply@mail.cs.c-ij.com".

There will be no error display even if you could not receive the e-mail because of the spam filter
setting or if you entered an incorrect e-mail address.

8. Check that you received blank e-mail, and then select Yes
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Preparation for registration

Did the e-mail client start automatically,
and was a blank e-mail sent? If it was
sant t "Yes".

If it was not sent, select "No™.

9. Follow instructions in screen display, and select OK

The registration page URL will be sent to the registered e-mail address.

Preparation for registration

Accepted the registration work. An e-mail
for completing the registration work will be
sent to the entered e-mail address.
Receive the e-mail and continug with the
registration work.

Access the URL in the e-mail, Register the Information, and Complete the
User Registration

1. Check that e-mail containing URL has been sent to registered e-mail address, and

access URL

2. In the License agreement and Privacy statement windows of Canon Inkjet Cloud
Printing Center, read the statements, and select Agree if you agree
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License agreement

- |
Impartant: Please read this before using
this service

Service Terms of Use

These Service Terms of Use (the "Terms")
are a binding agreement between you and
Canon Ine. ("Canon®) which govemn your
use of the " defined in Aricle 1
hereof offerad with a Canon brand printer.
You may agree to the Terms by choosing
"Agree". Your use of the Service also s

be deemed as agreement to the Terms. If
you do not agree to the Terms, you may
not use the Service,

Canon reserves the right to modify the
Terms at any time at its sole discretion.

hikamn tha Tarmme ars meadilad Maman

Do not agree Agree

Privacy statement

T

Impaortant: Please read this before using
this service

Privacy Statement

This Privacy Statement (the "Privacy
Statement®) describes information that
Canon Ine. ("Canon®) collects from users
of the rvice” defined in Article 1 hareo
thro il the world (subject to certain
exceptions) and how this information is
used and disclosed,

By using the Service, you expressly agree
to the collection, use and disclosure of

i ation as described in the Privacy
Statement and Service Terms of Use (the
"Terms"). If you do not e to the terms

A he B tmtarmant ar tha Tarmmes

Do not agree Agree

3. Register password for logging in to Canon Inkjet Cloud Printing Center

In the My account registration screen, enter the password you want to register into Password and
Password (Confirmation), and then select Next.
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Register My account

Set a password for logging into this
service,

Password:

Password (Confirmation):

8 to 32 characlars

Cancel

3% Important

* There are character restrictions for the Password, as shown below.

» The password must be between 8 and 32 characters long, using single-byte alphanumeric
characters and symbols ("#$%&'()*+,-./:;<=>?@[¥]*_{[}~). (Alphabets are case-sensitive)

4. Enter Nickname

Enter any user name you want to use.
Register My account
Mickname:

1 to 20 characlars

Time zone:

(UTC) Coordinated Universal Time i

22 Important

» The user name entry field has the following character restrictions:
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» The user name must be between 1 and 20 characters long, using single-byte alphanumeric
characters and symbols (I"#$%&'()*+,-./;;<=>?@[¥]*_*{|}~). (Alphabets are case-sensitive)

5. Specify the Time zone setting, and select Done

Select your region on the list. If you cannot find your region on the list, select the one closest to your
region.
Apply daylight saving time
This appears only when there is a daylight saving time in the Time zone that you selected.
Select whether or not to apply the daylight saving time.

Register My account

Mickname:

1 ko 20 characlars

Time zone:

The registration is complete. A registration completion message is displayed.
When you select the OK button in the message, the login screen is displayed.

Canon IJ Cloud Printing Center

E-mail address:

Password:

Keeap login info

Log in

Reset password from here

Create new account

About this service
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Enter the registered E-mail address and Password, and Log in to the Canon Inkjet Cloud Printing
Center.

= Using Canon Inkjet Cloud Printing Center
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Registering User Information to Canon Inkjet Cloud Printing Center
(Monochrome LCD Monitor)

To use the Canon Inkjet Cloud Printing Center, you need to follow the steps described below and register
My account information.

Print registration information from the printer

1. On the printer operation panel, select the m Setup button, and then select Web
service setup -> Connection setup -> IJCloudPrintingCtr -> Register w/ service

2. In the registration confirmation window, Select Yes
[ i '?
[ ¢ Yes >| Mo

3. In the print settings, select the display language

Language to print
L] English .

4. Follow the instructions displayed in the window, and print the URL of the authentication
site and the Printer registration ID

Set A4 size or Letter size or Legal size plain paper and select OK.
The authentication URL and Printer registration ID are printed.

32 Important

» The operation to complete the registration should be done within 60 minutes.

Access the URL on the printed page, and then enter the e-mail address and
other necessary information

32 Important

» Do not use the Back button of the web browser while an operation is processing. The screen may not
transition properly.

»» Note

« If you enter an e-mail address that has already been registered, you will receive an "already
registered" e-mail. Follow the instructions in the e-mail, and register a different e-mail address.

1. Use the web browser on your PC, smartphone, tablet, or other devices to access the
authentication URL
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Camon inkjet Ciowd Printing Center
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. When the printer registration screen is displayed, select Create new account
Canon IJ Cloud Printing Center

E-mail address:

Password:

Keap login info

Login

Reset password from hare

Create new account

About this service

. Enter the E-mail address and Printer registration ID of the printer's owner, and then
select OK

The registration page URL is sent to the e-mail address entered.
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Camon inkjet Clowd Printing Cenber Preparation
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22 Important

* There are character restrictions for the e-mail address, as shown below.

 Up to 255 characters consisting of single-byte alphanumeric characters and symbols (!$"/
A fi~.-@). (Uppercase and lowercase letters are differentiated.)

* Multibyte characters cannot be used.
You will get an error if the e-mail address you enter contains a character that cannot be
used.

« If you registered a different e-mail address by mistake, you can cancel the registration by
selecting the Setup button on the printer operation panel, and then selecting Web service
setup -> Connection setup -> IJCloudPrintingCtr -> Delete from service.

* You may not be able to receive the notification if you are using a spam filter. If you have a
setting to receive only the e-mails from certain domains, be sure to change the setting to allow
receiving e-mails from "noreply@mail.cs.c-ij.com"”.

There will be no error display even if you could not receive the e-mail because of the spam filter
setting or if you entered an incorrect e-mail address.

Access the URL in the e-mail, Register the Information, and Complete the
User Registration

1. Check that e-mail containing URL has been sent to entered e-mail address, and access
URL

2. In the License agreement and Privacy statement windows of Canon Inkjet Cloud
Printing Center, read the statements, and select Agree if you agree
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License agreement

- |
Impartant: Please read this before using
this service

Service Terms of Use

These Service Terms of Use (the "Terms")
are a binding agreement between you and
Canon Ine. ("Canon®) which govemn your
use of the " defined in Aricle 1
hereof offerad with a Canon brand printer.
You may agree to the Terms by choosing
"Agree". Your use of the Service also s

be deemed as agreement to the Terms. If
you do not agree to the Terms, you may
not use the Service,

Canon reserves the right to modify the
Terms at any time at its sole discretion.

hikamn tha Tarmme ars meadilad Maman

Do not agree Agree

Privacy statement

T

Impaortant: Please read this before using
this service

Privacy Statement

This Privacy Statement (the "Privacy
Statement®) describes information that
Canon Ine. ("Canon®) collects from users
of the rvice” defined in Article 1 hareo
thro il the world (subject to certain
exceptions) and how this information is
used and disclosed,

By using the Service, you expressly agree
to the collection, use and disclosure of

i ation as described in the Privacy
Statement and Service Terms of Use (the
"Terms"). If you do not e to the terms

A he B tmtarmant ar tha Tarmmes

Do not agree Agree

3. Register password for logging in to Canon Inkjet Cloud Printing Center

In the My account registration screen, enter the password you want to register into Password and
Password (Confirmation), and then select Next.
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Register My account

Set a password for logging into this
service,

Password:

Password (Confirmation):

8 to 32 characlars

Cancel

3% Important

* There are character restrictions for the Password, as shown below.

» The password must be between 8 and 32 characters long, using single-byte alphanumeric
characters and symbols ("#$%&'()*+,-./:;<=>?@[¥]*_{[}~). (Alphabets are case-sensitive)

4. Enter Nickname

Enter any user name you want to use.
Register My account
Mickname:

1 to 20 characlars

Time zone:

(UTC) Coordinated Universal Time i

22 Important

» The user name entry field has the following character restrictions:
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» The user name must be between 1 and 20 characters long, using single-byte alphanumeric
characters and symbols (I"#$%&'()*+,-./;;<=>?@[¥]*_*{|}~). (Alphabets are case-sensitive)

5. Specify the Time zone setting, and select Done

Select your region on the list. If you cannot find your region on the list, select the one closest to your
region.
Apply daylight saving time
This appears only when there is a daylight saving time in the Time zone that you selected.
Select whether or not to apply the daylight saving time.

Register My account

Mickname:

1 ko 20 characlars

Time zone:

The registration is complete. A registration completion message is displayed.
When you select the OK button in the message, the login screen is displayed.

Canon IJ Cloud Printing Center

E-mail address:

Password:

Keeap login info

Log in

Reset password from here

Create new account

About this service
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Enter the registered E-mail address and Password, and Log in to the Canon Inkjet Cloud Printing
Center.

= Using Canon Inkjet Cloud Printing Center
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Printing Your Printer Registration ID

32 Important

+ Some models do not support this function.

To add a printer by using Canon Inkjet Cloud Printing Center, you will need a Printer registration ID.

From the operation panel of this printer, print the URL of the authentication site and your Printer
registration ID. The procedure is as follows:
1. Check that the printer is connected to the Internet

3% Important

 To use this function, you must connect this printer to the Internet.

If your model has color LCD monitor

>
2. From the home window, select m Setup ( n Various settings) -> Web

service setup -> Web service connection setup -> IJ Cloud Printing Center setup ->

Register with this service

3. In the registration confirmation window, Select Yes

Register this printer with
[} Cloud Printing Center?

4. In the print settings, select the display language

Language for print settings
B8
English
Deutsch

francais

italiann
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If your model has monochrome LCD monitor
2. On the printer operation panel, select the Setup button, and then select Web

service setup -> Connection setup -> IJCloudPrintingCtr -> Register w/ service

3. In the registration confirmation window, Select Yes
| i 2
. < Yes > I Mo

4. In the print settings, select the display language

Language to print
- English L3

5. Follow the instructions displayed in the window, and print the URL of the authentication site

and your Printer registration ID

When you set A4 size or Letter size or Legal size plain paper and select OK, the authentication site URL
and your Printer registration ID are printed.

3% Important

» The operation to complete the registration should be done within 60 minutes.
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Registering User Information to Canon Inkjet Cloud Printing Center
(No LCD Monitor/Using PRO-1000 series or PRO-500 series)

To use the Canon Inkjet Cloud Printing Center, you need to follow the steps described below and register
My account information.

Registering from Your Smartphone, Tablet, or Computer

1. Check that the printer is connected to the Internet

22 Important

» To use this function, you must connect this printer to the Internet.

2. Displaying Printer Information

For details, go to the Online Manual home page, and see "Checking Printer Information" for your
model.

3. Select IJ Cloud Printing Center setup -> Register with this service

4. Follow the instructions displayed in the window, and run the authentication

5. When the Preparation for registration screen appears, select Send blank e-mail

Preparation for registration

As preparation for registration, send a
blank e-mail. When you [Send blank
e-mail], a blank e-mail wi sent to this
sarvice and an e-mail containing the LURL
for completing the registration work will be
sant to your e-mail address later.

If you want lo register with a different e-
mail address than the one set on the e-
mail client, select [Do not send].

Mote that the e-mail for completing the
tion work will be sent from
sply@mail.cs.c-ij.com". If you use e-
mail filters, be sure to allow e-mail from
this address.

Send blank e-mail

Do not send

»» Note

* When you select Send blank e-mail, the "destination entry completed" mailer starts up
automatically.
After the blank e-mail is created, send that e-mail without making any changes.
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If you want to register a different e-mail address, select Do not send to display the E-mail address
entry screen.

Preparation for registration

Enter the e-mail address you want to
register below, then select [Continue
registration].

E-mail address:

Continue registration

In the displayed screen, enter the E-mail address that you want to register, and then select Continue
registration.

»» Note

« If you enter an e-mail address that has already been registered, you will receive an "already
registered" e-mail. Follow the instructions in the e-mail, and register a different e-mail address.

32 Important

* There are character restrictions for the e-mail address, as shown below.

 Up to 255 characters consisting of single-byte alphanumeric characters and symbols (!$"/
A fi~.-@). (Uppercase and lowercase letters are differentiated.)

» Multibyte characters cannot be used.
You will get an error if the e-mail address you enter contains a character that cannot be
used.

« If you registered a different e-mail address by mistake, you can cancel the registration by
Displaying Printer Information and selecting IJ Cloud Printing Center setup -> Delete from
this service.

To display printer information, go to the Online Manual home page, and see "Checking Printer
Information” for your model.

* You may not be able to receive the notification if you are using a spam filter. If you have a
setting to receive only the e-mails from certain domains, be sure to change the setting to allow
receiving e-mails from "noreply@mail.cs.c-ij.com".

There will be no error display even if you could not receive the e-mail because of the spam filter
setting or if you entered an incorrect e-mail address.

6. Check that you received blank e-mail, and then select Yes
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Preparation for registration

Did the e-mail client start automatically,
and was a blank e-mail sent? If it was
sant t "Yes".

If it was not sent, select "No™.

7. Follow instructions in screen display, and select OK

The registration page URL will be sent to the registered e-mail address.

Preparation for registration

Accepted the registration work. An e-mail
for completing the registration work will be
sent to the entered e-mail address.
Receive the e-mail and continug with the
registration work.

Access the URL in the e-mail, Register the Information, and Complete the
User Registration

1. Check that e-mail containing URL has been sent to registered e-mail address, and

access URL

2. In the License agreement and Privacy statement windows of Canon Inkjet Cloud
Printing Center, read the statements, and select Agree if you agree
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License agreement

- |
Impartant: Please read this before using
this service

Service Terms of Use

These Service Terms of Use (the "Terms")
are a binding agreement between you and
Canon Ine. ("Canon®) which govemn your
use of the " defined in Aricle 1
hereof offerad with a Canon brand printer.
You may agree to the Terms by choosing
"Agree". Your use of the Service also s

be deemed as agreement to the Terms. If
you do not agree to the Terms, you may
not use the Service,

Canon reserves the right to modify the
Terms at any time at its sole discretion.

hikamn tha Tarmme ars meadilad Maman

Do not agree Agree

Privacy statement

T

Impaortant: Please read this before using
this service

Privacy Statement

This Privacy Statement (the "Privacy
Statement®) describes information that
Canon Ine. ("Canon®) collects from users
of the rvice” defined in Article 1 hareo
thro il the world (subject to certain
exceptions) and how this information is
used and disclosed,

By using the Service, you expressly agree
to the collection, use and disclosure of

i ation as described in the Privacy
Statement and Service Terms of Use (the
"Terms"). If you do not e to the terms

A he B tmtarmant ar tha Tarmmes

Do not agree Agree

3. Register password for logging in to Canon Inkjet Cloud Printing Center

In the My account registration screen, enter the password you want to register into Password and
Password (Confirmation), and then select Next.
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Register My account

Set a password for logging into this
service,

Password:

Password (Confirmation):

8 to 32 characlars

Cancel

3% Important

* There are character restrictions for the Password, as shown below.

» The password must be between 8 and 32 characters long, using single-byte alphanumeric
characters and symbols ("#$%&'()*+,-./:;<=>?@[¥]*_{[}~). (Alphabets are case-sensitive)

4. Enter Nickname

Enter any user name you want to use.
Register My account
Mickname:

1 to 20 characlars

Time zone:

(UTC) Coordinated Universal Time i

22 Important

» The user name entry field has the following character restrictions:
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» The user name must be between 1 and 20 characters long, using single-byte alphanumeric
characters and symbols (I"#$%&'()*+,-./;;<=>?@[¥]*_*{|}~). (Alphabets are case-sensitive)

5. Specify the Time zone setting, and select Done

Select your region on the list. If you cannot find your region on the list, select the one closest to your
region.
Apply daylight saving time
This appears only when there is a daylight saving time in the Time zone that you selected.
Select whether or not to apply the daylight saving time.

Register My account

Mickname:

1 ko 20 characlars

Time zone:

The registration is complete. A registration completion message is displayed.
When you select the OK button in the message, the login screen is displayed.

Canon IJ Cloud Printing Center

E-mail address:

Password:

Keeap login info

Log in

Reset password from here

Create new account

About this service
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Enter the registered E-mail address and Password, and Log in to the Canon Inkjet Cloud Printing
Center.

= Using Canon Inkjet Cloud Printing Center
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Using Canon Inkjet Cloud Printing Center

When the user registration is completed, you can log in to the Canon Inkjet Cloud Printing Center and use
the service.

1. From your PC, smartphone, or tablet, access the service login URL (http://cs.c-ij.com/)

2. On the Login screen, enter the E-mail address and Password, and then select Log in

32 Important

* The e-mail address and password are case-sensitive. Make sure the case is correct.

Canon IJ Cloud Printing Center

E-mail addrass:

Password:

Keep login info

Login

Reset password from here

Create new account

About this sarvice

E-mail address
Enter the e-mail address that you entered in the user registration.

Password
Enter the password that you entered in the user registration.

Keep login info
When you select the check box, the login screen is skipped for 14 days since the last day that the
service screen was accessed.

32 Important

+ If you fail to log in five straight times, you will not be able to login again for about the next 60 minutes.

* You remain logged in for 60 minutes after the last access.

» The service may not function properly if you log in by using the same e-mail address from multiple
devices at the same time.

After logging in, you can use useful services such as adding/managing apps that work in conjunction with
this product's cloud functionality and checking the ink status.

For screen descriptions and operation instructions, see "Canon Inkjet Cloud Printing Center window".
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Printing procedure

This section introduces the photo printing procedure by using CANON iMAGE GATEWAY as an example.

32 Important

» The available functions differ depending on the app.

* The printing procedure differs depending on the app.

* You need to get the account and register photo and other data beforehand.

 The following file formats can be printed: jpg, jpeg, pdf, docx, doc, xIsx, xls, pptx, ppt, and rtf.
The file formats that can be printed differ depending on the app.

» Before you print, check that printer is on and is connected to the network. Then start.

» This is available if you are using a smartphone or tablet.

»>» Note

* You can use CANON iMAGE GATEWAY to print jpg and jpeg file formats.

1. On the Main screen, select the app to be used

2. Enter the information according to the instructions on the authentication screen, and then
select Log in

Country/Region:

Japan

Uszer D

Password

Cancel

3. In the displayed album list, select the album of your choice
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{ CANON IMAGE GATEWAY —
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4. In the displayed image list, select the image that you want to print, and then select Next

5. Make the necessary print settings, and then select Print
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4 Print settings

@@ﬂﬂ#

Selected : 5
Paper size Letter
Media type Plus Glossy Il
Print quality Standard
Border Borderless
Photo fix ON |

Red-EveCorrection

Print

6. A print job completion message appears, and printing starts

The print data has been sent.

Continue

To continue printing, select Continue, and perform the operation from Step 3.
To end the printing, select Apps. The screen returns to the apps list screen.

3% Important

« If a print job is not printed within 24 hours after the print job is issued, the print job will expire and
cannot be printed.

» With premium apps that limit the number of print jobs, print jobs that expire and cannot be printed are
also included in the print count.

= Adding a Printer
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Canon Inkjet Cloud Printing Center window

This section describes the Canon Inkjet Cloud Printing Center screens that are displayed on your
smartphone, tablet device, or computer.

= Description of the Login screen
= Description of the Main screen

Description of the Login screen

This section provides the description of the Login screen of Canon Inkjet Cloud Printing Center.

Canon IJ Cloud Printing Center

E-mail address:

Password:

Keep login info

Login

Reset password from here

Create new account

About this service

22 Important

* You have 5 tries to enter your password. If you fail, you will not be able to log in for about the next 60
minutes.
* You remain logged in for 60 minutes after the last access.

Language
Select the language you will be using.

E-mail address
Enter the e-mail address that you entered in the user registration.

22 Important

* The e-mail address is case-sensitive. Make sure the case is correct.

Password
Enter the password that you entered in the user registration.

Keep login info
When you select the check box, the login screen is skipped for 14 days since the last day that the
service screen was accessed.
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Reset password from here
Select this if you forgot the password.
Reset your password by following the instructions on the screen.

Create new account
A new registration will be added to the Canon Inkjet Cloud Printing Center.
For a new registration, you need the Printer registration ID.

About this service
This displays the descriptions of this service.

System requirements
This displays the system requirements for the Canon Inkjet Cloud Printing Center.

Software license info
The licensing information of Canon Inkjet Cloud Printing Center is displayed.

Description of the Main screen

When you log in to the Canon Inkjet Cloud Printing Center, the Main screen appears.
If you are using a smartphone or a tablet, you can also print photos and documents.

2% Important

» With this service, the available functions differ depending on whether the user is the Administrator
or Standard user of the printer, and also on the management method that was set.

You can use areas shown below to start, add, and manage apps.

(1)(2) (3) (4)

series

Instagram

]
Scan to E-mail

Facebook
Photos in Tweets

Evernote

i o ®

Condig Proparties Manage jobs

(1) Left context menu (Administrator only)

(2) Select printer
(3) Printer name area
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(4) Right context menu

(5) Display area
(6) Menu area

(1) Left context menu (Administrator only)

When you select E the left context menu appears.
When you select Mng. printer, Manage users, Group management, or Advanced management, the
corresponding screen appears.

»>» Note

» Group management appears only when you use Select how to manage and set Manage by group
(for office users).

Mng. printer screen

Mng. printer

Updaled date: Mar 3, 2014 2:30 AM
Sares
Multiuser mode

Copy apps 4

+ Add printer

From the Mng. printer screen, you can check or update printer information registered to the Canon
Inkjet Cloud Printing Center, copy apps, change printer names, delete printers, and add printers.

» Check the printer information

Series

Multiuser mode

Copy apps

The registered printer name is displayed.

indicates that an error occurred on the printer.
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» Display update date/time of the printer information

Mng. printer

Updated data: Mar 3, 2014 2:30 AM
Sares
Multiuser mode

Copy apps

This displays the date and time the printer information was last updated.

refreshes the information.

* Multiuser mode (MAXIFY series only)

If multiple users will be using the printer, add a check mark to Multiuser mode.
The check mark is linked to the Require security code screen.

* Copy apps

Select this to copy apps added in the selected printer to another printer.

When you select , the screen shown below appears.

Copy registered apps to another
printer.
® Daestination printer:

Source printer:

series

Cancel

Set the Destination printer and the Source printer. Then select OK.

»» Note

+ If Select how to manage has been set, you can use this function only when you select
Manage app availability by printer.
For details, see "Tips on Using Canon Inkjet Cloud Printing Center (at Work)".

» Change the printer name

When you select , a screen to change the printer name appears.
Follow the instructions on the screen to change the name.

32 Important

» The printer name entry has the following character limitation:

» Up to 128 characters (Uppercase and lowercase letters are differentiated.)
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* Delete printers

When you select , the printer is deleted from the Canon Inkjet Cloud Printing Center.
When transferring the ownership of the printer, select Clear the information saved on the printer.

* Add printers

Multiuser mode

Copy apps I

+ Add printer

Select this to add printers to be used in the Canon Inkjet Cloud Printing Center.
You need a Printer registration ID to add a printer.

»» Note

+ Although the number of printers that can be registered for one domain is not limited, only up to
16 printers are guaranteed to operate.

Manage users screen

Eel Manage users =

Updated date: Feb 3, 2015 1:28 AM ﬂ

Delete

Mickname Authority

Administrator

Standard user

+ Add user

Close

From the Manage users screen, you can check user information registered to the Canon Inkjet Cloud
Printing Center, delete users, add users, and change the Administrator and Standard user settings.

» User deletion

Select the check box of the user to be deleted, and select Delete.
However, you cannot delete yourself. To delete yourself, cancel your membership from the My
account screen.
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* Adding a user

Select Add user. The user registration screen appears.

« Changing Administrator and Standard user settings

To change the privileges of the Administrator or a Standard user, select Authority for the user
whom you want to change the settings for.

Group management screen

i‘} Group management

About group management
groupi

Settings

+ Add group

Apps available on printers that do f)
not require a security code '

Settings

From the Group management screen, you can use functions for checking group information registered
to Canon Inkjet Cloud Printing Center, changing groups, deleting groups, adding groups, and setting up
users, printers, and apps belonging to each group.

* Checking group information

groupi

Settings

=+ Add group

The registered group names appear.

If there are items that have not been set, appears.

Select
group.

to display the following screen, which allows you to set up information for each

The displayed information changes depending on the selected tab.
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E Users

Displays all users and mail addresses registered in the domain.

E Printers

Displays all printers registered in the domain.

Apps

With the default settings, the screen displays all apps. To display only registered apps, select
the Registered category.

To switch between app registration/deletion, select / .

i=id Web services
Displays the external link service.
You can restrict the use of other web services that use Canon Inkjet Cloud Printing Center
accounts such as Easy-PhotoPrint+.

To switch between service linking/release, select / .

appears for items that do not have anything selected.
In the default settings, all check marks are cleared for Printers and Users. Only the system apps
under Apps are set to ON.

* Changing a Group name

To display the Group name change screen, select .
You can change the name to one of your liking by following the instructions in the displayed screen.

32 Important

* When you enter a Group name, the following restrictions apply:

+ When using single-byte alphanumeric characters, enter at least 1 but not more than 20
characters. When using double-byte characters, enter at least 1 but not more than 10
characters.

123



» Duplicate group names cannot be registered in the same domain.

* Deleting a Group

To delete a group from Canon Inkjet Cloud Printing Center, select .
If you delete all groups, you must create a new one. To set a different management method, set the
target method from the Select how to manage screen.

« Add group

groupi

Settings

+ Add group

Add a group to be used in Canon Inkjet Cloud Printing Center.
»>» Note

* You can register up to 20 groups.

« Apps available on printers that do not require a security code

Apps available on printers that do fj
not regquire a security code '

Settings

For printers without the Multiuser mode setting or Security code settings, set the apps to be

displayed when a user selects Cloud from the printer's home screen.

If the domain does not have a printer that meets this condition, this setup screen does not appear.

Selings

To go to the setup screen, select

»» Note

+ If only the following printer is registered in the domain, it is not displayed.

* Printer without LCD monitor
* Printer with monochrome LCD monitor
* Multiuser mode printer
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Advanced management screen

-I,',I- Advanced management

You can set how to manage printer users
and app availability.
See manual for details

Require securily code
Wou can restri

requiring a

to manage
ct how lo manage apps and

printars.

Set

The Advanced management screen allows you to set the management method for printer users and
apps that can be used.

To go to the setup screen, select .

* Require security code

$¥  Advanced management

Select the printer(s) you want to require a
security code for
See manual

You cannot select models for which the
setting cannot be changed.

Each user can set a Security code, start the app, and perform printing and other operations.
This setting is linked with Multiuser mode on the Mng. printer screen.

»» Note

» The list does not display models without an LCD or models with a monochrome LCD.
» The check box does not appear for models that do not support Multiuser mode.
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+ Select how to manage

$¥  Advanced management

Manage app availability by printer
* Manage app availability by user

Manage by group (for office users)
- Set applprinter availability by group -

Cancel

You can change the management method for usable apps and printers.

Manage app availability by printer
If you are using multiple printers, you can manage the useable apps for each printer.

Manage app availability by user
When one printer is used, you can manage the usable apps by user.
For usage examples, see "Tips on Using Canon Inkjet Cloud Printing Center (at Home/If you
are using PRO-1000 series or PRO-500 series)".

Manage by group (for office users)
You can manage the usable apps and printers by group.
For usage examples, see "Tips on Using Canon Inkjet Cloud Printing Center (at Work)".

»» Note

« If you manage the usable apps by printer, the default settings will allow all users to add, delete,
and rearrange apps.
Also, if you are using a MAXIFY series printer and you select Multiuser mode in the Mng.
printer screen, only the administrator will be able to add, delete, and rearrange apps.

+ If you manage the usable apps by user, all users will be able to add, delete, and rearrange
apps, regardless of the Multiuser mode setting.

« If you manage the usable apps and printers by group, all users will only be able to rearrange

apps.

(2) Select printer

Select , and then from the Select printer screen, select a printer.
If you are using a computer, you can select a printer directly from the pull-down menu.

»>» Note

* Printers with settings that restrict their use do not appear.
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(3) Printer name area

The registered name of the printer selected is displayed.

The Administrator can change the printer name from the Mng. printer screen of the left context menu.

(4) Right context menu

When you select E the context menu appears.
The information displayed depends on the menu currently selected in the menu area.

The symbol indicates that there is a new unread notice.

ILF =2 series

Sort

Latest notices

E My account

Help/flagal notices

[ 4
Log out

I" Photos in Tweets

m Evernote

Propartis Manage johs

This displays the screen to sort registered apps.

You can use the EI El buttons to change the display order of apps. When you finish sorting, select
Done.

127



Dropbox

Evernote

Facebook

Flickr

Google Drive

»>» Note

» Description of displayed icons
: Cannot be used because it is not yet released or does not support your region, model, or
language.
u : Can be used with genuine Canon ink.
If you are using a G3000 series model, you cannot use this service because the model is not
supported.

Latest notices

Latest notices

This displays the latest notices. The (i) symbol indicates that there is a new unread notice.

My account

My account

Displays user information.
From the My account screen, you can change your account settings.
From the My account screen, you can display the Permitted services screen and clear any linked

service setting.

Help/legal notices

The description of the Canon Inkjet Cloud Printing Center screen and various reminders are
displayed.

Log out

This opens the Log out screen of the Canon Inkjet Cloud Printing Center.
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(5) Display area

The display changes based on the menu you select.
series —
Instagram
L]
Scan to E-mail
Facebook

Photos in Tweets

Evearnote

% =5 ®

Apps Condig Proparins

(6) Menu area

The following 4 menu buttons are displayed:

. Apps Apps

This displays the list of registered apps in the Display area.

—F
- NI Config

This displays the Register apps screen in the Display area.
The display can be toggled between Registered and Search apps.

The Registered screen lists registered apps.
You can check the information of these apps or deregister them.

»>» Note

« If Group management has been set, Config is not displayed.
* If Manage app availability by user has been set, even Standard user can register and delete

apps.
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LF = series —

Registered | Search apps

Instagram

UM CANON ING.

L]
q Scan to E-mail

» ONE CANON INC.

'F Facebook

~ 0N CANGN NG,

& Photos in Tweets

(]

Proparies Manag

On the Search apps screen, the apps that you can register by using the Canon Inkjet Cloud Printing
Center are displayed by category.

qraphy
Productivity
Search apps
Creativily

Remote print manager
Cards

OFF | CANON NG,

Crafls

e ® cennto
Remote PIXUSMAXIFY

Forms
CFF | CANON INC.

g SlideShare

CANDH NG,

Onaelote
§—

o When you select , the details of the app are displayed.
When you select / , you can choose to register or unregister the app.
2> Note

» Description of displayed icons

: Cannot be used because it is not yet released or does not support your region, model,
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or language.

n : Can be used with genuine Canon ink.
If you are using a G3000 series model, you cannot use this service because the model is not
supported.

®

WM Properties

This screen displays the status of the printer that is currently selected.
You can check how much ink is remaining or details about an error that occurred. You can also
access the ink purchasing site and the Online Manual.

22 Important

» The Properties displayed may differ from the actual status at the display time, depending on the
printer status.

sl Manage jobs

This screen displays the print or scan status and history.

You can check the print or scan status by looking at Status list, and the print or scan history by
looking at History.

You can also cancel print or scan jobs and delete history information.

To cancel or delete a job, select that job and then select Cancel or Delete.
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Tips on Using Canon Inkjet Cloud Printing Center (at Home/If you
are using PRO-1000 series or PRO-500 series)

The Advanced management function allows you to take advantage of the many useful functions that the
service offers for home use.
This section introduces those functions by using a family of 3 (father, mother, and child) as an example.

If the father registers the printer to Canon Inkjet Cloud Printing Center, only the father is managed by the
service, and the mother and the child cannot use the service unless the father tells them the login E-mail
address and Password.

If Mother and Child Want to Use the Service from Their Smartphones

1. The father registers to Canon Inkjet Cloud Printing Center and becomes the

Administrator

2. After logging in, the father selects Manage users from Eﬂ
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series p—

Mng. printer
Manage users

Advanced management

Facebook

Photos in Tweets

f :
]
g Evernote
.

(i

L |

Apps Config Proporties

3. The father selects Add user, and by following the screen instructions, registers the

mother and child as users.

el Manage users =

Updated date: Feb 3, 2015 1:29 AM

Delete

Nickname Authority

Administrator

+ Add user

After this registration is complete, the mother and child can individually use the service.
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If Father, Mother, and Child Want to Manage Apps Individually

With the default settings, only the Administrator (father) can register apps to be used or delete apps.
After the Administrator (father) specifies settings according to the procedure below, the father, the
mother, and the child will be able to manage apps individually.

1. As the Administrator, the father logs in to Canon Inkjet Cloud Printing Center and

selects Advanced management from E

It v series o

Mng. printer
Manage users

Advanced management
Facebook

Evernote

" Photos in Tweets

s e

Apps Config Proparlies Manage johs

2. For Select how to manage, the father selects Set
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.;:1. Advanced management

You can set how to manage printer users
and app availability.
See manual for details

Require security code

Yiou can re
requiring a s
sanvica from the aoperation panel.

Set

3. The father sets Manage app availability by user and selects OK
{:I- Advanced management

Manage app availability by printer
® Manage app availability by user

Manage by group (for office users)
- Set app/printer availability by group -

Cancel

4. The screen for checking the management method change appears

In this mode, each user can freely set

In addition, recommended apps can

be used by default. Do you want to
change the setting?

Cancel oK

To complete the setup and return to the Advanced management window, select OK.
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All registered users can register and delete apps freely.
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Tips on Using Canon Inkjet Cloud Printing Center (at Work)

The Group management function allows you take advantage of the many useful functions that the service
offers for office use.

This section introduces an example in which two printers are used, the Administrator is the senior clerk,
and the other members are the company president, the section manager, and the new hire.

»» Note

+ If the second printer has not been registered, select "Adding a Printer" and register the printer by
following the procedure.

Creating a Group for All Office Members to Use

Set the basic group.
In this example, only the Evernote app will be used on 2 printers.

1. The senior clerk reqgisters to Canon Inkjet Cloud Printing Center and becomes the

Administrator

2. The senior clerk selects Manage users from E

Manage users

Advanced management
Facebook

Evernote

" Photos in Tweets

i - ®

Condig Proportins

3. On the displayed screen, the senior clerk selects Add user and registers the company
president, the section manager, and the new hire as users
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el Manage users

Updated date: Feb 4, 2015 5:17 AM

Delete

Nickname Authority

Chief Administrator

@

+ Add user

4. The senior clerk selects Advanced management from E

=

-I:I- Manage users =3

Mng. printer

Advanced management

Mickname Authority

Chief Administrator

President Standard user

Manager Standard user

5. For Select how to manage, the senior clerk selects Set

138



.;:1. Advanced management

You can set how to manage printer users
and app availability.
See manual for details

Require security code

Yo can n

requiring

sanvica from the aoperation panel.

Set

6. The senior clerk sets Manage by group (for office users) and selects OK
ﬂ- Advanced management
Manage app availability by printer

Manage app availability by user

® Manage by group (for office users)
- Set app/printer availability by group -

Cancel

»» Note

+ If Group management has already been set up, refer to step 10 and the subsequent steps.

7. On the screen for checking management method changes, the senior clerk checks the
displayed information and selects OK.
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In this mode, each user can freely set
their own app availability.

In addition, recommended apps can
be used by default. Do you want to
change the setting?

Cancel (] 4

The setting has baen changed. The
ing screen for group

management will be displayed.

Set groups according to purpose.

OK

This appears only if the selected mode is Group management.
To complete the setup and display the Group management screen, select OK.

»» Note

» With the default settings, the group is named "group1".
» With the default settings, all registered users belong to the same group.

8. In the Group management screen, the senior clerk selects the of the group to be
renamed

9. The senior clerk enters the Group name and selects OK

Enter the group name.

Group name;

Office

Cancel

The chief clerk enters "Office" here because the clerk is setting up a group that everyone in the office
will use.

32 Important

» The following restrictions apply to entering the Group name.

» The group name can have up to 20 single-byte alphanumeric characters or up to 10 double-
byte characters.

» The same group name cannot be registered more than once in the same domain.

» Up to 20 groups can be registered.

* The person who created the group becomes the Administrator.
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10. Select Settings, and in group setup screen, check that all users on the Users tab are
selected

~' President

| Manager

" Staff

11. On Printers tab, check that all printers are selected

ol

-
Printers
a

v

12. On Apps tab, set only Evernote app to
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Evernote

CANON NG

Dropbox

CANON INC.

Photos in Tweets

CANOMN INC.

Facebook

Close

To switch between app registration/deletion, select / .
To return to the Group management screen, select Close.

This completes the setup of the group to be used by the entire office.

> Note

» The group setup screen displays all users and printers that are registered in the domain.
* If you want to set up new apps as an individual, you can add a group.

To create a new group, use Add group, and then in the setup screen for the added group, add users
and printers.

= Limiting Apps That Each User Can Use

= Limiting Apps That All Members Can Use on Printer

= Limiting Apps That Individual Users Can Use on Printer
® Limiting Printers That Individual Users Can Use

3% Important

» The available apps may differ depending on the country or the region.

Limiting Apps That Each User Can Use
Set the following:

 Entire office: Use only Evernote app
» President: Use Evernote app and Facebook app
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Available Apps

Office group —————

Autharity Administrator

Manager

Evernote
ﬁ ] Authaority Standard user
Printer 1 1
Facebook
Authority Standard user

President

Authority Standard user

1. From Eﬂ select Group management
It =- series =
Mng. printer
Manage users
Group management

Advanced management

T Facebook

" Photos in Tweets

g Evernote

> Note

» This appears only if Manage by group (for office users) is set in Advanced management.

2. In displayed screen, select Add group
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{:I- Group management

About group management
Office

Settings

+ Add group

Apps available on printers that do fj
not require a security code )

Settings

. The senior clerk enters the Group name and selects OK

Enter the group name.

Group name:

Prasident

Cancel

In this field, enter "President" as the president-only group because you will be setting apps that only
the president can use.

3% Important

+ The following restrictions apply to entering the Group name.

» The group name can have up to 20 single-byte alphanumeric characters or up to 10 double-
byte characters.

» The same group name cannot be registered more than once in the same domain.
» Up to 20 groups can be registered.

* The person who created the group becomes the Administrator.

. Follow messages displayed on screen, and select OK

The group setup screen appears.

The group has been added. The
setting screen for the added group
will be displayed.

OK
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5. On Users tab, select only president

~"  President

Manager

Staff

6. On the Printers tab, select printer to be used.

F President

L e M
Printers

Y4

v

7. On the Apps tab, set the Evernote and Facebook apps to
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President

e

Evernote

CANON INC.,

Dropbox

CANON NG,

Photos in Tweets

CANON ING.

Facebook

Close

To switch between app registration/deletion, select / .
To return to the Group management screen, select Close.

The above procedure allows you to set apps that only the president can use.

> Note

» The group setup screen displays all users and printers that are registered in the domain.

Limiting Apps That All Members Can Use on Printer

To set the apps to be used on the printer, use the following procedure provided by this service.

As an example, this section describes the procedure for allowing all users to use the Evernote app from
the printer.

1. From E‘H select Group management
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series
Mng. printer

Manage users

Group management

Advanced management

T Facebook

Photos in Tweets

I ' |
7|
U Evernote
-

»» Note

» This appears only if Manage by group (for office users) is set in Advanced management.

2. For Apps available on printers that do not require a security code, select Settings

el Group management

President

Settings

+ Add group

Apps available on printers that do fj
not require a security code '

Settings

3. On Apps tab, set only Evernote app to
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fel Settings

& = P

G Evernote

» ON CANOM ING.

Dropbox

QFFE  CANON ING.

‘j Photos in Tweets

OFF  CANON INC.

-F Facebook

Close

To switch between app registration/deletion, select / .
To return to the Group management screen, select Close.

The above procedure sets up Evernote as the only app that all users can use on the printer.

Limiting Apps That Individual Users Can Use on Printer

For each user, you can set the apps that the user can use on the printer.

As an example, this section describes the procedure for allowing only the president to also use the
Facebook app from the printer.

1. From E] select Advanced management

148



saries

Mng. printer

Manage users
Group management
Advanced management

T Facebook
Photos in Tweets

fs
m Evernote
o)

&

Apns

2. For Require security code, select Set.

‘I:I- Advanced management

You can set how to manage printer Usars
and app availability.

See manual for details

Require security code
You can restri

requinng a

sanvica from

s

Set

3. Select printer for setting up Security code.

Security codes identify individual users when multiple users are using a printer.
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Advanced management

ct the printar{s) you want o requine a
rity code for U

See manual

You cannot select models for which the
setting cannot be changed.

»» Note

+ On models where the settings cannot be changed, this function cannot be selected.
Some models do not support this function. To check whether your model supports this function,
see "Models that Support Security Codes".

. Set up Security code

If there are users who have not set up a Security code, a screen appears for checking whether to
send an e-mail prompting those users to set up a Security code.

There is a user whose security code
is not set. Do you want to send an e-
mail prompting the user to set a

sacurity code?

Cancel QK

To send a notification e-mail only to users without a Security code, select OK.

To display the Security code setup screen when each user logs in and not send the notification e-
mail, select Cancel.

150



The adminisirator has changed the
setting and now you need to set a
security code. Enter a 0- to 8-digit
security code, then select [OK]. To
set later, select [Cancel].

For details on the security code,
cantact the administrator.

About security code

Security code:

Security code (confirmation):

0o 8 digils

Cancel

22 Important

» The following character restriction applies to Security code entries:

» Up to 8 alphanumeric characters

Changed the security cod

The Security code change process ends, and the change completion message appears.
In the message screen, select OK to return to the main screen.

5. Select Cloud from the printer's home screen

6. In Switch user screen, select user
Switch user
Chief

President

Manager

Staff

7. Enter Security code that you set and Log in
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Enter security code.

Mickname:
President

security code:

——

»» Note

+ If you have not set a Security code, set a Security code from My account, and then Log in.

8. Select Facebook app

-F Facebook
Q Evernote
Matices

[ ]

Edit Manage

Only the president will be able to use the Facebook app from the printer.

Limiting Printers That Individual Users Can Use

As an example, this section describes the procedure for setting up one printer for the president and
another printer for all users.

Available Apps ——— Office.group ————

Authority Administrator

President

Authorit Standard user
ﬁ) Apps that are set | = -

for Office grou
Printer 1 arotp Manager

Authority Standard user

Authority Standard user

h .

—— President group ———

ﬁ Apps to be used I President

by President group

Printer 2 Autherity Standard user
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1. From E select Group management

It =- series

Mng. printer
Manage users
Group management

Advanced management

T Facebook
I " Photos in Tweets

U Evernote

»» Note

» This appears only if Manage by group (for office users) is set in Advanced management.

2. Select Settings for the group containing all users
I Group management

About group manageament
Office

Settings

President

Settings

+ Add group

Apps available on printers thatdo )

Close

3. On the Printers tab, clear printer that was set up for president
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o

=
Frinters

¥4

To return to the Group management screen, select Close.

22 Important

« If a user is being managed in multiple groups and an app is deleted or the target printer is
changed for one of those groups, the user can still use that app or printer if the one of the other
groups allows it.

Only the printer that was set can be used by all users.
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What is a Security code?

A Security code identifies the user when multiple other users are sharing the same printer.

3% Important

« If you are using the MAXIFY series, you can set a Security code. We recommend that you set a
Security code to prevent other users from using your account.

» This code is valid only when you use MAXIFY Cloud Link from the printer operation panel. You cannot
use this code when you access the Canon Inkjet Cloud Printing Center from your smartphone, tablet, or

computer.
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Adding a Printer

With one account, you can use the Canon Inkjet Cloud Printing Center services on multiple printers.
The procedure for adding a printer is as follows:
= |f your model has color LCD monitor

= |f your model has monochrome LCD monitor
If your model has no LCD monitor/If you are using PRO-1000 series or PRO-500 series

If your model has color LCD monitor

1. Check that an e-mail containing the URL has been sent to the registered e-mail address,

and access the URL

2. Enter the information according to the instructions on the authentication screen, and then
select Log in

User authentication

E-mail address:

Password:

Keep login info

Cancel

3. When printer addition complete message appears, select OK

Added the printer.
Do you want to select the added
printer?

Cancel

The printer addition process ends, and the main screen of Canon Inkjet Cloud Printing Center
appears.
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»» Note

« If you select Cancel, the printer selection status does not change and the main screen of
Canon Inkjet Cloud Printing Center appears.

If your model has monochrome LCD monitor
If your model has no LCD monitor/If you are using PRO-1000 series or
PRO-500 series

1. Check that an e-mail containing the URL has been sent to the registered e-mail address,
and access the URL

= |f your model has monochrome LCD monitor
= |f your model has no LCD monitor/If you are using PRO-1000 series or PRO-500 series

2. Enter the information according to the instructions on the authentication screen, and then
select Log in

User authentication

E-mail address:

Password:

Keep login info

Cancel

3. When printer addition complete message appears, select OK

Added the printer.
Do you want to select the added
printer?

Cancel

The printer addition process ends, and the main screen of Canon Inkjet Cloud Printing Center
appears.

157



»» Note

« If you select Cancel, the printer selection status does not change and the main screen of
Canon Inkjet Cloud Printing Center appears.

= Adding a PIXMA/MAXIFY Cloud Link User
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Adding a PIXMA/MAXIFY Cloud Link User

Several people can use one printer.
This section describes the user addition procedure and the user privileges.

Adding a user

1. On the service screen, select Manage users from E

series

Mng. printer

Manage users

Advanced management

Facebook

m Evernote

o
iy ®

Apps Condig Proportins

" Photos in Tweets

2. Select Add user

T Manage users —

Updated date: Feb 3, 2015 1:29 AM

Delate

Nickname Authority

Administrator

+ Add user
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»» Note

* When you select Add user, the service first checks whether the maximum number of users has
been reached. If new users can be added, the user registration screen appears.
* The maximum number of users that can be added for 1 printer is 20.

3. Enter the e-mail address of the user to be added, and then select OK

The URL for completing the registration is then sent to the entered e-mail address.

> Note

« If you enter an e-mail address that is already registered, you will receive notification that the
address is registered. To specify another e-mail address, follow the displayed instructions.

4. Access the URL reported in the e-mail

The procedure that follows describes what to do if you receive a notification e-mail.

5. Read the terms displayed in the License agreement and Privacy statement screens. If
you agree to the terms, select Agree.

License agreement

Leooisn_ 4

Impartant: Please read this before using
this service

Service Terms of Use

These Service Terms of Use (the "Terms")
are a binding agreement between you and
Canon Ine. an™) which govern your
use of the defined in Arficle 1
hereof offerad with a Canon brand printer.
You may agree to the Terms by choosing
"Agree". Your use of the Service also shall
be deemed as agreement to the Terms. If
you do not agree to the Terms, you may
not use the Service,

Canon reserves the right to modify the
Terms at any time at its sole discretion.

WWihan tha Tarme ara madifad Canmn

Do not agree Agree
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Privacy statement

: b=

English b
Impartant: Please read this before using
this service

Privacy Statement

This Privacy Statement (the "Privacy
Statement™) zribes information that
Canon Ine. ("Ca collects from us
vice™ defined in Artic
ut the warld (subject to cert:
exceptions) and how this information is
used and disclosed.
ng the Senvice, you expressly agree
pllection, use and disclosure of
information as described in the Privacy
Statement and Service Terms of Use (the
do not agree fo the terms

AF e Tarmme

Do nat agree Agres

6. Register a password for logging in to the Canon Inkjet Cloud Printing Center.

On the My Account Registration screen, enter you desired password into Password and Password
(Confirmation) and select Next.

Register My account

Set a password for logging into this
service

Password (Confirmation):

8 o 32 characlars

Cancel

32 Important

* There are character restrictions for the Password, as shown below.

» The password must be between 8 and 32 characters long, using single-byte alphanumeric
characters and symbols ("#$%&'()*+,-./:;<=>?@[¥]*_{[}~). (Alphabets are case-sensitive)
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7. Enter Nickname

Enter any user name that you want to use.

Register My account

Mickname:

1 to 20 characlars

Time zone:

(UTC) Coordinated Universal Time i

22 Important

» The user name entry field has the following character restrictions:

» The user name must be between 1 and 20 characters long, using single-byte alphanumeric
characters and symbols ("#$%&'()*+,-./:;<=>?@[¥]*_*{[}~). (Alphabets are case-sensitive)

8. Specify the Time zone setting, and select Done

Select your region on the list. If you cannot find your region on the list, select the one closest to your
region.
Apply daylight saving time
This appears only when there is a daylight saving time in the Time zone that you selected.
Select whether or not to apply the daylight saving time.
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Register My account

Mickname:

1 o 20 characlars

Time zone:

(UTC) Goordinated Universal Time A4

The main registration is complete, and a registration completion e-mail is sent.

»>» Note

* When you use MAXIFY Cloud Link, a cookie for the selected user is added to the printer, and the
login status of each user is recovered. For each printer, you can register cookies for up to 8 users.

Printer user privileges

If several users are using the cloud service for 1 printer, each user is categorized as the Administrator or
a Standard user.

»» Note

» The user who is registered first becomes the Administrator. The administrator can change the
privileges of users from the Manage users screen.

An Administrator can change printer information, add and delete apps, manage users, and perform
various other operations.

A Standard user can check printer information and start apps.

For information about the functions that each user can use, refer to the "Canon Inkjet Cloud Printing
Center window".

If you are using MAXIFY Cloud Link from the printer, select Multiuser mode in the Mng. printer screen to
set the printer to Multiuser mode. Each user can then start an app and print documents.

7> Note

* If you have not set your own Security code, select Multiuser mode to display the Security code
setup screen.
If you select Cancel, you will not be able to set Multiuser mode.

« If you are the Administrator, a confirmation screen appears asking whether you want to send an e-
mail prompting standard users without a Security code to set up their Security code.

» To send a notification e-mail is sent only to users without a Security code and to set Multiuser
mode, select OK.
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» To set Multiuser mode without sending a notification e-mail, select Cancel.

= Troubleshooting Canon Inkjet Cloud Printing Center
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Troubleshooting Canon Inkjet Cloud Printing Center

If an app cannot be installed

If the registered app is not in the Apps list

If the information is not updated when you press the update button

If you do not receive the registration e-mail

If you cannot print

Printing starts on its own even if you do not do anything

If you are unable to log in correctly even after entering the correct password in iOS or Mac

LR 2R 3E 2 2R B

If an app cannot be installed

Check the country or region where the printer was purchased.
If the printer is taken outside the country or region where it was purchased, apps cannot be installed.

If You Are Using iP110 series

Check the country or region where the printer was purchased.

If you take the printer outside the country or region where you purchased it, you may not be able to install
certain apps.

You can continue to use apps that are already installed, as long as the apps support the country or region
you are moving to.

If the registered app is not in the Apps list

Check the display language of Canon Inkjet Cloud Printing Center.

If the display language is switched to a language that does not support an app, the app will not be
displayed in the apps list but will continue to be registered.

If you switch back to the target language of the app, it will be displayed in the apps list and you will be
able to start, register, or unregister the app.

If the information is not updated when you press the update button

Because the Properties screen requires network connection with this product, the information may not be
reflected immediately. Please wait awhile, and then try updating the information again.
If the information is still not updated, then check that the product is connected to the Internet.

If you do not receive the registration e-mail

You may have entered a different e-mail address during the user registration of Canon Inkjet Cloud
Printing Center.

If your model has color LCD monitor

On the printer's Home screen, select m Setup ( - Various settings) -> il Web service

setup -> Web service connection setup -> IJ Cloud Printing Center setup -> Delete from this
service to delete the service registration.
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If your model has monochrome LCD monitor

On the printer operation panel, select the m Setup button, and then select Web service setup ->
Connection setup -> IJCloudPrintingCtr -> Delete from service to delete the service registration.

If your model has no LCD monitor

Displaying Printer Information -> IJ Cloud Printing Center setup -> Delete from this service to
delete the service registration.

To display printer information, go to the Online Manual home page, and see "Checking Printer
Information" for your model.

After resetting the printer, repeat the user registration of Canon Inkjet Cloud Printing Center from the
beginning.

If you cannot print

Check the following if you cannot print.

If your model has color LCD monitor

» Check that the printer is connected to the Internet.

» Check that the printer is connected to a LAN and the LAN environment is connected to the Internet.
» Check that no error message is displayed on the printer's LCD monitor.

« If printing does not start even after you wait awhile, go to the printer's home screen, and select

w Setup ( n Various settings) -> Web service inquiry.

If your model has monochrome LCD monitor

» Check that the printer is connected to the Internet.
» Check that the printer is connected to a LAN and the LAN environment is connected to the Internet.
» Check that no error message is displayed on the printer's LCD monitor.

« If printing does not start even after you wait awhile, go to the printer operation panel, select m
Setup, and run Web service inquiry. If printing does not start, run the inquiry several times.

If your model has no LCD monitor

» Check that the printer is connected to the Internet.

» Check that the printer is connected to a LAN and the LAN environment is connected to the Internet.

« If printing does not start even after you wait awhile, first turn off the printer, and then turn it back on
again.
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If the problem is not resolved, use the printer driver from your computer to perform the print job and check
whether the data can be printed normally on the printer.
If you still cannot print, see the troubleshooting page for your model on the Home of the Online Manual.

2> Note

» With a wireless LAN connection, after the printer is turned on, it may take several minutes before
communication is possible. Check that your printer is connected to the wireless network, and wait a
while before you start printing.

« If the printer is not turned on or is not connected to the Internet, and consequently a print job is not
processed within 24 hours after it was submitted, the print job is automatically canceled. If this
happens, check the printer power and the Internet connection, and then re-submit the print job.

Printing starts on its own even if you do not do anything

A third party may be able to illegally use the Canon Inkjet Cloud Printing Center services.

If your model has color LCD monitor

On the printer's Home screen, select m Setup ( n Various settings) ->

=2l Web service
setup -> Web service connection setup -> IJ Cloud Printing Center setup -> Delete from this
service to delete the service registration.

If your model has monochrome LCD monitor

On the printer operation panel, select the m Setup button, and then select Web service setup ->
Connection setup -> IJCloudPrintingCtr -> Delete from service to delete the service registration.

If your model has no LCD monitor

Displaying Printer Information -> IJ Cloud Printing Center setup -> Delete from this service to
delete the service registration.

To display printer information, go to the Online Manual home page, and see "Checking Printer
Information" for your model.

After resetting the printer, repeat the user registration of Canon Inkjet Cloud Printing Center from the
beginning.

If you are unable to log in correctly even after entering the correct
password in iOS or Mac

If you are using iOS or Mac and the password contains the ¥ or ¥ symbol, enter a backslash instead. For
instructions on entering a backslash, see the OS help.
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Print Easily from a Smartphone or Tablet with Canon PRINT Inkjet/
SELPHY

Use the "Canon PRINT Inkjet/SELPHY" application to easily print photos saved on a smartphone or tablet
(iOS or Android) wirelessly.

You can also receive scanned data (PDF or JPEG) directly on a smartphone or tablet without using a
computer.

Canon PRINT Inkjet/SELPHY can be downloaded from App Store and Google Play.
Follow the steps below to print photos easily.
1. Download Canon PRINT Inkjet/SELPHY.
ForiOS
For Android

2. Connect printer to Wi-Fi by following instructions on application screen.
3. Select photo in Photo Print of application, and then tap Print.
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Printing with Windows RT

When you use Windows RT 8.1 or a later version, printing is easy because you simply connect this printer to
the network.

For information about connecting to the network, see the setup URL (http://www.canon.com/ijsetup) for
using this product from your computer, smartphone, or tablet device.

When the connection is complete, the Canon Inkjet Print Utility software, which allows you to specify
detailed print settings, is downloaded automatically.

By using Canon Inkjet Print Utility, you can check the Printer status and specify detailed print settings. (The
available functions will differ depending on your usage environment and connection method.)
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Online Storage Integration Function

The printer can integrate with online storage services such as Evernote.

Integration with Online Notetaking Service [%3 "Evernote"

If an Evernote client application is installed on your computer, you can import scanned images into the
application and upload them to the Evernote server.

The uploaded images can be browsed from other computers, smartphones, etc.

To use Evernote, you need to create an account. See the "CREATE ACCOUNT" page of Evernote for
account creation.

Settings

For Windows:

In the Settings Dialog Box of IJ Scan Utility, select the item you want to set, then select Evernote for
Send to an application in Application Settings.

Refer to "Settings Dialog Box" for your model from Home of the Online Manual for details.

For Mac OS:

In the Settings Dialog of IJ Scan Ultility, select the item you want to set, then select Evernote for Send
to an application in Application Settings.

Refer to "Settings Dialog" for your model from Home of the Online Manual for details.

22 Important

» The Evernote service features are subject to change or termination without prior notice.
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Handling Paper, Originals, Ink Tanks, etc.
» Loading Paper
« Paper Sources
@« Loading Plain Paper / Photo Paper
@« Loading Envelopes

» Loading Originals

t.

Where to Load Originals

t.

Loading Originals on the Platen Glass

t.

Loading Documents in the ADF (Auto Document Feeder)

t.

Loading Based on Use

t.

Supported Originals
» Inserting a USB Flash Drive
« Inserting a USB Flash Drive
« Removing a USB Flash Drive
» Replacing Ink Tanks
@« Replacing Ink Tanks

@« Checking Ink Status on the Touch Screen
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Loading Paper
» Paper Sources
» Loading Plain Paper / Photo Paper

» Loading Envelopes
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Paper Sources

Types and Sizes of Paper You Can Use

Paper can be loaded in cassette 1 (A) and in cassette 2 (B).

o7

On top, cassette 1 (A) holds all sizes of paper that are compatible with the machine, such as plain paper,
photo paper, and envelopes.

Below it, cassette 2 (B) holds A4, Letter, Legal, Oficio, B-Oficio, M-Oficio, Foolscap, and Legal (India)-
sized plain paper.

= Supported Media Types

To avoid running out of paper, you can load the same size of plain paper (A4, Letter, Legal, Oficio, B-
Oficio, M-Oficio, Foolscap, or Legal (India)) in both cassettes and set the machine to automatically switch
to the other cassette when the first one is empty.

= Cassette settings

»>» Note

* When printing, select the correct sizes and types of paper. Incorrect page size and media type
settings may cause feeding from the wrong paper source, or print quality may be affected.

For instructions on loading paper in a cassette, see these sections.

= | oading Plain Paper / Photo Paper
= | oading Envelopes

Adjusting the cassette to the Size of Paper Used

The cassette can be adjusted to three lengths. To extend the cassette, hold down the lock (C) as you pull
the front toward you.
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D: Lock position for stowing the cassette

Set to position D when the machine will not be used for some time, or before shipping it. In this position,
the cassette is flush against the surface of the machine. Note that paper cannot be loaded in this position.

E: Lock position for A4 or Letter-sized paper or smaller

Set to position E for paper of A4 or Letter size or smaller. The cassette is not flush against the machine,
but you can cover it by pulling out the paper output tray. Set the cassette to this position for normal use.

F: Lock position for paper larger than A4 or Letter size

Set to position F for paper larger than A4 size, such as Legal-sized paper. In this position, the cassette is
not fully covered when you pull out the paper output tray. (By design, the cassette protrudes from the
machine a little.)

Load Paper Printing-Side Down

Some paper such as photo paper has distinct top and bottom surfaces. Load this paper with the whiter or
glossy side facing down.
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Loading Plain Paper / Photo Paper

Load paper in cassette 1 or cassette 2.

* This example demonstrates loading in cassette 1, but paper is loaded the same way in cassette 2.

22 Important

» Paper may jam if you test printing by cutting plain paper into smaller sizes, such as 4" x 6" (10 x 15 cm)
or5"x 7" (13 x 18 cm).

»» Note

* In cassette 1, you can load all sizes of paper that are compatible with the machine, such as plain paper,
photo paper, and envelopes.

* In cassette 2, load A4, Letter, Legal, Oficio, B-Oficio, M-Oficio, Foolscap, or Legal (India)-sized plain
paper.

» For details on sizes and weights of paper you can use, see Supported Media Types.

* For instructions on loading envelopes, see Loading Envelopes.

1. Prepare the paper.

Align the edges of the paper. If the paper is curled, flatten it.

»» Note

+ Align the edges of paper neatly before loading it. Loading an uneven stack of paper may cause
paper jams.
* If paper is curled, gently bend the curled corners in the opposite direction to flatten the paper.

For details on how to flatten curled paper, see "Correct curl before loading paper." in Paper Is
Smudged / Printed Surface Is Scratched.

+ Slight curling of Photo Paper Plus Semi-gloss SG-201 should not be straightened. Instead, load
one sheet at a time as-is. Bending this kind of paper to flatten it may crack the surface and reduce
print quality.

2. Pull out a cassette.
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3. Slide the front (A) and right (B) paper guides out to make room for the paper.

4. Load the stack of paper printing-side DOWN, centered on the cassette.

3% Important

» Always load paper in portrait orientation (C). Loading paper in landscape orientation (D) may
cause paper jams.

17%%» Note

» Some paper such as photo paper has distinct top and bottom surfaces. Load this paper with the
whiter or glossy side facing down.
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« Align the stack of paper with the edge of the cassette as shown.
Feeding problems may occur if the paper is touching the protrusion (E).

E

\

» To load paper 5" x 7" (13 x 18 cm) or smaller, lift the tab (F) on the paper guide. (Only cassette 1
can be used for paper of this size.)

» To load paper larger than A4 size, press the lock (G) and pull the cassette all the way out.

5. Align the front paper guide (A) with the stack.

The paper guide (A) clicks into place when aligned with a page size marked on the cassette.

6. Slide the right paper guide (B) to align the right and left guides with both edges of the stack.

Do not set the paper guides too firmly against the paper, which may cause feeding problems.
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»» Note

* Do not load sheets of paper past the load limit mark (H).
» Keep the stack height below the paper guide tabs (I).

7. Insert the cassette.

Push the cassette into the machine until it stops.

After you insert the cassette, a screen for registering paper information for the cassette is displayed on

the touch screen.

.

&/

> Note

» Paper A4 or Letter-sized or smaller: The cassette stops at the same position as the extended

paper output tray, which then covers the cassette.
» Paper larger than A4 or Letter size: The cassette protrudes past the paper output tray. Do not
force the cassette into the machine any further, which may damage the machine or cassette.
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8. Select the size and type of paper in the cassette in Page size and Type, and then tap
Register.

Follow the instructions of any messages displayed to register the paper information.

= Paper Settings

Cassette 1 paper information

Select the paper loaded in
cassette 1.

Page size Ad

Type Plain paper

Register

9. Pull out the output tray extension (J) and open the paper output support (K).

»» Note

» Before printing, select the size and type of paper loaded, either on the print settings screen of the
operation panel or in the printer driver.

180



Loading Envelopes

Load envelopes in cassette 1.

Once you have set up the printer driver correctly, addresses are automatically rotated and printed to suit the

envelope orientation.

32 Important

» Do not use the following envelopes. These kinds of envelops may become stuck or cause the machine

to malfunction.

» Envelopes with embossed or coated surfaces
» Envelopes with a double flap
* Envelopes with adhesive flaps that are already moistened

»>» Note

 For details on sizes and weights of paper you can use, see Supported Media Types.

1. Prepare the envelopes.

* To flatten the envelopes, press down on the corners and edges.

* Flatten any flaps that are bent.
» Using a pen, press the leading edge in the direction of insertion to flatten the envelope.

; - - Q £
N ___;;_-r ': “ N
Side view of the envelope's leading edge.

3% Important

» Envelopes that are not flat or that are loaded unevenly may become stuck. Make sure that any
curled or bowed surfaces are no higher than 0.1 inch (3 mm).

2. Pull out cassette 1.
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3. Slide the front (A) and right (B) paper guides out to make room for the paper.

4. Load the envelopes face-DOWN, centered in cassette 1.

The flap will face up, as shown below.

Up to 10 envelopes can be loaded at once.

23> Note

« Align the stack of envelopes with the edge of cassette 1 as shown.

Feeding problems may occur if the envelopes are touching the protrusion (C).
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5. Align the front paper guide (A) with the edge of the envelopes.

6. Slide the right paper guide (B) to align the right and left guides with both edges of the
envelopes.

Do not set the paper guides too firmly against the envelopes, which may cause feeding problems.

»» Note

* Do not load envelopes past the load limit mark (D).
» Keep the stack height below the paper guide tabs (E).

7. Insert cassette 1.

Push cassette 1 into the machine until it stops.

After you insert the cassette, a screen for registering paper information for the cassette is displayed on
the touch screen.

183



P

8. Select the size and type of envelopes in the cassette in Page size and Type, and then tap
Register.

= Paper Settings

Cassette 1 paper information

Select the paper loaded in
cassette 1.

Page size Envelope DL

Type Envelope

Register

9. Pull out the output tray extension (F), and then open the paper output support (G).

»» Note

» Before printing, select the size and type of loaded envelopes on the print settings screen of the printer
driver.
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Loading Originals
» Where to Load Originals
» Loading Originals on the Platen Glass

» Loading Documents in the ADF (Auto Document Feeder)
» Loading Based on Use

» Supported Originals

185



Where to Load Originals

Load originals on the platen glass or in the ADF (Auto Document Feeder).

To decide where to load originals, consider the size and type of originals and the purpose of use.

= Supported Originals

Loading Originals, Photos, or Books on the platen glass

Loading Multiple Documents of the Same Size and Thickness in the ADF

Individual documents can also be loaded in the ADF.

»>» Note

» For best results, load originals on the platen glass.
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Loading Originals on the Platen Glass

1. Open the document cover.

32 Important

* When opening or closing the document cover, be careful not to touch buttons or the touch screen
on the operation panel. This may cause unexpected operation.

2. Load the original face-DOWN on the platen glass.

= Supported Originals
= |oading Based on Use

2» Important

* Note these precautions when loading originals on the platen glass.

» Do not place any objects weighing 4.4 Ib (2.0 kg) or more on the platen glass.
» Do not apply pressure of 4.4 Ib (2.0 kg) or more against the platen glass, as by pressing down
on originals.

This may prevent correct scanning or damage the platen glass.

3. Close the document cover gently.

32 Important

+ After loading an original on the platen glass, close the document cover before copying, faxing, or
scanning.
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Loading Documents in the ADF (Auto Document Feeder)

23 Note

* For best results, load documents on the platen glass.

1. Remove any originals left on the platen glass.

2. Open the document tray.

3. Insert the document in the document tray until the machine beeps.

Load documents face-UP in the document tray.

= Supported Originals

12> Note

» No tone is played if you have silenced beeping in Device user settings > Sound control.

= Device user settings

4. Adjust the document guides (A) to match the width of the document.

Do not set the document guides too firmly against the document, which may cause feeding problems.
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Loading Based on Use

Load originals correctly for how they will be used. Originals loaded incorrectly may cause scanning
problems.

Align Originals with the alignment mark

* When loading originals to copy or fax

* When selecting Doc.type > Document or Photo in Scan and specifying a standard size (such as A4/
Letter) in Scan size

* When using a computer to:

o Scan documents, magazines, or newspapers
o Specify a standard size (such as A4/Letter) to scan originals

Place the original face-DOWN on the platen glass and align it with the alignment mark ( ). The
diagonally striped area is outside the scanning area.
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22 Important
» The striped area (A, 0.04 inch (1 mm) from the edges of the platen glass) is outside the scanning
area.

A

Center One Original on the platen glass

* When selecting Doc.type > Photo in Scan and specifying Scan size > Auto scan to scan one
original

Load the original face-DOWN at least 0.4 inch (1 cm) from the edges of the platen glass. The diagonally
striped area is outside the scanning area.
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Load Multiple Originals on the platen glass

* When selecting Doc.type > Photo in Scan and specifying Scan size > Auto multi scan to scan
multiple originals
* When scanning multiple photos, postcards, or business cards from a computer

Load the originals face-DOWN. Leave at least 0.4 inch (1 cm) open between originals and from the edges
of the platen glass. The diagonally striped area is outside the scanning area.

You can load up to 12 originals at once.
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A: At least 0.4 inch (1 cm)
»» Note

» Skew Correction automatically straightens images scanned from originals loaded askew (up to
approximately 10°). However, scans of photos with a long edge of 7.1 inches (180 mm) or more that
are loaded askew cannot be corrected.

» Non-rectangular or irregularly shaped photos (such as cut-out photos) may not be scanned correctly.
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Supported Originals

On the platen glass

Item Details

Kind of original - Document, magazine, or newspaper

- Photo, postcard, business card, or optical disc (Blu-ray disc, DVD, or
CD)

- Documents unsuitable for the ADF

Size (width x height) Max. 8.5 x 11.7 inches (216 x 297 mm)
Quantity One or more sheets*
Thickness Max. 0.4 inch (10 mm)

* With some functions, multiple originals can be loaded on the platen glass.

= | oading Based on Use

In the ADF (Auto Document Feeder)

Item Details
Kind of original Plain-paper documents with multiple pages of the same size, thickness,
and weight
Size (width x height) - Max. 8.5 x 14.0 inches (216 x 356 mm)

- Min. 5.8 x 5.8 inches (148 x 148 mm)

Duplex copying or 2-on-1/4-on-1 copying: A4/Letter only

Quantity - Ad/Letter: Max. 50 sheets (20 Ib (75 g /m2) paper), up to 0.20 inch (5
mm) high

- Legal: Max. 10 sheets (20 Ib (75 g /m?2) paper), up to 0.04 inch (1 mm)
high

- Other sizes: 1 sheet

Thickness 0.003 to 0.005 inch (0.07 to 0.13 mm)
Weight 16.0 to 25.3 Ib (60 to 95 g /m?)
»» Note

» Make sure any liquids on documents, such as glue, ink, or correction fluid are dry before loading.
Do not load glued documents in the ADF, even if the glue is dry, because this may cause paper jams.

» Remove all staples, paper clips, or other fasteners before feeding documents.
» Load Legal-sized documents in the ADF.
» Do not load these kinds of documents in the ADF, which may cause paper jams.

* Wrinkled or creased documents
* Curled documents

» Torn documents

* Documents with holes
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Glued documents

Documents with sticky notes
Documents on carbon paper
Documents on coated paper

Documents on onion skin or other thin paper

Photos or excessively thick documents
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Inserting a USB Flash Drive
» Inserting a USB Flash Drive

» Removing a USB Flash Drive
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Inserting a USB Flash Drive

Supported Image Files

» Can print images taken with cameras conforming to Design Rule for Camera File System
specifications, as well as TIFF images. Both types of images must conform to Exif 2.2/2.21/2.3. Other
types of images or movies such as RAW images cannot be printed.

» Can print images scanned and saved by the machine itself with Doc.type set to Photo and Format
set to JPEG (file extension ".jpg").

> Note

 This device incorporates exFAT technology licensed from Microsoft.

« If the USB flash drive does not fit in the machine's USB flash drive port, you may need an extension
cable for it. This accessory is available at electronics stores.

* Not all USB flash drives may be detected by the machine, and correct operation is not guaranteed.

» Secure USB flash drives may not be compatible.

1. Insert the USB flash drive into the USB flash drive port.

Make sure the USB flash drive is right-side up and insert it straight into the port.

194



Removing a USB Flash Drive

1. Before removing a USB flash drive, make sure the machine is not reading or writing data.

During these operations, a message appears on the touch screen.

2% Important

* Do not remove a USB flash drive or turn off the machine while the machine is reading or writing
data.

»» Note

« If your USB flash drive has an access indicator, check it to make sure reading or writing is
finished. Refer to the USB flash drive instruction manual, as needed.

2. Remove the USB flash drive.

Hold the USB flash drive and pull it straight out of the machine.
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Replacing Ink Tanks
» Replacing Ink Tanks

» Checking Ink Status on the Touch Screen
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Replacing Ink Tanks

In the case of warnings or errors caused by low ink levels, messages appear on the touch screen to notify
you. Respond to the message as needed.

= Message Appears
»» Note

« If printing is faint or affected by white streaks even when there is enough ink, see Maintenance
Procedure.
» For precautionary notes on handling ink tanks, see Notes on ink tanks.

Steps to Replace ink tanks

When needed, replace ink tanks as follows.

1. After confirming that the machine is on, open the front cover.

The ink tanks you can replace are identified on the touch screen, and the print head holder (A) moves
into position for replacement of those ink tanks.

/A Caution

» Do not stop the moving print head holder or force it to a different position. Do not touch the print
head holder until it stops moving.

3% Important

* Do not remove an ink tank until a new one is prepared to be installed.

» Once you remove an ink tank, the machine will not operate until a new one is installed.
» Once you remove an ink tank, the machine will not operate even if the removed ink tank is
just reinstalled.

» The ink tanks in other positions cannot be replaced. Forcing them out may damage the machine
or cause malfunction.
* Do not touch metallic parts or other areas inside the machine.
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« If you leave the front cover open for more than 60 minutes, the print head holder will move to
the right. In this case, close the front cover and open it again.

22> Note

« If a warning about ink tank replacement appears, check the message and tap OK.

2. Once the ink tank for replacement is identified on the touch screen, push up the ink tank
eject lever (B).
The ink tank is ejected.

To replace another ink tank, tap Next to display the screen for the next ink tank to replace.

S ——

32 Important

+ Place the removed ink tank into a plastic bag immediately after removing from the machine.
Otherwise, ink residue may stain your clothes or the surrounding area.

» Do not touch parts other than ink tanks.

» Follow local regulations when discarding used ink tanks.

» Handle ink tanks carefully. Do not drop them or press hard on them.

3. Remove the ink tank from the package.

2% Important

» Do not touch the contact (C) or interface (D) of the ink tank.
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2% Important

» The ink tank will not fit in the wrong position. Check the label under the installation position, and
install the ink tank in the correct position.

5. Push the ink tank in firmly until it clicks into place.

6. Tap Exit on the touch screen.

If Next is displayed, another ink tank can be replaced.

To replace the next ink tank, tap Next and repeat this procedure from step 2.
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To exit ink tank replacement, tap Next until Exit is displayed.

The print head holder moves to the standby position. The ink tanks cannot be removed from this
position.

32 Important

* Printing is not possible without a complete set of ink tanks installed. Install all ink tanks.
* Installed ink tanks cannot be removed until a replacement message appears.

7. Close the front cover.

After ink tank replacement, the machine starts mixing the ink automatically. Wait until this noise stops.
(Mixing takes 1-2 minutes.)

23> Note

* Respond to any error messages as needed.

= Message Appears

« If the print head is out of alignment, as when parallel lines are not printed parallel, align the print
head.
» The machine may make a noise during these operations, but this does not indicate a problem.
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Notes on ink tanks

32 Important

« Install replacement ink tanks promptly. Do not leave the machine without ink tanks installed.

» Replace empty ink tanks with new ones. Installing used ink tanks may clog the nozzles. Used ink
tanks may also prevent correct notification of the ink tank replacement timing.

* Do not remove installed ink tanks and leave them outside the machine. In this state, ink tanks will dry
out, which may prevent correct operation when they are reinstalled. To maintain optimal print quality,
use up ink tanks within six months after you install them.

»>» Note

» Color ink may be consumed even when printing black-and-white originals, or when black-and-white
printing is specified.

All colors of ink are also consumed during standard and deep print head cleaning to maintain
performance. When ink tanks run out of ink, promptly replace them with new ones.

= |nk Tips

201



Checking Ink Status on the Touch Screen

»» Note

* If one or more ink colors runs out, changes to in the HOME screen. When

appears, check which ink (or inks) has run out using the following procedure.

1. Make sure the machine is on, and display the HOME screen.

If the HOME screen is not displayed, press the HOME button to display it.

2. Tap on the HOME screen.

= Using the Operation Panel

A symbol appears in area A in case of any messages about the remaining ink level.

Current estimated ink levels

_|H|5|n

Y BK C N

Ink number

Example: *

Ink tank is running low. Prepare a new ink tank.

»» Note

* Ink levels on this screen are estimates.

* You can also display the Current estimated ink levels screen by tapping Setup on the HOME
screen and selecting Estimated ink levels in the setup menu.

To check the ink tank model number, display the Ink number screen by tapping Ink number.
Tapping Print no. on this screen enables you to print the ink tank model number. Tapping Order
ink now displays the QR code for accessing the ink order site. Cost of connecting to Internet is to
be born by the customer.

Ink status can also be checked from the touch screen during printing.

* You can also check ink status from a computer.

= Checking the Ink Status from Your Computer (Windows)
= Checking the Ink Status from Your Computer (Mac OS)
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Maintenance

Y

If Printing Is Faint or Uneven

Y

Performing Maintenance Functions from Your Computer (Windows)

Y

Performing Maintenance Functions from Your Computer (Mac OS)

Y

Cleaning
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If Printing Is Faint or Uneven

» Maintenance Procedure

¥

Printing the Nozzle Check Pattern

¥

Examining the Nozzle Check Pattern

¥

Cleaning the Print Head

¥

Deep Print Head Cleaning

¥

Aligning the Print Head

¥

Aligning the Print Head Manually
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Maintenance Procedure

Follow these steps to restore print quality if printing becomes faint or uneven, colors are incorrect, or printing
results are not as expected (as when parallel lines are not printed parallel).

»>» Note

* Increasing the print quality in the printer driver may give better results.

= Changing the Print Quality and Correcting Image Data (Windows)
= Changing the Print Quality and Correcting Image Data (Mac OS)

To Correct Faint or Uneven Printing:

Print the nozzle check pattern.

From your machine

= Printing the Nozzle Check Pattern

From your computer

= Printing a Nozzle Check Pattern (Windows)
= Printing a Nozzle Check Pattern (Mac OS)

Examine the nozzle check pattern.

Some missing lines or horizontal white streaks in the pattern:

Clean the print head.

From your machine

= Cleaning the Print Head

From your computer

= Cleaning the Print Heads (Windows)
= Cleaning the Print Heads (Mac OS)

After cleaning the print head, print and examine the nozzle check pattern again: = Step1

Problem not resolved after you perform from step 1 to step 3 twice:

‘v"

Perform deep print head cleaning.

From your machine

= Deep Print Head Cleaning

From your computer

= Cleaning the Print Heads (Windows)
= Cleaning the Print Heads (Mac OS)
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> Note

« If printing problems remain even after step 4, turn the machine off, wait at least 24 hours, and perform
deep print head cleaning again. Leave the machine plugged in after you turn it off.

If the problem is still not resolved, the print head may be damaged. Contact the service center.

To Correct Misalignment:

Align the print head.

From your machine

= Aligning the Print Head

From your computer

= Aligning the Print Head Position (Windows)
= Aligning the Print Head Position (Mac OS)
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Printing the Nozzle Check Pattern

Print the nozzle check pattern to determine whether ink is being ejected correctly from the print head
nozzles.

»>» Note

* If ink runs out as the nozzle check pattern is printed, an error message appears on the touch screen.

= Message Appears

What you will need: one sheet of A4 or Letter-sized plain paper

1. Make sure the machine is on.

| A
T.
2. Flick the HOME screen, and then tap . Setup.

= Using the Operation Panel

The setup menu screen is displayed.

Maintenance.

The Maintenance screen is displayed.

4. Tap Print nozzle check pattern.

Maintenance
int nozzle check pattern

Cleaning

Deep cleaning

fitn haad alinnmeant

A confirmation screen is displayed.

5. Load a sheet of A4 or Letter-sized plain paper in cassette 1.

32 Important

» The screen for registering page size and media type is not displayed during any of the operations
available in the Maintenance screen. Therefore, printing will be executed even if paper other than
A4 or Letter-sized plain paper is loaded.

» Nozzle check patterns cannot be printed from cassette 2. Load paper in cassette 1.

6. Pull out the output tray extension and open the paper output support.
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7. Tap Yes.

After the nozzle check pattern is printed, two pattern confirmation screens are displayed.

8. Examine the nozzle check pattern.
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Examining the Nozzle Check Pattern

Examine the nozzle check pattern and clean the print head if necessary.

1. Check for any missing lines in pattern C or horizontal white streaks in pattern D.

A B

| (e

X 7

A: No missing lines or horizontal white streaks
B: Some missing lines and horizontal white streaks

E: Number of pages printed to date

2. On the checking screen, select patterns that most resemble the printed nozzle check
pattern.

Which is closer for printed
color patterns?

Which is closer for printed
color patterns?

A B

In the case of A (no missing lines or horizontal white streaks) in both patterns (C and D):
No cleaning is required. Tap All A, check the message, and then tap OK.

The Maintenance screen is now displayed again.
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In the case of B (some missing lines or horizontal white streaks) in either pattern (C or D) or both
patterns:

Cleaning is required. Tap Also B, and then tap Yes on the cleaning confirmation screen.
The machine now starts cleaning the print head.

= Cleaning the Print Head

»>» Note

» On the nozzle check printout, the record of total pages printed is indicated in increments of 50 pages.
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Cleaning the Print Head

Clean the print head if the nozzle check pattern has missing lines or horizontal white streaks. Cleaning
unclogs nozzles and restores the print head to a better condition. However, because print head cleaning
consumes ink, this operation is advisable only when necessary.

»» Note

* Cleaning can also be performed from a computer. When using a computer, you can also select the ink
group for cleaning.

= Cleaning the Print Heads (Windows)
= Cleaning the Print Heads (Mac OS)

+ Cleaning from the operation panel cleans all print head colors.

What you will need: one sheet of A4 or Letter-sized plain paper

1. Make sure the machine is on.

| A
T.
2. Flick the HOME screen, and then tap . Setup.

= Using the Operation Panel

The setup menu screen is displayed.

Maintenance.

The Maintenance screen is displayed.

4. Tap Cleaning.

Maintenance
Print nozzle check pattern

|,_E_Ie aning

Deep cleaning

fitn haad alinnmeant

A confirmation screen is displayed.

5. Tap Yes.

The machine now starts cleaning the print head.

Do not perform any other operations until print head cleaning is finished. Cleaning will take about 2
minutes.
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Afterward, a confirmation screen is displayed for printing a nozzle check pattern.

6. Load a sheet of A4 or Letter-sized plain paper in cassette 1.

3% Important

» The screen for registering page size and media type is not displayed during any of the operations
available in the Maintenance screen. Therefore, printing will be executed even if paper other than

A4 or Letter-sized plain paper is loaded.
» Nozzle check patterns cannot be printed from cassette 2. Load paper in cassette 1.

7. Pull out the output tray extension and open the paper output support.

8. Tap Yes.

The nozzle check pattern is now printed.

9. Examine the nozzle check pattern.

»» Note

« If printing problems remain even after you clean the print head twice, perform deep print head cleaning.
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Deep Print Head Cleaning

If standard print head cleaning does not improve print quality, try deep print head cleaning. However,
because deep print head cleaning consumes more ink, this operation is advisable only when necessary.

»>» Note

» Deep print head cleaning can also be performed from a computer. When using a computer, you can
also select the ink group for deep cleaning.

= Cleaning the Print Heads (Windows)
= Cleaning the Print Heads (Mac OS)

*» Deep print head cleaning from the operation panel cleans all print head colors.

What you will need: one sheet of A4 or Letter-sized plain paper

1. Make sure the machine is on.

2. Flick the HOME screen, and then tap W Setup.

= Using the Operation Panel

The setup menu screen is displayed.

Maintenance.

The Maintenance screen is displayed.

4. Tap Deep cleaning.

Maintenance
Print nozzle check pattern

Cleaning

__:I:!eep cleaning

fitn haad alinnmeant

A confirmation screen is displayed.

5. Tap Yes.
Deep print head cleaning now begins.

Do not perform any other operations until deep print head cleaning is finished. Cleaning will take 2—3
minutes.

Afterward, a confirmation screen is displayed for printing a nozzle check pattern.
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6. Load a sheet of A4 or Letter-sized plain paper in cassette 1.

2% Important

» The screen for registering page size and media type is not displayed during any of the operations
available in the Maintenance screen. Therefore, printing will be executed even if paper other than
A4 or Letter-sized plain paper is loaded.

» Nozzle check patterns cannot be printed from cassette 2. Load paper in cassette 1.

7. Pull out the output tray extension and open the paper output support.

8. Tap Yes.

The nozzle check pattern is now printed.

9. Tap OK when a message is displayed indicating that deep print head cleaning is finished.

10. Examine the nozzle check pattern.

If printing problems remain, turn the machine off, wait at least 24 hours, and perform deep print head
cleaning again. Leave the machine plugged in after you turn it off.

If the problem is still not resolved, the print head may be damaged. Contact the service center.
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Aligning the Print Head
If printed images seem distorted, as when parallel lines are not printed parallel, align the print head.

»» Note

« If ink runs out as the print head alignment sheet is printed, an error message appears on the touch
screen.

= Message Appears

What you will need: one sheet of A4 or Letter-sized plain paper (recycled paper is acceptable)*

* Use white paper that is clean on both sides.

1. Make sure the machine is on.

| A
T.
2. Flick the HOME screen, and then tap . Setup.

= Using the Operation Panel

The setup menu screen is displayed.

3. Tap Maintenance.

The Maintenance screen is displayed.
4. Tap Auto head alignment.

Maintenance
Leep cileaning

|ﬁv. uto head alignment

MManual head alignment

Print the haad alisnmeant valiie

A confirmation screen is displayed.

5. Load a sheet of A4 or Letter-sized plain paper in cassette 1.

3% Important

» The screen for registering page size and media type is not displayed during any of the operations
available in the Maintenance screen. Therefore, printing will be executed even if paper other than
A4 or Letter-sized plain paper is loaded.

* Print head alignment cannot be performed from cassette 2. Load paper in cassette 1.
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6. Pull out the output tray extension and open the paper output support.

7. Tap Yes.
The print head alignment sheet is printed, and the print head is aligned automatically.

This process takes 3—4 minutes.

»» Note

+ If automatic print head alignment fails, an error message appears on the touch screen.

= Message Appears

8. Tap OK when a message is displayed indicating that print head alignment is finished.

> Note

« If printing is still unsatisfactory after automatic print head alignment, align the print head manually.
You can also align the print head manually from a computer.

= Aligning the Print Head Position Manually (Windows)
= Aligning the Print Head Position Manually (Mac OS)
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Aligning the Print Head Manually

Try aligning the print head manually after automatic alignment if printing results are not as expected, as
when parallel lines are not printed parallel.

»>» Note

* For details on automatic print head alignment, see Aligning the Print Head.

What you will need: two sheets of A4 or Letter-sized plain paper

1. Make sure the machine is on.

| A
T.
2. Flick the HOME screen, and then tap . Setup.

= Using the Operation Panel

The setup menu screen is displayed.

3. Tap m

The Maintenance screen is displayed.

Maintenance.

4. Tap Manual head alignment.

Maintenance
Liegp Cleaning

Auto head alignment

j_fqlanual head alignment

Print the haad alinonmeant valip

A confirmation screen is displayed.

»» Note

+ To print and check the current head position alignment values, select Print the head alignment
value.

5. Load two sheets of A4 or Letter-sized plain paper in cassette 1.

2% Important

» The screen for registering page size and media type is not displayed during any of the operations
available in the Maintenance screen. Therefore, printing will be executed even if paper other than
A4 or Letter-sized plain paper is loaded.

» Manual print head alignment cannot be performed from cassette 2. Load paper in cassette 1.
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6. Pull out the output tray extension and open the paper output support.

7. Tap Yes.

The print head alignment pattern is printed.

8. Confirm that the pattern was printed correctly, and if so, tap Yes after "Did the patterns
print correctly?" is displayed.

9. Check the message and tap Next.

The input screen for head position alignment values is displayed.

Manual head alignment

10. Examine the first patterns and tap A. In column A, find the pattern in which vertical streaks
are least noticeable, and then tap the number of that pattern.

U
T

L
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11.

12.

13.

»» Note

« If all patterns look different, choose the pattern in which vertical streaks are least noticeable.

A B

A: Subtle vertical streaks

B: Noticeable vertical streaks

Repeat these steps until you have finished entering pattern numbers for columns B to M,
and then tap OK.

Check the message, and then tap OK.

The second set of patterns is printed.

Examine the second patterns and tap N. In column N, find the pattern in which horizontal
streaks are least noticeable, and then tap the number of that pattern.

i

I

11

»» Note

« If all patterns look different, choose the pattern in which horizontal streaks are least noticeable.

c D

C: Subtle horizontal streaks
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14.

15.

D: Noticeable horizontal streaks

Repeat these steps until you have finished entering pattern numbers for columns O to T,
and then tap OK.

For column P, choose the pattern in which vertical streaks are least noticeable.

Tap OK when a message is displayed indicating that print head alignment is finished.

220



Performing Maintenance Functions from Your Computer
(Windows)

» Cleaning the Print Heads
» Aligning the Print Head Position

» Printing a Nozzle Check Pattern
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Cleaning the Print Heads

The print head cleaning function allows you to clear up clogged print head nozzle. Perform print head
cleaning if printing is faint or a specific color fails to print, even though there is enough ink.

The procedure for cleaning the print head is as follows:

©

N\

Cleaning

1. Open the printer driver setup window

2. Click Cleaning on the Maintenance tab

When the Print Head Cleaning dialog box opens, select the ink group for which cleaning is to be
performed.
Click Initial Check Items to display the items you need to check before performing cleaning.

3. Execute cleaning

Make sure that the printer is on and then click Execute.

Print head cleaning starts.

4. Complete cleaning

The Nozzle Check dialog box opens after the confirmation message.

5. Check the results

To check whether the print quality has improved, click Print Check Pattern. To cancel the check
process, click Cancel.

If cleaning the head once does not resolve the print head problem, clean it once more.

22 Important

* Cleaning consumes a small amount of ink.
Cleaning the print head frequently will rapidly deplete your printer's ink supply. Consequently, perform
cleaning only when necessary.

Deep Cleaning

Deep Cleaning is more thorough than cleaning. Perform deep cleaning when two Cleaning attempts do
not resolve the print head problem.

1. Open the printer driver setup window
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2. Click Deep Cleaning on the Maintenance tab

When the Deep Cleaning dialog box opens, select the ink group for which deep cleaning is to be
performed.
Click Initial Check Items to display the items you need to check before performing deep cleaning.

3. Execute deep cleaning

Make sure that the printer is on and then click Execute.
Click OK when the confirmation message appears.

Print head deep cleaning starts.

4. Complete deep cleaning

The Nozzle Check dialog box opens after the confirmation message.

5. Check the results

To check whether the print quality has improved, click Print Check Pattern. To cancel the check
process, click Cancel.

3% Important

* Deep Cleaning consumes a larger amount of ink than Cleaning.
Cleaning the print head frequently will rapidly deplete your printer's ink supply. Consequently, perform
cleaning only when necessary.

»>» Note

« If there is no sign of improvement after Deep Cleaning, turn off the printer, wait 24 hours, and then
perform Deep Cleaning again. If there is still no sign of improvement, the ink may have run out or the
print head may be worn. For details on the remedial action to be taken, see "No Ink Comes Out."

Related Topic

= Printing a Nozzle Check Pattern

223



Aligning the Print Head Position

Print head alignment corrects the installation positions of the print head and improves deviated colors and
lines.

This printer supports two head alignment methods: automatic head alignment and manual head alignment.
Normally, the printer is set for automatic head alignment.

If the printing results of automatic print head alignment are not satisfactory, perform manual head alignment.

The procedure for performing automatic print head alignment is as follows:

1. Open the printer driver setup window

Print Head Alignment

2. Click Print Head Alignment on the Maintenance tab

The Start Print Head Alignment dialog box opens.

3. Load paper in the printer

Load one sheet of A4 size or Letter size plain paper into the cassette 1.

22 Important

» The cassette 2 is not available for the print head alignment procedure. Be sure to load paper in
the cassette 1.

> Note

» The number of sheets to be used differs when you select the manual head alignment.

4. Execute head alignment

Make sure that the printer is on and click Align Print Head.
Follow the instruction in the message.

3% Important

» Do not open the front cover while printing is in progress.

»» Note

» Wait until printing ends before performing other operations. Printing takes about 3 to 4 minutes
to complete.

»>» Note

» To print and check the current setting, open the Start Print Head Alignment dialog box, and click
Print Alignment Value.

224



Aligning the Print Head Position Manually
Print head alignment corrects the installation positions of the print head and improves deviated colors and
lines.

This printer supports two head alignment methods: automatic head alignment and manual head alignment.
Normally, the printer is set for automatic head alignment.

If the printing results of automatic print head alignment are not satisfactory, perform manual head alignment.

The procedure for performing manual print head alignment is as follows:

1. Open the printer driver setup window

Print Head Alignment

2. Click Custom Settings on the Maintenance tab

The Custom Settings dialog box opens.

»» Note

« If the printer is off or if communication between the printer and the computer is disabled, an
error message may appear because the computer cannot collect the printer status.
If this happens, click OK to display the most recent settings specified on your computer.

3. Switch head alignment to manual

Check the Align heads manually check box.

4. Apply the settings

Click OK and when the confirmation message appears, click OK.

5. Click Print Head Alignment on the Maintenance tab

The Start Print Head Alignment dialog box opens.

6. Load paper in the printer

Load two sheets of A4 size or Letter size plain paper into the cassette 1.

32 Important

» The cassette 2 is not available for the print head alignment procedure. Be sure to load paper in
the cassette 1.

7. Execute head alignment

Make sure that the printer is on and click Align Print Head.
Follow the instruction in the message.
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32 Important

* Do not open the front cover while printing is in progress.

8. Check the printed pattern

Enter the numbers of the patterns with the least noticeable streaks in the associated boxes.
Even if the patterns with the least noticeable streaks are clicked in the preview window, their numbers
are automatically entered in the associated boxes.

am=az

i -1

TS

When you have entered all the necessary values, click OK.

2> Note
« If it is difficult to pick the best pattern, pick the setting that produces the least noticeable vertical
streaks.
|
(A) (B}

(A) Least noticeable vertical streaks
(B) Most noticeable vertical streaks

9. Confirm the displayed message and click OK
The second pattern is printed.

3% Important

» Do not open the front cover while printing is in progress.

10. Check the printed pattern
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Enter the numbers of the patterns with the least noticeable stripes or streaks in the associated boxes.
Even if the patterns with the least noticeable stripes or streaks are clicked in the preview window, their
numbers are automatically entered in the associated boxes.

atiesd

LR R

When you have entered all the necessary values, click OK.

»» Note

« Ifit is difficult to pick the best pattern, pick the setting that produces the least noticeable
horizontal stripes.

(A) (B)

(A) Least noticeable horizontal stripes
(B) Most noticeable horizontal stripes

« If it is difficult to pick the best pattern, pick the setting that produces the least noticeable vertical
streaks.

(A} (E)

(A) Least noticeable vertical streaks
(B) Most noticeable vertical streaks

»>» Note

+ To print and check the current setting, open the Start Print Head Alignment dialog box, and click
Print Alignment Value.
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Printing a Nozzle Check Pattern

The nozzle check function allows you to check whether the print head is working properly by printing a
nozzle check pattern. Print the pattern if printing becomes faint, or if a specific color fails to print.

The procedure for printing a nozzle check pattern is as follows:

Nozzle Check

1. Open the printer driver setup window

2. Click Nozzle Check on the Maintenance tab

The Nozzle Check dialog box opens.
Click Initial Check Items to display the items that you need to check before printing the nozzle check
pattern.

3. Load paper in the printer
Load one sheet of A4 size or Letter size plain paper into the cassette 1.

22 Important

» The cassette 2 is not available for the nozzle check pattern printing. Be sure to load paper in the
cassette 1.

4. Print a nozzle check pattern

Make sure that the printer is on and click Print Check Pattern.
Printing of the nozzle check pattern begins.

Click OK when the confirmation message appears.
The Pattern Check dialog box opens.

5. Check the print result

Check the print result. If the print result is normal, click Exit.

If the print result is smudged or if there are any unprinted sections, click Cleaning to clean the print
head.

Related Topic

= Cleaning the Print Heads
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Cleaning

» Cleaning Exterior Surfaces

¥

Cleaning the Platen Glass and Document Cover

¥

Cleaning the ADF (Auto Document Feeder)

¥

Cleaning Paper Feed Rollers

¥

Cleaning Inside the Machine (Bottom Plate Cleaning)

¥

Cleaning Cassette Pads
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Cleaning Exterior Surfaces

Using a soft, dry cloth such as an eyeglass cloth, gently wipe the surfaces clean. Smooth out any wrinkles in
the cloth before you begin.

22 Important

 Before cleaning the machine, turn it off and unplug it.

» The power cannot be turned off while the machine is sending or receiving a fax, or when unsent
faxes are stored in the machine's memory. Make sure the machine has finished sending or
receiving faxes before turning it off.

» Remember that faxes cannot be sent or received while the machine is off.

» Unplugging the machine will reset the date/time setting and erase all documents in the machine's
memory. Send faxes, print documents, or save jobs to a USB flash drive as needed before
unplugging the machine.

 To avoid scratching surfaces, do not clean with tissue paper, paper towels, or rough-textured cloth.
Additionally, paper dust or fibers may remain in the machine and clog the print head or affect printing
quality.

* Never clean the machine with detergent or volatile chemicals such as thinner, benzine, or acetone,
which may cause malfunction or damage surfaces.

* When cleaning the touch screen, use a soft cloth such as an eyeglass cloth to wipe the surface. Do not
press down too firmly. Never wipe the touch screen with cleaners containing organic solvents.

230



Cleaning the Platen Glass and Document Cover

32 Important

» Before cleaning the machine, turn it off and unplug it.

» The power cannot be turned off while the machine is sending or receiving a fax, or when unsent
faxes are stored in the machine's memory. Make sure the machine has finished sending or
receiving faxes before turning it off.

* Remember that faxes cannot be sent or received while the machine is off.

» Unplugging the machine will reset the date/time setting and erase all documents in the machine's
memory. Send faxes, print documents, or save jobs to a USB flash drive as needed before
unplugging the machine.

+ To avoid scratching surfaces, do not clean with tissue paper, paper towels, or rough-textured cloth.
Additionally, paper dust or fibers may remain in the machine and clog the print head or affect printing
quality.

» Never clean the machine with detergent or volatile chemicals such as thinner, benzine, or acetone,
which may cause malfunction or damage surfaces.

Use a soft, dry cloth that is clean and lint-free.

Wipe away any smudges or dust on the platen glass (A), the bottom of the document cover (B, in white), the
glass surface of the ADF (Auto Document Feeder) (C), and the bottom of the ADF (D, in white).

Wipe the glass surfaces carefully, leaving no residue.

3% Important

» Be especially gentle when wiping the bottom of the document cover (B, in white).
* Any glue, ink, correction fluid, or other substances on the ADF glass (C) may cause black streaks in
scanned images. Gently wipe away any of these substances on the glass.
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Cleaning the ADF (Auto Document Feeder)
Use a soft, dry cloth that is clean and lint-free to clean the ADF (Auto Document Feeder).

3% Important

 Before cleaning the machine, turn it off and unplug it.

» The power cannot be turned off while the machine is sending or receiving a fax, or when unsent
faxes are stored in the machine's memory. Make sure the machine has finished sending or
receiving faxes before turning it off.

* Remember that faxes cannot be sent or received while the machine is off.

» Unplugging the machine will reset the date/time setting and erase all documents in the machine's
memory. Send faxes, print documents, or save jobs to a USB flash drive as needed before
unplugging the machine.

+ To avoid scratching surfaces, do not clean with tissue paper, paper towels, or rough-textured cloth.
Additionally, paper dust or fibers may remain in the machine and clog the print head or affect printing
quality.

* Never clean the machine with detergent or volatile chemicals such as thinner, benzine, or acetone,
which may cause malfunction or damage surfaces.

1. Open the document tray.

2. Open the document feeder cover.

3. Use the cloth to wipe off any paper dust inside the document feeder cover (A).
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4. When finished, push the document feeder cover closed until it clicks into place.

5. Close the document tray.
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Cleaning Paper Feed Rollers

Dusty or dirty paper feed rollers may prevent correct feeding.

In this case, clean the paper feed rollers. However, because cleaning causes roller wear, perform cleaning
only when necessary.

What you will need: three sheets of A4 or Letter-sized plain paper

1. Make sure the machine is on.

| A
T.
2. Flick the HOME screen, and then tap . Setup.

= Using the Operation Panel

The setup menu screen is displayed.

Maintenance.
The Maintenance screen is displayed.
4. Tap Roller cleaning.

Maintenance
Ividlidal Nead Sigiimeric

Print the head alignment value

[Roller cleaning

Bottom plate cleaning

A confirmation screen is displayed.

5. Tap Yes.

6. Tap the paper source to clean (Cassette 1 or Cassette 2).

7. Follow the instructions to remove any paper from the paper source selected in step 6.

8. Tap OK.

The paper feed rollers rotate as they are cleaned without paper.

9. After confirming that the paper feed rollers have stopped rotating, follow the instructions to
load three sheets of A4 or Letter-sized plain paper in the paper source selected in step 6.
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2% Important

» The screen for registering page size and media type is not displayed during any of the operations
available in the Maintenance screen. Therefore, printing will be executed even if paper other than
A4 or Letter-sized plain paper is loaded.

10. Pull out the output tray extension and open the paper output support.

11. Tap OK.

Cleaning begins again. Once the paper is ejected, cleaning is finished.

12. Tap OK when a message is displayed indicating that cleaning is finished.

If the problem remains after you clean the paper feed rollers, contact the service center.
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Cleaning Inside the Machine (Bottom Plate Cleaning)

Remove stains inside the machine as follows. Clean this way regularly, because any dust or excess ink in
the machine may get on your printouts.

What you will need: one sheet of A4 or Letter-sized plain paper*

* Use a new sheet of paper.

1. Make sure the machine is on.

| A
T.
2. Flick the HOME screen, and then tap . Setup.

= Using the Operation Panel

The setup menu screen is displayed.

Maintenance.

The Maintenance screen is displayed.

4. Tap Bottom plate cleaning.

E
Ividlidal Nead Sigiimeric
Print the head alignment value

Roller cleaning

|_:ﬁuttum plate cleaning

A confirmation screen is displayed.

5. Tap Yes.

6. Follow the instructions to remove any paper from cassette 1, and then tap OK.

7. Fold a single sheet of A4 or Letter-sized plain paper in half widthwise, and then unfold it.

8. Fold one side in half again, aligning the edge of the sheet with the center crease. Unfold the
paper and tap OK.
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9. Load only this sheet in cassette 1, with the ridges of the creases facing up and the edge of
the uncreased half facing away from you.

2% Important

» The screen for registering page size and media type is not displayed during any of the operations
available in the Maintenance screen. Therefore, printing will be executed even if paper other than
A4 or Letter-sized plain paper is loaded.

» Bottom Plate Cleaning cannot be performed from cassette 2. Load paper in cassette 1.

10. Pull out the output tray extension and open the paper output support.

11. Tap OK.

The paper now cleans inside the machine as it passes through.

Check the ridges of the ejected paper. If they are smudged with ink, perform Bottom Plate Cleaning
again.

12. Tap OK when a message is displayed indicating that cleaning is finished.

> Note

* When repeating Bottom Plate Cleaning, use a new sheet of paper.

If the problem remains after repeated cleaning, protrusions inside the machine may be stained. Carefully
wipe off any ink on the protrusions using a cotton swab or the like.

32 Important

» Before cleaning the machine, turn it off and unplug it.
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» The power cannot be turned off while the machine is sending or receiving a fax, or when unsent
faxes are stored in the machine's memory. Make sure the machine has finished sending or
receiving faxes before turning it off.

* Remember that faxes cannot be sent or received while the machine is off.

» Unplugging the machine will reset the date/time setting and erase all documents in the machine's
memory. Send faxes, print documents, or save jobs to a USB flash drive as needed before
unplugging the machine.
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Cleaning Cassette Pads

If the pad in a cassette becomes dirty or covered with paper dust, multiple sheets of paper may be ejected
at once. Clean cassette pads as follows.

What you will need: cotton swab

1. Pull out cassette 1 or cassette 2 and remove the paper.

2. Use a moistened cotton swab to wipe away any dirt or debris on the pad (A).

3% Important

« After cleaning, allow the pad to dry completely.

Example of cleaning cassette 1:

3. Reload the paper and insert the cassette.

»» Note

« If a message appears after you insert the cassette, tap Register.

If the problem is not resolved, contact the service center.

239



Overview
» Safety
« Safety Precautions
@« Regulatory Information
« WEEE (EU & EEA)

» Main Components and Their Use

t.

Main Components

t.

Power Supply

t.

Using the Operation Panel

t.

Entering Numbers, Letters, and Symbols
» Changing Settings
@« Changing Printer Settings from Your Computer (Windows)
@« Changing Printer Settings from Your Computer (Mac OS)
@« Changing Settings from Operation Panel
« Changing Printer's Setting Using Web Browser
» Network Connection
@« Network Connection Tips
» Network Settings (IJ Network Device Setup Utility) (Windows)
« |J Network Device Setup Utility
« Starting Up IJ Network Device Setup Utility
« |J Network Device Setup Utility Screen
@« Performing Network Settings
@« Checking Network Status
« |J Network Device Setup Utility Menus
@« Other Network Information
» Network Communication (Mac OS)

@« Checking and Changing Network Settings

240



]

Network Communication Tips

» Ensuring Optimal Printing Results

]

]

Ink Tips

Printing Tips

Check Paper Settings Before Printing

Set Cassette Paper Information After Loading Paper
Canceling Print Jobs

Keeping Print Quality High

Transporting Your Machine

» Legal Restrictions on Scanning/Copying

» Specifications

241



Safety

» Safety Precautions
» Regulatory Information

» WEEE (EUEEA)

242



Safety Precautions

Choosing a location

Do not install the printer in a location that is unstable or subject to excessive vibration.

Do not install the printer in locations that are very humid or dusty, in direct sunlight, outdoors, or close
to a heating source.

To avoid the risk of fire or electric shocks, use the printer under the operating environment specified in
the Specifications.

Do not place the printer on a thick rug or carpet.

Place the printer with its back in a location that is more than 2 inches (5 cm) away from the wall.

Power Supply

Ensure that the area around the power outlet is kept clear at all times so you can easily unplug the
power cord if necessary.

Never remove the plug by pulling on the cord.

Pulling the cord may damage the power cord, leading to possible fire or electrical shock.

Do not use an extension lead/cord.

Working Around the Printer

Never put your hands or fingers in the printer while it is printing.

When moving the printer, carry the printer at both ends. In case the printer weighs more than 14 kg, it
is recommended to have two people lifting the printer. Accidental dropping of the printer causes injury.
For the printer's weight, refer to the Specifications.

Do not place any object on the printer. Especially do not place metal objects (paper clips, staples,
etc.) or containers of flammable solvents (alcohol, thinners, etc.) on top of the printer.

Do not transport or use the printer on a slant, vertically or upside-down, as the ink may leak and
damage the printer.

When loading a thick book on the Platen Glass, do not press hard on the Document Cover. The
Platen Glass may break and cause injury.

Print Heads/Ink Tanks/FINE Cartridges

Keep ink tanks out of the reach of children. In case ink is accidentally licked or swallowed, rinse out
mouth or give one or two glasses of water to drink. If irritation or discomfort occurs, obtain medical
advice immediately.

In case ink gets in contact with eyes, rinse with water immediately. In case ink gets in contact with
skin, wash with soap and water immediately. If irritation to eyes or skin persists, obtain medical advice
immediately.

Never touch the electrical contacts on a print head or FINE cartridges after printing.

The metal parts may be very hot and could cause burns.

Do not throw ink tanks and FINE cartridges into fire.

Do not attempt to disassemble or modify the print head, ink tanks, and FINE cartridges.
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Regulatory Information

IMPORTANT SAFETY INSTRUCTIONS
SAVE THESE INSTRUCTIONS

When using your telephone equipment, basic safety precautions should always be followed to reduce the
risk of fire, electric shock and injury to persons, including the following:

1. Do not use this product near water, for example, near a bath tub, wash bowl, kitchen sink or laundry
tub, in a wet basement or near a swimming pool.

2. Avoid using this product during an electrical storm. There may be a remote risk of electric shock from
lightning.

3. Do not use this product to report a gas leak in the vicinity of the leak.

"CAUTION - To reduce the risk of fire, use only No. 26 AWG or larger telecommunication line cord."

IMPORTANTES MESURES DE SECURITE
CONSERVER CES INSTRUCTIONS

Certaines mesures de sécurité doivent étre prises pendant l'utilisation de matérial téléphonique afin de
réduire les risques d'incendie, de choc électrique et de blessures.

En voice quelquesunes :

1. Ne pas utiliser I'appareil prés de l'eau, p.ex., prés d'une baignoire, d'un lavabo, d'un évier de cuisine,
d'un bac a laver, dans un sous-sol humide ou prés d'une piscine.

2. Eviter d'utiliser I'appareil pendant un orage électrique. Ceci peut présenter un risque de choc
électrique causé par la foudre.

3. Ne pas utiliser I'appareil pour signaler une fuite de gaz s'il est situé prés de la fuite.

"ATTENTION - Pour réduire les risques d'incendie, utiliser uniquement des conducteurs de
télécommunications 26 AWG au de section supérleure.”

Users in the U.S.A.

FCC Notice (U.S.A. Only)
For 120V, 60Hz model
Model Number: K10435 (Contains FCC Approved WLAN Module K30365)

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If this equipment
does cause harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:
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» Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

» Consult the dealer or an experienced radio/TV technician for help.

Use of a shielded cable is required to comply with Class B limits in Subpart B of Part 15 of the FCC Rules.

Do not make any changes or modifications to the equipment unless otherwise specified in the manual. If
such changes or modifications should be made, you could be required to stop operation of the equipment.

FCC ID:AZDK30365

Changes or modifications not expressly approved by the party responsible for compliance could void the
user's authority to operate equipment.

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

The equipment complies with FCC radiation exposure limits for at uncontrolled equipment. This
equipment should be installed and operated with minimum distance at least 20cm between the radiator
and persons body (excluding extremities: hands, wrists, feet and ankles) and must not be colocated or
operated with any other antenna or transmitter.

Canon U.S.A,, Inc.

One Canon Park
Melville, New York 11747
1-800-652-2666

Pre-Installation Requirements

Order Information

When ordering service from the telephone company for this equipment, the following may be required.
Universal Service Order Code (USOC): RJ11C

The Facility Interface Code (FIC): 02LS2

Service Order Code (SOC): 9.0F

Connection of the Equipment
This equipment complies with Part 68 of the FCC rules and the requirements adopted by the ACTA.

A label on this equipment contains, among other information, a product identifier in the format
US:AAAEQ##TXXXX. If requested, this number must be provided to the telephone company.

The REN is used to determine the number of devices that may be connected to a telephone line.

Excessive RENs on a telephone line may result in the devices not ringing in response to an incoming call.
In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the number of
devices that may be connected to a line, as determined by the total RENs, contact the local telephone
company. The REN for this product is part of the product identifier that has the format
US:AAAEQ##TXXXX. The digits represented by ## are the REN without a decimal point (e.g., 03 is a
REN of 0.3).
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A plug and jack used to connect this equipment to the premises wiring and telephone network must
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant
telephone cord and modular plug is provided with this product. It is designed to be connected to a
compatible modular jack that is also compliant. See installation instructions for details.

Connection to party lines is subjected to state tariffs. Contact the state public utility commission, public
service commission or corporation commission for information.

If your home has specially wired alarm equipment connected to the telephone line, ensure the installation
of this equipment does not disable your alarm equipment. If you have questions about what will disable
alarm equipment, consult your telephone company or a qualified installer.

In Case of Equipment Malfunction

Should any malfunction occur which cannot be corrected by the procedures described in the Online
Manual, disconnect the equipment from the telephone line cable, turn off the power and disconnect the
power cord. The telephone line cable should not be reconnected or the main power switch turned ON until
the problem is completely resolved. Users should contact their local authorized Canon Facsimile Service
Dealer for the servicing of equipment.

Information regarding Authorized Service Facility locations can be obtained by calling the Canon
Customer Center.

Rights of the Telephone Company

If this equipment causes harm to the telephone network, the telephone company may temporarily
disconnect service. The telephone company also retains the right to make changes in facilities and
services that may affect the operation of this equipment. When such changes are necessary, the
telephone company is required to give adequate prior notice to the user. However, if advance notice is not
possible, the telephone company will notify the customer as soon as possible. Also, the customer will be
advised of his/her right to file a compliant with the FCC if he/she believes it is necessary.

Warning

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or
other electronic device to send any message via a telephone FAX machine unless such message clearly
contains in a margin at the top or bottom of each transmitted page, or on the first page of the
transmission, the date and time it is sent and an identification of the business or other entity, or other
individual sending the message and the telephone number of the sending machine or such business,
other entity, or individual.

In order to program this information into your FAX machine, you should complete the procedure to register
your name, unit's telephone number, time, and date. Refer to the Online Manual.

Users in Canada

This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject to the
following two conditions:

(1) this device may not cause interference, and (2) this device must accept any interference, including
interference that may cause undesired operation of the device.
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This equipment complies with IC radiation exposure limits set forth for an uncontrolled environment and
meets RSS-102 of the IC radio frequency (RF) Exposure rules. This equipment should be installed and
operated keeping the radiator at least 20cm or more away from person's body (excluding extremities:
hands, wrists, feet and ankles).

Pre-Installation Requirements

Notice

This product meets the applicable Innovation, Science and Economic Development Canada technical
specifications.

The Ringer Equivalence Number is an indication of the maximum number of devices allowed to be
connected to a telephone interface. The termination on an interface may consist of any combination of
devices subject only to the requirement that the sum of the RENs of all the devices does not exceed five.

Pour les usagers résidant au Canada

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts
de licence. L'exploitation est autorisée aux deux conditions suivantes :

(1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de I'appareil doit accepter tout brouillage
radioélectrique subi, méme si le brouillage est susceptible d'en compromettre le fonctionnement.

Cet équipement est conforme aux limites d'exposition aux rayonnements énoncées pour un
environnement non contrdlé et respecte les regles d'exposition aux fréquences radioélectriques (RF)
CNR-102 de I'IC. Cet équipement doit étre installé et utilisé en gardant une distance de 20 cm ou plus
entre le dispositif rayonnant et le corps (a I'exception des extrémités : mains, poignets, pieds et chevilles).

Conditions de pré-installation

Avis

Le présent produit est conforme aux spécifications techniques applicables d'Innovation, Sciences et
Développement économique Canada.

L'indice d'équivalence de la sonnerie (IES) sert a indiquer le nombre maximal de terminaux qui peuvent
étre raccordés a une interface téléphonique. La terminaison d'une interface peut consister en une
combinaison quelconque de dispositifs, a la seule condition que la somme d'indices d'équivalence de la
sonnerie de tous les dispositifs n'excéde pas 5.

Users in New Zealand

The grant of a Telepermit for any item of terminal equipment indicates only that Spark has accepted that
the item complies with minimum conditions for connection to its network. It indicates no endorsement of
the product by Spark, nor does it provide any sort of warranty. Above all, it provides no assurance that any
item will work correctly in all respects with another item of Telepermitted equipment of a different make or
model, nor does it imply that any product is compatible with all of Spark's network services.

This equipment is not capable, under all operating conditions, of correct operation at the higher speeds for
which it is designed. Spark will accept no responsibility should difficulties arise in such circumstances.
This condition typically applies to 56 kbit/s modems and V34 facsimile machines.
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Please note when you connect an extension phone to this device, if you use an extension phone which
has features such as "last number redial", redial memory numbers may be lost.

The automatic calling functions of this equipment must not be used to a nuisance to other Spark
customers.

Telepermitted equipment only may be connected to the telephone port. The telephone port is not
specifically designed for 3-wire connected equipment. 3-wire connected equipment might not respond to
incoming ringing when attached to this port.

Environmental Information

Reducing your environmental impact

Power Consumption and Operational Modes

The amount of electricity a device consumes depends on the way the device is used. This product is
designed and set in a way to allow you to reduce the power consumption. After the last print it switches
to Ready Mode. In this mode it can print again immediately if required. If the product is not used for a
time, the device switches to its Sleep Mode. The devices consume less power (Watt) in these modes.

Energy Star®

The Energy Star® programme is a voluntary scheme to promote the development and purchase of
energy efficient models, which help to minimise environmental impact.
Products which meet the stringent requirements of the Energy Star® programme for both environmental

benefits and the amount of energy consumption will carry the Energy Star® logo accordingly.

Paper types
This product can be used to print on both recycled and virgin paper (certified to an environmental
stewardship scheme), which complies with EN12281 or a similar quality standard. In addition it can

support printing on media down to a weight of 64g/m?, lighter paper means less resources used and a
lower environmental footprint for your printing needs.

ENERGY STAR

C€
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WEEE (EU&EEA)

Only for European Union and EEA (Norway, Iceland and Liechtenstein)

)24

This symbol indicates that this product is not to be disposed of with your household waste, according to
the WEEE Directive (2012/19/EU) and national legislation. This product should be handed over to a
designated collection point, e.g., on an authorized one-for-one basis when you buy a new similar product
or to an authorized collection site for recycling waste electrical and electronic equipment (EEE). Improper
handling of this type of waste could have a possible negative impact on the environment and human
health due to potentially hazardous substances that are generally associated with EEE. At the same time,
your cooperation in the correct disposal of this product will contribute to the effective usage of natural
resources. For more information about where you can drop off your waste equipment for recycling, please
contact your local city office, waste authority, approved WEEE scheme or your household waste disposal
service. For more information regarding return and recycling of WEEE products, please visit www.canon-
europe.com/weee.

Nur fur Europaische Union und EWR (Norwegen, Island und Liechtenstein)

h2d

Dieses Symbol weist darauf hin, dass dieses Produkt gemaR der EU-Richtlinie tGber Elektro- und
Elektronik-Altgerate (2012/19/EU) und nationalen Gesetzen nicht Uber den Hausmdll entsorgt werden
darf. Dieses Produkt muss bei einer dafiir vorgesehenen Sammelstelle abgegeben werden. Dies kann z.
B. durch Ruckgabe beim Kauf eines ahnlichen Produkts oder durch Abgabe bei einer autorisierten
Sammelstelle fir die Wiederaufbereitung von Elektro- und Elektronik-Altgeraten geschehen. Der
unsachgemalfe Umgang mit Altgeraten kann aufgrund potentiell gefahrlicher Stoffe, die generell mit
Elektro- und Elektronik-Altgeraten in Verbindung stehen, negative Auswirkungen auf die Umwelt und die
menschliche Gesundheit haben. Durch die umweltgerechte Entsorgung dieses Produkts tragen Sie
aullerdem zu einer effektiven Nutzung natiirlicher Ressourcen bei. Informationen zu Sammelstellen fiir
Altgerate erhalten Sie bei lhrer Stadtverwaltung, dem 6&ffentlich-rechtlichen Entsorgungstrager, einer
autorisierten Stelle fiir die Entsorgung von Elektro- und Elektronik-Altgeraten oder Ihrem 6rtlichen
Entsorgungsunternehmen. Weitere Informationen zur Rickgabe und Entsorgung von Elektro- und
Elektronik-Altgeraten finden Sie unter www.canon-europe.com/weee.

Union Européenne, Norvége, Islande et Liechtenstein uniquement.

hid

Ce symbole indique que ce produit ne doit pas étre jeté avec les ordures ménageéres, conformément a la
directive DEEE (2012/19/UE) et a la réglementation de votre pays. Ce produit doit étre confié au
distributeur a chaque fois que vous achetez un produit neuf similaire, ou a un point de collecte mis en
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place par les collectivités locales pour le recyclage des Déchets des Equipements Electriques et
Electroniques (DEEE). Le traitement inapproprié de ce type de déchet risque d'avoir des répercussions
sur I'environnement et la santé humaine, du fait de la présence de substances potentiellement
dangereuses généralement associées aux équipements électriques et électroniques. Parallélement, votre
entiere coopération dans le cadre de la mise au rebut correcte de ce produit favorisera une meilleure
utilisation des ressources naturelles. Pour plus d'informations sur les points de collecte des équipements
a recycler, contactez vos services municipaux, les autorités locales compétentes, le plan DEEE approuvé
ou le service d'enlévement des ordures ménagéres. Pour plus d'informations sur le retour et le recyclage
des produits DEEE, consultez le site: www.canon-europe.com/weee.

Uitsluitend bestemd voor de Europese Unie en EER (Noorwegen, IJsland en
Liechtenstein)

hid

Dit symbool geeft aan dat dit product in overeenstemming met de AEEA-richtlijn (2012/19/EU) en de
nationale wetgeving niet mag worden afgevoerd met het huishoudelijk afval. Dit product moet worden
ingeleverd bij een aangewezen, geautoriseerd inzamelpunt, bijvoorbeeld wanneer u een nieuw
gelijksoortig product aanschaft, of bij een geautoriseerd inzamelpunt voor hergebruik van elektrische en
elektronische apparatuur (EEA). Een onjuiste afvoer van dit type afval kan leiden tot negatieve effecten op
het milieu en de volksgezondheid als gevolg van potentieel gevaarlijke stoffen die veel voorkomen in
elektrische en elektronische apparatuur (EEA). Bovendien werkt u door een juiste afvoer van dit product
mee aan het effectieve gebruik van natuurlijke hulpbronnen. Voor meer informatie over waar u uw
afgedankte apparatuur kunt inleveren voor recycling kunt u contact opnemen met het gemeentehuis in uw
woonplaats, de reinigingsdienst, of het afvalverwerkingsbedrijf. U kunt ook het schema voor de afvoer van
afgedankte elektrische en elektronische apparatuur (AEEA) raadplegen. Ga voor meer informatie over het
inzamelen en recyclen van afgedankte elektrische en elektronische apparatuur naar www.canon-
europe.com/weee.

Sélo para la Unién Europea y el Area Econémica Europea (Noruega,
Islandia y Liechtenstein)

)= 4

Este simbolo indica que este producto no debe desecharse con los desperdicios domésticos, de acuerdo
con la directiva RAEE (2012/19/UE) y con la legislacion nacional. Este producto debe entregarse en uno
de los puntos de recogida designados, como por ejemplo, entregandolo en el lugar de venta al comprar
un producto similar o depositandolo en un lugar de recogida autorizado para el reciclado de residuos de
aparatos eléctricos y electronicos (RAEE). La manipulacion inapropiada de este tipo de desechos podria
tener un impacto negativo en el entorno y la salud humana, debido a las sustancias potencialmente
peligrosas que normalmente estan asociadas con los RAEE. Al mismo tiempo, su cooperacion a la hora
de desechar correctamente este producto contribuira a la utilizacion eficazde los recursos naturales. Para
mas informacién sobre como puede eliminar el equipo para su reciclado, pongase en contacto con las
autoridades locales, con las autoridades encargadas de los desechos, con un sistema de gestion RAEE
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autorizado o con el servicio de recogida de basuras doméstico. Si desea mas informacién acerca de la
devolucién y reciclado de RAEE, visite la web www.canon-europe.com/weee.

Només per a la Unié Europea i a I’Espai Economic Europeu (Noruega,
Islandia i Liechtenstein)

h24

Aquest simbol indica que aquest producte no s’ha de llengar a les escombraries de la llar, d’acord amb la
Directiva RAEE (2012/19/UE) i la legislacié nacional. Aquest producte s’hauria de lliurar en un dels punts
de recollida designats, com per exemple, intercanviant-lo un per un en comprar un producte similar o
lliurant-lo en un lloc de recollida autoritzat per al reciclatge de residus d’aparells eléctrics i electronics
(AEE). La manipulacio inadequada d’aquest tipus de residus podria tenir un impacte negatiu en I'entorn i
en la salut humana, a causa de les substancies potencialment perilloses que normalment estan
associades als AEE. Aixi mateix, la vostra cooperacio a I'hora de llengar correctament aquest producte
contribuira a la utilitzacio efectiva dels recursos naturals. Per a més informacio sobre els punts on podeu
lliurar aquest producte per procedir al seu reciclatge, adreceu-vos a la vostra oficina municipal, a les
autoritats encarregades dels residus, al pla de residus homologat per la RAEE o al servei de recollida de
deixalles domeéstiques de la vostra localitat. Per a més informacio sobre la devolucio i el reciclatge de
productes RAEE, visiteu www.canon-europe.com/weee.

Solo per Unione Europea e SEE (Norvegia, Islanda e Liechtenstein)

)= 4

Questo simbolo indica che il prodotto deve essere oggetto di raccolta separata in conformita alla Direttiva
RAEE (2012/19/UE) e alla normativa locale vigente. Il prodotto deve essere smaltito presso un centro di
raccolta differenziata, un distributore autorizzato che applichi il principio dell"'uno contro uno", ovvero del
ritiro della vecchia apparecchiatura elettrica al momento dell'acquisto di una nuova, o un impianto
autorizzato al riciclaggio dei rifiuti di apparecchiature elettriche ed elettroniche. La gestione impropria di
questo tipo di rifiuti pud avere un impatto negativo sull'ambiente e sulla salute umana causato dalle
sostanze potenzialmente pericolose che potrebbero essere contenute nelle apparecchiature elettriche ed
elettroniche. Un corretto smaltimento di tali prodotti contribuira inoltre a un uso efficace delle risorse
naturali ed evitera di incorrere nelle sanzioni amministrative di cui all'art. 255 e successivi del Decreto
Legislativo n. 152/06. Per ulteriori informazioni sullo smaltimento e il recupero dei Rifiuti di
Apparecchiature Elettriche ed Elettroniche, consultare la Direttiva RAEE, rivolgersi alle autorita
competenti, oppure visitare il sito www.canon-europe.com/weee.

Apenas para a Uniao Europeia e AEE (Noruega, Islandia e Liechtenstein)

hid
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Este simbolo indica que o produto ndo deve ser colocado no lixo doméstico, de acordo com a Directiva
REEE (2012/19/UE) e a legislacao nacional. Este produto devera ser colocado num ponto de recolha
designado, por exemplo, num local préprio autorizado quando adquirir um produto semelhante novo ou
num local de recolha autorizado para reciclar residuos de equipamentos eléctricos e electrénicos (EEE).
O tratamento inadequado deste tipo de residuo podera causar um impacto negativo no ambiente e na
saude humana devido as substancias potencialmente perigosas normalmente associadas aos
equipamentos eléctricos e electronicos. Simultaneamente, a sua cooperagao no tratamento correcto
deste produto contribuira para a utilizagéo eficaz dos recursos naturais. Para mais informagdes sobre os
locais onde o equipamento podera ser reciclado, contacte os servigos locais, a autoridade responsavel
pelos residuos, o esquema REEE aprovado ou o servigo de tratamento de lixo doméstico. Para mais
informacgdes sobre a devolugao e reciclagem de produtos REEE, va a www.canon-europe.com/weee.

Galder kun i Europaiske Union og EGS (Norge, Island og Liechtenstein)

hid

Dette symbol angiver, at det pageeldende produkt ikke ma bortskaffes sammen med dagrenovation jf.
direktivet om affald af elektrisk og elektronisk udstyr (WEEE) (2012/19/EU) og gaeldende national
lovgivning. Det pagzeldende produkt skal afleveres pa et neermere specificeret indsamlingssted, f.eks. i
overensstemmelse med en godkendt én-til-én-procedure, nar du indkgber et nyt tilsvarende produkt, eller
produktet skal afleveres pa et godkendt indsamlingssted for elektronikaffald. Forkert handtering af denne
type affald kan medfere negative konsekvenser for miljget og menneskers helbred pa grund af de
potentielt sundhedsskadelige stoffer, der generelt kan forefindes i elektrisk og elektronisk udstyr. Nar du
foretager korrekt bortskaffelse af det pagaeldende produkt, bidrager du til effektiv brug af
naturressourcerne. Yderligere oplysninger om, hvor du kan bortskaffe dit elektronikaffald med henblik pa
genanvendelse, far du hos de kommunale renovationsmyndigheder. Yderligere oplysninger om
returnering og genanvendelse af affald af elektrisk og elektronisk udstyr far du ved at bes@age www.canon-
europe.com/weee.

Mévo yia Tnv EupwTraiki ‘Evwon kail Tov EOX (NopBnyia, loAavdia kai
AixtevoTdiv)

h2d

AuTé TO oUPBOoAO utTodnAwWwvEl OTI AUTO TO TTPOIGV OEV TTPETTEI VA ATTOPPITITETAI JAdi PE T OIKIAKA
aroppiypara, cuyewva pe Tnv Odnyia oxetikd pe Ta ATTORANTa HAekTpIkoU Kol HAekTpovikoU EEotTAIcOU
(AHHE) (2012/19/EE) ka1 TnVv €BvIkr oag vouobeaia. AuTtd To TTPOIoOV TTPETTEI va TTapadideTal g€
KaBoplopévo anpeio oUNOYNG, TT1.X. O€ Pia eEouciodoTnuévn Baon aviaAlaynig étav ayopddeTte £va véo
TTapOuoIo TTPOIGV 1) O€ pia e§ouaiodoTnuévn BEan GUANOYAG yIa TNV AVOKUKAWGN TwV ATTORANTWY
HAekTpikoU kal HAekTpovikoU EEotrAiopol (HHE). O akatdAAnAog xeipiopdg autou Tou TUTTOU aTToBAATWYV
MTTOPEI Va £x€l apvnNTIKO avTIKTUTTO OTO TTEPIBGAAOV Kal TNV uyeia Tou avBpwTTou, Adyw duvnTIKWG
ETMIKIVOUVWYV OUCIWV TToU YevIKA ouvdéovTtal ue Tov HHE. Tautdxpova, n cuvepyaoia aag 6oov agopd tn
owaTr amméppiyn auTtoU Tou TTPOIGVTOg Ba GUUBAAEI TNV ATTOTEAECUATIKA XPAON TWV QUOIKWY TTOpwv. MNa
TTEPIOOOTEPEG TTANPOPOPIEG OXETIKA PE T onuEia GTTOU PTTOPEITE va ATTOPPIYETE TOV EEOTTAICUO CaG YIa
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AVaKUKAWGT, ETTIKOIVWVIOTE JE TO TOTTIKO YPAQPEIO TNG TTOANG 0AG, TNV UTINPECIA aTTOPPIMKATWY, TO
eykekpipgévo oxnua AHHE ) Tnv uttnpeaia atréppiyng OIKIGKWY atroRANTwV. [a TTEPICOOTEPES
TTANPOPOPIEG OXETIKA PE TNV ETTIOTPOPN KAI TNV AVAKUKAWGON Twv TTPoidvTwyv AHHE, emoke@Beite Tnv
ToTT00E0i0 Www.canon-europe.com/weee.

Gjelder kun den europeiske union og E@S (Norge, Island og Liechtenstein)

h24

Dette symbolet indikerer at dette produktet ikke skal kastes sammen med husholdningsavfall, i henhold il
WEEE-direktiv (2012/19/EU) og nasjonal lov. Produktet ma leveres til et dertil egnet innsamlingspunkt, det
vil si pa en autorisert en-til-en-basis nar du kjgper et nytt lignende produkt, eller til et autorisert
innsamlingssted for resirkulering av avfall fra elektrisk og elektronisk utstyr (EE-utstyr). Feil handtering av
denne typen avfall kan veere miljg- og helseskadelig pa grunn av potensielt skadelige stoffer som ofte
brukes i EE-utstyr. Samtidig bidrar din innsats for korrekt avhending av produktet til effektiv bruk av
naturressurser. Du kan fa mer informasjon om hvor du kan avhende utrangert utstyr til resirkulering ved &
kontakte lokale myndigheter, et godkjent WEEE-program eller husholdningens renovasjonsselskap. Du
finner mer informasjon om retur og resirkulering av WEEE-produkter pd www.canon-europe.com/weee.

Vain Euroopan unionin seka ETA:n (Norja, Islanti ja Liechtenstein) alueelle.

h2d

Tama tunnus osoittaa, ettd sahko- ja elektroniikkalaiteromua koskeva direktiivi (SER-direktiivi,
2012/19/EU) seka kansallinen lainsdadanto kieltavat tuotteen havittdmisen talousjatteen mukana. Tuote
on vietava asianmukaiseen kerayspisteeseen, esimerkiksi kodinkoneliikkeeseen uutta vastaavaa tuotetta
ostettaessa tai viralliseen sahko- ja elektroniikkalaiteromun kerdyspisteeseen. Sahko- ja
elektroniikkalaiteromun virheellinen kasittely voi vahingoittaa ymparistéa ja ihmisten terveytta, koska
laitteet saattavat siséltda ymparistdlle ja terveydelle haitallisia aineita. Lisaksi tuotteen asianmukainen
havittaminen saastaa luonnonvaroja. Lisatietoja sahko- ja elektroniikkalaiteromun kerayspisteista saat
kaupunkien ja kuntien tiedotuksesta, jatehuoltoviranomaisilta, séhko- ja elektroniikkalaiteromun
kierratysjarjestelman yllapitajalta ja jatehuoltoyhtiolta. Lisatietoja sdhko- ja elektroniikkalaiteromun
kerayksesta ja kierratyksesta on osoitteessa www.canon-europe.com/weee.

Endast for Europeiska unionen och EES (Norge, Island och Liechtenstein)

h24

Den har symbolen visar att produkten enligt WEEE-direktivet (2012/19/EU) och nationell lagstiftning inte
far sorteras och slangas som hushallsavfall. Den har produkten ska [dmnas in pa en darfér avsedd
insamlingsplats, t.ex. pa en atervinningsstation auktoriserad att hantera elektrisk och elektronisk
utrustning (EE-utrustning) eller hos handlare som ar auktoriserade att byta in varor da nya, motsvarande
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kops (en mot en). Olamplig hantering av avfall av den har typen kan ha en negativ inverkan pa miljon och
manniskors hélsa pa grund av de potentiellt farliga &mnen som kan aterfinnas i elektrisk och elektronisk
utrustning. Din medverkan till en korrekt avfallshantering av den har produkten bidrar dessutom till en
effektiv anvandning av naturresurserna. Kontakta ditt lokala kommunkontor, berérd myndighet, féretag for
avfallshantering eller ta del av en godkand WEEE-organisation om du vill ha mer information om var du
kan lamna den kasserade produkten for atervinning. Fér mer information om inldmning och atervinning av
WEEE-produkter, se www.canon-europe.com/weee.

Pouze Evropska unie a EHP (Norsko, Island a Lichtenstejnsko)

hid

Tento symbol znamena, Ze podle smérnice o OEEZ (2012/19/EU) a podle vnitrostatnich pravnich
predpisl nema byt tento vyrobek likvidovan s odpadem z domacnosti. Tento vyrobek ma byt vracen do
sbérného mista, napf. v ramci autorizovaného systému odbéru jednoho vyrobku za jeden nové prodany
podobny vyrobek nebo v autorizovaném sbérném misté pro recyklaci odpadnich elektrickych a
elektronickych zafizeni (OEEZ). Nevhodné nakladani s timto druhem odpadu by mohlo mit negativni
dopad na Zivotni prostfedi a lidské zdravi, protoZe elektricka a elektronicka zafizeni zpravidla obsahuji
potencialné nebezpecné latky. Vase spoluprace na spravné likvidaci tohoto vyrobku sou¢asné napom(ize
efektivnimu vyuzivani pfirodnich zdroju. Dal$i informace o mistech sbéru vaSeho odpadniho zafizeni

k recyklaci vam sdéli mistni urad vasi obce, spravni organ vykonavajici dozor nad likvidaci odpadu,
sbérny OEEZ nebo sluzba pro odvoz komunalniho odpadu. Dalsi informace tykajici se vraceni a
recyklace OEEZ naleznete na adrese www.canon-europe.com/weee.

Csak az Eurépai Unié és az EGT (Norvégia, Izland és Liechtenstein)
orszagaiban

)= 4

Ez a szimbdlum azt jelzi, hogy a helyi tdrvények és a WEEE-iranyelv (2012/19/EU) szerint a termék nem
kezelhetd haztartasi hulladékként. A terméket a kijeldlt nyilvanos gytijtépontokon kell leadni, példaul
hasonlé cserekészllék vasarlasakor, illetve barmelyik, elektromos és elektronikai berendezésekbdl
szarmazo hulladék (WEEE) atvételére feljogositott gyiijtéponton. Az ilyen jellegli hulladékok a nem
megfelel§ kezelés esetén a bennik talalhatd veszélyes anyagok révén artalmasak lehetnek a kérnyezetre
és az emberek egészségére. Tovabba, a termékbdl szarmazé hulladék megfelel6 kezelésével
hozzajarulhat a természetes nyersanyagok hatékonyabb hasznositasahoz. A berendezésekb6l szarmazo,
Ujrahasznosithaté hulladékok elhelyezésére vonatkozo tovabbi tudnivaldkért forduljon a helyi
Onkormanyzathoz, a kdzterulet-fenntart6 vallalathoz, a haztartasi hulladék begydijtését végz6 vallalathoz,
illetve a hivatalos WEEE-képviselethez. Tovabbi tudnivaldkat a WEEE-termékek visszajuttatasarol és
Ujrahasznositasarol a www.canon-europe.com/weee.
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Tylko dla krajow Unii Europejskiej oraz EOG (Norwegia, Islandia i
Liechtenstein)

hid

Ten symbol oznacza, ze zgodnie z dyrektywg WEEE dotyczgcg zuzytego sprzetu elektrycznego i
elektronicznego (2012/19/UE) oraz przepisami lokalnymi nie nalezy wyrzuca¢ tego produktu razem z
odpadami gospodarstwa domowego. Produkt nalezy przekaza¢ do wyznaczonego punktu gromadzenia
odpaddw, np. firmie, od ktérej kupowany jest nowy, podobny produkt lub do autoryzowanego punktu
gromadzenia zuzytego sprzetu elektrycznego i elektronicznego w celu poddania go recyklingowi.
Usuwanie tego typu odpaddéw w nieodpowiedni sposéb moze mie¢ negatywny wptyw na otoczenie i
zdrowie innych osob ze wzgledu na niebezpieczne substancje stosowane w takim sprzecie. Jednoczesnie
pozbycie sie zuzytego sprzetu w zalecany sposob przyczynia sie do wiasciwego wykorzystania zasobow
naturalnych. Aby uzyska¢ wiecej informacji na temat punktow, do ktérych mozna dostarczy¢ sprzet do
recyklingu, prosimy skontaktowac sie z lokalnym urzedem miasta, zaktadem utylizacji odpadow,
skorzystac¢ z instrukcji zatwierdzonej dyrektywg WEEE lub skontaktowac¢ sie z przedsiebiorstwem
zajmujgcym sie wywozem odpaddéw domowych. Wiecej informacji o zwracaniu i recyklingu zuzytego
sprzetu elektrycznego i elektronicznego znajduje sie w witrynie www.canon-europe.com/weee.

Plati len pre Staty Eurépskej unie a EHP (N6rsko, Island a Lichtenstajnsko)

hid

Tento symbol znamena, Ze podla Smernice 2012/19/EU o odpade z elektrickych a elektronickych
zariadeni (OEEZ) a podla platnej legislativy Slovenskej republiky sa tento produkt nesmie likvidovat spolu
s komunalnym odpadom. Produkt je potrebné odovzdat do uréenej zberne, napr. prostrednictvom vymeny
za kupu noveho podobného produktu, alebo na autorizované zberné miesto, ktoré spracuva odpad z
elektrickych a elektronickych zariadeni (EEZ). Nesprdvna manipuldcia s takymto typom odpadu méze mat
negativny vplyv na Zivotné prostredie a ludské zdravie, pretoZe elektrické a elektronické zariadenia
obsahuju potencialne nebezpecéné latky. Spolupracou na spravne;j likvidacii produktu prispejete

k G&innému vyuzivaniu prirodnych zdrojov. DalSie informacie o mieste recyklacie opotrebovanych
zariadeni ziskate od miestneho uUradu, dradu zivotného prostredia, zo schvaleného planu OEEZ alebo od
spoloc¢nosti, ktora zaistuje likvidaciu komunalneho odpadu. Viac informacii najdete aj na webovej stranke:
WWww.canon-europe.com/weee.

Uksnes Euroopa Liit ja EMP (Norra, Island ja Liechtenstein)

)24

See simbol naitab, et antud toodet ei tohi vastavalt elektri- ja elektroonikaseadmete jaatmeid kasitlevale
direktiivile (2012/19/EL) ning teie riigis kehtivatele digusaktidele utiliseerida koos olmejaatmetega. Antud
toode tuleb anda selleks maaratud kogumispunkti, nt matgipunkt, mis on volitatud tks Uhe vastu
vahetama, kui ostate uue sarnase toote, voi elektri- ja elektroonikaseadmete jaatmete imbertéotlemiseks
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mdeldud kogumispunkti. Taiendava teabe saamiseks elektri- ja elektroonikaseadmetest tekkinud jaatmete
tagastamise ja Umbertd6tlemise kohta vdtke Uhendust kohaliku omavalitsusega, asjakohase
valitsusasutusega, asjakohase tootjavastutusorganisatsiooniga voi olmejaatmete kaitlejaga. Lisateavet
leitate ka Interneti-lehekuljelt www.canon-europe.com/weee.

Tikai Eiropas Savienibai un EEZ (Norvégijai, Islandei un Lihtensteinai)

h24

Sis simbols norada, ka atbilsto$i ES Direktivai (2012/19/ES) par elektrisko un elektronisko iekartu
atkritumiem (EEIA) un vietéjiem tiesibu aktiem no 31 izstradajuma nedrikst atbrivoties, izmetot to kopa ar
sadzives atkritumiem. Sis izstradajums ir janodod piemérota savak$anas vieta, pieméram, apstiprinata
veikala, kur iegadajaties I1dzigu jaunu produktu un atstajat veco, vai apstiprinata vieta izlietotu elektrisko
un elektronisko iekartu parstradei. Nepareiza $ada veida atkritumu apsaimnieko$ana var apdraudét vidi
un cilvéka veselibu tadu iespéjami bistamu vielu dél, kas parasti ir elektriskajas un elektroniskajas
iekartas. Turklat josu atbalsts pareiza $ada veida atkritumu apsaimnieko$Sana sekmés efektivu dabas
resursu izmantoSanu. Lai sanemtu pilnigaku informaciju par vietam, kur izlietoto iekartu var nodot
parstradei, sazinieties ar vietéjo pasvaldibu, atkritumu savak8anas atbildigo dienestu, pilnvarotu EEIA
struktdru vai sadzives atkritumu apsaimniekoSanas iestadi. Lai sanemtu plasaku informaciju par elektrisko

un elektronisko iekartu nodoSanu parstradei, apmeklgjiet timekla vietni www.canon-europe.com/weee.

Tik Europos Sajungai ir EEE (Norvegijai, Islandijai ir Lichtensteinui)

h2d

Sis Zenklas reigkia, kad gaminio negalima imesti su buitinémis atliekomis, kaip yra nustatyta Direktyvoje
(2012/19/ES) ir nacionaliniuose teisé aktuose dél EE| atlieky tvarkymo. Sj gaminj reikia atiduoti j tam
skirtg surinkimo punktg, pvz., pagal patvirtintg keitimo sistema, kai perkamas panasus gaminys, arba j
elektros ir elektroninés jrangos (EE]) atlieky perdirbimo punktg. Netinkamas tokios rusies atlieky
tvarkymas dél elektros ir elektroninéje jrangoje esanciy pavojingy medziagy gali pakenkti aplinkai ir
Zmoniy sveikatai. Padédami uztikrinti tinkama Sio gaminio Salinimo tvarka, kartu prisidésite prie
veiksmingo gamtos istekliy naudojimo. Jei reikia daugiau informacijos, kaip Salinti tokias atliekas, kad jos
baty toliau perdirbamos, kreipkités j savo miesto valdZios institucijas, atlieky tvarkymo organizacijas,
patvirtinty EE] atlieky sistemy arba jasy buitiniy atlieky tvarkymo jstaigy atstovus. ISsamesnés
informacijos apie EE] atlieky graZinimo ir perdirbimo tvarka galite rasti apsilanke tinklalapyje www.canon-
europe.com/weee.

Samo za Evropsko unijo in EGP (Norveska, Islandija in Lihtenstajn)

hid
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Ta simbol pomeni, da tega izdelka v skladu z direktivo OEEO (2012/19/EU) in drzavno zakonodajo ne
smete odvredi v gospodinjske odpadke. Ta izdelek morate odloZiti na ustrezno zbiralno mesto, na primer
pri pooblaséenem prodajalcu, ko kupite podoben nov izdelek ali na zbiralno mesto za recikliranje
elektrine in elektronske opreme. Neprimerno ravnanje s takdnimi odpadki lahko negativno vpliva na
okolje in ¢lovekovo zdravje zaradi nevarnih snovi, ki so povezane z elektri¢no in elektronsko opremo. S
pravilno odstranitvijo izdelka hkrati prispevate tudi k uginkoviti porabi naravnih virov. Ce Zelite ved
informacij o tem, kje lahko odlozite odpadno opremo za recikliranje, pokli¢ite ob&inski urad, komunalno
podijetje ali sluzbo, ki skrbi za odstranjevanje odpadkoyv, ali si oglejte naért OEEOQ. Ce Zelite ve¢ informacij
o vrac¢anju in recikliranju izdelkov v skladu z direktivo OEEO, obis¢ite www.canon-europe.com/weee.

Cawmo 3a EBponeinckus cbio3 u EUIN (Hopeernsa, UcnaHamsa n JInxteHwamnH)

hid

To3n cMMBO Nokasea, Ye To3n NpoAyKT He TpsibBa fa ce N3XBbpIs 3ae4HOo ¢ BUToBUTE OTNagbum,
cbrnacHo Oupektuarta 3a NYEEO (2012/19/EC) 1 BaweTto HaumoHanHo 3akoHogaTencrso. To3u npogykT
TpsbBa ga 6bae npeaageH B npeaHasHayveH 3a uenTta nyHKT 3a cboupaHe, Hanpumep Ha 6asa pa3msiHa,
KoraTo KynyBaTe HOB Nogo6eH NpoayKT, unu B o4o0dpeH cbbuparteneH nyHKT 3a peuuknMpaHe Ha U3nsano
OT ynotpeba enekTpruyecko un enekTpoHHo obopyasaHe (MYEEQ). HenpaBunHoTo TpetnpaHe Ha To31 Tun
oTnagbLM MOXe Aa AOBeAEe OO0 eBEHTYyarHu oTpuuaTenHu NocrneacTBns 3a OKofnHaTa cpega M YOBELLKOTO
3gpase nopaam NoTeHUmManHo onacHuTe BeLecTBa, KOMTo 0BUKHOBEHO ca cBbp3aHu ¢ EEO. B cbuoto
BpeMe Balueto cbaencTBue 3a NpaBUHOTO U3XBBPIISIHE Ha TO3W MPOAYKT e AonpuHece 3a
eheKTUBHOTO U3non3BaHe Ha NpupoaHuTe pecypcu. MNMoeeve MHOPMaLMsi OTHOCHO MecTaTa, KbAeTo
MOXe Ja npedaBaTe U3nas3no ot ynorpeba obopyaBaHe 3a peumKknnpaHe, MoXe Aa nonyynte oT MECTHUTE
BNacTu, OT opraHa, OTTOBOPEH 3a OTNaabuuTe U OT ogobpeHa cuctema 3a ns3nasno ot ynorpeda EEO vnu
ot Bawara mectHa cnyxba 3a 6utoBm oTnagbuu. 3a noBeve HGPOpMaLnsi OTHOCHO BPBLUAHETO U
peuuKnupaHeTo Ha NPoayKTU OT n3naano ot ynotpeba EEO nocetete www.canon-europe.com/weee.

Doar pentru Uniunea Europeana si EEA (Norvegia, Islanda si Liechtenstein)

)= 4

Acest simbol indica faptul ca acest produs nu trebuie aruncat o data cu reziduurile menajere, in
conformitate cu Directiva DEEE (Directiva privind deseurile de echipamente electrice si electronice)
(2012/19/UE) si legile nationale. Acest produs trebuie transportat la un punct de colectare special, de
exemplu un centru care preia produsele vechi atunci cand achizitionati un produs nou similar, sau la un
punct de colectare autorizat pentru reciclarea deseurilor provenite de la echipamentele electrice si
electronice (EEE). Manuirea necorespunzatoare a acestor tipuri de deseuri poate avea un impact negativ
asupra mediului inconjurator si sanatatii indivizilor, din cauza substantelor potential nocive care sunt in
general asociate cu EEE. in acelasi timp, cooperarea dvs. la reciclarea corecta a acestui produs va
contribui la utilizarea efectiva a resurselor naturale. Pentru mai multe informatii privind locurile de reciclare
a deseurilor provenite de la echipamente, contactati biroul primariei locale, autoritatea responsabila cu
colectarea deseurilor, schema DEEE aprobata sau serviciul de colectare a deseurilor menajere. Pentru
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mai multe informatji privind returnarea si reciclarea produselor DEEE, vizitati www.canon-europe.com/
weee.

Samo za Europsku uniju i EEZ (Norveska, Island i Lihtenstajn)

h24

Ovaj simbol pokazuje da se ovaj proizvod ne smije odlagati s kuénim otpadom sukladno WEEE Direktivi
(2012/19/EC) i vasem nacionalnom zakonu. Ovaj proizvod je potrebno predati na posebno mjesto za
sakupljanje otpada, npr. na ovladteno mjesto gdje mozete zamijeniti staro za novo ukoliko kupujete novi
slian proizvod ili na ovlasteno mjesto za sakupljanje rabljene elektri¢ne i elektroniCke opreme (EEE) za
recikliranje. Nepropisno rukovanje ovom vrstom otpada moZze imati negativan ucinak na okolinu i zdravlje
ljudi zbog supstanci koje su potencijalno opasne za zdravlje, a opéenito se povezuju s EEE. Istovremeno,
vaSa ¢e suradnja kroz propisno odlaganje ovog proizvoda doprinijeti efektivnoj uporabi prirodnih resursa.
Za vi8e informacija o tome gdje mozete odloZiti svoj otpad za recikliranje obratite se vaSem lokalnom
gradskom uredu, komunalnoj sluzbi, odobrenom WEEE programu ili sluzbi za odlaganje kuénog otpada.
Ostale informacije o vra¢anju i recikliranju WEEE proizvoda potrazite na www.canon-europe.com/weee.

Korisnici u Srbiji

)= 4

Ovaj simbol oznacava da ovaj proizvod ne sme da se odlaZze sa ostalim kuénim otpadom, u skladu sa
WEEE Direktivom (2012/19/EU) i nacionalnim zakonima. Ovaj proizvod treba predati odredenom centru
za prikupljanje, npr. na osnovi "jedan-za-jedan" kada kupujete sli€an novi proizvod, ili ovla8¢éenom centru
za prikupljanje za reciklazu istroSene elektri¢ne i elektronske opreme (EEE). Nepravilno rukovanje ovom
vrstom otpada moZe da ima mogucée negativne posledice po Zivotnu sredinu i ljudsko zdravlje usled
potencijalno opasnih materijala koji se uglavnhom vezuju za EEE. U isto vreme, vaSa saradnja na
ispravhom odlaganju ovog proizvoda ¢e doprineti efikasnom koriS¢éenju prirodnih resursa. Za viSe
informacija o tome gde mozete da predate vasu staru opremu radi recikliranje, vas molimo, da
kontaktirate lokalne gradske vlasti, komunalne sluZzbe, odobreni plan reciklaZe ili Gradsku ¢&istoéu. Za viSe
informacija o vrac¢aniju i recikliranju WEEE proizvoda, posetite stranicu www.canon-europe.com/weee.
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Main Components and Their Use
» Main Components
» Power Supply
» Using the Operation Panel

» Entering Numbers, Letters, and Symbols
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Main Components
» Front View
» Rear View
» Inside View

» Operation Panel
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Front View

11 10

(1) operation panel
Used to adjust settings or operate the machine.

= Operation Panel

(2) ADF (Auto Document Feeder)
Load documents here. Documents loaded in the document tray are scanned automatically, one page at
a time.

= | oading Documents in the ADF (Auto Document Feeder)

(3) document feeder cover
Open to clear jammed documents.

(4) document guides
Adjust to match the width of documents in the ADF.

(5) document tray
Open to load documents in the ADF. You can load multiple pages of the same size and thickness. Load
documents face-up.

(6) document output slot
Ejects documents scanned in the ADF.

(7) document cover
Open to load originals on the platen glass.

(8) front cover
Open to replace ink tanks or clear internal paper jams.

(9) paper output tray
Pull out to support printed documents. The tray covers the cassette when extended. Normally, leave the
tray out.
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(10) output tray extension
Pull out to support ejected paper.

(11) paper output support
Open to support ejected paper.

12 13 14 15

(12) USB flash drive port
Insert USB flash drives here.

Ay Warning

» Do not connect any equipment other than USB flash drives to the machine's USB flash drive port.
This may cause fire, electric shock, or damage to the machine.

32 Important

» Do not touch any exposed metal parts.
» Do not connect USB cables longer than 10 feet (3 meters), which may affect operation of other
peripherals.

(13) cassette 1
Holds all sizes of paper that are compatible with the machine, such as plain paper, photo paper, and
envelopes.
= Paper Sources
(14) cassette 2
Holds A4, Letter, Legal, Oficio, B-Oficio, M-Oficio, Foolscap, and Legal (India)-sized plain paper.
= Paper Sources

(15) platen glass
Load originals here.
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Rear View

(1) rear cover
Open to clear paper jams.

(2) power cord connector
Connect the supplied power cord.

(3) telephone line jack
Connect the phone cord.

(4) external device jack
Connect a telephone or answering machine.

(5) wired LAN connector
Connect an Ethernet cable to use the machine in a local network.

(6) USB port

Connect the USB cable for a direct connection with a computer.

22 Important

» Do not touch any exposed metal parts.
» Do not connect or disconnect the USB or Ethernet cable while printing or scanning from a computer.
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Inside View

1 2

(1) ink tank eject lever
Push up to remove ink tanks.

(2) print head holder
The print head is pre-installed.

» Note

» For instructions on replacing ink tanks, see Replacing Ink Tanks.

264



Operation Panel

* Here, all operation panel indicators are shown lit for the purpose of illustration.

-
2
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(1) POWER lamp
Remains lit after flashing when the machine is turned on.

(2) ON button
Turns the machine on or off.

= Turning the Machine On and Off

(3) HOME button
Used to display the HOME screen.

= Using the Operation Panel

(4) touch screen
Displays messages, menu items, and operating status. Touch the screen lightly with your finger to
select a menu item or button.

= Basic Touch Screen Operations

(5) Black button
Starts black-and-white copying, scanning, or faxing.

(6) Stop button
Cancels printing, copying, scanning, or faxing in progress.

(7) Alarm lamp
Lights up or flashes in case of errors.

(8) Color button
Starts color copying, scanning, or faxing.

(9) Back button
Returns to the previous screen.

(10) FAX Memory lamp
When lit, indicates that there are received or unsent documents in the machine's memory.

»» Note

» The machine beeps or plays alarm tones in response to touching button on the operation panel. You
can adjust the volume in Device user settings > Sound control.
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= Device user settings
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Power Supply
» Confirming that the Power Is On
» Turning the Machine On and Off
» Checking the Power Plug/Power Cord

*» Unplugging the Machine
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Confirming that the Power Is On

The POWER lamp is lit when the machine is on.

Even if the touch screen is off, as long as the POWER lamp is lit, the machine is on.

»» Note

+ After you turn the machine on, it requires a warm-up period of about 20 seconds before any operations.
Wait until the HOME screen is displayed.

» The touch screen display turns off automatically after about 5 minutes of inactivity. To activate the touch
screen again, touch it. The display is also activated again when a fax is received or an original is printed
from a computer.
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Turning the Machine On and Off
Turning the machine on

1. Press the ON button to turn the machine on.

The POWER lamp flashes and then remains lit.

= Confirming that the Power Is On

» Note

+ After you turn the machine on, it requires a warm-up period of about 20 seconds before any
operations. Wait until the HOME screen is displayed.

« If the Alarm lamp lights up or flashes and an error message appears on the touch screen, see
Message Appears.

* You can schedule automatic power-on at specified times on specified days of the week.

= ECO settings

* You can set the machine to turn on automatically when printing is started from a machine
connected by USB or network or when scanning or fax reception is started. This feature is
disabled by default.

= ECO settings

Turning the machine off

1. Press the ON button to turn the machine off.

Once the POWER lamp stops flashing, the machine goes off.

32 Important

» Before unplugging the machine after turning it off, confirm that the POWER lamp is off.
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»» Note

+ Remember that faxes cannot be sent or received while the machine is off.

» The power cannot be turned off while the machine is sending or receiving a fax, or when unsent
faxes are stored in the machine's memory.

* You can schedule automatic power-off at specified times on specified days of the week.

= ECO settings

* You can set the machine to turn off automatically after a specified period when no operations
are performed or print jobs are received from a computer. (The machine cannot be turned off
when a telephone is connected.) This feature is enabled by default.

= ECO settings
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Checking the Power Plug/Power Cord

Check the power plug/power cord once a month to ensure that it is not affected by these problems.

» Excessively hot
» Corroded

» Bent

* Worn

» Cracked or split

/A Caution

« If the power plug/power cord case is affected by these or other problems, unplug the machine and
request service. Continuing to use the machine with any of these problems may cause a fire or electric

shock.
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Unplugging the Machine
Always follow these steps when unplugging the machine.

3% Important

* Unplug the machine only after pressing the ON button and confirming that the POWER lamp is off.
Unplugging the machine while the POWER lamp is still on may cause the print head to dry out or
become clogged, which may affect print quality.

+ Unplugging the machine will reset the date/time setting and erase all documents in the machine's
memory. Send faxes, print documents, or save jobs to a USB flash drive as needed before unplugging
the machine.

1. Press the ON button to turn the machine off.

3. Unplug the machine.

Power cord specifications vary by region.
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Using the Operation Panel

The operation panel features a touch screen (A) and buttons (B).
Touch icons on the touch screen's HOME screen to select menus for copying, scanning, and other functions.

The HOME screen consists of three sections.

i )

ﬁ_’& Custam Q {3 LAN iR, ECO
" profiles [ Choud | settings settings

' a® Arcess | Records

medium

Wi-F|

A: touch screen

B: Buttons on the operation panel

Basic touch screen operations

Tap the touch screen lightly or use other gestures to access various functions and settings.

22 Important

» Note the following touch screen precautions to avoid malfunction or damage to the machine.

» Do not press hard against the touch screen.

» Do not press the touch screen with objects other than your finger—especially sharp objects, such
as pens, pencils, or nails.

» Do not touch the touch screen if your hands are wet or dirty.

» Do not place any objects on the touch screen.

» Do not apply a screen protector to the touch screen. Removing it may damage the touch screen.

Tap
Touch lightly and briefly with your fingertip.

Tap to select an item or photo on the screen, for example.
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Touch

Touch with your fingertip, pressing lightly.

Keep touching the "next" (or "back") icon to move forward or back through menus or photos continuously,
for example.

Flick
Flick up, down, left, or right on the screen with your finger.

Flick to switch menus or move forward or back through photos, for example.

Drag
While lightly touching the screen, move your finger up, down, left, or right.

Drag to view listed items or move sliders, for example.
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Example of using the touch screen

These touch screen operations are available on the copy standby screen.

A

Tap A to display the print settings menu.

Drag up or down, and then tap an item to select it.

You can scroll up and down through the menu by touching n or u (D).
After the list is displayed, tap a setting to select it.

._ i Lasselie (aulo)

b
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Tap B to display the screen for selecting the number of copies.

Tap a number to specify the number of copies, and then tap OK.

Tap C to display the preview screen.

As you view the preview at left, drag the slider (E) up or down to reduce or enlarge the image.

You can also tap n or u (D) to reduce or enlarge images. Keep touching n or ﬂ to adjust
magnification continuously.

After you have the desired magnification, tap OK.
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Entering Numbers, Letters, and Symbols

When entering user or recipient names or other information, you can enter or edit characters by selecting
them on the screen.
Switching the Input Mode

The machine has one input mode for letters and another for numbers and symbols. To switch modes, tap

(A) in the lower left.

To switch between lower and uppercase in the alphabetic mode and between different types of characters

in the number/symbol mode, tap m (B).

»>» Note

» The screen only shows numbers and symbols that are available for the type of information you are
entering, such as numbers for telephone or fax number input.
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Entering or Editing Numbers, Letters, and Symbols

Enter information as follows.

» To move the insertion point (cursor position) in the input field (C)

Tap n or u (D).

+ To delete an entered character
Move the cursor to the character to delete, and then tap (E).

Touch to keep deleting characters.

* To insert a space

Tap (F).

After you are finished entering information, tap OK (G).

Entering Letters With Accents or Diacritics

Tap the same key repeatedly until the desired character is displayed in the input field (C).

Key Lowercase Uppercase

alA adddaadae AAAAAAA E
c/C c¢ C¢C

elE eéééé EEEEE

i/l it 1Tt

n/N nA N N

0/0 008660066 0006060060
p/P pp Pp

u/U uliaud uouuo

ylY yy YY
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Changing Settings
» Changing Printer Settings from Your Computer (Windows)
» Changing Printer Settings from Your Computer (Mac OS)
» Changing Settings from Operation Panel

» Changing Printer's Setting Using Web Browser
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Changing Printer Settings from Your Computer (Windows)
» Changing the Print Options
» Registering a Frequently Used Printing Profile
» Managing the Printer Power
*» Reducing the Printer Noise

» Changing the Printer Operation Mode
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Changing the Print Options

You can change the detailed printer driver settings for print data that is sent from an application software.

Check this check box if part of the image data is cut off, the paper source during printing differs from the
driver settings, or printing fails.

The procedure for changing the print options is as follows:

1. Open the printer driver setup window

2. Click Print Options... on the Page Setup tab

Caick: Sehup | Man | P58 5600 | Martenance
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The Print Options dialog box opens.
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23 Note

* When you use the XPS printer driver, the functions available to you are different.

3. Change the individual settings

If necessary, change the setting of each item, and then click OK.
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The Page Setup tab is displayed again.
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Registering a Frequently Used Printing Profile

You can register the frequently used printing profile to Commonly Used Settings on the Quick Setup tab.
Unnecessary printing profiles can be deleted at any time.

The procedure for registering a printing profile is as follows:
Registering a Printing Profile

1. Open the printer driver setup window

2. Set the necessary items

From Commonly Used Settings on the Quick Setup tab, select the printing profile to be used and if
necessary, change the settings after Additional Features.
You can also register necessary items on the Main and Page Setup tabs.

3. Click Save...

Commenzely Lised Setiengs
ST

[T B Document
I Paper Savirg

4. Save the settings
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Enter a name in the Name field. If necessary, click Options..., set the items, and then click OK.

In the Save Commonly Used Settings dialog box, click OK to save the print settings and return to the
Quick Setup tab.

The name and icon are displayed in Commonly Used Settings.

22 Important

+ To save the page size, orientation, and number of copies that was set in each sheet, click Options...,
and check each item.

»>» Note

* When you re-install the printer driver or upgrade the printer driver version, the print settings that are
already registered will be deleted from Commonly Used Settings.
Registered print settings cannot be saved and preserved. If a profile is deleted, register the print
settings again.

Deleting Unnecessary Printing Profile

1. Select the printing profile to be deleted

Select the printing profile you want to delete from the Commonly Used Settings list on the Quick
Setup tab.

2. Delete the printing profile

Click Delete. When the confirmation message appears, click OK.
The selected printing profile is deleted from the Commonly Used Settings list.

»>» Note

* Printing profiles that are registered in the initial settings cannot be deleted.
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Managing the Printer Power

This function allows you to manage the printer power from the printer driver.

The procedure for managing the printer power is as follows:

é Power Off

The Power Off function turns off the printer. When you use this function, you will not be able to turn the

printer on from the printer driver.

1. Open the printer driver setup window

2. Execute power off
Click Power Off on the Maintenance tab. When the confirmation message appears, click OK.

The printer power switches off, and the Maintenance tab is displayed again.

3% Important

* You cannot receive faxes when the printer is switched off.

285



Reducing the Printer Noise

The silent function allows you to reduce the operating noise of this printer. Select when you wish to reduce
the operating noise of the printer at night, etc.
Using this function may lower the print speed.

The procedure for using the quiet mode is as follows:

&

1. Open the printer driver setup window

Quiet Settings

2. Click Quiet Settings on the Maintenance tab

The Quiet Settings dialog box opens.
3> Note

« If the printer is off or if communication between the printer and the computer is disabled, an
error message may appear because the computer cannot collect the printer status.

3. Set the quiet mode

If necessary, specify one of the following items:

Do not use quiet mode
Select this option when you wish to use the printer with volume of normal operating noise.

Always use quiet mode
Select this option when you wish to reduce the operating noise of the printer.

Use quiet mode during specified hours
Select this option when you wish to reduce the operating noise of the printer during a specified
period of time.
Set the Start time and the End time of the quiet mode you wish to be activated. If both are set to
the same time, the quiet mode will not function.

3% Important

* You can set the quiet mode from the operation panel of the printer, the printer driver, or
ScanGear (scanner driver).
No matter how you use to set the quiet mode, the mode is applied when you perform operations
from the operation panel of the printer or printing and scanning from the computer.

4. Apply the settings

Make sure that the printer is on and click OK.
Click OK when the confirmation message appears.

The settings are enabled hereafter.
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»» Note

» The effects of the quiet mode may be less depending on the paper source and the print quality settings.

287



Changing the Printer Operation Mode

If necessary, switch between various modes of printer operation.

The procedure for configuring Custom Settings is as follows:

— | Custom Settings

1. Open the printer driver setup window

2. Make sure that the printer is on, and then click Custom Settings on the Maintenance
tab

The Custom Settings dialog box opens.

»» Note

« If the printer is off or if communication between the printer and the computer is disabled, an
error message may appear because the computer cannot collect the printer status.
If this happens, click OK to display the most recent settings specified on your computer.

3. If necessary, complete the following settings:

Prevent paper abrasion
The printer can increase the gap between the print head and the paper during high-density
printing to prevent paper abrasion.
Check this check box to prevent paper abrasion.

Align heads manually
Usually, the Print Head Alignment function on the Maintenance tab is set to automatic head
alignment, but you can change it to manual head alignment.
If the printing results of automatic print head alignment are not satisfactory, perform manual head
alignment.
Check this check box to perform the manual head alignment. Uncheck this check box to perform
the automatic head alignment.

Rotate 90 degrees left when orientation is [Landscape]
On the Page Setup tab, you can change the rotation direction of the Landscape in the
Orientation.
To rotate the print data 90 degrees to the left during printing, select this item. To rotate the print
data 90 degrees to the right during printing, clear this item.

32 Important

» Do not change this setting while the print job is displayed in the print wait list. Otherwise,
characters may be omitted or the layout may become corrupt.

Don't detect mismatch of paper settings when printing from computer
When you print documents from your computer and the paper settings on the printer driver and
the cassette paper information registered on the printer do not match, this setting disables the
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message display and allows you to continue printing.
To disable detection of paper setting mismatches, select this check box.

Ink Drying Wait Time
You can set the length of the printer rest time until printing of the next page begins. Moving the
slider to the right increases the pause time, and moving the slider to the left decreases the time.
If the paper gets stained because the next page is ejected before the ink on the printed page
dries, increase the ink drying wait time.
Reducing the ink drying wait time speeds up printing.

4. Apply the settings
Click OK and when the confirmation message appears, click OK.

The printer operates with the modified settings hereafter.
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Changing Settings from Operation Panel

>

>

Changing Settings from Operation Panel
Setting Items on Operation Panel

FAX settings

Print settings

LAN settings

Device user settings

Language selection

Firmware update

Cassette settings

Administrator password setting
Operation restrictions

Reset setting

Web service setup

System information

ECO settings

Quiet setting

Registering Favorite Settings (Custom profiles)

Checking the Total Number of Uses of Machine
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Changing Settings from Operation Panel

This section describes the procedure to change the settings in the Device settings screen, taking the steps
to specify Prevent paper abrasion as an example.

1. Make sure printer is turned on.

| A
2. Flick HOME screen and tap . Setup.

= Using the Operation Panel

3. Tap Device settings.

The Device settings screen appears.

4. Tap setting item to adjust.

Device settings

FAX settings

Print settings

LAN settings

MNawira ear cattinae

The setting screen for the selected item is displayed.

5. Tap setting item.

Print settings

Prevent paper abrasion ||

6. Tap setting to specify.
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For more on setting items on the operation panel:

= Setting Items on Operation Panel
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Setting Items on Operation Panel

»» Note

» The administrator password is required to change some setting items if it is enabled for changing
settings using the operation panel.

For more on setting items which the administrator password is required:

= Setting Administrator Password on Operation Panel

Items for Security

= Administrator password setting
= QOperation restrictions

Items for Printer

FAX settings
Device user settings

Web service setup
Language selection

ECO settings

Quiet setting
Reqistering Favorite Settings (Custom profiles)

L 2R 2 B B B R

Items for Paper/Printing

= Print settings
= Cassette settings

= Paper Settings

Items for Maintenance/Management

= System information
= Firmware update

= | AN settings

= Reset setting
= Checking the Total Number of Uses of Machine
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FAX settings

3% Important

 This setting item is for the administrator.

This section describes the setting items in FAX settings.

= FAX user settings

= Advanced FAX settings
= Auto print settings

= Auto save setting
=
=

Security control
Easy setup

»» Note

» Before changing the settings, you can confirm the current settings by printing USER'S DATA LIST.

= Summary of Reports and Lists

FAX user settings

» User information settings
Registers your name and fax/telephone number printed on sent faxes.

= Registering User Information

» Telephone line type
Selects the telephone line type setting for the printer.

= Setting Telephone Line Type
»» Note

 This setting may not be available depending on the country or region of purchase.

Advanced FAX settings

» Auto redial
Enables/disables automatic redialing.
If you select ON, you can specify the maximum number of redial attempts and the length of time the
printer waits between redial attempts.
+ Dial tone detect
Avoids mistransmission when reception and transmission occur at the same time.

If you select ON, the printer transmits the fax after confirming the dial tone.

»>» Note

 This setting may not be available depending on the country or region of purchase.
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Pause time settings

Sets the length of pause time for each when you enter "P" (pause).

TTI position

Selects the position of the sender information (outside or inside the image area).

Remote RX
Enables/disables remote reception.
If you select ON, you can specify the remote reception ID.

= Remote Reception

Color transmission

When faxing color documents using the ADF, selects whether to convert them into black & white data
if the recipient's fax device does not support color faxing.

If you select Disconnect, the printer does not send color documents when the recipient's fax device
does not support color faxing.

RX image reduction

Enables/disables automatic reduction of incoming faxes so that they fit in the selected paper.

If you select ON, you can select the image reduction direction.

Adv. communication settings
> ECMTX
Selects whether to send faxes in Error Correction Mode (ECM).

= Transmission/Reception of Faxes Using ECM

o ECM RX
Selects whether to receive faxes in Error Correction Mode (ECM).

= Transmission/Reception of Faxes Using ECM

o TX start speed
Selects the fax transmission speed.
The fax transmission start speed will be faster as the value is bigger.

When the telephone line condition or connection is poor, selecting a lower transmission start
speed may solve transmission problems.

o RX start speed
Selects the fax reception speed.
The fax reception start speed will be faster as the value is bigger.

When the telephone line condition or connection is poor, selecting a lower reception start speed
may solve reception problems.
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Auto print settings

* Received documents
Selects whether to print the received fax automatically when receiving a fax.
If you select Do not print, the received fax is stored in the printer's memory.
For details on the received fax stored in the printer's memory:

= Document Stored in Printer's Memory

* Activity report
Selects whether to print ACTIVITY REPORT automatically.

If you select Print, the printer prints ACTIVITY REPORT for the 20 histories of sent and received
faxes automatically.

For details on the procedure to print ACTIVITY REPORT manually:

= Summary of Reports and Lists

* TX report
Selects whether to print TX REPORT/ERROR TX REPORT automatically after sending a fax.
If you print the report, select Print error only or Print for each TX.
If you select Print error only or Print for each TX, you can specify the print setting that the first page
of the fax is printed along with the report.
* RX report
Selects whether to print RX REPORT automatically after receiving a fax.

If you print RX REPORT, select Print error only or Print for each RX.

¢ Print when out of ink

Sets whether to continue printing the received fax without storing it in the printer's memory when the
ink has run out.

However, part or all of the fax may not be printed since the ink has run out.

Auto save setting

Selects whether to save the received fax on the USB flash drive automatically or to forward to the shared
folder on the computer automatically after receiving a fax.

= Saving Received Faxes Automatically on USB Flash Drive
= Forwarding Received Faxes Automatically to Shared Folder on Computer

Security control

* FAX number re-entry

If you select ON, you can set the printer to send faxes after entering the number twice. By using this
setting, you can avoid the mistransmission of faxes.

= Preventing Mistransmission of Faxes
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¢ Check RX FAX information

If you select ON, the printer checks whether the recipient's fax device information matches the dialed
number. If it matches the number, the printer starts to send faxes.

= Preventing Mistransmission of Faxes

* Hook key setting

If you select Enable, you can use the on hook dial function.

* FAX reception reject

If you select ON, the printer rejects the reception of faxes with no sender information or faxes from
specific senders.

= Rejecting Fax Reception

 Caller rejection

If you subscribe to the Caller ID service, the printer detects the sender's Caller ID. If the sender's ID
matches the condition specified in this setting, the printer rejects the phone call or fax reception from
the sender.

If you select Yes on the subscribing confirmation screen, you can specify the settings of rejection.

= Using Caller ID Service to Reject Calls

»>» Note

 This setting may not be supported depending on the country or region of purchase. Contact your
telephone company to confirm whether it provides this service.

Easy setup

The printer must be set up depending on your telephone line and use of the faxing function. Follow the
procedure according to the instructions on the touch screen.

»» Note

* You can specify the setup setting individually or the advanced setting.
For details on how to specify the setting:

= Preparing for Faxing
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Print settings

Select this setting item from Device settings on Setup.

* Prevent paper abrasion

Use this setting only if the print surface becomes smudged.

22 Important

* Be sure to set this back to OFF after printing since it may result in lower printing speed or lower
print quality.
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LAN settings

Select this setting item from Device settings on Setup.

32 Important

» The administrator password is required to change settings if it is enabled for changing settings using
the operation panel.

* Change LAN

Enables either wireless LAN, wired LAN, or direct connection. You can also disable all.

* Wireless LAN setup
Selects the setup method for wireless LAN connection.

»» Note

* You can also enter this setting menu by selecting LAN settings on the HOME screen. In this case,
enable wireless LAN.

o Cableless setup

Select if you specify the settings of the access point information to the printer directly from a device
(e.g. smartphone, or tablet) without operating the wireless router. Follow the on-screen instructions
of the connecting device for the setup procedure.

o Standard setup
Select when you perform settings for wireless LAN manually using the operation panel of the printer.
o WPS (Push button method)

Select when you perform settings for wireless LAN using a wireless router supporting a Wi-Fi
Protected Setup (WPS) push button method. Follow the on-screen instructions during setup.

o Other setup
m Advanced setup

Select when you perform settings for wireless LAN manually. You can specify multiple WEP
keys.

m WPS (PIN code method)
Select when you perform settings for wireless LAN using a wireless router supporting a Wi-Fi
Protected Setup (WPS) PIN code method. Follow the on-screen instructions during setup.
+ Confirm LAN settings

The list of wireless/wired LAN settings or the direct connection of this printer is displayed on the touch
screen. Tap Print details and then Yes to print the list.

For more information on the printer's network setting is printed out:
= Printing Network Settings
22 Important

» The network settings printout contains important information about your network. Handle it with
care.
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o WLAN setting list
The list of wireless LAN settings of this printer is displayed on the touch screen.

The following setting items are displayed. (Some setting items are not displayed depending on the
printer settings.)

Items Setting

SSID XXXXXXXXXXXXXXXX
XXXXXXXXXXXXXXXX (up to 32 characters)

Wireless LAN security Inactive/WEP(64bit)/WEP(128bit)/WPA-PSK(TKIP)WPA-PSK(AES)/
WPA2-PSK(TKIP)/WPA2-PSK(AES)

Signal strength (%) XXX

IPv4 address XXX, XXX, XXX. XXX (12 characters)
IPv4 subnet mask XXX, XXX, XXX. XXX (12 characters)
IPv4 default gateway XXX, XXX, XXX. XXX (12 characters)
IPv6 address XXXX: XXXX: XXXX: XXXX:

XXXX: XXXX: XXXX: XXXX (32 characters)

MAC address XX XX XX XX:XX: XX (12 characters)
Printer name XXXXXXXXXXXXXXX (up to 15 characters)
Bonjour service name XXXXXXXXXXXXX

XXXXXXXXXXXXX

XXXXXXXXXXXXX

XXXXXXXXXXXXX (up to 52 characters)

Root cert. thumbprint (SHA-1) | XXXXXXXX XXXXXXXX XXXXXXXX
XXXXXXXX XXXXXXXX

Root cert. thumbprint (SHA-256) | XXXXXXXX XXXXXXXX XXXXXXXX XXXXXXXX
19,999,909, 9.9,.9,0.9.9,0.0.9.0.9,0,.0.9,0.0.9.0.9,.0,0.9,.0,0.4

("XX" represents alphanumeric characters.)
o LAN setting list
The list of wired LAN settings of this printer is displayed on the touch screen.

The following setting items are displayed. (Some setting items are not displayed depending on the
printer settings.)

Items Setting

IPv4 address XXX, XXX. XXX. XXX (12 characters)
IPv4 subnet mask XXX, XXX, XXX. XXX (12 characters)
IPv4 default gateway XXX, XXX, XXX. XXX (12 characters)

300



IPv6 address XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

MAC address XX XX XX XX:XX: XX (12 characters)
Printer name XXXXXXXXXXXXXXX (up to 15 characters)
Bonjour service name XXXXXXXXXXXXX

XXXXXXXXXXXXX

XXXXXXXXXXXXX

XXXXXXXXXXXXX (up to 52 characters)

Root cert. thumbprint (SHA-1) | XXXXXXXX XXXXXXXX XXXXXXXX
XXXXXXXX XXXXXXXX

Root cert. thumbprint (SHA-256) | XXXXXXXX XXXXXXXX XXXXXXXX XXXKXXXXX
09.9,0,.0.9.0,.0.9.9.9,0,0.9,0,.0.9.0,0.9,.0,.0.9,0.9.0,0.9,0,0.9,0.4

("XX" represents alphanumeric characters.)
o Direct connection setting list
The list of direct connection settings of this printer is displayed on the touch screen.

The following setting items are displayed. (Some setting items are not displayed depending on the
printer settings.)

Items Setting

SSID DIRECT-XXXX-XXXXXXseries
Password XXXXXXXXXX (10 characters)
Wireless LAN security WPA2-PSK(AES)

IPv4 address XXX, XXX, XXX. XXX (12 characters)
IPv4 subnet mask XXX, XXX, XXX. XXX (12 characters)
IPv4 default gateway XXX, XXX, XXX. XXX (12 characters)
IPv6 address XXXX: XXXX: XXXX: XXXX:

XXXX: XXXX: XXXX: XXXX (32 characters)

MAC address XX XX XX XX:XX: XX (12 characters)
Printer name XXXXXXXXXXXXXXX (up to 15 characters)
Bonjour service name XXXXXXXXXXXXX

XXXXXXXXXXXXX

XXXXXXXXXXXXX

XXXXXXXXXXXXX (up to 52 characters)

Direct connection device name | XXXXXX-XXXXXXseries

Root cert. thumbprint (SHA-1) | XXXXXXXX XXXXXXXX XXXXXXXX
XXXXXXXX XXXXXXXX
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Root cert. thumbprint (SHA-256) [ XXXXXXXX XXXXXXXX XXXXXXXX XXXXXXXX
XXXXXXXX XXXKXKXX XXXXXXXX XXXKXXKXX

("XX" represents alphanumeric characters.)

» Other settings
3% Important

* You cannot select the items below when Disable LAN is selected for Change LAN.

o Direct connection settings

Setting items are available when you connect a device to the printer.

22 Important

* You can select these setting items only when Activate direct connect. is selected for Change
LAN.

m Update SSID/password

Selecting Yes updates the identifier (SSID) and password for direct connection.
m Change device name

Changes the printer's name displayed on a Wi-Fi Direct compatible device.
m Connection request confirmation

Selecting Yes displays the confirmation screen when a Wi-Fi Direct compatible device is
connecting the printer.

= Using Machine with Direct Connection

o Set printer name

Specifies the printer name. You can use up to 15 characters for the name.

»» Note

* You cannot use the same printer name as that already used for other LAN connected devices.
* You cannot use a hyphen for the initial or last character of the printer name.

o TCP/IP settings
Performs IPv4 or IPv6 setting.
o WSD setting

Setting items when you use WSD (one of the network protocols supported in Windows 10, Windows
8.1, Windows 8, Windows 7, and Windows Vista).

m Enable/disable WSD
Selects whether WSD is enabled or disabled.

»» Note

* When this setting is enabled, the printer icon is displayed on the Network Explorer in
Windows 10, Windows 8.1, Windows 8, Windows 7, and Windows Vista.

m Optimize inbound WSD
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Selecting Enable allows you to receive the WSD printing data faster.
m WSD scan from this device
Selecting Enable allows you to transfer the scanned data to the computer using WSD.
m Timeout setting
Specifies the timeout length.
> Bonjour settings
Setting items for LAN using Bonjour for Mac OS.
m Enable/disable Bonjour
Selecting Enable allows you to use Bonjour to perform the network settings.
m Service name

Specifies the Bonjour service name. You can use up to 48 characters for the name.

»>» Note

* You cannot use the same service name as that already used for other LAN connected
devices.

° LPR protocol setting
Enables/disables the LPR setting.
> RAW protocol
Enables/disables RAW printing.

o

LLMNR

Enables/disables LLMNR (Link-Local Multicast Name Resolution). Selecting Active allows the
printer to detect printer's IP address from the printer name without a DNS server.

> Wired LAN DRX setting

Selecting Enable allows you to activate discontinuous reception when the printer is connected to a
device compatible with wired LAN.
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Device user settings

Select this setting item from Device settings on Setup.

32 Important

» The administrator password is required to change settings if it is enabled for changing settings using
the operation panel.

» Date/time setting
Sets the current date and time.
For more on the procedure:

= Setting Sender Information

* Date display format

Sets the format of dates displayed on the touch screen and printed on sent faxes and photos.

> Note

* When ON is selected for Print date on the print settings screen in printing from a USB flash drive,
the shooting date is printed in the date display format you selected.

= Setting Items for Photo Printing Using Operation Panel

» Daylight saving time setting

Enables/disables the summer time setting. If you select ON, you can select additional sub-settings. This
setting may not be available depending on the country or region of purchase.

o Start date/time
Sets the date and time that summer time starts.
Month: Specify the month.
Week: Specify the week.
DOW: Specify the day of the week.

The screen to set the shift time to start summer time will be displayed after specifying the items
above and tapping OK.

After specifying the shift time and tapping OK, you can specify the end date/time.
> End date/time

Sets the date and time that summer time ends.

Month: Specify the month.

Week: Specify the week.

DOW: Specify the day of the week.

The screen to set the shift time to end summer time will be displayed after specifying the items
above and tapping OK.

Specify the shift time and tap OK.
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* Time zone
Specifies the time zone according to a country or region you live in.

Specifying the time zone allows you to display the correct time and date an e-mail was sent on your mail
software.

For more on the time zone for each country or region:

= Timezone List

* Sound control
Selects the volume.
> Keypad volume
Selects the beep volume when tapping the touch screen or the buttons on the operation panel.
o Alarm volume
Selects the alarm volume.
° Line monitor volume
Selects the line monitor volume.
o Offhook alarm

Selects the alarm volume when the phone receiver is not put on the hook properly.

» Country or region
Selects the country or region where you are using the printer.

»» Note

+ This setting may not be available depending on the country or region of purchase.

» Device info sending setting
Selects whether you will send the printer usage information to Canon. The information sent to Canon will
be utilized to develop better products. Select Agree to send the printer usage information to Canon.

* Power control

Allows you to turn on/off the printer automatically to save electricity. In addition, you can specify the time
and day to turn it on/off.

o Enable auto power control

Specifies the length of time to turn off the printer automatically when no operation is made or no
printing data is sent to the printer. In addition, you can allow the printer to turn on automatically
when a scanning command from a computer or printing data is sent to the printer.

o Enable scheduling
Specifies the time to turn on/off the printer automatically for each day.
> Do not control power

Disables the function to turn on/off the printer automatically.
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»» Note

* You can also enter this setting menu by selecting ECO settings and Power control on the
HOME screen.

= ECO settings
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Timezone List

Time zone |Country or region

(UTC-12:00) | Baker Island, Howland Island

(UTC-11:00) | American Samoa, Niue

(UTC-10:00) | Hawaii, Western area of Aleutian Islands
(UTC-9:00) (Alaska

(UTC-8:00) |US/Canada/Mexico (Pacific Time)

(UTC-7:00) |US/Canada/Mexico (Mountain Time)
(UTC-6:00) | US/Canada/Mexico (Central Time)

(UTC-5:00) |US/Canada/Mexico (Eastern Time), Cuba, Peru
(UTC-4:30) |Venezuela

(UTC-4:00) ([Canada (Atlantic Time), Most areas of Lesser Antilles, Brazil (Amazon Time), Chile
(UTC-3:30) ([Canada (Newfoundland)

(UTC-3:00) |Brazil (Brasilia time), Argentina, Greenland
(UTC-2:00) (Brazil (Fernando de Noronha)

(UTC-1:00) |Azores, Cape Verde

(UTC+00:00)

United Kingdom, Ireland, Portugal, Iceland, Morocco (Western Africa), Ghana

(UTC+1:00) [ Central European Time (France, Germany), West Africa Time (Nigeria, Congo)
(UTC+2:00) [ Eastern European Time (Finland, Greece), Central Africa Time, South Africa
(UTC+3:00) (Russia (Kaliningrad), Ukraine, Belarus, Saudi Arabia, East Africa Time
(UTC+3:30) (lIran

(UTC+4:00) | Russia (Moscow), Azerbaijan, Georgia, United Arab Emirates, Mauritius
(UTC+4:30) [ Afghanistan

(UTC+5:00) | Pakistan

(UTC+5:30) |India

(UTC+5:45) | Nepal

(UTC+6:00) | Russia (Yekaterinburg), Kazakhstan, Bangladesh

(UTC+6:30) [ Myanmar, Cocos Islands

(UTC+7:00) [ Russia (Omsk), Mongolia, Thailand, Vietnam, Jakarta

(UTC+8:00) | Russia (Krasnoyarsk), China, Mongolia, Malaysia, Australia (Western Australia)
(UTC+8:45) | Australia (Eucla)

(UTC+9:00) | Russia (Irkutsk), South Korea, Japan, Palau

(UTC+9:30) | Australia (Northern Territory, South Australia)

(UTC+10:00)

Russia (Yakutsk), Guam, Australian Eastern Standard Time

(UTC+10:30)

Australia (Lord Howe Island)
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(UTC+11:00) [ Russia (Vladivostok), Solomon Islands, New Caledonia

(UTC+12:00) | Russia (Magadan), New Zealand, Fiji, Kiribati (Gilbert Islands)

(UTC+12:45) | New Zealand (Chatham Island)

(UTC+13:00) [ Tonga, Kiribati (Phoenix Islands), Samoa (From 2011/12/31), Tokelau (From 2011/12/31)

(UTC+14:00) | Kiribati (Line Islands)
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Language selection

Select this setting item from Device settings on Setup.

32 Important

» The administrator password is required to change settings if it is enabled for changing settings using
the operation panel.

Changes the language for the messages and menus on the touch screen.
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Firmware update

Select this setting item from Device settings on Setup.

32 Important

» The administrator password is required to change settings if it is enabled for changing settings using
the operation panel.

You can update the firmware of the printer, check the firmware version, or perform settings of a notification
screen, a DNS server and a proxy server.

»>» Note

» Only Check current version is available when Disable LAN or Activate direct connect. is selected
for Change LAN in LAN settings.

* Install update

Performs the firmware update of the printer. If you select Yes, the firmware update starts. Follow the on-
screen instructions to perform update.

22 Important

» When you use this function, make sure the printer is connected to the Internet.
« If the firmware update is carried out, all faxes stored in the printer's memory are deleted.
* You cannot start the firmware update under the following conditions:

» While the printer is sending or receiving a fax
» While the printer is storing the unprinted fax in printer's memory (memory reception)
* When the unsent faxes are stored in the printer's memory

»» Note

« If the firmware update is not complete, check the following and take an appropriate action.

* When using wired LAN, make sure the printer is connected to the computer with a LAN cable
properly.

» Check the network settings such as a router.

+ If Cannot connect to the server. is displayed on the touch screen, tap OK and try again after
a while.

* Check current version

You can check the current firmware version.

» Update notification setting

When Yes is selected and the firmware update is available, the screen to inform you of the firmware
update is displayed on the touch screen.

* DNS server setup

Performs settings for a DNS server. Select Auto setup or Manual setup. If you select Manual setup,
follow the display on the touch screen to perform settings.
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* Proxy server setup

Performs settings for a proxy server. Follow the display on the touch screen to perform settings.
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Cassette settings

Select this setting item from Device settings on Setup.

By registering the paper size and the media type loaded in the cassette, you can prevent the printer from
misprinting by displaying the message before printing starts when the paper size or the media type of the
loaded paper differs from the print settings. In addition, you can allow the printer to switch the paper source
automatically when a cassette runs out of paper.

For details:
= Paper Settings

* Register cassette paper info

Registers the paper size and the media type you load in the cassette.

»» Note

* When you register the paper size and the media type, the screen to select whether you apply the
settings to those for copying is displayed. Select Yes to apply the registered settings to copying.
» For more on the combination of paper settings you can specify by the printer driver or on the touch

screen:
e For Windows:

= Paper Settings on the Printer Driver and the Printer (Media Type)
= Paper Settings on the Printer Driver and the Printer (Paper Size)

* For Mac OS:

= Paper Settings on the Printer Driver and the Printer (Media Type)
= Paper Settings on the Printer Driver and the Printer (Paper Size)

» Detect paper setting mismatch
If you select Yes, the printer detects whether the paper size and the media type are identical with those
registered in Register cassette paper info. If printing starts with the settings that do not match, an error
message is displayed on the touch screen.

» Detect cassette reinsertion
If you select Yes, the printer detects the cassette is reinserted. When the Register cassette paper info
screen is displayed, register the paper size and the media type.

» Auto feed switch

If you select Yes, the printer switches the paper source automatically when a cassette runs out of paper.
Load A4, Letter, or Legal sized plain paper in both of the cassettes to activate this function.
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Administrator password setting

Select this setting item from Device settings on Setup.

32 Important

» The administrator password is required to change settings if it is enabled for changing settings using
the operation panel.

You can specify or disable the administrator password.
If you specify the administrator password, select the range and specify the administrator password.

Remote Ul or other tools

Entering the administrator password is required to change the setting items using Remote Ul or some
software.

LCD, Remote Ul or other tools
Entering the administrator password is required to change the setting items using the operation panel of
the printer, Remote Ul, or some software.

For details:

= Setting Administrator Password on Operation Panel
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Setting Administrator Password on Operation Panel

You can specify or disable the administrator password.

Specifying the administrator password requires you to enter the password to use the items or change the
settings below.

+ Web service setup

+ FAX settings

* LAN settings

» Device user settings

+ Language selection

* Firmware update

+ ECO settings

* Quiet setting

+ Administrator password setting
* Operation restrictions

* Reset setting (except for Reset all)
* Import e-mail address book

+ Export e-mail address book

Follow the procedure below to specify the administrator password.

1. Make sure printer is turned on.

| A
2. Flick HOME screen and tap . Setup.

= Using the Operation Panel

3. Tap Device settings.

The Device settings screen appears.
4. Tap Administrator password setting.

5. When confirmation screen to specify administrator password is displayed, tap Yes.

If an administrator password is not specified, the register confirmation message appears. Tapping Yes
displays the message again. Tap OK.

3% Important

» The administrator password is set at the time of purchase. The printer's serial number is used as
the password.

For the administrator password, refer to Administrator Password.

6. Tap Change administrator password.
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If you do not specify an administrator password, tap Remove administrator password. Tapping Yes
displays the message again. Tap OK.

7. Tap range where administrator password is valid.

Remote Ul or other tools
Entering the administrator password is required to change the setting items using Remote Ul or
some software.

LCD, Remote Ul, or other tools
Entering the administrator password is required to change the setting items using the operation
panel of the printer, Remote Ul, or some software.

8. Enter administrator password.

2% Important

» The following character restrictions apply to the password:

+ Set the password by using 4 to 32 characters.
» The allowed characters are single-byte alphanumeric characters.
» For security reasons, we recommend you use 6 and more alphanumeric characters.

9. Tap Apply.
10. Enter administrator password you specified again.

11. Tap Apply.

The administrator password is enabled.

When You Want to Change or Disable the Administrator Password:

When the administrator password is enabled, tapping Setup, Device settings, and Administrator
password setting in this order and entering the administrator password displays Change administrator
password and Remove administrator password on the touch screen. Select either item and follow the
on-screen instructions to perform settings.
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Operation restrictions

Select this setting item from Device settings on Setup.

32 Important

» The administrator password is required to change settings if it is enabled for changing settings using
the operation panel.

You can restrict printing, copying, or faxing operations or to use a USB flash drive or a shared folder on the
computer.

»» Note

* When no operation restrictions are enabled, the confirmation screen to enable operation restrictions is
displayed. Tapping Yes enables you to restrict operations. If you have already restricted any operations,
the menu items are displayed. Tapping Change operation restrictions enables you to change the
settings of operation restrictions.

For details:

= Restricting Machine Operation
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Restricting Machine Operation

You can restrict printing, copying, or faxing operations or to use a USB flash drive or a shared folder on the
computer. Restrictions can be disabled temporality.

= Disabling Operation Restriction Temporarily

To enable this function, apply the administrator password for changing settings on the operation panel.

= Setting Administrator Password on Operation Panel

1. Make sure printer is turned on.

| A
2. Flick HOME screen and tap . Setup.

= Using the Operation Panel

3. Tap Device settings.

4. Tap Operation restrictions.

5. Enter administrator password.

6. When confirmation screen of operation restriction is displayed, tap Yes.

If you have already performed operation restriction setting, the menu items are displayed. Tap Change
operation restrictions.

7. Tap operation you want to restrict and tap function you want to restrict.

Copy
Restricts copying operations. If you select Restrict all copying, you can restrict all copying
operations. If you select Restrict color copying, you can restrict color copying operations only.

Print from storage medium
Restricts to print from a USB flash drive.

Scan to USB flash drive
Restricts to save the scanned data on a USB flash drive.

Scan to destination folder
Restricts to forward the scanned data to a shared folder on the computer.

Scan (E-mail direct from device)
Restricts to send an e-mail with scanned data attached from the printer.

E-mail address book
Restricts operations related to the printer's e-mail address book.

FAX transmission
Restricts to send a fax from the printer. (Sending a fax from the computer is not restricted.)
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FAX reception
Restricts to receive a fax.

2% Important

« If the printer receives a fax while Restrict is selected, Not available. An operation restriction is
set. is displayed on the touch screen and the fax standby screen is displayed. In this case, you
cannot receive the faxes. Ask the administrator of the printer you are using to change the setting
and have the sender resend the faxes.

Directory
Restricts operations related to the printer's directory.

8. Tap Exit.
The operation restrictions you selected are enabled.

»» Note

+ If you disable all restrictions, tap Cancel operation restrictions in step 6. When the confirmation
screen is displayed, tap Yes.

To disable each operation restriction, tap the item in step 7 and tap Do not restrict.

Disabling Operation Restriction Temporarily

Specify the override password to disable operation restriction temporarily following the procedure below.

1. Make sure printer is turned on.

| A
2. Flick HOME screen and tap . Setup.

= Using the Operation Panel

3. Tap Device settings.

4. Tap Operation restrictions.

5. Enter administrator password.

6. Tap Override password setting on displayed screen.

7. Tap Yes on displayed screen.

8. Tap OK on displayed screen.

9. Specify password.
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10. Tap Apply.

11. Enter password you specified again.

12. Tap Apply.
The override password is enabled.

»>» Note

* Receiving a fax is restricted even though operation restriction is disabled by the override password.
« If the touch screen turns off while disabling operation restriction temporarily, enter the override
password again to resume the printer.
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Reset setting

Select this setting item from Device settings on Setup.

Returns all settings you made to the printer back to the default. However, some data may not be changed,
depending on the current usage state of your printer.

32 Important

» The administrator password is required to change settings if it is enabled for changing settings using
the operation panel.

» Depending on the setting item, it is necessary to perform connection or setup again after you have
returned the setting back to the default.

* Web service setup only

Deletes 1J Cloud Printing Center and Google Cloud Print registrations.

* LAN settings only
Sets the LAN settings other than the administrator password back to the default.

After resetting, perform setup again as necessary.

» Telephone number only

Deletes all registered telephone/fax numbers.

+ Settings only
Returns the settings such as the paper size, media type, or other setting items back to the default. The
LAN settings and the telephone/fax number are not returned back to the default.

» Device info sending setting only

Applies the setting not to send the device information to Canon.

+ E-mail address book entries only

Deletes all registered e-mail addresses.

* FAX settings only

Returns all fax settings back to the default. Disconnect the telephone line from the printer before you
return this setting item back to the default.

After resetting, perform setup again as necessary.

* Reset all

Sets all settings you made to the printer back to the default. The administrator password specified for
the printer is set to the default setting.

After resetting, perform setup again as necessary.

»» Note

* You cannot set the following setting items back to the default:

» The language displayed on the touch screen
» The current position of the print head
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» The country or region selected for Country or region
« Total use of copying, scanning, and faxing recorded in Records of use
* CSR (Certificate Signing Request) for encryption method (SSL/TLS) setting

You can delete the registered user's name or telephone number following the procedure below.
1. Display User information settings screen.

= Setting Sender Information

2. Tap user's name or telephone number and delete all characters or numbers.
3. Tap OK when you finished deleting all characters or numbers.

» Agree is selected for Device info sending setting on Device user settings after you have reset the
setting to send device information. However, the printer does not send device information. Tap Do not
agree to disable the function to send device information.
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Web service setup

Select this setting item from Web service setup on Setup.

32 Important

» The administrator password is required to change settings if it is enabled for changing settings using
the operation panel.

+ Web service connection setup
The following setting items are available.
o Google Cloud Print setup
Registers/Deletes the printer to/from Google Cloud Print.
° |J Cloud Printing Center setup
Registers/Deletes the printer to/from Canon Inkjet Cloud Printing Center.
o Check Web service setup
Make sure whether the printer is registered to Google Cloud Print or Canon Inkjet Cloud Printing
Center.
* DNS server setup
Performs settings for a DNS server. Select Auto setup or Manual setup. If you select Manual setup,
follow the display on the touch screen to perform settings.
* Proxy server setup

Performs settings for a proxy server. Follow the display on the touch screen to perform settings.
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System information

Select this setting item from System information on Setup.

Current version

Displays the current firmware version.

Printer name

Displays the printer name currently specified.

Serial number

Displays the printer serial number.

MAC address of wireless LAN
Displays the MAC address for wireless LAN.

MAC address of wired LAN
Displays the MAC address for wired LAN.
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ECO settings

Select this setting item from HOME screen.
This setting allows you to use following functions.

» Using automatic duplex printing to save paper
= Using Duplex Printing

» Turning on the printer automatically when printing or scanning from a device, or turning it off
automatically during the specified elapsed time to save electricity
= Turning On/Off Printer Automatically

» Turning on/off the printer automatically at the specified time and day
= Specifying Time and Day to Turn on/off Printer Automatically

»>» Note

* You cannot enable the functions below at the same time.

» Turning on/off the printer automatically
» Specifying the time and day to turn on/off the printer automatically

3% Important

» The administrator password is required to change settings if it is enabled for changing settings using
the operation panel.

Using Duplex Printing

Follow the procedure below to use duplex printing.

1. Make sure printer is turned on.

fEco
2. Flick HOME screen and tap . ECO settings.

= Using the Operation Panel

3. Tap Two-sided printing setting.

4. Specify settings as necessary.

Copy A

PDOF file print B

FAX print ' c
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A. Tap to select two-sided copying as a default.
B. Tap to select duplex printing PDF files saved on a USB flash drive as a default.
C. Tap to select two-sided printing of sent/received faxes, reports, or lists as a default.

D. Tap to specify the print settings.
»>» Note

» When duplex printing is selected, the ' icon is displayed on each menu of the HOME
screen or on the setting items for duplex printing on each print setting screen.

Turning On/Off Printer Automatically

Follow the procedure below to enable turning on/off the printer automatically.

1. Make sure printer is turned on.

[Eco
2. Flick HOME screen and tap . ECO settings.

= Using the Operation Panel

3. Tap Power control.

4. Tap Enable auto power control.

5. Check message and tap Next.

6. Specify settings as necessary.

Auto power off 240 min, A

Auto power on OFF B

A. Tap to specify the length of time to turn the printer off automatically when no operation is made
or no printing data is sent to the printer.

B. Tap to select the setting.

Selecting ON enables the printer to turn on automatically when a scanning command from a
computer or printing data is sent to the printer.

C. Tap to confirm the settings.
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Specifying Time and Day to Turn on/off Printer Automatically

Follow the procedure below to use power saving function.

1. Make sure printer is turned on.

P
fEco
2. Flick HOME screen and tap . ECO settings.

= Using the Operation Panel

3. Tap Power control.

4. Tap Enable scheduling.

5. Check message and tap Next.

6. Specify settings as necessary.

* When you specify the time and day to turn the printer on:

Scheduling

“ﬁkuto ON timer settings

Auto OFF timer settings

1. Tap Auto ON timer settings.
2. Tap ON on the displayed screen.

The screen below is displayed.

Time setting

Time to turn ON

3. Tap time.

The screen below is displayed.
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Time to

4. Tap numbers to specify time to turn on printer.
You can specify the hour from 0 to 24 and specify the minute in increments of 10 minutes.
5. Tap OK to confirm time to turn on printer.

After confirming the time to turn the printer on, the screen to specify the day is displayed.
Tap the day, tap Enable or Disable, and then tap OK. The setting is valid on the day(s) you
select Enable for.

* When you specify the time and day to turn the printer off:
Scheduling
Auto ON timer settings

Jl.ﬁ.utu OFF timer settings

1. Tap Auto OFF timer settings.
2. Tap ON on displayed screen.
3. Check message and tap OK.

The screen below is displayed.

Time setting

Time to turn OFF

20 : 00

4. Tap time.

The screen below is displayed.
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Time to

5. Tap numbers to specify time to turn off printer.
You can specify the hour from 0 to 24 and specify the minute in increments of 10 minutes.
6. Tap OK to confirm time to turn off printer.

After confirming the time to turn the printer off, the screen to specify the day is displayed.
Tap the day, tap Enable or Disable, and then tap OK. The setting is valid on the day(s) you
select Enable for.
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Quiet setting

Select this setting item from HOME screen.

Enables this function on the printer if you want to reduce the operating noise, such as when printing at night.
In addition, you can specify the time range to reduce the operating noise.

3% Important

» The administrator password is required to change settings if it is enabled for changing settings using
the operation panel.
+ Set the current date and time in advance.

= Setting Sender Information

Follow the procedure below to perform setting.

1. Make sure printer is turned on.

2. Flick HOME screen and tap Quiet setting.

= Using the Operation Panel

3. Tap Use quiet mode or Use during specified hours.

* When Use quiet mode is selected:

The confirmation screen is displayed and the icon appears as the Quiet setting menu icon.
* When Use during specified hours is selected:

The Quiet mode hours screen is displayed.

Quiet mode hours

Start time

E

A. Tap to display the screen below.
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Start t

1. Tap numbers to specify starting time.
You can specify the hour from 0 to 24.
2. Tap to confirm starting time.
After specifying the starting time, specify the ending time following the same procedure.
B. Tap to confirm the time to start and to end.

You can reduce the operating noise during the specified time.

3
The confirmation screen is displayed and the icon appears as the Quiet setting menu icon.
3% Important

» Operating speed is reduced compared to when Do not use quiet mode is selected.
+ This function may not be so effective depending on the printer's setting. Furthermore, certain
noise, such as when the printer is preparing for printing, is not reduced.

> Note

* You can set the quiet mode from the operation panel of the printer or the printer driver. No matter
how you set the quiet mode, the mode is applied when you perform operations from the operation
panel of the printer or printing and scanning from the computer.

» For Windows, you can set the quiet mode from ScanGear (scanner driver).
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Registering Favorite Settings (Custom profiles)

You can register the favorite copying, scanning, or faxing settings and call them up from the HOME screen.
You can register up to 20 settings.

= Registering the Setting
= Calling Up the Registered Setting
= Editing/Deleting the Registered setting

Registering the Setting

Tap Save profile on each standby screen or on the screen displayed after the settings are specified.

Copy standby screen Scan standby screen Fax transmission standby screen

TEL priority 20/07 14:40
1234567

B Add recipient

Doc.type Document

[i_-+ Save profi gl

.y
Settings ‘E‘-”__' Send FAX

' | Local (USE) | 4 Save profile |

*Settings

When the confirmation screen of Save profile is displayed, tap Yes.
When the screen to enter the name of the setting is displayed, enter the name and tap Register.

»>» Note

* If you tap Register without entering the name, the name currently shown is applied as the name of
the setting.

Calling Up the Registered Setting

Follow the procedure below to call up the registered setting.

1. Make sure printer is turned on.

2. Flick HOME screen and tap Custom profiles.

= Using the Operation Panel

3. Tap setting you want to call up.

> Note

* You can change the displayed items by tapping Switch view.

Editing/Deleting the Registered setting

Follow the procedure below to edit or delete the registered setting.
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1. Make sure printer is turned on.

2. Flick HOME screen and tap Custom profiles.

= Using the Operation Panel

3. Tap Edit/delete.

You can change the order or name of the registered settings and delete the settings.
 To change the order of the registered settings
1. Tap Rearrange.

2. Tap setting you want to move.

3. Tap or to move selected setting.
4. Tap Apply.
5. Tap Exit.

* To change the name of the registered settings
1. Tap Rename.
2. Tap setting you want to rename.
3. Enter new name and tap OK.

= Entering Numbers, Letters, and Symbols

4. Tap Exit.
» To delete the registered settings
1. Tap Delete.
2. Tap setting you want to delete.
3. Tap Yes on displayed screen.

4. Tap Exit.
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Checking the Total Number of Uses of Machine

You can check the total number of uses of the printer (e.g. the total number of printing, copying, sending/
receiving faxes, or scanning).

1. Make sure printer is turned on.

2. Flick HOME screen and tap m Records of use.

= Using the Operation Panel

The Records of use screen is displayed.

3. Tap item to check.

Total sheets used on the device
Displays the total number of printing.

No. of sheets used for copying
Displays the total number of copying.

No. of sheets used for FAX
Displays the total number of received or printed faxes.

Sheets used for other functions
Displays the total number of printing other than copying or faxing.

Number of FAX sheets sent
Displays the total number of sent faxes.

Number of sheets scanned
Displays the total number of scanning.

»» Note

» The record of the total number of uses is not reverted even if the printer is reverted back to the default
by Reset setting in Device settings.
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Changing Printer's Setting Using Web Browser

» Changing Settings Using Web Browser

¥

Changeable Setting Items Using Web Browser

¥

Setting Password

¥

Setting Mail Server

¥

Specifying Mail Setting for Sending Scanned Data

¥

Receiving Printer Status by E-mail
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Changing Settings Using Web Browser

You can check the printer status and change the printer settings using the web browser on your smartphone,
tablet, or computer.

To check the printer status and to change the printer settings, display "Remote UI" on the web browser.

»» Note

* Remote Ul is a software that enables you to perform operations, which are usually performed on the

printer's operation panel, using a Web browser over a network.
LAN connection with the printer is required to use Remote Ul.
* You can use Remote Ul on the following OS and the web browser.
+ iOS device
0S:i0S 7.0 or later
Web browser: iOS standard Web browser (Mobile Safari)
» Android device
OS: Android 4.0 or later
Web browser: Android standard Web browser (Browser or Chrome)
* Mac OS device
0OS: Mac OS X v.10.6 or later
Web browser: Safari 5.1 or later
» Windows device
OS: Windows Vista SP2 or later

Web browser: Internet Explorer 9 or later, Google Chrome 41.0.2272.118m or later, Mozilla Firefox
37.0.1 or later

1. Make sure printer is turned on.

2. Check printer's IP address.

Check the printer's IP address by following the steps below.

| A
1. Flick HOME screen and tap . Setup.

= Using the Operation Panel

The menu screen is displayed.

Tap Device settings.
Tap LAN settings.
Tap Confirm LAN settings.

o &~ w0 N

Check IPv4 address.
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3. Open web browser on your smartphone, tablet, or computer and enter IP address.
Enter as following in the URL field of the web browser.
http://XXX. XXX XXX
Enter the IP address in "XXX. XXX XXX".

When you access, "Remote UI" will be displayed on the web browser on your smartphone, tablet, or
computer.

4. If you display Remote Ul for the first time on your smartphone, tablet, or computer, select
For secure communication.

Download the root certificate, and then register it.

= Registering Printer's Root Certificate to WWeb Browser

»» Note

» Once you register the root certificate to the web browser on your smartphone, tablet, or computer,
this step is not necessary after the next time.

If Reset all was performed from the printer's operation panel, download the root certificate again,
and then register it.

« If the root certificate is not registered, a message to warn you that the secure connection is not
guaranteed may appear.

5. Select Log on.

The password authentication screen appears.

»» Note

* When the standard user mode is enabled, choose either administrator mode or standard user
mode to log on.

+ After choosing a mode and selecting Log on, the password authentication screen of each mode
appears.

6. Enter password.

When the password authentication is complete, the menus that can be utilized are displayed on the web
browser.

3% Important

» The password is set at the time of purchase. The password is the printer serial number. The
printer serial number is printed on the sticker attached on the printer. It consists of 9 alphanumeric
characters (four alphabets followed by five numbers).

For details on setting password, see Setting Password.

7. Check printer status and change printer settings.
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For changeable setting items, see below.

= Changeable Setting Items Using Web Browser

8. When you finish checking printer status and changing printer settings, select Log off.

9. Close web browser.
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Registering Printer's Root Certificate to Web Browser

If the printer's root certificate has not been registered to the web browser, a message to warn you that the
secure connection is not guaranteed may appear.

When you display Remote Ul for the first time on your smartphone, tablet, or computer, download the root
certificate, and then register it to the web browser. The secure connection will be confirmed and a message
will not appear.

How to register the root certificate varies depending on the web browser.

= For Internet Explorer

= For Safari

= For Chrome on Android
= For Mobile Safari on iOS

For other web browser, refer to each help.

22 Important

» Make sure that you have accessed to the printer IP address correctly by checking the URL field of the
web browser before registering the root certificate.

For Internet Explorer

1. Select Download on Remote UI.

Downloading the root certificate is started.

2. If confirmation screen appears, select Open.

Certificate screen is displayed.

> Note

» To save the certificate file to your device and register it, select Save. Select Internet options
from Tool menu of Internet Explorer, register the root certificate from Certificates on Content
sheet.

3. Select Install Certificate.

Certificate Import Wizard screen is displayed.

4. Select Next.

5. Select Place all certificates in the following store.

6. Select Browse.

Select Certificate Store screen is displayed.

7. Select Trusted Root Certification Authorities and OK.
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8. Select Next on Certificate Import Wizard screen.

9. If Completing the Certificate Import Wizard appears, select Finish.

Security Warning screen is displayed.

10. Make sure that thumbprint on Security Warning screen matches printer's thumbprint.

For printer's thumbprint, press the HOME button, select Setup -> Device settings -> LAN settings ->
Confirm LAN settings, check Root cert. thumbprint (SHA-1) or Root cert. thumbprint (SHA-256).

11. If thumbprint on Security Warning screen matches printer's thumbprint, select Yes.

12. Select Yes on Certificate Import Wizard screen.

The root certificate registration is completed.

For Safari

1. Select Download on Remote UI.

Downloading the root certificate is started.

2. Open the download file.

Add Certificates screen is displayed.
3. Select Add.

4. Make sure that thumbprint of certificate detail information matches printer's thumbprint.

For printer's thumbprint, press the HOME button, select Setup -> Device settings -> LAN settings ->
Confirm LAN settings, check Root cert. thumbprint (SHA-1) or Root cert. thumbprint (SHA-256).

5. If thumbprint of certificate detail information matches printer's thumbprint, select Always
Trust.

The root certificate registration is completed.

»» Note

« If a password is set on your device, entering a password may be required.

For Chrome on Android

1. Select Download on Remote UI.

Downloading the root certificate is started and then Downloading Certificate screen is displayed.
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2. Specify certificate name, and then select OK.

The root certificate registration is completed.

> Note

« If PIN or password is not set as security type, the attention screen may appear. Select OK, and
then set the security type to PIN or password.

« |If the message to warn you that the secure connection is not guaranteed appears when you
select Log on on Remote Ul after registering the root certificate, restart the web browser. The
message will not appear on the web browser.

After Root Certificate Registration
We recommend that you make sure that the correct root certificate has been registered.

Depending on the Android device, a warning may appear because the root certificate that contains the
authentication information was registered.

To make sure that the correct root certificate has been registered, make sure that thumbprint of
certificate information matches printer's thumbprint. Follow the steps below.

»» Note

+ Some Android devices cannot check the thumprint of a registered root certificate.

1. From Settings menu on your device, select Security, Trust credentials, and USER.
The list of downloaded certificates is displayed.

2. Select downloaded certificate.
The certificate information is displayed.

3. Make sure that thumbprint of certificate information matches printer's thumbprint.

For printer's thumbprint, press the HOME button, select Setup -> Device settings -> LAN
settings -> Confirm LAN settings, check Root cert. thumbprint (SHA-1) or Root cert.
thumbprint (SHA-256).

4. If thumbprint of certificate information matches printer's thumbprint, select OK.

Confirmation of the root certificate is completed.

For Mobile Safari on iOS

1. Select Download on Remote UlI.

Downloading the root certificate is started and then Install Profile screen is displayed.

2. Select Install.

Warning screen is displayed.

»» Note

« If a password is set on your device, entering a password may be required.
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3. Select Install.

4. Select Install on displayed dialog.

The root certificate registration is completed.
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Changeable Setting Items Using Web Browser

»» Note

» The items described here and the items displayed in the web browser may differ in display order.

* The item which can be used is different in administrator mode or in standard user mode.

Items for Security

Security (Item for administrator)
This function allows you to specify the password, the standard user mode settings, the operation
restrictions, and SSL/TLS settings of certificate for encrypted communication.
For details on setting password, see Setting Password.

Items for Maintenance/Management
Utilities

This function allows you to set and execute the printer utility functions such as cleaning.
System info and LAN settings

This function allows you to check the system information and to change the LAN settings.

Using IP filtering in Other settings in LAN settings, you can permit or refuse the connection of a
specific IP address for IPv4 address or IPv6 address.

Using SNMP settings in Other settings in LAN settings, you can specify the SNMP and MIB setting

to management the printer via a network.
22 Important

* If you has refused the IP address of administrator's device using IP filtering by mistake, reset
LAN settings of the printer.

For resetting LAN settings, see Reset setting.

»» Note

» Some of the menu is available only when you logged on in administrator mode.

Firmware update (Iltem for administrator)
This function allows you to update the firmware and check version information.

Language selection (Item for administrator)
This function allows you to change the language on the display.

Items for Printer

Device settings
This function allows you to change the printer settings such as the quiet setting, the energy saving
settings, and the print settings.

Additionally, this function allows you to change the mail settings and to receive the printer status
information such as the remaining ink level and the error.
= Setting Mail Server
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= Specifying Mail Setting for Sending Scanned Data
= Receiving Printer Status by E-mail

»» Note

» Some of the menu is available only when you logged on in administrator mode.

AirPrint settings
This function allows you to specify the AirPrint settings, such as position information.

Web service connection setup (Iltem for administrator)
This function allows you to register to Google Cloud Print or IJ Cloud Printing Center, or delete a
registration.

Other Items

Printer status
This function displays printer information such as the remaining ink amount, the status, and detailed
error information.
You can also connect to the ink purchase site or support page, and use Web Services.

Records of use
This function displays the total number of uses of the printer (e.g. the total number of printing,
copying, sending/receiving faxes, or scanning).

Manual (Online)
This function displays the Online Manual.
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Setting Password

Each of passwords for administrator and standard user can be set.

When logging on with password for administrator, all settings can be changed.

When logging on with password for standard user, some of the settings can be changed.

When logging on with password for administrator, you can restrict the function for standard user.

= Setting Administrator Password
= Setting Standard User Password

»» Note

» Password can be set only when you are logged in administrator mode.

Setting Administrator Password
Change the administrator password by following the steps below.

32 Important

» The password is set at the time of purchase. The password is the printer serial number. The printer
serial number is printed on the sticker attached on the printer. It consists of 9 alphanumeric
characters (four alphabets followed by five numbers).

1. Display printer status on web browser.

2. Select Security.

The menus are displayed.
3. Select Administrator password setting.

4. Select Change administrator password.

If the administrator password is not set, registration confirming message is displayed. Select Yes.
When message is displayed again, select OK.

5. Select a range where the administrator password is valid, and then select OK.

Remote Ul or other tools

Entering the administrator password is required to change the setting items using the Remote Ul
or some software.

Operation panel/Remote Ul/other tools

Entering the administrator password is required to change the setting items using the operation
panel of the printer, the Remote Ul, or some software.

6. Enter a password, and then select OK.
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32 Important

» The following character restrictions apply to the password:
+ Set the password by using 4 to 32 characters.
» The allowed characters are single-byte alphanumeric characters.

» For security reasons, we recommend you use 6 and more alphanumeric characters.

7. When the completion message is displayed, select OK.

Setting Standard User Password

For restricting the function for standard user, enable the standard user mode and set a standard user
password by following the steps below.

1. Display printer status on web browser.

2. Select Security.

The menus are displayed.

3. Select Standard user mode settings.
4. When the confirming message is displayed, select Yes.

5. Enter a password, and then select OK.

32 Important

» The following character restrictions apply to the password:
+ Set the password by using 4 to 32 characters.
» The allowed characters are single-byte alphanumeric characters.

» For security reasons, we recommend you use 6 and more alphanumeric characters.

6. When the completion message is displayed, select OK.
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Setting Mail Server

To use mail function, specify the mail server settings.

»» Note

+ If you did not specify the time zone setting using the printer's operation panel, a message to inform you
that the correct time may not be reflected on the sent e-mail appears. We recommended that you set
the time zone setting using the printer's operation panel.

For the time zone setting, see Device user settings.

» These functions can be set only when you are logged in administrator mode.

1. Display printer status on web browser.

2. Select Device settings.

The menus are displayed.

3. Select Set mail server / test connect.

4. Select Set mail server.

The setting items for mail server are displayed.

5. Specify mail server settings.

Specify the following items.

Sender address
Enter the e-mail address of the sender (this printer).

Outgoing mail server (SMTP)
Enter the address of your SMTP server.

Port number (SMTP)
Enter the port number of your SMTP server.

Secure connection (SSL)
Select if you use the secure connection (SSL).

Don't verify certificates
Select if you do not verify the certificate.

Authentication method
Select one of the following authentication methods.

SMTP authentication
Select if you send e-mail with SMTP authentication.
Next, you can specify the following settings.
» Outgoing account

Enter the account name for sending to perform the authentication.

» Outgoing password
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Enter the password for sending to perform the authentication.

POP before SMTP
Select if you send e-mail with POP before SMTP authentication.
Next, you can specify the following settings.

Incoming mail server (POP3)

Enter the address of your POP server.

Port number (POP3)

Enter the port number of your POP server.

Incoming account

Enter the account name for receiving to perform the authentication.
Incoming password

Enter the password for receiving to perform the authentication.
Use APOP authentication

Select if you send the password by the encryption transmission.
Clear mailbox

Select if you delete the e-mails that remain in the POP3 server.

32 Important

* When this setting is enabled, e-mail in the Inbox on the server will have all been removed. If
you specify the e-mail address of your everyday, be sure to disable this setting as unread e-
mail is not deleted. We recommended that you prepare this printer dedicated e-mail
account not to accidentally delete the unread e-mail.

No authentication
Select if the authentication is not necessary.

6. After specifying mail server settings, select OK.

The setting operation is completed.

»» Note

» To make sure that the mail server settings have been specified correctly, select Test connection
to mail server.
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Specifying Mail Setting for Sending Scanned Data

You can specify the mail settings to send the scanned data from printer via e-mail.

This section describes the mail settings such as the title of e-mail, initial body text, and file size.

»>» Note

» These functions can be set only when you are logged in administrator mode.

» To send the scanned data from printer via e-mail and to register the e-mail address of the destination,
see below.

= Sending Scanned Data as E-Mail from Machine

» Specify the mail server settings in advance.

= Setting Mail Server

1. Display printer status on web browser.

2. Select Device settings.

The menus are displayed.
3. Select Scan(Email direct from device).

4. Select E-mail transmission settings.

The setting items for mail setting are displayed.

5. Specify mail settings.
Specify the following items.

Subject
Enter the title of the e-mail up to 20 alphanumeric characters.

»» Note

+ The title that you specify here is the initial titte when sending scan data. You can change the
title when sending scan data using the printer's operation panel.

Body text
Enter the body text of the e-mail up to 80 alphanumeric characters.

Maximum attachment size
Select a maximum file size of the scan data that can be sent.

6. After specifying mail settings, select OK.

The setting operation is completed.
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Receiving Printer Status by E-mail

You receive the printer status information such as the remaining ink level and the error from the printer.

»» Note

» Specify the mail server settings in advance.

= Setting Mail Server

+ If you did not specify the the date and time setting using the printer's operation panel, the date and time
may not be reflected on the sent e-mail. We recommended that you set the date and time setting using
the printer's operation panel.

For the date and time setting, see Device user settings.

» These functions can be set only when you are logged in administrator mode.

Specify the information settings by following the steps below.

1. Display printer status on web browser.

2. Select Device settings.

The menus are displayed.
3. Select Status notification e-mail.

4. Select Notification recipients.

The screen to register the destination is displayed.

5. Specify destination settings.
Up to 5 destinations can be registered by following the steps below.
1. Select number of destination.
2. Select Register.
3. Enter e-mail address, and then select printer status to send information.
4. Select OK.

The registration for destination is completed.

6. Select Device settings -> Status notification e-mail -> Retry settings.

7. Specify resending settings.
The number of resending can be specified by following the steps below.
1. Specify number of resending.
2. Specify interval of resending.

3. Select OK.
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The resending setting is completed.
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Network Connection

» Network Connection Tips
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Network Connection Tips
» Default Network Settings
» Another Printer Found with Same Name

» Connecting to Another Computer via LAN/Changing from USB to LAN
Connection

» Printing Network Settings

» Changing LAN Connection Method/Changing Wireless LAN Connection Method
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Default Network Settings

LAN Connection Defaults

Item Default

Change LAN Disable LAN
SSID BJNPSETUP
Communication mode Infrastructure

Wireless LAN security | Disable

IP address (IPv4) Auto setup
IP address (IPv6) Auto setup
Set printer name* XXXXXXXXXXXX

Enable/disable IPv6 Enable

Enable/disable WSD Enable

Timeout setting 1 minute

Enable/disable Bonjour | Enable

Service name Canon MB2700 series

LPR protocol setting Enable

Wired LAN DRX setting | Enable

RAW protocol Enable

LLMNR Active

("XX" represents alphanumeric characters.)

* Default value depends on printer. To check value, use operation panel.

= | AN settings

Direct Connection Defaults

Item Default

SSID (Identifier for direct connection) | DIRECT-abXX-MB2700series *1

Password YYYYYYYYYY *2
Wireless LAN security WPA2-PSK (AES)
Direct connection device name 277777Z-MB2700series *3

Connection request confirmation | Displayed
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*1 "ab" is specified at random and "XX" represents last two digits of printer's MAC address. (The value is
specified when the printer is turned on for the first time.)

*2 The password is specified automatically when the printer is turned on for the first time.

*3"ZZZZZZ" represents last six digits of printer's MAC address.
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Another Printer Found with Same Name

When the printer is found during setup, other printers with the same name may appear on the results
screen.

Select a printer with checking the printer settings against those on detection result screen.
* For Windows:
Check the printer's MAC address or serial to select the correct printer from the results.
* For Mac OS:

The printer names appear with the MAC address added at the end or as the printer name specified by
Bonjour.

Check identifiers such as the MAC address, the printer name specified by Bonjour, and the printer's
serial number to select the printer from among those that appear.

»» Note

+ Serial number may not appear on result screen.

Check the printer's MAC address and the serial number by one of the following methods.
* Display on the touch screen.
MAC address
= | AN settings
Serial number

= System information

* Print the network settings.

= Printing Network Settings
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Connecting to Another Computer via LAN/Changing from USB to
LAN Connection

= For Windows:
= For Mac OS:

For Windows:

To add a computer to connect to the printer on a LAN or to change from USB to LAN connection, perform
setup using the Setup CD-ROM or follow the instructions on the Canon website.

For Mac OS:

To connect an additional computer to the printer via LAN, or to change from USB to LAN connection,
follow the instructions on the Canon website.
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Printing Network Settings

Use the operation panel to print the printer's current network settings.

32 Important

» The network settings printout contains important information about your network. Handle it with care.

1. Make sure printer is turned on.

2. Load three sheets of A4 or Letter-sized plain paper.

| A
3. Flick HOME screen and tap . Setup.

= Using the Operation Panel

The menu screen appears.

4. Tap Device settings.

5. Tap LAN settings.

If you specify the administrator password, enter the password.

6. Tap Confirm LAN settings.

7. Check message and tap OK.

8. Tap Print details.

9. Tap Yes.

The printer starts printing network settings information.

The printed network settings information is as follows:

Item Description Setting

Product Information Product information -

Product Name Product name XXXXXXXX

ROM Version ROM version XXXXXXXX

Serial Number Serial number XXXXXXXX
Wireless LAN Wireless LAN Enable/Disable

MAC Address MAC address XXXXXX XX XX XX
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Infrastructure Infrastructure Enable/Disable
Connection Connection status Active/lnactive

SSID SSID Wireless LAN SSID
Channel *1 Channel XX (1to 11)
Encryption Encryption method None/WEP/TKIP/AES

WEP Key Length

WEP key length (bits)

Inactive/128/64

Authentication

Authentication method

None/auto/open/shared/WPA-PSK/WPA2-PSK

Signal Strength

Signal strength

0 to 100 [%]

TCP/IPv4 TCP/IPv4 Enable

IP Address IP address XXX XXX XXX XXX

Subnet Mask Subnet mask XXX XXX XXX XXX

Default Gateway Default gateway XXX XXX XXX XXX

TCP/IPv6 TCP/IPv6 Enable/Disable

Link Local Address Link local address XXXXXXXXXXXXX XXX
XXXXXXXXKXXXXXXXX

Link Local Prefix Length Link local prefix length XXX

Manual Setting Manual setting Enable/Disable

IP Address *2 IP address XXXX XXX XXX XXXX
XXXXXXXXKXXXXXXXX

Subnet Prefix Length Subnet prefix length XXX

Stateless Address1 *2 Stateless address 1 XXX :XXXXX XXX XXXX
XXXX XXX XXX XXXX

Stateless Prefix Length1 *2 | Stateless prefix length 1 XXX

Stateless Address2 *2 Stateless address 2 XXX XXXXXXXXKXXXX
XXXXXXXXKXXXXKXXXX

Stateless Prefix Length2 *2 | Stateless prefix length 2 XXX

Stateless Address3 *2 Stateless address 3 XXXXXXXX XX XX XXXX
XXXXXXXXKXXXXKXXXX

Stateless Prefix Length3 *2 | Stateless prefix length 3 XXX

Stateless Address4 *2 Stateless address 4 XXXXXKXXXXXXXXXX
XXX XXX XXX XXXX
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Stateless Prefix Length4 *2 | Stateless prefix length 4 XXX

Default Gateway1 *2 Default gateway 1 XXX XXXXXXXXKXXXX
XXXX XXX XXX XXXX

Default Gateway2 *2 Default gateway 2 XXX XXX XXXXX XXX
XXX XXX XXX XXXX

Default Gateway3 *2 Default gateway 3 XXX X XXX XXXXKXXXX
XXXXXXXXKXXXXKXXXX

Default Gateway4 *2 Default gateway 4 XXXXXXXX XXX X XXXX
XXX XXX XXX XXXX

IPsec *3 IPsec setting Active

Security Protocol *3

Security method

ESP/ESP & AH/AH

Direct Connection

Direct connection

Enable/Disable

Connection Connection status Active/Inactive

SSID SSID Direct Connection SSID

Password Password Direct Connection password (10 alphanumeric
characters)

Channel Channel 3

Encryption Encryption method AES

Authentication Authentication method WPA2-PSK

TCP/IPv4 TCP/IPv4 Enable

IP Address IP address XXX XXX XXX XXX

Subnet Mask Subnet mask XXX XXX XXX XXX

Default Gateway Default gateway XXX XXX XXX XXX

TCP/IPv6 TCP/IPv6 Enable/Disable

Link Local Address Link local address XXXXXXXXK XXX XK XXXX
XXXXXXXXKXXXXXXXX

Subnet Prefix Length *2 Subnet prefix length XXX

IPsec *3 IPsec setting Active

Security Protocol *3 Security method -

Wired LAN Wired LAN Enable/Disable

MAC Address MAC address XXXX XX XX XX XX
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Connection

Wired LAN status

Active/lnactive

TCP/IPv4 TCP/IPv4 Enable

IP Address IP address XXX XXX XXX XXX

Subnet Mask Subnet mask XXX XXX XXX XXX

Default Gateway Default gateway XXX XXX XXX XXX

TCP/IPv6 TCP/IPv6 Enable/Disable

Link Local Address Link local address XXXXXXXXXXXXXXXX
XXXXXXXXKXXXXXXXX

Link Local Prefix Length Link local prefix length XXX

Manual Setting Manual setting Enable/Disable

IP Address *2 IP address XXXX XXX XXX XXXX
XXXXXXXXKXXXXXXXX

Subnet Prefix Length Subnet prefix length XXX

Stateless Address1 *2 Stateless address 1 XXX XXXXXXXXXXXX
XXXXXXXXXXXXKXXXX

Stateless Prefix Length1 *2 | Stateless prefix length 1 XXX

Stateless Address2 *2 Stateless address 2 XXX XXXXXXXXKXXXX
XXXXXXXXKXXXXKXXXX

Stateless Prefix Length2 *2 | Stateless prefix length 2 XXX

Stateless Address3 *2 Stateless address 3 XXXXXXXXXXXXXXXX
XXXXXXXXKXXXXXXXX

Stateless Prefix Length3 *2 | Stateless prefix length 3 XXX

Stateless Address4 *2 Stateless address 4 XXXXXKXX XXX X XXXX
XXX XXX XXX XXXX

Stateless Prefix Length4 *2 | Stateless prefix length 4 XXX

Default Gateway1 *2 Default gateway 1 XXX XXXXXXXXKXXXX
XXXX XXX XXX XXXX

Default Gateway2 *2 Default gateway 2 XXX XXX XXXXX XXX
XXX X XXX XXX XXXX

Default Gateway3 *2 Default gateway 3 XXX X XXX XXXXKXXXX
XXXXXXXXKXXXXKXXXX

Default Gateway4 *2 Default gateway 4 XXXXXXXX XXX X XXXX
XXX XXX XXX XXXX
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IPsec *3

IPsec setting

Active

Security Protocol *3

Security method

ESP/ESP & AH/AH

Wired LAN DRX

Discontinuous reception (wired
LAN)

Enable/Disable

Other Settings

Other settings

Printer Name

Printer name

Printer name (Up to 15 alphanumeric charac-
ters)

Direct Conn. DevName

Device name for direct connec-
tion (Up to 32 characters)

Device name for direct connection

WSD Printing WSD printing setting Enable/Disable
WSD Timeout Timeout 1/5/10/15/20 [min]
LPD Printing LPD printing setting Enable/Disable
RAW Printing RAW printing setting Enable/Disable
Bonjour Bonjour setting Enable/Disable

Bonjour Service Name

Bonjour service name

Bonjour service name (Up to 52 alphanumeric
characters)

LLMNR LLMNR setting Enable/Disable
SNMP SNMP setting Enable/Disable
DNS Server Obtain DNS server address auto- | Auto/Manual
matically
Primary Server Primary server address XXX XXX XXX XXX
Secondary Server Secondary server address XXX XXX XXX XXX
Proxy Server Proxy server setting Enable/Disable
Proxy Address Proxy address )9, 0.0.9.0.9.9.9.0.0.9.0.9.9.0.9.9.9 6.4
Proxy Port Proxy port specification 1 to 65535

Cert. Fingerprt(SHA-1)

Certificate fingerprint(SHA-1)

XXXXXXXX XXXXXXXX XXXXXXXX
XXXXXXXX XXXXXXXX

Cert. Fingerprt(SHA-256)

Certificate fingerprint(SHA-256)

XXXXXXXX XXXXXXXX XXXXXXXX
XXXXXXXX
XXXXXXXX XXXXXXXX XXXXXXXX
XXXXXXXX

("XX" represents alphanumeric characters.)

*1 Channel may range from 1 to 11 depending on country or region of purchase.
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*2 Network status is only printed when IPv6 is enabled.

*3 Network status is only printed when IPv6 and IPsec settings are enabled.
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Changing LAN Connection Method/Changing Wireless LAN
Connection Method

= Changing LAN Connection Method
= Changing Wireless LAN Connection Method

Changing LAN Connection Method

Follow either procedure below to change LAN connection method (wired or wireless).

¢ For Windows:

o Use the Setup CD-ROM or follow the instructions on the Canon website to redo setup.
o Tap the icon on the lower left on HOME screen, select Change LAN, and then select Activate
wireless LAN or Activate wired LAN.

After that, perform settings on the Protocol Settings screen on IJ Network Device Setup Utility.

For details, refer to Performing/Changing Wireless LAN Settings or Performing/Changing Wired
LAN Settings.

¢ For Mac OS:

o Follow the instructions on the Canon website to redo setup.
o Tap the icon on the lower left on HOME screen, select Change LAN, and then select Activate
wireless LAN or Activate wired LAN.

After that, perform settings on the Wireless LAN or Wired LAN sheet on IJ Network Tool.

For details, refer to Changing Settings in Wireless LAN Sheet or Changing Settings in Wired LAN
Sheet.

Changing Wireless LAN Connection Method
Follow either procedure below to change wireless LAN connection method (infrastructure or direct
connection).

* For Windows:

o Use the Setup CD-ROM or follow the instructions on the Canon website to redo setup.
o Perform settings on the Protocol Settings screen on IJ Network Device Setup Utility.

22 Important

» Before you perform settings using |J Network Device Setup Utility, turn on cableless setup
mode on the printer following the procedure below.

1. Make sure printer is turned on.

()
2. Flick HOME screen and tap ] LAN settings.

= Using the Operation Panel

If you specify the administrator password, enter the password.

3. Tap Wireless LAN setup.
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4. Tap Cableless setup.
5. Check message and tap OK.
Follow instructions on your smartphone or tablet.

6. If message saying setup is completed appears, tap OK.

¢ For Mac OS:

Follow the instructions on the Canon website to redo setup.
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Network Settings (IJ Network Device Setup Utility) (Windows)

» |J Network Device Setup Utility

¥

Starting Up IJ Network Device Setup Utility

¥

IJ Network Device Setup Utility Screen

¥

Performing Network Settings

¥

Checking Network Status

¥

IJ Network Device Setup Utility Menus

¥

Other Network Information
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IJ Network Device Setup Utility

IJ Network Device Setup Utility allows a network/printer administrator to manage printers on network. When
you perform printer setup, the utility is installed at the same time.

Use IJ Network Device Setup Utility for:

» Searching printers on network and performing initial network setup for detected printers

» Performing initial network setup by connecting the printer and computer using a USB cable (Not
available for some models)

» Changing printer network settings

» Checking status between computer on which IJ Network Device Setup Utility is installed and printer if
anything is wrong with connection

3% Important

» Depending on the printer you are using, an administrator password is already specified for the printer at
the time of purchase. When you change the network settings, authentication by the administrator
password is required.

For details:

= Administrator Password

For improving security, we recommend to change the administrator password.

= Changing Administrator Password

 To use the printer over LAN, make sure you have the equipment necessary for the connection type,
such as a wireless router or a LAN cable.

» When you perform setup or install IJ Network Device Setup Utility, disable block function of firewall.

» Do not change network settings using |J Network Device Setup Utility while printing is in progress.

366



Starting Up IJ Network Device Setup Utility

Start up IJ Network Device Setup Utility as shown below.

* In Windows 10, click the Start button, select All apps, Canon Utilities, and then IJ Network Device
Setup Utility. If IJ Network Device Setup Utility is not displayed, search for "IJ Network Device Setup
Utility" on Search the web and Windows.

* In Windows 8.1 or Windows 8, select IJ Network Device Setup Utility on the Start screen to start IJ
Network Device Setup Utility. If IJ Network Device Setup Utility is not displayed on the Start screen,
select the Search charm and search for "IJ Network Device Setup Utility".

* In Windows 7 or Windows Vista, click Start and select All Programs, Canon Utilities, IJ Network
Device Setup Utility, and then IJ Network Device Setup Ultility.

When you start up IJ Network Device Setup Ultility, it searches for printers on network and detected printers
are listed.
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IJ Network Device Setup Utility Screen

= |tems on |J Network Device Setup Utility Screen
= Menus on |J Network Device Setup Utility Screen
= |tems on |J Network Device Setup Utility Screen Toolbar

Items on IJ Network Device Setup Utility Screen

The screen below appears when you start up IJ Network Device Setup Utility. Detected printers are listed
on the screen and the items below are shown.
1 2 3 4 5 B 7 8 2 10

=]

Prntsi | View Opton talg

o ¥ | e

' Prodect Mame I

Sarial Plumser (Last § Digity

e | e

1. Product Name

Displays the product name of detected printer. The icon below appears on the left if the printer cannot
be used.

'l:i: Appears when the printer has not been connected or configured.

I? : Appears when the IP address is duplicated to another printer.

: Appears when you cannot communicate with the printer.

»» Note

+ If a printer you want to use is not detected, try to set the criteria for printer search.

= Setting Criteria for Printer Search/Searching Specific Printer

2. Serial Number (Last 5 Digits)

Displays the last five digits of printer's serial number.

3. Status

Displays the printer status as shown below.

Available
Indicates the printer is available.
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Setup Completed
Appears after performing network setup and clicking Set to close the window.

Not Connected
Indicates the printer is required to perform wireless LAN setup.

= Performing/Changing Wireless LAN Settings

Not Set
Indicates the printer cannot be used on network. Specify an IP address or enable IPv6.

IP Address Overlap
Indicates the IP address is duplicated to another printer.

Unknown
Indicates the printer used in the past cannot be used currently.

»» Note

 If USB is selected from the pulldown menu on the toolbar, nothing is displayed.

. IP Address

Displays the printer IP address.

»» Note

« If USB is selected from the pulldown menu on the toolbar, "-" is displayed for the interface
(wireless/wired LAN) disabled on the printer setting.

. Location

Displays the printer location if it is registered.

»» Note

+ If USB is selected from the pulldown menu on the toolbar, nothing is displayed.

= Assigning Printer Information

. Connection Method

Displays printer connection method (wired or wireless LAN).

»» Note

 If USB is selected from the pulldown menu on the toolbar, either of the LAN connection method

(wired or wireless) available for the printer is displayed.

If the printer supports both of the LAN connection methods, the printer is recognized as two

printers and they are displayed separately.

If the printer does not support wired LAN, wired LAN is not displayed.

* If you are using IJ Network Device Setup Utility on the computer which does not support
wireless LAN, wireless LAN is not displayed.

« If you are using the printer with direct connection, neither wired LAN nor wireless LAN is

displayed.
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7.

10.

Setting Method
Displays printer setting method.
* Auto
Appears if the printer is used by IP address specified automatically.
* Manual

Appears if the printer is used by IP address specified manually.

»» Note

« If USB is selected from the pulldown menu on the toolbar, "-" is displayed for the interface
(wireless/wired LAN) disabled on the printer setting.

. MAC Address

Displays the MAC address of the detected printer.
3> Note

* [f USB is selected from the pulldown menu on the toolbar,
(wireless/wired LAN) disabled on the printer setting.

is displayed for the interface

Device Name

Displays the printer device name if it is registered.

»» Note

 If USB is selected from the pulldown menu on the toolbar, nothing is displayed.

= Assigning Printer Information

IPv6
On appears when an IPv6 address is assigned for the printer.

»» Note

« If USB is selected from the pulldown menu on the toolbar, "-" is displayed.

Menus on IJ Network Device Setup Utility Screen

This section describes menus on |J Network Device Setup Utility screen.

1 2 3 4

o+,

(pine) i) optin) (]

) & IPv4 Al
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1. Printer menu

= Printer Menu

2. View menu

= View Menu

3. Option menu

= Option Menu

4. Help menu

= Help Menu

Items on IJ Network Device Setup Utility Screen Toolbar

This section describes items on IJ Network Device Setup Utility Screen toolbar.

e

| Printer  View Option Help

o= g

4 6

1. Perform wired or wireless LAN setup.

»» Note

» This item has the same function as Protocol Settings... in the Printer menu.

2. Redetects printers.

> Note

» This item has the same function as Update in the View menu.

3. Stops detecting printers.
3> Note

» This item has the same function as Cancel in the View menu.

4. Switches the printer list. (IPv4, IPv6, or USB printers)
> Note

+ This item has the same function as Switch IPv4/IPv6/USB in the View menu.
* You can also display the USB connected printer list. (Not available for some models.) In this
case, select USB.
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5. Displays this guide.
2> Note

» This item has the same function as Online Manual in the Help menu.
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Performing Network Settings

>

>

Performing/Changing Wired LAN Settings
Performing/Changing Wireless LAN Settings

Assigning Printer Information

Initializing Network Settings

Changing Administrator Password

Setting Criteria for Printer Search/Searching Specific Printer
If WEP Details Screen Appears

If WPA/WPA2 Details Screen Appears
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Performing/Changing Wired LAN Settings

Follow the procedure below to perform/change wired LAN settings.

»» Note

» For some models, you can perform network setup for a USB connected printer using IJ Network Device
Setup Utility. Select USB on Switch IPv4/IPv6/USB under the View menu to display printers for which
you can perform setup.

1. Start up IJ Network Device Setup Utility.

Detected printers are listed.

2. Select printer to perform/change settings from printer list.

Select the printer with Wired LAN displayed on Connection Method and the setting other than
Unknown or Setup Completed displayed on Status to perform settings.

To perform setup for a USB connected printer, select USB from the pulldown menu on the toolbar and
select the printer with Wired LAN displayed on Connection Method.

3. Select Protocol Settings... on Printer menu.

The Confirm Printer Password screen appears.

For more on the password, refer to Administrator Password.

> Note

* Clicking the icon allows you to perform/change settings.

4. Enter password and click OK.

The Protocol Settings screen appears.

5. Perform/change settings.

You can switch the screen between IPv4 and IPv6. Click the tab to switch the protocol.

+ IPv4 settings
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Uise raxt P adidress

1. Use IPv4 address
Always selected. (displayed in a gray out state)
2. Get IP address automatically

Select this option to use an IP address automatically assigned by a DHCP server. DHCP
server functionality must be enabled on your router.

3. Use next IP address

Select this option if no DHCP server functionality is available in your setup where you use the
printer, or you want to use a fixed IP address.

Enter the IP address, subnet mask, and default gateway.

* |IPv6 settings
22> Note

+ If USB is selected from the pulldown menu on the toolbar, you cannot perform IPv6 settings.

1
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1. Use IPv6 address
Select when you use the printer with IPv6 environment.
2. Use Stateless Address:

Select when you use an IP address assigned automatically. Use a router compatible with IPv6.

> Note

» This setting item is not available depending on the printer you are using.

3. Use Manual Address:

Select this option if no DHCP server functionality is available in your setup where you use the
printer, or you want to use a fixed IP address.

Enter the IP address and IP address prefix length.
2> Note

» This setting item is not available depending on the printer you are using.

4. Use DHCPV6:

Select when you obtain an IP address using DHCPV6.

»» Note

+ This setting item is not available depending on the printer you are using.

6. Click Set.
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Performing/Changing Wireless LAN Settings

Follow the procedure below to perform/change wireless LAN settings.

32 Important

» Enable cableless setup before performing printer setup. (Not required if you change the IP address.)
For details, search for "NR049" on your printer's online manual and see the page shown.

»» Note

» For some models, you can perform network setup for a USB connected printer using IJ Network Device
Setup Utility. Select USB on Switch IPv4/IPv6/USB under the View menu to display printers.

1. Start up IJ Network Device Setup Utility.

Detected printers are listed.

2. Select printer to perform/change settings from printer list.

Select the printer with Wireless LAN displayed on Connection Method and the setting other than
Unknown or Setup Completed displayed on Status to perform settings.

To perform setup for a USB connected printer, select USB from the pulldown menu on the toolbar and
select the printer with Wireless LAN displayed on Connection Method.

3. Select Protocol Settings... on Printer menu.

The Confirm Printer Password screen appears.

For more on the password, refer to Administrator Password.

> Note

* Clicking the icon allows you to perform/change settings.

4. Enter password and click OK.

The Protocol Settings screen appears.

5. Perform/change settings.

You can switch the screen between IPv4 and IPv6. Click the tab to switch the protocol.

* IPv4/IPv6 settings
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1. Network Type:
Select the wireless LAN mode.

Infrastructure
Connects the printer to the wireless LAN with a wireless router.

Direct
Connects the printer to wireless communication devices without a wireless router.

> Note

+ If Direct is selected, the Search... button is displayed in a gray out status.

In addition, you cannot connect to Internet from your computer depending on your
operating environment.

2. SSID:
The network identifier (SSID) of the wireless LAN currently used is displayed.
The identifier for direct connection (SSID) appears while in direct connection.
3. Search...

The Detected Wireless Routers screen is displayed to select a wireless router to connect to.
For a wireless router already connected to the computer, Available is displayed on
Communication Status.

If you select a wireless router with Not Connected on Communication Status from the list,
clicking Set displays the WPA/WPA2 or WEP setting screen for a wireless router.

= |f WEP Details Screen Appears
= |[f WPA/WPA2 Details Screen Appears

4. Encryption Method:
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Displays the encryption method used over the wireless LAN.

* |Pv4 settings
2> Note

» The setting items below are available only when Infrastructure is selected for Network
Type:.

If Direct is selected, the setting items below are displayed in a gray out status.

| Protocal Settings (Wirstess LAN) “
Hiatwaork Type

¥ Infrastruchre
DT
S5 - iy Semch...
Ersryption Mathod

P | v
[i et P address la.'..'--a:-'.'.-‘-] 2

Lise next [P acddress ]
3

Set Cangel Hel

1. Use IPv4 address
Always selected. (displayed in a gray out state)
2. Get IP address automatically

Select this option to use an IP address automatically assigned by a DHCP server. DHCP
server functionality must be enabled on your router.

3. Use next IP address

Select this option if no DHCP server functionality is available in your setup where you use the
printer, or you want to use a fixed IP address.

Enter the IP address, subnet mask, and default gateway.

* |IPv6 settings
2> Note

« If USB is selected from the pulldown menu on the toolbar, you cannot perform IPv6 settings.
+ The setting items below are available only when Infrastructure is selected for Network

Type:.

If Direct is selected, the setting items below are displayed in a gray out status.
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1. Use IPv6 address
Select when you use the printer with IPv6 environment.
2. Use Stateless Address:
Select when you use an IP address assigned automatically. Use a router compatible with IPv6.

»» Note

+ This setting item is not available depending on the printer you are using.

3. Use Manual Address:

Select this option if no DHCP server functionality is available in your setup where you use the
printer, or you want to use a fixed IP address.

Enter the IP address and IP address prefix length.
2> Note

» This setting item is not available depending on the printer you are using.

4. Use DHCPV6:

Select when you obtain an IP address using DHCPVG.

»» Note

 This setting item is not available depending on the printer you are using.

6. Click Set.
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Assigning Printer Information

Follow the procedure below to assign/change printer location name or device name.

The names appear on Device Name: and Location: on the IJ Network Device Setup Utility screen.

»>» Note

+ If USB is selected from the pulldown menu on the toolbar, this setting item is not available.

1. Start up IJ Network Device Setup Utility.

Detected printers are listed.

2. Select printer to assign location name and device name.

Select the printer with Available displayed on Status.

3. Select Detailed Printer Settings... on Printer menu.

The Confirm Printer Password screen appears.

For more on the password, refer to Administrator Password.

4. Enter password and click OK.

The Detailed Printer Settings screen appears.

5. Perform/change settings.

Cretasied Printer Seftings
; [Lll.-.'i Parra; . J— 'I
Ll-:-:.:r.l:l" J_ 2

St Cance

The setting items below are available.
1. Device Name:
Assigns the device name.
2. Location:

Assigns the location name.

6. Click Set.
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Initializing Network Settings

Follow the procedure below to initializing printer network settings.

1. Start up IJ Network Device Setup Utility.

Detected printers are listed.

2. Select printer to initialize settings.

Select the printer with Available displayed on Status.

3. Select Reset LAN settings on Printer menu.

The Confirm Printer Password screen appears.

For more on the password, refer to Administrator Password.

4. Enter password and click OK.

5. Click Yes on the displayed screen.

6. Click OK on the displayed screen.

The printer network settings are initialized.
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Changing Administrator Password

Follow the procedure below to change the administrator password.

1. Start up IJ Network Device Setup Utility.

Detected printers are listed.

2. Select printer to change password.

Select the printer with Available displayed on Status.

3. Select Change Password... on Printer menu.

The Change Printer Password screen appears.

For more on the password, refer to Administrator Password.

074 Cancal

4. Enter current password and new password.
5. Enter new password in Confirm: again.

6. Click OK.

The administrator password is updated.
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Setting Criteria for Printer Search/Searching Specific Printer
You can set the criteria for printer search when you start up IJ Network Device Setup Ultility or update the
printer search, or you can search the specific printer.

Changing these settings may detect the printer you want to use if it is not detected

»» Note

« If the printer you want to use is not detected, it may be detected by entering IP address, subnet mask,
or default gateway on the operation panel and search again.

= Setting Criteria for Printer Search
= Searching Specific Printer

Setting Criteria for Printer Search

1. Start up I|J Network Device Setup Utility.

2. Select Search Settings... on Option menu.

The Search Settings screen appears.

3. Enter criteria for printer search.

Bl Soarch Tima: io = s, (5-30) -1 1
Toas waluw speclies the search processing tma _]
Trra put 2 . &, (18]
| Thus i§ T Timw-out vaiss Tor not receing & responss from the ponter afoer € has 2
framn deteced
[ Cancal ieaig

1. Search Time:
Specifies the time to search printers.
2. Time out:

Specifies the timeout length for not receiving a response from printer.

> Note

* Printers you want to find are more likely to be detected as the values are larger, however, it may
take a while to search them.

4. Click Set.

Searching Specific Printer

1. Start up |J Network Device Setup Utility.
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2. Select Specified Searching... on Option menu.

The Specified Searching screen appears.

3. Select item to specify and enter value.

Selact the search method, and then cick [Search].
The results wil be displayed in the kst

®Py4 Address

—
T
() IPv6 Address

[ Host Name I
b |

1. IPv4 Address

Specifies the IPv4 address of the printer you want to search.
2. IPv6 Address

Specifies the IPv6 address of the printer you want to search.
3. Host Name

Specifies the host name of the printer you want to search.

4. Click Search.

IJ Network Device Setup Utility starts searching by the specified criteria and detected printers are
listed.
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If WEP Details Screen Appears

Enter the password (passphrase) according to wireless router's encryption method if you change a wireless

router to connect to the printer.

1. Enter items below when WEP Details screen appears.

. WEP Details [ x |
[ WEP Key —1
Eey Length L v 2
Eey Format = ] W 3
(key D <=4
Sl Cancel
1. WEP Key:

Enter the same key as the one set to the wireless router.

The number of characters and character type that can be entered differ depending on the
combination of the key length and key format.

Key Length:
64bit 128bit
Key Format: | ASCII 5 characters | 13 characters
Hexadecimal (Hex) | 10 digits 26 digits
2. Key Length:

Select either 64bit or 128bit.
. Key Format:

Select either ASCII or Hex.
. Key ID:

Select the Key ID (index) set to the wireless router.

2. Click Set.
2» Important

« |If the printer cannot communicate with the computer after the encryption type of the printer was
switched, make sure encryption types for the computer and the wireless router match that set to
the printer.
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If WPA/WPA2 Details Screen Appears

Enter the password (passphrase) according to wireless router's encryption method if you change a wireless
router to connect to the printer.

1. Enter passphrase when WPA/WPA2 Details screen appears.

Enter the passphrase set to the wireless router. The passphrase should be a string of 8 to 63
alphanumeric characters or a 64-digit hexadecimal value.

If you do not know the wireless router passphrase, refer to the instruction manual provided with the
wireless router or contact its manufacturer.

. WPA/WPA2 Details [ x |
[ Passphrase ]
Set Ciance|
2. Click Set.
3% Important

« If the printer cannot communicate with the computer after the encryption type of the printer was
switched, make sure encryption types for the computer and the wireless router match that set to
the printer.
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Checking Network Status
» Checking Wireless Network Status
» Displaying Computer Network Information
» Displaying Printer Network Information
» Checking Connection Status between Printer and Wireless Router

» Checking Network Setting Difference
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Checking Wireless Network Status

Follow the procedure below to check the wireless network status (signal strength) between the printer and
computer.

If anything is wrong with the wireless LAN connection, check the network status from this menu.

1. Start up IJ Network Device Setup Utility.

The detected printers are listed.

2. Select printer to check wireless network status from printer list.

Select the printer with Available displayed on Status.

3. Select Check Wireless Communication Status on Printer menu.

The Confirm Printer Password screen appears.

For more on the password, refer to Administrator Password.

4. Enter password and click OK.

« If the printer is connected to the computer with a wireless router:

The screen below appears.

Cormmunication status betwean printer and wineless router
Sqgnal Strength: 100%

I | vocace |

Communication status between computer and wreless router
Signal Strength: 100%

« If the printer is connected to the computer using direct connection:

The screen below appears.

Communication status between computer and printer

Clicking Update measures the signal strength again.

5. Click OK to close screen.
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Displaying Computer Network Information

Follow the procedure below to display the network information of the computer which the printer selected in
the IJ Network Device Setup Utility screen connects to and on which IJ Network Device Setup Utility is
installed.

1. Start up IJ Network Device Setup Utility.

2. Select Computer Network Information on View menu.
The screen below appears.
[ Compures Herwors nforsanon L=

Fastuyrek, B wton

I Tl L . .,
[LE Sl Pob Ackivess . . .
[t es Peb Aodiat.

Capsy Infg

Clicking Copy Info copies all network information on the clipboard.

3. Click OK to close screen.
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Displaying Printer Network Information

Follow the procedure below to display the printer network information.

1. Start up IJ Network Device Setup Utility.

The detected printers are listed.

2. Select printer to display network information from printer list.

Select the printer with Available displayed on Status.

3. Select Printer Network Information on View menu.

The Confirm Printer Password screen appears.

For more on the password, refer to Administrator Password.

4. Enter password and click OK.

The screen below appears.
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Clicking Copy Info copies all network information on the clipboard.

5. Click OK to close screen.
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Checking Connection Status between Printer and Wireless Router

Follow the procedure below to check the wireless router information detected by the printer.

Detects wireless routers around the printer and the detected ones are listed. Use this menu to make sure
whether the printer is located properly.

1. Start up IJ Network Device Setup Utility.

The detected printers are listed.

2. Select printer to check connection status between printer and wireless router from printer
list.

Select the printer with Available displayed on Status and Wireless LAN displayed on Connection
Method.

3. Select Status of Printer and Wireless Router Connection on View menu.

The Confirm Printer Password screen appears.

For more on the password, refer to Administrator Password.

4. Enter password and click OK.

The screen below appears.

Wiretess Router Information Detected by Printer Ex
S5ID Chanmel Comumunicatio. .. Sl;l'lal SETE"I;!!'I
n i
Update Ok

Clicking Update searches wireless routers again.

5. Click OK to close screen.
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Checking Network Setting Difference

If you cannot use a printer you used on the network before, compare the current network status with that
when you could use the printer and check the difference.

1. Start up IJ Network Device Setup Utility.

The detected printers are listed.
2. Select printer with Unknown or Not Set displayed on Status from printer list.

3. Select Check Connection Status on View menu.

The screen below appears.
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If the network status when you used the printer is different from the current status, Mismatch appears on
Status and the items are displayed in red. Check the red items.

4. Click OK to close screen.
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IJ Network Device Setup Utility Menus
» Printer Menu
» View Menu
» Option Menu

» Help Menu
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Printer Menu

This section describes the items displayed on the Printer menu.

‘

iﬂ'intl:r View Option Help

I Protocol Settings... :'

[Detailed Printer Settinus...}
[Reset LAN settings }

[Change Password...}

[ Check Wirgless Communication 5iatus jr——
[5et up device by using web brﬂfw:r;r_}—i—
f Esit } T

« O OO AN

1. Protocol Settings...

Performs wired or wireless LAN settings.

= Performing/Changing Wired LAN Settings
= Performing/Changing Wireless LAN Settings

2. Detailed Printer Settings...

Assigns the printer device name and location name.

= Assigning Printer Information

3. Reset LAN settings

Initializes the printer LAN settings.

= |nitializing Network Settings

4. Change Password...

Changes the password specified for the printer.

= Changing Administrator Password

5. Check Wireless Communication Status

Check wireless LAN communication status.

= Checking Wireless Network Status

6. Set up device by using web browser

Check the printer information or perform settings in detail on the web page.

»» Note

* You can use this function on the following the OS and the web browser.

OS: Windows Vista SP2 or later
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Web browser: Internet Explorer 9 or later, Google Chrome 41.0.2272.118m or later, Mozilla Firefox
37.0.1 or later

7. Exit

Finishes IJ Network Device Setup Utility.
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View Menu

This section describes the items displayed on the View menu.

L]

F'rl-nb;__ View | Opbon  Help
S [Cclmpu‘t:r Mebeork InFnrma‘tic-n-'}
Product [Frinter Metwork Information )
[Status of Printer and Wireless Router Cl:lnnl:-:‘tic'n]__

E"."-'.Z:' —Cnnecihon ':-t-‘.'ﬁ-:}

[Switch IPvAIPvE/USE }

Delete from List }

oo bBWWMN =

1. Computer Network Information

Check the computer network information.

= Displaying Computer Network Information

2. Printer Network Information

Check the printer network information.

= Displaying Printer Network Information

3. Status of Printer and Wireless Router Connection

Searches wireless routers and check the wireless router information (wireless channel, communication
status, and signal strength) detected by the printer.

= Checking Connection Status between Printer and Wireless Router

4. Check Connection Status

If you cannot use a printer you used on the network before, compare the current network status with that
when you can use the printer and check the difference.

= Checking Network Setting Difference

5. Switch IPv4/IPv6/USB

Switches the printer list between IPv4 printers and IPv6 printers. For some models, you can list USB
connected printers.

6. Delete from List

Deletes the selected printer from the printer list.

7. Cancel

Cancels printer search.
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»» Note

* You can also cancel printer search by clicking the % icon.

8. Update
Searches printers again.

»» Note

* You can also search printers again by clicking the € icon.
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Option Menu

This section describes the items displayed on the Option menu.

Printer View | Option  Help

@ e x| (edseting)—1
Product Mame | Specified Searching.. - 2

1. Search Settings...

Specifies criteria for printer search.

= Setting Criteria for Printer Search

2. Specified Searching...
Searches the printer by an IP address or host name.

= Searching Specific Printer
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Help Menu

This section describes the items displayed on the Help menu.

Printer  View Option | Help

@& R e Online Manual ]
Product Namie Serial Caution when Connecting — 2
n Changing Wired/Wireless LAN Connections — 3
F.

1. Online Manual

Displays this guide.

2. Caution when Connecting to Wireless LAN

Displays the caution message for wireless LAN connection.

3. Changing Wired/Wireless LAN Connections

Displays the message on changing LAN connection method (wired or wireless) for the selected printer.

4. About

Displays IJ Network Device Setup Utility version information.
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Other Network Information
» Technical Terms
» Restrictions

» Firewall
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Technical Terms

In this section, technical terms used in the manual are explained.

AR IR SE 2 JE Bk JE SE JE 2E 2 2R SR 3 2R AR
SlcH®DIOOEREC-X"—"ITMOIO W >

>

Access point mode

The printer is used as an access point to connect external wireless communication devices (e.qg.
computers, smartphones, or tablets) in an environment where no access point (wireless router) is
available. You can connect up to 5 devices to the printer using the access point mode (direct
connection).

Ad-hoc

Client computer and printer setting where wireless communication occurs on a peer-to-peer basis,
i.e., all clients in with the same SSID/network name communicate directly with each other. No wireless
router is required. This printer does not support ad-hoc communication.

Admin Password

Administrator password in IJ Network Device Setup Utility to restrict access to network users. It must
be entered to access the printer and change printer settings.

AES

An encryption method. It is optional for WPA. Strong cryptographic algorithm adopted within U.S.
government organizations for information processing.

Authentication Method

The method that a wireless router uses to authenticate a printer through a wireless LAN. The methods
are agreeable each other.

For WPA/WPAZ2, authentication method is PSK.
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Bonjour

A service built into Mac OS X operating system to detect the connectable devices on a network
automatically.

Cableless setup

Specifies a wireless router settings using a device (e.g. smartphone) directly without using a wireless
router.

Channel

Frequency channel for wireless communication. In the infrastructure mode, the channel is
automatically adjusted to match that set to the wireless router. This printer supports channels 1 to 13.
(Channels 12 and 13 are not supported depending on the country or region of purchase.) Note that
the number of channels that can be used for your wireless LAN varies depending on the region or
country.

Default Gateway

A relay device to connect to another network such as a router or a computer.

Default router address

A default IP address set for a router.

DHCP server functionality

The router assigns an IP address automatically whenever the printer or the personal computer on a
network starts up.

DHCPv6

A protocol to assign necessary information automatically when a computer connects to network.
DHCPv6 can be used when IPv6 is enabled.

Direct connection (Access point mode)

The printer is used as an access point to connect external wireless communication devices (e.g.
computers, smartphones, or tablets) in an environment where no wireless router is available. You can
connect up to 5 devices to the printer using the direct connection (access point mode).

DNS server

A server that converts device names into IP addresses. When specifying IP addresses manually,
specify the addresses of both a primary and a secondary server.
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Firewall

It is a system that prevents an unlawful computer access in the network. To prevent, you can use the
firewall function of a broadband router, the security software installed in the computer, or operation
system for computer.

Host name

A name for a computer or printer on network so that it can be recognized easily. Single-byte
alphanumeric characters are used generally.

IEEE802.11b

International standard for wireless LAN using the 2.4 GHz frequency range with a throughput of up to
11 Mbps.

IEEE802.11g

International standard for wireless LAN using the 2.4 GHz frequency range with a throughput of up to
54 Mbps. Compatible with 802.11b.

IEEE802.11n

International standard for wireless LAN using the 2.4 GHz and 5 GHz frequency ranges. Even when
using two or more antennas simultaneously or obtaining a bigger transfer rate than before by using
multiple communication channels at the same time, the transmission speed may be influenced by the
connected apparatus.

At the maximum transfer rate of 600 Mbps, it is possible to communicate with multiple computer
terminals within a dozen or so metre radius.

Compatible with 802.11b and 802.11g.

Infrastructure

One of the wireless communication methods. Wireless communication devices (e.g. computer or
printer) are connected to the network via a wireless router.

IP Address

A unique number with four parts separated by dots. Every network device that is connected to the
Internet has an IP address. Example: 192.168.0.1

An IP address is usually assigned by a wireless router or a DHCP server of the router automatically.

IPv4/IPv6

They are internetwork-layer protocol used on the internet. IPv4 uses 32-bit addresses and IPv6 uses
128-bit addresses.
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* Key Format

Select either ASCII or Hex as the WEP key format. The character that can be used for the WEP key
differs depending on the selected key formats.

> ASCII

Specify with a 5 or 13-character string that can include alphanumeric and underscore
characters. It is case-sensitive.

o Hex

Specify a 10-digit or 26-digit string that can contain hexadecimal (0 to 9, A to F, and a to f).

* Key Length

Length of the WEP key. Select either 64 bits or 128 bits. Longer key length allows you to set a more
complex WEP key.

* Link local address
An IP address generated automatically from a specific prefix (information of current network: fe80::)
and an interface identifier generated from printer's MAC address.

+ Link Quality
The status of the connection between the wireless router and the printer excluding noise
(interference) is indicated with a value from 0 to 100%.

* LPR

A platform-independent printing protocol used in TCP/IP networks. It does not support bidirectional
communication.

« MAC Address

Also known as the physical address. A unique and permanent hardware identifier that is assigned to
network devices by its manufacturer. MAC addresses are 48 bits long and are written as a
hexadecimal number separated by colons, i.e., 11:22:33:44:55:66.

Operation Status

Indicates the status on whether the printer can be used.
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Prefix length

The number of bits on the network part of an IP address. The number of bits is 8 bit to 24 bit for IPv4,
and 64 bit for IPv6.

Proxy server

A server that links a LAN-connected computer to the Internet. When using a proxy server, specify the
address and the port number of the proxy server.

PSK

An encryption method employed by WPA/WPA2.

Router

A relay device to connect to another network.

Signal Strength

The strength of the signal received by the printer from the wireless router is indicated with a value
from 0 to 100%.

SSID

Unique label for wireless LAN. It is often represented such as a network name or a wireless router
name.

SSID distinguishes one wireless LAN from another to prevent interference.

The printer and all clients on a wireless LAN must use the same SSID in order to communicate with
each other. The SSID can be up to 32 characters long, and is made up of alphanumeric characters.
The SSID may also be referred to by its network name.

Stealth

In the stealth mode, a wireless router hides itself by not broadcasting its SSID. The client must specify
the SSID set to the wireless router to detect it.

Stateful address

An IPv6 address acquired from a DHCP server using DHCPV6.

Stateless address

A tentative IPv6 address generated automatically using a prefix included in RA (Router
Advertisement) and a MAC address. An IPv6 address is generated in an environment where a DHCP
server is not available.
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¢ Subnet Mask

IP address has two components, the network address and the host address. Subnet Mask used to
calculate the Subnet Mask address from the IP address. A Subnet Mask is usually assigned by a
wireless router or a DHCP server of the router automatically.

Example:

IP Address: 192.168.127.123

Subnet Mask: 255.255.255.0

Subnet Mask Address: 192.168.127.0

* TCP/IP

Suite of communications protocols used to connect hosts on the Internet or the LAN. This protocol
allows different terminals to communicate with each other.

* TKIP

An encryption protocol employed by WPA/WPA2.

- USB

Serial interface designed to enable you to "hot-swap" devices, i.e., by plugging and unplugging them
without turning off the power.

* WCN (Windows Connect Now)
Users running Windows Vista or later can obtain the setting information directly via wireless network
(WCN-NET).

+ WEP/WEP Key

An encryption method employed by IEEE 802.11. Shared security key used to encrypt and decrypt
data sent over wireless networks. This printer supports key length of 64 bits or 128 bits, key format of
ASCII code or Hexadecimal, and key number of 1 to 4.

* Wi-Fi

International association that certifies interoperability of wireless LAN products based on the IEEE
802.11 specification.

This printer is a Wi-Fi authorized product.

¢ Wireless LAN

A network that, instead of being connected by physical wires, is connected by a wireless technology,
such as Wi-Fi.
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* Wireless Router
A wireless transceiver or base station that receives information from wireless clients/the printer and
rebroadcasts it. Required in an infrastructure network.

+ WPA

Security framework announced by the Wi-Fi Alliance in October 2002. The security has been
strengthened more than WEP.

o Authentication

WPA defines the following authentication methods: PSK that can be used without an
authentication server, plus WPA-802.1x that do require an authentication server.

This printer supports WPA-PSK.
o Passphrase
This encrypted key is used to perform WPA-PSK authentication.

The passphrase should be a string of 8 to 63 alphanumeric characters or a 64-digit hexadecimal
value.

+ WPA2

Security framework released by the Wi-Fi Alliance in September 2004 as a later version of WPA.
Provides a stronger encryption mechanism through Advanced Encryption Standard (AES).

o Authentication

WPAZ2 defines the following authentication methods: PSK that can be used without an
authentication server, plus WPA2-802.1x that do require an authentication server.

This printer supports WPA2-PSK.
o Passphrase
This encrypted key is used to perform WPA2-PSK authentication.

The passphrase should be a string of 8 to 63 alphanumeric characters or a 64-digit hexadecimal
value.

* WPS (Wi-Fi Protected Setup)
WPS is a standard for easy and secure establishment of a wireless network.
There are 2 primary methods used in the Wi-Fi Protected Setup:
PIN entry: a mandatory method of setup for all WPS certified devices

Push button configuration (PBC): an actual push button on the hardware or through a simulated push
button in the software.
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Restrictions

If you use a printer over the wireless LAN, the printer may recognize nearby wireless systems, you should
set a network key (WEP or WPA/WPAZ2) to the access point to encrypt wireless transmission. Wireless
communication with a product that does not comply with the Wi-Fi standard cannot be guaranteed.

Connecting with too many computers may affect the printer performance, such as printing speed.
If you use a printer with direct connection, you cannot perform the following settings:

» Specifying an IP address manually
» Enabling/disabling IPv6
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Firewall

A firewall is a function of the security software installed in the computer or operation system for computer,
and is a system that is designed to prevent unauthorized access to a network.

Precautions When Firewall Function is Enabled

« A firewall function may limit communications between a printer and a computer. This may disable
printer setup and communications.

» During the printer setup, you may be prompted to enable or disable communications, depending on
the firewall function of the security software or operation system. If so, choose to enable
communications.

» When using IJ Network Device Setup Utility, you may be prompted to enable or disable
communications, depending on the firewall function of the security software. If so, choose to enable
communications.

* If you cannot set up the printer, temporarily disable the firewall function of the security software or
operation system.

32 Important

+ If you disabled the firewall function, disconnect your network from the Internet.

» Some applications (like the network configuration software) override firewall settings. Check the
application's settings beforehand.

« If the printer you use is set to Get IP address automatically, the IP address changes every time the
printer connects to the network. This may disable printer setup and communications, depending on
the firewall settings. In this case, either change the firewall settings or assign a fixed IP address to the
printer. An IP address can be set using |J Network Device Setup Utility.

= Performing/Changing Wired LAN Settings
= Performing/Changing Wireless LAN Settings

When assigning a fixed IP address to the printer, you will need to specify an IP address with which the
computer can communicate.

»>» Note

» For the operation system firewall settings or the security software firewall settings, refer to the
instruction manual of the computer or software, or contact its manufacturer.
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Ink Tips

Is ink consumed for purposes other than printing?

Ink is sometimes consumed for purposes other than printing.

When you use the Canon printer for the first time after you install the bundled ink tanks, the printer
consumes a small amount of ink in the amount to enable printing by filling the nozzles of the Print Head
with ink.

The printing costs described in the brochures or websites are based on the consumption data from not the
first ink tank /ink cartridge but the succeeding ink tank /ink cartridge.

Ink is sometimes used to maintain the optimal printing quality.

To keep printer's performance, Canon printer performs cleaning automatically according to its condition.
When the printer performs cleaning, a small amount of ink is consumed. In this case, all colors of ink may
be consumed.

[Cleaning function]

The cleaning function helps the printer to suck air bubbles or ink itself from the nozzle and thus prevents
print quality degradation or nozzle clogging.

Is color ink consumed for black-and-white printing?

Black-and-white printing may consume ink in colors other than black, depending on the type of paper and
printer driver settings used. Color ink is therefore consumed in some cases even for black-and-white print
jobs.

»>» Note

» The machine uses pigment ink. With pigment ink, some ink on printed surfaces may come off when
rubbed or scratched.
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Printing Tips

Check status before printing

* Is the print head in good condition?

Clogged print head nozzles make printing fainter, which affects print quality and wastes paper. To
check the print head, print the nozzle check pattern.

= Maintenance Procedure

« Is ink smeared inside the machine?

After many print jobs, areas where paper passes through the machine may become smeared with ink.
To clean the inside the machine, perform Bottom Plate Cleaning.

Confirm that paper is loaded correctly
* |Is the paper loaded in the correct orientation?

To load paper in a cassette, load paper printing-side DOWN.

= | oading Paper

A: cassette 1

B: cassette 2
* |Is the paper curled?

The curled paper causes paper jam. Flatten the curled paper, and then reload it.

= "Correct curl before loading paper." in Paper Is Smudged / Printed Surface Is Scratched
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Check Paper Settings Before Printing

Before printing, complete paper settings on the operation panel or from a computer.

Paper comes in many varieties. Some is specially coated for high-quality photo printing, while other paper is
designed for documents.

Each type of paper has specific preset settings that determine details such as ink application and usage and
the distance from nozzles, which ensures optimal print quality for the paper. In contrast, incorrect paper
settings may impair color performance, or printed surfaces may rub against the machine.

If printing seems blurry or colors uneven, try printing again at a higher print quality setting.
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Set Cassette Paper Information After Loading Paper

When you insert a cassette after loading paper, a screen for setting the type and size of paper is displayed.
Set the paper information for the cassette, indicating the type and size of paper loaded.

To prevent incorrect printing, the machine can compare paper information entered for the cassette to print
job paper settings to ensure they match. Before printing, specify paper settings consistent with the cassette
paper information. If these settings do not match, automatic paper checking (if enabled) will prevent
incorrect printing and display an error message. In this case, check and correct the paper settings.

To check cassette paper information, display the paper information screen on the operation panel.
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Canceling Print Jobs

Do not press the ON button to cancel print jobs

Pressing the ON button to turn off the machine during printing may prevent the machine from printing
again if print jobs are not cleared internally.

Press the Stop button to cancel printing.
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Keeping Print Quality High

The key to maintaining optimal print quality is preventing the print head from drying out or becoming
clogged. To ensure print quality, follow these tips.

»>» Note

» On some paper, ink may run if you mark over it with a highlighter or water-based marker, or if water or
sweat comes into contact with printed areas.

Never unplug the machine until it is off

Pressing the ON button to turn off the machine will automatically cap the print head (which is equipped
with nozzles) to prevent it from drying out. However, capping is not performed if you unplug the machine
while the POWER lamp is lit or flashing. This may cause drying or clogging.

Before unplugging the machine, make sure the POWER lamp is not lit.

32 Important

* Unplugging the machine will reset the date/time setting and erase all documents in the machine's
memory. Send faxes, print documents, or save jobs to a USB flash drive as needed before
unplugging the machine.

Print regularly

Just as felt-tip pens dry up and become unusable (even when capped) if not used over extended periods,
the print head may dry out or become clogged if the machine is not used for some time. Use the machine
at least once a month, if possible.

Allow regular ink mixing

The machine automatically mixes ink periodically to maintain optimal print quality. Regular printing helps
keep the ink in good condition.

If the machine is not used for some time, it will automatically mix the ink before printing.
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Transporting Your Machine

Take these precautions when relocating the machine for changing your living place or repairing it.

3% Important

Place the machine upright in a sturdy box and pack it with sufficient cushioning to protect it in transit.
With the print head and ink tank set still installed, press the ON button to turn off the machine. This
enables automatic capping of the print head, which prevents it from drying out.

After packing, do not tilt the box, tip it over, or turn it upside down. This may damage the machine and
cause ink leakage in transit.

When shipping the machine via a courier service, label the box "THIS SIDE UP". Also label the box
"FRAGILE" or "HANDLE WITH CARE".

. Turn the machine off.

. After confirming that the POWER lamp is off, unplug the machine.

2% Important

* Do not unplug the machine while the POWER lamp is lit or flashing. This may damage the
machine or cause it to malfunction, which may prevent you from printing.

. Take out the cassettes and remove the paper. Shorten the cassettes in preparation for

stowing them inside.

= Paper Sources

. Close the paper output support, and then push in the output tray extension and paper

output tray.

Reinsert the cassettes.

Disconnect all cables and the power cord from the machine.

. Tape down all covers on the machine to prevent them from opening, and to prevent the

cassettes from coming out in transit. Place the machine in a plastic bag.

In the box, surround the machine with cushioning material to protect it.
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Legal Restrictions on Scanning/Copying

Scanning, printing, copying, or modifying copies of the following may be punishable under law.

This list is non-exhaustive. When in doubt, check with a local legal representative.

» Paper money

* Money orders

* Certificates of deposit

» Postage stamps (canceled or uncanceled)

+ Identification badges or insignia

+ Selective service or draft papers

» Checks or drafts issued by governmental agencies
» Motor vehicle licenses and certificates of title

» Traveler's checks

* Food stamps

» Passports

* Immigration papers

* Internal revenue stamps (canceled or uncanceled)
» Bonds or other certificates of indebtedness

+ Stock certificates

» Copyrighted works or works of art, without the owner's consent
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Specifications

General Specifications

Printing resolution (dpi)

600 (horizontal) x 1200 (vertical)

Interface USB Port:
Hi-Speed USB *1
USB Flash Drive Port:
USB flash drive
LAN Port:
Wired LAN: 100BASE-TX / 10BASE-T
Wireless LAN: IEEE802.11n / IEEE802.11g / IEEE802.11b *2
*1 A computer that complies with Hi-Speed USB standard is required. Since
the Hi-Speed USB interface is fully upwardly compatible with USB 1.1, it can
be used at USB 1.1.
*2 Setup possible through Standard setup, WPS (Wi-Fi Protected Setup), WCN
(Windows Connect Now) or Cableless setup.
USB and LAN can be used at the same time.
Wireless LAN and wired LAN cannot be used at the same time.
Print width 8 inches/203.2 mm

Operating environment

Temperature: 41 to 95 °F (5 to 35 °C)
Humidity: 10 to 90 % RH (no condensation)

* The performance of the printer may be reduced under certain temperature
and humidity conditions.

Recommended conditions:
Temperature: 59 to 86 °F (15 to 30 °C)
Humidity: 10 to 80 % RH (no condensation)

* For the temperature and humidity conditions of papers such as photo paper,
refer to the paper's packaging or the supplied instructions.

Storage environment

Temperature: 32 to 104 °F (0 to 40 °C)
Humidity: 5 to 95 % RH (no condensation)

Power supply

AC 100-240 V, 50/60 Hz

Power consumption

Printing (Copy): Approx. 26 W

Standby (minimum): Approx. 0.9 W *1*2
OFF: Approx. 0.2 W *1

*1 USB connection to PC

*2 The wait time for standby cannot be changed.

External dimensions

Approx. 18.3 (W) x 15.3 (D) x 12.6 (H) inches
Approx. 463 (W) x 389 (D) x 320 (H) mm

420




* With the Paper Output Tray and Cassettes retracted.

Weight Approx. 26.5 Ib (Approx. 12.1 kg)
* With the Print Head and ink tanks installed.
Print Head/Ink Total 4352 nozzles (BK 1280 nozzles, C/M/Y 512 x 6 nozzles)

ADF capacity

A4 or Letter size: max. 50 sheets (20 Ib/75 g /m?2 paper), up to 0.20 inch/5 mm
in height

Legal size: max. 10 sheets (20 Ib/75 g /m2 paper), up to 0.04 inch/1 mm in
height

Other sizes: 1 sheet

Copy Specifications

Multiple copy

max. 99 pages

Intensity adjustment

9 positions, Auto intensity (AE copy)

Reduction / Enlargement

25 % - 400 % (1 % unit)

Scan Specifications

Scanner driver

Windows: TWAIN 1.9 Specification, WIA
Mac OS: ICA

Maximum scanning size

Platen Glass: A4/Letter, 8.5" x 11.7"/216 x 297 mm
ADF: A4/Letter/Legal, 8.5" x 14.0"/216 x 356 mm

Scanning resolution

Optical resolution (horizontal x vertical) max: 1200 x 1200 dpi *1
Interpolated resolution max: 19200 x 19200 dpi *2

*1 Optical Resolution represents the maximum sampling rate based on ISO
14473.

*2 Increasing the scanning resolution will limit the maximum possible scanning
area.

Gradation (Input / Output)

Gray: 16 bit/8 bit
Color: 48 bit/24 bit (RGB each 16 bit/8 bit)

Fax Specifications

Applicable line

Public Switched Telephone Network (PSTN)

Communication mode

Super G3, G3

Data compressing system

Black: MH, MR, MMR
Color: JPEG

Modem speed

max. 33.6 kbps
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(Automatic fallback)

Transmission speed

Black: Approx. 3 seconds/page at 33.6 kbps

(Based on ITU-T No.1 chart for US specifications and Canon FAX Standard
chart No.1 for others, both in standard mode.)

Color: Approx. 1 minute/page at 33.6 kbps
(Based on Canon COLOR FAX TEST SHEET.)

Gradation

Black: 256 levels
Color: 24 bit Full Color (RGB each 8 bit)

Density adjustment

3 levels

Memory

Transmission/reception: approx. 250 pages

(Based on ITU-T No.1 chart for US specifications and Canon FAX Standard
chart No.1 for others, both in standard mode.)

Fax resolution

Black Standard: 203 pels/inch x 98 lines/inch (8 pels/mm x 3.85 lines/mm)
Black Fine, Photo: 203 pels/inch x 196 lines/inch (8 pels/mm x 7.70 lines/mm)
Black Extra fine: 300 x 300 dpi

Color: 200 x 200 dpi

Dialing Automatic dialing
- Recipient (max. 100 destinations)
- Group dial (max. 99 destinations)
Regular dialing
Automatic redialing
Manual redialing (max. 10 destinations)
Others Activity report (after every 20 transactions)

Sequential broadcasting (max. 101 destinations)

Rejected numbers (max. 10 destinations)

Network Specifications

Communication protocol

SNMP (supports Canon-MIB), TCP/IP

Wired LAN Supported Standards: IEEE802.3u (100BASE-TX) / IEEE802.3 (10BASE-T)
Transfer speed: 10 M/100 Mbps (auto switching)
Wireless LAN Supported Standards: IEEE802.11n / IEEE802.11g / IEEE802.11b

Frequency bandwidth: 2.4 GHz
Channel: 1-11 or 1-13

* Frequency bandwidth and available channels differ depending on country or
region.

Communication distance: Indoors 164 feet/50 m

* Effective range varies depending on the installation environment and location.
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Security:

WEP (64/128 bits)

WPA-PSK (TKIP/AES)

WPA2-PSK (TKIP/AES)

Setup:

Standard setup

WPS (Push button configuration/PIN code method)
WCN (WCN-NET)

Cableless setup

Other Features: Administration password

Minimum System Requirements

Conform to the operating system's requirements when higher than those given here.

Windows
Operating System Windows 10, Windows 8.1*, Windows 8
Windows 7, Windows 7 SP1
Windows Vista SP2
* Windows 8.1 includes Windows 8.1 Update.
For the printer driver, fax driver, Quick Utility Toolbox, and IJ Network Device
Setup Utility:
Windows Server 2008, Windows Server 2008 R2, Windows Server 2012, and
Windows Server 2012 R2
Hard Disk Space 3.1 GB
Note: For bundled software installation.
The necessary amount of hard disk space may be changed without notice.
Display XGA 1024 x 768
Mac OS
Operating System 0OS Xv10.8.5-0S X v10.11
Hard Disk Space 1.5GB
Note: For bundled software installation.
The necessary amount of hard disk space may be changed without notice.
Display XGA 1024 x 768

Other Supported OS

Some functions may not be available with each OS. Refer to the Canon web site for details on operation with iOS,
Android, and Windows RT.
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Mobile Printing Capability

Apple AirPrint

Google Cloud Print

MAXIFY Cloud Link

» An internet connection is required to use Easy-WebPrint EX and all the Online Manual.

» Windows: Operation can only be guaranteed on a computer with Windows 10, Windows 8.1,
Windows 8, Windows 7 or Windows Vista pre-installed.

* Windows: A CD-ROM Dirive or internet connection is required during software installation.

* Windows: Internet Explorer 8, 9, 10 or 11 is required to install Easy-WebPrint EX.

* Windows: Some functions may not be available with Windows Media Center.

* Windows: .NET Framework 4 or 4.5 must be installed to use the Windows software.

* Windows: The TWAIN driver (ScanGear) is based on the TWAIN 1.9 Specification and requires the
Data Source Manager bundled with the operating system.

* Mac OS: For Mac OS, an internet connection is required during software installation.

* In an in-house network environment, the 5222 port must be open. Contact the network
administrator for details.

Information in this guide is subject to change without notice.
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Information about Paper
» Supported Media Types
@« Paper Load Limit
» Unsupported Media Types
» Handling Paper
» Print Area
@ Print Area
« Standard Sizes

« Envelopes
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Supported Media Types

For best results, choose paper designed for how you are printing. A variety of paper for documents as well
as photos or illustrations is available from Canon. Use genuine Canon paper to print important photos, when
possible.

Media Types

Genuine Canon paper
22 Note

» For warnings on use of the non-printable side, see each product's usage information.

 For details on page sizes and media types, access the Canon website.

» Genuine Canon paper is not available in some countries or regions. Note that in the United States,
Canon paper is not sold by model number. Instead, purchase paper by name.

Paper for printing documents:

« Canon Red Label Superior <WOP111>
» Canon Océ Office Colour Paper <SAT213>
+ High Resolution Paper <HR-101N>

Paper for printing photos:

* Glossy Photo Paper "Everyday Use" <GP-501/GP-601>
» Photo Paper Glossy <GP-601>

» Photo Paper Plus Glossy Il <PP-201>

» Photo Paper Pro Luster <LU-101>

» Photo Paper Plus Semi-gloss <SG-201>

+ Matte Photo Paper <MP-101>

Paper other than genuine Canon paper

* Plain Paper (including recycled paper)
* Envelopes
» Label Paper

= Paper Load Limit
= Paper Settings on the Printer Driver and the Printer (Media Type) (Windows)
= Paper Settings on the Printer Driver and the Printer (Media Type) (Mac OS)

Page Sizes
You can use the following page sizes.

> Note

» Page sizes and media types the machine supports differ depending on the OS you are using.

Standard sizes:

e Letter
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* Legal

» Executive (7.25 x 10.5 inches (184.2 x 266.7 mm))
+ A4

* B5

* A5

* A6

» Oficio (8.5 x 12.5 inches (215.9 x 317.5 mm))

+ B-Oficio (8.5 x 14 inches (216.0 x 355.0 mm))

» M-Oficio (8.50 x 13.43 inches (216.0 x 341.0 mm))
» Foolscap (8.5 x 13 inches (215.9 x 330.2 mm))

» Legal(India) (8.46 x 13.58 inches (215 x 345 mm))
* L(89x127mm)

* KG/4"x6"(10x15)

« 2L/5"x7"(13x18)

* Hagaki

» Hagaki 2

» 8"x10"(20x25cm)

* Envelope Com 10

* Envelope DL

» Nagagata 3

* Nagagata 4

* Yougata 4

* Yougata 6

* Envelope C5

» Envelope Monarch (3.88 x 7.5 inches (98.4 x 190.5 mm))

Special sizes
Special page sizes must be within the following limits:

» cassette 1

o Minimum size: 3.50 x 5.00 inches (89.0 x 127.0 mm)
o Maximum size: 8.50 x 14.00 inches (216.0 x 355.6 mm)

e cassette 2

o Minimum size: 8.27 x 11.00 inches (210.0 x 279.4 mm)
o Maximum size: 8.50 x 14.00 inches (216.0 x 355.6 mm)

Paper Weight
You can use paper in the following weight range.

+ 17 to 28 Ib (64 to 105 g /m?) (plain paper other than genuine Canon paper)
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Paper Load Limit

Genuine Canon Paper

Paper for printing documents:

Media Name <Model No.>

Cassette 1

Cassette 2

Paper Output Tray

Canon Red Label Superior <WOP111>

Approx. 250 sheets

Approx. 250 sheets

Approx. 75 sheets

Canon Océ Office Colour Paper
<SAT213>

Approx. 200 sheets

Approx. 200 sheets

Approx. 75 sheets

High Resolution Paper <HR-101N>

65 sheets

N/A*1

65 sheets

Paper for printing photos:

7> Note

» Feeding the following paper from cassette 2 may damage the machine. Always load in cassette 1.
» For best results in continuous printing, remove printed sheets from the paper output tray to avoid

smearing or discoloration.

Media Name <Model No.>

Cassette 1

Glossy Photo Paper "Everyday Use" <GP-501/GP-601>*2

A4, Letter: 10 sheets
4" x 6" (10 x 15 cm): 20 sheets

Photo Paper Glossy <GP-601>*2

A4, Letter: 10 sheets
4" x 6" (10 x 15 cm): 20 sheets

Photo Paper Plus Glossy Il <PP-201>*2

4" x 6" (10 x 15 cm): 20 sheets

A4, Letter, 5" x 7" (13 x 18 cm), 8" x 10" (20 x 25 cm):
10 sheets

Photo Paper Pro Luster <LU-101>*2

A4, Letter: 10 sheets

Photo Paper Plus Semi-gloss <SG-201>*2

4" x 6" (10 x 15 cm): 20 sheets

A4, Letter, 5" x 7" (13 x 18 cm), 8" x 10" (20 x 25 cm):
10 sheets

Matte Photo Paper <MP-101>

A4, Letter: 10 sheets
4" x 6" (10 x 15 cm): 20 sheets

Paper other than Genuine Canon Paper

Common Name

Cassette 1

Cassette 2

Paper Output Tray

Plain Paper (including recycled pa-
per):3

Approx. 250 sheets

Approx. 250 sheets

Approx. 75 sheets

Envelopes

10 envelopes

N/A*1

Label Paper

10 sheets

N/A*1

*1 Feeding paper and envelopes from cassette 2 may damage the machine. Always load in cassette 1.
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*2 Feeding from a loaded stack of paper may leave marks on the printed side or prevent efficient feeding.

In this case, load one sheet at a time.

*3 Normal feeding at maximum capacity may not be possible with some types of paper, or under very high
or low temperature or humidity. In this case, load half the amount of paper or less.

*4 For best results in continuous printing, remove printed paper or envelopes from the paper output tray to
avoid smearing or discoloration.
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Unsupported Media Types

Do not use the following paper. Not only will print quality be poor, the paper may jam or cause the machine
to malfunction.

» Paper that is folded, curled, or wrinkled

* Paper that is damp

* Plain paper or notepad paper cut to a smaller size

* Picture postcards

» Postcards with photos or stickers attached

» Envelopes with a double flap

» Envelopes with embossed or coated surfaces

» Envelopes with adhesive flaps that are already moistened
» Any paper with holes

* Non-rectangular paper

 Stapled or glued paper

» Paper with an adhesive surface

» Paper coated with glitter or other decorative particles
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Handling Paper

» Be careful not to rub or scratch the surfaces of any types of paper when handling.

» Hold the paper as closely as possible to its edges and try not to touch the printing surface. The print
quality may be degraded if the printing surface is smudged with sweat or oil that comes from your
hands.

» Do not touch the printed surface until the ink is dried. Even when the ink is dried, be careful not to touch
the printed surface as much as possible when handling. Due to the nature of the pigment ink, the ink on
the printed surface may be removed when being rubbed or scratched.

» Take out only the necessary number of paper from the package, just before printing.

» To avoid curling, when you do not print, put unused paper back into the package and keep it on a level
surface. And also, store it avoiding heat, humidity, and direct sunlight.
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Print Area
» Print Area
» Standard Sizes

» Envelopes
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Print Area

To maintain print quality, the machine leaves a margin around the edges of paper. The printable area is
inside this margin.

B (recommended print area): Print within this area, when possible.

[ (printable area): You can also print in this area. However, feeding precision or print quality may be
affected.

»» Note

» Automatic duplex printing and duplex copying reduces the printable area by 0.08 inch (2 mm) in the top
margin.
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Standard Sizes

Size Print Area (width x height)

Letter 8.00 x 10.69 inches (203.2 x 271.4 mm)
Legal 8.00 x 13.69 inches (203.2 x 347.6 mm)
Executive 6.98 x 10.19 inches (177.4 x 258.7 mm)
A6 3.87 x 5.51 inches (98.2 x 140.0 mm)
A5 5.56 x 7.95 inches (141.2 x 202.0 mm)
A4 8.00 x 11.38 inches (203.2 x 289.0 mm)
B5 6.90 x 9.80 inches (175.2 x 249.0 mm)
Oficio 8.00 x 12.09 inches (203.2 x 307.0 mm)
B-Oficio 8.00 x 13.66 inches (203.2 x 347.0 mm)
M-Oficio 8.00 x 13.11 inches (203.2 x 333.0 mm)
Foolscap 8.00 x 12.69 inches (203.2 x 322.2 mm)
Legal (India) 8.00 x 13.27 inches (203.2 x 337.0 mm)

4" x 6" (10 x 15 cm)

3.73 x 5.69 inches (94.8 x 144.4 mm)

5"x 7" (13 x 18 cm)

4.73 x 6.69 inches (120.2 x 169.8 mm)

8" x 10" (20 x 25 cm)

7.73 x 9.69 inches (196.4 x 246.0 mm)

- —

Il Recommended print area

A: 1.80 inches (45.8 mm)
B: 1.45 inches (36.8 mm)

[ Printable area

Executive, A6, A5, A4, B5, 4" x 6" (10 x 15 cm), 5" x 7" (13 x 18 cm), 8" x 10" (20 x 25 cm)

C: 0.12inch (3.0 mm)
D: 0.20 inch (5.0 mm)
E: 0.13 inch (3.4 mm)
F: 0.13 inch (3.4 mm)




Letter, Legal, Foolscap

C: 0.12inch (3.0 mm)
D: 0.20 inch (5.0 mm)
E: 0.25 inch (6.4 mm)
F: 0.25 inch (6.3 mm)

Legal (India)

C: 0.12inch (3.0 mm)
D: 0.20 inch (5.0 mm)
E: 0.23 inch (5.9 mm)
F: 0.23 inch (5.9 mm)

Oficio
C: 0.12inch (3.0 mm)
D: 0.30 inch (7.5 mm)

E: 0.25inch (6.4 mm)
F: 0.25 inch (6.3 mm)

B-Oficio, M-Oficio

C: 0.12inch (3.0 mm)
D: 0.20 inch (5.0 mm)
E: 0.25inch (6.4 mm)
F: 0.25 inch (6.4 mm)
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Envelopes

Size Recommended Print Area (width x height)

Envelope Com 10 3.68 x 8.50 inches (93.5 x 215.9 mm)
Envelope DL 3.88 x 7.67 inches (98.8 x 194.6 mm)
Envelope C5 5.94 x 8.02 inches (150.8 x 203.6 mm)
Envelope Monarch 3.43 x 6.50 inches (87.2 x 165.1 mm)
A :%Z =]
B : :

T‘—-J — e r—

D

Il Recommended print area

A: 0.5inch (12.7 mm)
B: 0.5 inch (12.7 mm)
C: 0.22 inch (5.6 mm)
D: 0.22 inch (5.6 mm)
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Administrator Settings

» Sharing the Printer on a Network
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Sharing the Printer on a Network

When computers are used in a network environment, documents can be printed from multiple computers

that share a single printer.

Prind Sorvar
Ly
Metwork
Q 4]_ rJ
£ LY ¥ Y ra Y
Chent PC Client PC Client PC

» Setting Up a Shared Printer

This section describes how to set up the print server and the client.

»>» Note

» The Windows versions of the computers connected to the network do not necessarily have to be the

same.
* To set up the fax driver, use the same procedure.

Related Topic

= Restrictions on Printer Sharing
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Setting Up a Shared Printer

On the print server, set up sharing of the printer driver. Then from the client, set up the connection to the
print server.

1. Install the printer driver on the print server system

2. Select as described below:

* If you are using Windows 10, Windows 8.1, Windows 8, Windows 7, Windows Server 2012 R2,
Windows Server 2012, or Windows Server 2008 R2, select the Control Panel -> Hardware and
Sound (Hardware) -> Devices and Printers
The Devices and Printers window is displayed.

* If you are using Windows Vista or Windows Server 2008, select the Control Panel -> Hardware
and Sound -> Printers
The Printers window is displayed.

3. Click the icon for the model name of printer to be shared

* If you are using Windows 10, Windows 8.1, Windows 8, Windows 7, Windows Server 2012 R2,
Windows Server 2012, or Windows Server 2008 R2, press the Alt key, and from the displayed File
menu, select Printer properties -> Sharing tab.

« If you are using Windows Vista, press the Alt key, and from the displayed File menu, select Run as
administrator -> Sharing....

* If you are using Windows Server 2008 select Sharing... from the File menu.

3% Important

* A confirmation/warning dialog box may appear when starting, installing or uninstalling software.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

4. Set sharing

On the Sharing tab, check (or select) Share this printer, set the shared name as necessary, and then
click OK.

5. If the print server and the client have different architectures (32 bit or 64 bit), install an
additional driver

1. Display the Devices and Printers, Printers, or Printers and Faxes window.
2. Select as described below:
* If you are using Windows 10, Windows 8.1, Windows 8, Windows 7, Windows Server 2012
R2, Windows Server 2012, or Windows Server 2008 R2, select the printer icon, click Print
server properties, and select the Drivers tab
+ If you are using Windows Vista, press the Alt key, and from the displayed File menu, select
Run as administrator -> Server Properties..., and select the Drivers tab
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+ If you are using Windows Server 2008 from the File menu, open Server Properties, and
select the Drivers tab

3. Click Add....

4. When the Add Printer Driver Wizard window is displayed, click Next.

5. If the print server has a 32-bit architecture, select x64. If the print server has a 64-bit architecture,
select x86. Then click Next.

6. Click Have Disk....

7. In the Install From Disk window, open the "Driver" folder of the downloaded printer driver, specify
the "inf" file, and click OK.

8. Select the printer to be used, and click Next.

»» Note

+ If an error message is displayed, select the other printer.

9. Click Finish

The setup on the print server system is complete. Next, set up the client systems.

6. On the client, open Explorer, and double-click the icon of the printer to be shared

7. Follow the window instructions, and install the printer driver

The setup on the client system is complete.
Even when you perform the setup on a different client, follow the same steps 6 and 7.
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Restrictions on Printer Sharing

If you are using the XPS printer driver, replace "Canon |J Preview" with "Canon IJ XPS Preview" when
reading this information.

These are restrictions that apply when you are using a printer in a network environment. Check the
restrictions for the environment you are using.

Restriction on setting up printer sharing

« If "ntprint.inf" is requested when you install the driver from Add Printer, specify the file as follows:

1. Start Explorer on the print server and on the client with the different architecture, paste the
following path in the address bar, and press Enter on the keyboard:
%windir%)\system32\driverstore\

2. Right-click the FileRepository folder, and click Properties.

3. On the Sharing tab, click Share.

4. In the message window displayed on the print server, specify "ntprint.inf_xxxxxxxx" in the folder
that was shared in step 3, and click OK.

If there are multiples copies, select the file with the latest update date and time.

Restrictions on sharing and using a printer

* A print completion message may be displayed. To disable the message display, follow the procedure
below.
o If you are using Windows 10, Windows 8.1, Windows 8, Windows Server 2012 R2, or Windows
Server 2012:

In the Devices and Printers window of the client system, select the printer from Printers, and
click Print server properties on the command bar.
Uncheck Show informational notifications for network printers on the Advanced tab, and
then restart the computer.

o If you are using Windows 7 or Windows Server 2008 R2:

In the Devices and Printers window of the client system, select the printer from Printers and
Faxes, and click Print server properties on the command bar.
Uncheck Show informational notifications for network printers on the Advanced tab, and
then restart the computer.

o If you are using Windows Vista:

In the Printers window of the client system, press the Alt key, and from the displayed File menu,
click Run as administrator -> Server Properties....
Uncheck Show informational notifications for network printers on the Advanced tab, and
then restart the computer.

o If you are using Windows Server 2008:

In the Printers window of the client system, click Server Properties... from the File menu.
Uncheck Show informational notifications for network printers on the Advanced tab, and
then restart the computer.

» The bi-directional communication function is disabled and the correct printer status may not be
recognized.
If a client user opens the printer driver properties and then clicks OK with the Enable bidirectional
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support check box cleared on the Ports tab, the bidirectional communication function of the print
server may also be disabled.

In this case, check Enable bidirectional support check box on both the print server system and the
client system.

When you print from a client system, you cannot use Canon IJ Preview.

When the functions on the Maintenance tab cannot be set properly from a client system, they may be
grayed out. In this case, change the settings from the print server.

When you change the settings of the print server, you should delete the icon of the shared printer from
the client system, and then specify the shared settings again in the client system.

If the same driver installed on the print server is also installed on the client, the network printer icon
may be created automatically.

If an error occurs when you print a document on a shared printer from a client, the error message of
the Canon IJ status monitor is displayed on both the client and the print server. If a document is
printed out normally, the Canon IJ status monitor is displayed only on the client.
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Administrator Password

Depending on the printer you are using, an administrator password is specified at the time of purchase.

The password is either "canon" or the printer serial number if it is specified.

Model whose administrator password is specified as "canon":
MG7500 series, MG6700 series, MG6600 series, MG5600 series
MG2900 series, MX490 series, MB5300 series, MB5000 series
MB2300 series, MB2000 series, E480 series, E460 series
iP110 series, iB4000 series, PRO-100S series, PRO-10S series
+ At the time of purchase, the user name "ADMIN" is also specified for the models above.
» The following character restrictions apply to the password that you change:
o Set the password by using 0 to 32 characters.
o The allowed characters are single-byte alphanumeric characters.

» For security reasons, we recommend you use 6 and more alphanumeric characters.

Model whose serial number is used as the administrator password:
* For the models other than the above, the printer serial number is used as the administrator password.

= \Where Serial Number Is Located

» The following character restrictions apply to the password that you change:
o Set the password by using 4 to 32 characters.
o The allowed characters are single-byte alphanumeric characters.

 For security reasons, we recommend you use 6 and more alphanumeric characters.

32 Important

* You can change the password using one of the tools below. (Some tools may not be available
depending on the printer you are using.)

« operation panel of the printer
* 1J Network Tool
« printer information screen displayed on some Canon application software
* 1J Network Device Setup Utility*
* Only for Windows

« If the password has been changed while you are sharing the printer and you do not know the password,
ask the administrator of the printer you are using.

» Set the password back to the default setting by initializing the printer settings.
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For more on initializing the printer, search for "UG067" or "UG505" on your printer's Online Manual and
see the instructions shown.
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Password and Cookie

= Password

= Cookie

Password
Enter the password when the authentication screen is displayed.

= Administrator Password

You need to enter the user name as well as the password depending on the printer you are using. For
more on the user name, see the link above.

3% Important

* A message to warn you that the identification information is not verified may be displayed depending
on the printer you are using.

* We recommend you change the password.

Cookie

Cookie allows a website master to save user information or user's access log on each computer through a
web browser temporarily.

The printer may send one or more cookies to your communication device to verify Remote Ul users and
to enable the printer to offer useful information for each user.

3% Important

» Most browsers automatically accept cookies, but you can modify your browser setting so as not to
accept cookies.

If you modify your browser so as not to accept cookies, you cannot log on to Remote Ul and none of
its functions are available.

7> Note

* Use an OS or web browser below to use Remote Ul.
* iOS devices:
0S:i0S 7.0 or later
Browser: Default browser of iOS device (Mobile Safari)
» Android devices:
OS: Android 4.0 or later
Browser: Default browser of Android device (browser or Chrome)
* Mac OS devices:
OS: Mac OS X v.10.6 or later
Browser: Safari 5.1 or later

¢ Windows devices:
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OS: Windows Vista SP2 or later

Browser: Internet Explorer 9 or later / Google Chrome 41.0.2272.118m or later / Mozilla Firefox
37.0.1 or later
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How to locate your printer's serial number

The serial number is printed on a white sticker attached to each printer. The serial number will consists of 9
alphanumeric characters (4 letters followed by 5 numbers).

Example:

A

XXXX00000

»» Note

» Depending on the printer you are using, you can check the serial number by printing out the network
setting information of the printer. For more on printing, search for "NR044" on your printer's Online
Manual and see the instructions shown.
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Registering Root Certificate to Web Browser

When you display Remote Ul for the first time on your smartphone, tablet, or computer, download the root
certificate, and then register it to the web browser. The secure connection will be confirmed and a message

will not appear.

For details, search for "AF111" on your printer's Online Manual and see the instructions shown.
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Printing

Printing from Computer Printing from Smartphone/Tablet

=

Printing Using Operation Panel Paper Settings

=
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Printing from Computer

» Printing from Application Software (Windows Printer Driver)

Y

Printing from Application Software (Mac OS Printer Driver)

Y

Printing Using Canon Application Software

Y

Printing Using a Web Service

Y

Printing from an AirPrint-enabled Printer with Mac
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Printing from Application Software (Windows Printer Driver)

» Printing with Easy Setup

¥

Various Printing Methods

¥

Changing the Print Quality and Correcting Image Data

¥

Overview of the Printer Driver

¥

Printer Driver Description

¥

Updating the MP Drivers
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Printing with Easy Setup

This section describes the simple procedure for setting the Quick Setup tab so that you can carry out
appropriate printing on this printer.

Printing with Easy Setup

1. Check that the printer is turned on

2. Load paper on the printer

3. Open the printer driver setup window

4. Select a frequently used profile

In Commonly Used Settings on the Quick Setup tab, select a printing profile suited for the purpose.
When you select a printing profile, the Additional Features, Media Type, and Printer Paper Size
settings are automatically switched to the values that were preset.
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5. Select the print quality

For Print Quality, select High or Standard according to your purpose.
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3% Important

» The print quality settings that can be selected may differ depending on a printing profile.

6. Select the paper source

Select Cassette (Auto Select), Cassette 1, or Cassette 2 that matches your purpose for Paper
Source.

Prter Paper Sos:
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2 2% Important

» The paper source settings that can be selected may differ depending on the paper type and
size.
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7. Complete the setup

Click OK.
When you execute print, the document is printed with settings that match your purpose.
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32 Important

» When you select the Always Print with Current Settings check box, all settings specified on the
Quick Setup, Main, and Page Setup tabs are saved, and you can print with the same settings from
the next time as well.

* In the Commonly Used Settings window, click Save... to register the specified settings.

»>» Note

+ If the paper settings on the printer driver differ from the cassette paper information registered on the
printer, an error may occur. For instructions on what to do if an error occurs, see "Paper Settings."
To check the current printer settings or to apply the printer settings to the printer driver, click Printer
Media Information... from the Quick Setup tab, and specify the settings in the dialog box that
appears.

For details about the cassette paper information to be registered on the printer, see the following:
» Paper Settings on the Printer Driver and the Printer (Media Type)
» Paper Settings on the Printer Driver and the Printer (Paper Size)

Checking Printer Settings and Applying Settings to Printer Driver

1. Open printer driver setup window

2. Click Printer Media Information... on Quick Setup tab
The Printer Media Information dialog box appears.
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3. Select Paper Source

From Paper Source, check the setting or select a new paper source.
The current printer settings appear in Media Type and Page Size.

4. Apply settings
To apply the printer settings to the printer driver, click Set.

»» Note

+ If the media type on the printer is set to Hagaki, Ink Jet Hagaki, or Hagaki K or if the output
paper size on the printer is set to 2L/5"x7"(13x18), click Set to display the dialog box.
Select the media type and paper size that matches your purpose, and then click OK.

« If the media type and the output paper size are not set on the printer, Set will be grayed out and
cannot be clicked.

« If communication with the printer is disabled, the Printer Media Information... does not appear
or printer media information from the printer cannot be obtained.
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Paper Settings on the Printer Driver and the Printer (Media Type)

When you use this printer, selecting a media type and paper size that matches the print purpose will help
you achieve the best print results.
You can use the following media types on this printer.

Canon genuine papers (Document Printing)

. Media Type in the printer Paper information registered on
Media name <Model No.> . .
driver the printer
Canon Red Label Superior <WOP111> Plain Paper Plain paper
Canon Océ Office Colour Paper <SAT213> | Plain Paper Plain paper

Canon genuine papers (Photo Printing)

Paper information registered on the

Media name <Model No.> Media Type in the printer driver .
printer
Photo Paper Plus Glossy Il <PP-201> Photo Paper Plus Glossy Il Plus Glossy Il
Photo Paper Pro Luster <LU-101> Photo Paper Pro Luster Pro Luster

Photo Paper Plus Semi-gloss <SG-201> | Photo Paper Plus Semi-gloss | Plus Semi-gloss

Photo Paper Glossy <GP-501/GP-601> | Glossy Photo Paper Glossy

Matte Photo Paper <MP-101> Matte Photo Paper Matte

Canon genuine papers (Business Letter Printing)

Paper information registered on the

Media name <Model No.> Media Type in the printer driver ]
printer

High Resolution Paper <HR-101N> | High Resolution Paper High-Res Paper

Commercially available papers

Paper information registered on the

Media name Media Type in the printer driver .
printer

Plain Paper (including recycled pa-

Plain Paper Plain paper
per)
Envelopes Envelope Envelope
Label Paper Label Paper Label Paper
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Paper Settings on the Printer Driver and the Printer (Paper Size)

When you use this printer, selecting a paper size that matches the print purpose will help you achieve the
best print results.
You can use the following paper sizes on this printer.

Printer Paper Size in the printer driver Paper information registered on the printer
Letter 8.5"x11" 22x28cm Letter
Legal 8.5"x14" 22x36cm Legal
Executive 7.25"x10.5" 184.2x266.7mm Executive
A6 A6
A5 A5
A4 A4
B5 B5
Oficio 8.5"x12.5" 215.9x317.5mm Oficio
B-Oficio 8.5"x14" 216.0x355.0mm B-Oficio
M-Oficio 8.50"x13.43" 216.0x341.0mm M-Oficio
Foolscap 8.5"x13" 215.9x330.2mm Foolscap
Legal (India) 8.46"x13.58" 215x345mm Legal(India)
4"x6" 10x15cm KG/4"x6"(10x15)
5"x7" 13x18cm 2L/5"x7"(13x18)
8"x10" 20x25cm 8"x10"(20x25¢cm)
L 89x127mm L(89x127mm)
2L 127x178mm 2L/5"x7"(13x18)
Envelope Com 10 Envelope Com 10
Envelope DL Envelope DL
Yougata 4 4.13"x9.25" Yougata 4
Yougata 6 3.86"x7.48" Yougata 6
Envelope C5 Envelope C5
Envelope Monarch 3.88"x7.5" 98.4x190.5mm | Envelope Monarch
Custom Size Others
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Various Printing Methods
» Setting a Page Size and Orientation
» Setting the Number of Copies and Printing Order
» Setting the Stapling Margin
» Fit-to-Page Printing
» Scaled Printing
» Page Layout Printing
» Tiling/Poster Printing
» Booklet Printing
*» Duplex Printing
» Stamp/Background Printing
» Registering a Stamp
» Registering Image Data to be Used as a Background
» Setting Up Envelope Printing
* Printing on Postcards
» Switching the Paper Source to Match the Purpose
» Displaying the Print Results before Printing
» Setting Paper Dimensions (Custom Size)

» Editing the Print Document or Reprinting from the Print History
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Setting a Page Size and Orientation

The paper size and orientation are essentially determined by the application software. When the page size
and orientation set for Page Size and Orientation on the Page Setup tab are same as those set with the
application software, you do not need to select them on the Page Setup tab.

When you are not able to specify them with the application software, the procedure for selecting a page size
and orientation is as follows:
You can also set page size and orientation on the Quick Setup tab.

1. Open the printer driver setup window

2. Select the paper size

Select a page size from the Page Size list on the Page Setup tab.
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3. Set Orientation

Select Portrait or Landscape for Orientation. Check Rotate 180 degrees check box when you want to
perform printing with the original being rotated 180 degrees.

4. Complete the setup

Click OK.
When you execute print, the document will be printed with the selected page size and the orientation.

»» Note

+ If Normal-size is selected for Page Layout, then Automatically reduce large document that the
printer cannot output is displayed.
Normally, you can leave the check box checked. During printing, if you do not want to reduce large
documents that cannot be printed on the printer, uncheck the check box.
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Setting the Number of Copies and Printing Order

The procedure for specifying the number of copies and printing order is as follows:
You can also set the number of copies on the Quick Setup tab.

1. Open the printer driver setup window

2. Specify the number of copies to be printed

For Copies on the Page Setup tab, specify the number of copies to be printed.
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3. Specify the print order

Check the Print from Last Page check box when you want to print from the last page in order, and
uncheck the check box when you want to print from the first page.

Check the Collate check box when you are printing multiple copies of a document and want to print out
all pages in each copy together. Uncheck this check box when you want to print all pages with the same
page number together.

* Print from Last Page: [ /Collate: [
A

* Print from Last Page: [l /Collate: [
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4. Complete the setup

Click OK.
When you execute print, the specified number of copies will be printed with the specified printing order.

32 Important

* When the application software that you used to create the document has the same function, specify the
settings on the printer driver. However, if the print results are not acceptable, specify the function
settings on the application software. When you specify the number of copies and the printing order with
both the application software and this printer driver, the number of copies may be multiplied numbers of
the two settings or the specified printing order may not be enabled.

 Print from Last Page appears grayed out and is unavailable when Tiling/Poster is selected for Page
Layout.

* When Booklet is selected for Page Layout, Print from Last Page and Collate appear grayed out and
cannot be set.

* When Duplex Printing is selected, Print from Last Page appears grayed out and cannot be set.

»» Note

By setting both Print from Last Page and Collate, you can perform printing so that papers are collated
one by one starting from the last page.
These settings can be used in combination with Normal-size, Fit-to-Page, Scaled, and Page Layout.
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Setting the Stapling Margin

The procedure for setting the staple side and the margin width is as follows:

1. Open the printer driver setup window

2. Specify the side to be stapled

Check the position of the stapling margin from Stapling Side on the Page Setup tab.
The printer analyzes the Orientation and Page Layout settings, and automatically selects the best
staple position. When you want to change the setting, select from the list.
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3. Set the margin width

If necessary, click Specify Margin... and set the margin width, and then click OK.
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»» Note

» The printer automatically reduces the print area depending on the staple position margin.

4. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified staple side and margin width.

22 Important

+ Stapling Side and Specify Margin... appear grayed out and are unavailable when:
« Tiling/Poster or Booklet is selected for Page Layout
 Scaled is selected for Page Layout (When Duplex Printing is also selected, only Stapling Side
can be specified.)
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Fit-to-Page Printing
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The procedure for printing a document that is automatically enlarged or reduced to fit the page size to be
used is as follows:

1. Open the printer driver setup window

2. Set fit-to-page printing
Select Fit-to-Page from the Page Layout list on the Page Setup tab.
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3. Select the paper size of the document

Using Page Size, select the page size that is set with your application software.

4. Select the print paper size

Select the size of the paper loaded in the printer from the Printer Paper Size list.
When the Printer Paper Size is smaller than the Page Size, the page image will be reduced. When the
Printer Paper Size is larger than the Page Size, the page image will be enlarged.
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The current settings are displayed in the settings preview on the left side of the printer driver.
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5. Complete the setup

Click OK.
When you execute print, the document will be enlarged or reduced to fit to the page size.
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Scaled Printing
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The procedure for printing a document with pages enlarged or reduced is as follows:

1. Open the printer driver setup window

2. Set scaled printing
Select Scaled from the Page Layout list on the Page Setup tab.
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3. Select the paper size of the document

Using Page Size, select the page size that is set with your application software.

4. Set the scaling rate by using one of the following methods:

» Select a Printer Paper Size
When the printer paper size is smaller than the Page Size, the page image will be reduced. When
the printer paper size is larger than the Page Size, the page image will be enlarged.
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» Specify a scaling factor
Directly type in a value into the Scaling box.
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The current settings are displayed in the settings preview on the left side of the printer driver.

5. Complete the setup

Click OK.
When you execute print, the document will be printed with the specified scale.
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3% Important

* When the application software which you used to create the original has the scaled printing function,

configure the settings on your application software. You do not need to configure the same setting in the
printer driver.

»» Note

+ Selecting Scaled changes the printable area of the document.
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Page Layout Printing

The page layout printing function allows you to print more than one page image on a single sheet of paper.

The procedure for performing page layout printing is as follows:

1. Open the printer driver setup window

2. Set page layout printing

Select Page Layout from the Page Layout list on the Page Setup tab.
The current settings are displayed in the settings preview on the left side of the printer driver.
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3. Select the print paper size

Select the size of the paper loaded in the printer from the Printer Paper Size list.

4. Set the number of pages to be printed on one sheet and the page order

If necessary, click Specify..., specify the following settings in the Page Layout Printing dialog box, and
click OK.

469



Page Layout Printing < ]
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Page Layout
To change the number of pages to be printed on a single sheet of paper, select the number of pages
from the list.

Page Order
To change the page arrangement order, select a placement method from the list.

Page Border
To print a page border around each document page, check this check box.

. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the specified number of pages will be arranged on each sheet of paper in the
specified order.
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Tiling/Poster Printing

The tiling/poster printing function allows you to enlarge image data, divide it into several pages, and print
these pages on separate sheets of paper. You can also paste the pages together to create a large print like
a poster.

The procedure for performing tiling/poster printing is as follows:
Setting Tiling/Poster Printing

1. Open the printer driver setup window

2. Set tiling/poster printing

Select Tiling/Poster from the Page Layout list on the Page Setup tab.
The current settings are displayed in the settings preview on the left side of the printer driver.
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3. Select the print paper size

Select the size of the paper loaded in the printer from the Printer Paper Size list.
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4. Set the number of image divisions and the pages to be printed

If necessary, click Specify..., specify the following settings in the Tiling/Poster Printing dialog box,
and then click OK.
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Image Divisions
Select the number of divisions (vertical x horizontal).
As the number of divisions increases, the number of sheets used for printing increases. If you are
pasting pages together to create a poster, increasing the number of divisions allows you to create
a larger poster.

Print "Cut/Paste” in margins
To leave out words "Cut" and "Paste", uncheck this check box.

»» Note

» This feature may be unavailable when certain printer drivers or operating environments are
used.

Print "Cut/Paste” lines in margins
To leave out cut lines, uncheck this check box.

Print page range
Specifies the printing range. Select All under normal circumstances.
To reprint only a specific page, select Pages and enter the page number you want to print. To
specify multiple pages, enter the page numbers by separating them with commas or by entering a
hyphen between the page numbers.

»» Note

* You can also specify the print range by clicking the pages in the settings preview.

5. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the document will be divided into several pages during printing.

Printing Only Specific Pages
If ink becomes faint or runs out during printing, you can reprint only the specific pages by following the

procedure below:

1. Set the print range
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In the settings preview on the left of the Page Setup tab, click the pages that do not need to be
printed.
The pages that were clicked are deleted, and only the pages to be printed are displayed.
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23> Note

* Click the deleted pages to display them again.
» Right-click the settings preview to select Print all pages or Delete all pages.

2. Complete the setup

After completing the page selection, click OK.
When you execute print, only specified pages will be printed.

32 Important

+ Since tiling/poster printing enlarges the document when printing it, the print results may become coarse.
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Booklet Printing

The booklet printing function allows you to print data for a booklet. Data is printed on both sides of the paper.
This type of printing ensures that pages can be collated properly, in page number order, when the printed
sheets are folded and stapled at the center.

‘W

The procedure for performing booklet printing is as follows:

1. Open the printer driver setup window

2. Set booklet printing

Select Booklet from the Page Layout list on the Page Setup tab.
The current settings are displayed in the settings preview on the left side of the window.
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3. Select the print paper size

Select the size of the paper loaded in the printer from the Printer Paper Size list.

4. Set the margin for stapling and the margin width

Click Specify... and specify the following settings in the Booklet Printing dialog box, and then click OK.
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Booklet Printing
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Margin for stapling
Select which side should the stapling margin be on when the booklet is completed.

Insert blank page
To leave one side of a sheet blank, check the check box, and select the page to be left blank.

Margin
Enter the margin width. The specified width from the center of the sheet becomes the margin width
for one page.

Page Border
To print a page border around each document page, check the check box.

5. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the document is automatically printed first on one side of a sheet of paper and

then on the opposite side.
When the printing is complete, fold the paper at the center of the margin and make a booklet.

32 Important

» Booklet cannot be selected when a media type other than Plain Paper is selected for Media Type on
the Main tab.

»» Note

» The stamp and background are not printed on the inserted blank sheets with the Insert blank page
function of booklet printing.
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Duplex Printing
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The procedure for printing data on both sides of a sheet of paper is as follows:
You can also set duplex printing in Additional Features on the Quick Setup tab.

Performing Automatic Duplex Printing

You can perform the duplex printing without having to turn over the paper.

1. Open the printer driver setup window

2. Set automatic duplex printing

Check the Duplex Printing check box on the Page Setup tab and confirm that Automatic is checked.
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3. Select the layout

Select Normal-size, Fit-to-Page, Scaled, or Page Layout from the Page Layout list.

4. Set the print area

476



When you perform duplex printing, the print area of the document becomes slightly narrower than
usual and the document may not fit on one page.
Click Print Area Setup..., select one of the following process methods, and then click OK.
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Use normal-size printing
Print without reducing the page.

Use reduced printing
Reduce the page slightly during printing.

5. Specify the side to be stapled

The best Stapling Side is selected automatically from the Orientation and Page Layout settings. To
change the setting, select another stapling side from the list.

6. Set the margin width

If necessary, click Specify Margin... and set the margin width, and then click OK.

7. Complete the setup

Click OK on the Page Setup tab.
When you execute print, duplex printing will be started.

Performing Duplex Printing Manually

You can perform the duplex printing manually.

1. Open the printer driver setup window

2. Set duplex printing

Check the Duplex Printing check box and uncheck the Automatic check box on the Page Setup tab.
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=i Caran 8 series Printer Printing Preferences
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3. Select the layout

Select Normal-size, Fit-to-Page, Scaled, or Page Layout from the Page Layout list.

4. Specify the side to be stapled

The best Stapling Side is selected automatically from the Orientation and Page Layout settings. To
change the setting, select another stapling side from the list.

5. Set the margin width

If necessary, click Specify Margin... and set the margin width, and then click OK.

6. Complete the setup

Click OK on the Page Setup tab.

When you execute print, the document is first printed on one side of a sheet of paper. After one side is
printed, reload the paper correctly according to the message.
Then click Start Printing to print the opposite side.

32 Important

* When a media type other than Plain Paper is selected from the Media Type list on the Main tab,
Duplex Printing appears grayed out and is unavailable.
* When Tiling/Poster, or Booklet is selected from the Page Layout list, Duplex Printing and Stapling
Side appear grayed out and are unavailable.
» Duplex Printing can be performed only when one of the following paper sizes is selected from Page
Size on the Page Setup tab.
* Letter 8.5"x11" 22x28cm, A4
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« After printing the front page, there is an ink drying wait time before starting to print the back page
(Operation stops temporarily). Do not touch the paper during this time. You can change the ink drying
wait time at Custom Settings on the Maintenance tab.

Related Topic

= Changing the Printer Operation Mode
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Stamp/Background Printing

Stamp or Background may be unavailable when certain printer drivers or operating environments are used.

The Stamp function allows you to print a stamp text or a bitmap over or behind document data. It also
allows you to print date, time and user name. The Background function allows you to print a light illustration
behind the document data.

The procedure for performing stamp/background printing is as follows:

Printing a Stamp
"CONFIDENTIAL," "IMPORTANT," and other stamps that are used often in companies are pre-registered.

1. Open the printer driver setup window

2. Click Stamp/Background... (Stamp...) on the Page Setup tab
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The Stamp/Background (Stamp) dialog box opens.
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»» Note

» With the XPS printer driver, the Stamp/Background... button has become the Stamp... button
and only the stamp function can be used.

3. Select a stamp

Check the Stamp check box, and select the stamp to be used from the list.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.

4. Set the stamp details

If necessary, specify the following settings, and then click OK.

Define Stamp... button
To change the stamp text, bitmap, or position, click this.

Place stamp over text
To print the stamp on the front of the document, check this check box.

> Note

» The stamp is given priority because the stamp is printed over the document data in the
sections where the stamp and the document data overlap. When this check box is
unchecked, the stamp is printed behind the document data and may be hidden in the
overlapping sections depending on the application software used.

» Place stamp over text cannot be used when the XPS printer driver is used.

When the XPS printer driver is used, the stamp is normally printed in the foreground of the
document.

Print semitransparent stamp
Check this check box to print a semi-transparent stamp on the document.
This function is available only when the XPS printer driver is used.

Stamp first page only
To print the stamp only on the first page, check this check box.

5. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified stamp.

Printing a Background

Two bitmap files are pre-registered as samples.

1. Open the printer driver setup window

2. Click Stamp/Background... on the Page Setup tab

The Stamp/Background dialog box opens.

3. Select the background
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Check the Background check box, and select the background to be used from the list.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.

4. Set the background details

If necessary, complete the following settings, and then click OK.

Select Background... button
To use another background or change the layout or density of a background, click this.

Background first page only
To print the background only on the first page, check this check box.

5. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified background.

»» Note

» The stamp and background are not printed on blank sheets inserted with the Insert blank page
function of booklet printing.

Related Topics

= Registering a Stamp
= Registering Image Data to be Used as a Background
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Registering a Stamp

This feature may be unavailable when certain printer drivers or operating environments are used.

You can create and register a new stamp. You can also change and re-register some of the settings of an
existing stamp. Unnecessary stamps can be deleted at any time.

The procedure for registering a new stamp is as follows:

Registering a New Stamp

1. Open the printer driver setup window

2. Click Stamp/Background... (Stamp...) on the Page Setup tab
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3. Click Define Stamp...

The Stamp Settings dialog box opens.
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4. Configure the stamp while viewing the preview window

« Stamp tab

Select Text, Bitmap, or Date/Time/User Name that matches your purpose for Stamp Type.

o For Text registration, the characters must already be entered in Stamp Text. If necessary,
change the TrueType Font, Style, Size, and Outline settings. You can select the color of
the stamp by clicking Select Color....

> For Bitmap, click Select File... and select the bitmap file (.bmp) to be used. If necessary,
change the settings of the Size and Transparent white area.

o For Date/Time/User Name, the creation date/time and user name of the printed object are
displayed in Stamp Text. If necessary, change the settings of TrueType Font, Style, Size,
and Outline. You can select the color of the stamp by clicking Select Color....

22 Important

» Stamp Text appears grayed out and is unavailable when Date/Time/User Name is
selected.

* Placement tab

Select the stamp position from the Position list. You can also select Custom from the Position
list and specify coordinates for X-Position and Y-Position.

You can also change the stamp position by dragging the stamp in the preview window.

To change the stamp position angle, type a value in the Orientation box directly.

32 Important

« Orientation cannot be changed when Bitmap is selected for Stamp Type on the Stamp tab.

5. Save the stamp
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Click the Save settings tab and enter a title in the Title box, and then click Save.
Click OK when the confirmation message appears.

»» Note

» Spaces, tabs, and returns cannot be entered at the beginning or end of a title.

6. Complete the setup

Click OK. The Stamp/Background (Stamp) dialog box opens again.
The registered title appears in the Stamp list.

Changing and Registering Some of Stamp Settings

1. Select the stamp for which the settings are to be changed

Select the Stamp check box in the Stamp/Background (Stamp) dialog box. Then from the list, select
the title of the stamp to be changed.

2. Click Define Stamp...

The Stamp Settings dialog box opens.
3. Configure the stamp while viewing the preview window

4. Overwrite save the stamp

Click Save overwrite on the Save settings tab.
When you want to save the stamp with a different title, type a new title in the Title box and click Save.
Click OK when the confirmation message appears.

5. Complete the setup

Click OK. The Stamp/Background (Stamp) dialog box opens again.
The registered title appears in the Stamp list.

Deleting an Unnecessary Stamp

1. Click Define Stamp... in the Stamp/Background (Stamp) dialog box

The Stamp Settings dialog box opens.

2. Select the stamp to be deleted

Select the title of the stamp you want to delete from the Stamps list on the Save settings tab. Then
click Delete.
Click OK when the confirmation message appears.

3. Complete the setup

Click OK. The Stamp/Background (Stamp) dialog box opens again.
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Registering Image Data to be Used as a Background

This feature may be unavailable when certain printer drivers or operating environments are used.

You can select a bitmap file (.bmp) and register it as a new background. You can also change and register
some of the settings of an existing background. An unnecessary background can be deleted.

The procedure for registering image data to be used as a background is as follows:
Registering New Background

1. Open the printer driver setup window

2. Click Stamp/Background... on the Page Setup tab
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22> Note

» With the XPS printer driver, the Stamp/Background... button has become the Stamp... button
and Background cannot be used.
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3. Click Select Background...

The Background Settings dialog box opens.
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4. Select the image data to be registered to the background

Click Select File.... Select the target bitmap file (.bmp), and then click Open.

5. Specify the following settings while viewing the preview window

Layout Method
Select how the background image data is to be placed.
When Custom is selected, you can set coordinates for X-Position and Y-Position.
You can also change the background position by dragging the image in the preview window.

Intensity
Set the intensity of the background image data with the Intensity slider. Moving the slider to the
right darkens the background, and moving the slider to the left lightens the background. To print
the background at the original bitmap intensity, move the slider to the rightmost position.

6. Save the background

Click the Save settings tab and enter a title in the Title box, and then click Save.
Click OK when the confirmation message appears.

»» Note

» Spaces, tabs, and returns cannot be entered at the beginning or end of a title.

7. Complete the setup

Click OK, then it returns to Stamp/Background dialog box.
The registered title appears in the Background list.

Changing and Registering Some Background Settings

1. Select the background for which the settings are to be changed
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Select the Background check box in the Stamp/Background dialog box. Then from the list, select
the title of the background you want to change.

2. Click Select Background...

The Background Settings dialog box opens.
3. Specify each item on the Background tab while viewing the preview window

4. Save the background

Click Save overwrite on the Save settings tab. When you want to save the background with a
different title, enter a new title in the Title box and click Save.
Click OK when the confirmation message appears.

5. Complete the setup

Click OK, then it returns to Stamp/Background dialog box.
The registered title appears in the Background list.

Deleting an Unnecessary Background

1. Click Select Background... in the Stamp/Background dialog box

The Background Settings dialog box opens.

2. Select the background to be deleted

Select the title of the background you want to delete from the Backgrounds list on the Save settings
tab, and then click Delete.
Click OK when the confirmation message appears.

3. Complete the setup

Click OK, then it returns to Stamp/Background dialog box.
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Setting Up Envelope Printing

The procedure for performing envelope printing is as follows:

1. Load envelope on the printer

2. Open the printer driver setup window

3. Select the media type

Select Envelope from Commonly Used Settings on the Quick Setup tab.
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4. Select the paper size

When the Envelope Size Setting dialog box is displayed, select Envelope Com 10, Envelope DL,
Yougata 4 4.13"x9.25", Yougata 6 3.86"x7.48", Envelope C5, or Envelope Monarch 3.88"x7.5"
98.4x190.5mm and then click OK.

5. Set the orientation

To print the addressee horizontally, select Landscape for Orientation.

A

> Note

* If Yougata 4 4.13"x9.25", Yougata 6 3.86"x7.48", Envelope Com 10, Envelope DL, Envelope
C5, or Envelope Monarch 3.88"x7.5" 98.4x190.5mm is selected for Printer Paper Size, the
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printer rotates the paper 90 degrees to the left to print, regardless of the Rotate 90 degrees left
when orientation is [Landscape] setting for Custom Settings on the Maintenance tab.

6. Select the print quality

Select High or Standard that matches your purpose for Print Quality.

7. Complete the setup

Click OK.
When you execute print, the information is printed on the envelope.

22 Important

* When you execute envelope printing, guide messages are displayed.
To hide the guide messages, check the Do not show this message again check box.
To show the guide again, click the View Printer Status button on the Maintenance tab, and start the
Canon |J Status Monitor.
Then click Envelope Printing from Display Guide Message of the Option menu to enable the setting.

»» Note

+ If the paper settings on the printer driver differ from the cassette paper information registered on the
printer, an error may occur. For instructions on what to do if an error occurs, see "Paper Settings."
To check the current printer settings or to apply the printer settings to the printer driver, click Printer
Media Information... from the Quick Setup tab, and specify the settings in the dialog box that appears.
For details about the cassette paper information to be registered on the printer, see the following:
» Paper Settings on the Printer Driver and the Printer (Media Type)
» Paper Settings on the Printer Driver and the Printer (Paper Size)
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Printing on Postcards

This section describes the procedure for postcard printing.
1. Load postcard on the printer

2. Open the printer driver setup window

3. Select commonly used settings

Display the Quick Setup tab, and for Commonly Used Settings, select Standard.

4. Select the media type

For Media Type, select Ink Jet Hagaki (A), Ink Jet Hagaki, Hagaki K (A), Hagaki K, Hagaki (A), or
Hagaki.

32 Important

+ This printer cannot print on postcards that have photos or stickers attached.
* When printing on each side of a postcard separately, you will get cleaner printing if you print the
message side first and then print the address side.
» The paper settings on the printer driver are different, depending on whether you are printing on
the address side or the message side.
To check the current printer settings or to apply the printer settings to the printer driver, click
Printer Media Information... from the Quick Setup tab, and specify the settings in the dialog box
that appears.
For details about the cassette paper information to be registered to the printer driver and on the
printer, see the following:
+ Paper Settings on the Printer Driver and the Printer (Media Type)
» Paper Settings on the Printer Driver and the Printer (Paper Size)

5. Select the paper size
For Printer Paper Size, select Hagaki 100x148mm or Hagaki 2 200x148mm.
3% Important

» Return postcards can be used only when you print them from the computer.

* When printing a return postcard, always set the paper size to Hagaki 2 200x148mm from your
application software or the printer driver.

» Do not fold the return postcard. If a crease is formed, the printer will not be able to feed the
postcard properly, and this condition will cause line shifts or a paper jam.

6. Set the print orientation

To print the address horizontally, set Orientation to Landscape.

7. Select the print quality

For Print Quality, select High or Standard, according to your purpose.
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8. Complete the setup

Click OK.
When you execute printing, the data will be printed onto the postcard.

32 Important

* When you execute postcard printing, a guide message is displayed.
When the guide message is displayed, select Do not show this message again if you do not want any
guide messages to be displayed.
To display guide messages again, open the Maintenance tab and click View Printer Status to start the
Canon |J Status Monitor.
On the Option menu, choose Display Guide Message and click Hagaki Printing to enable the setting.
* When printing on media other than postcards, load the media according to usage method of that media,
and click Start Printing.
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Switching the Paper Source to Match the Purpose

In this printer, there are two paper sources, a cassette 1 and a cassette 2.
You can facilitate printing by selecting a paper source setting that matches your media type or purpose.

The procedure for setting paper source is as follows:

You can also set the paper source on the Quick Setup tab.

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.

3. Select the paper source

From the Paper Source list, select the paper source that matches your purpose.
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Cassette (Auto Select)
Based on the paper settings on the printer driver and the cassette paper information registered on
the printer, the printer automatically determines which cassette to use and feeds paper from that
cassette.
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Cassette 1
Paper is fed from the cassette 1.

Cassette 2
Paper is fed from the cassette 2.

3% Important

* When a media type other than Plain Paper is selected for Media Type on the Main tab, paper
cannot be supplied from the cassette 2.
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* When a paper size other than Letter 8.5"x11" 22x28cm, Legal 8.5"x14" 22x36cm, A4, Oficio
8.5"x12.5" 215.9x317.5mm, B-Oficio 8.5"x14" 216.0x355.0mm, M-Oficio 8.50"x13.43"
216.0x341.0mm, Foolscap 8.5"x13" 215.9x330.2mm, or Legal (India) 8.46"x13.58"
215x345mm is selected for Page Size on the Page Setup tab, paper cannot be supplied from
the cassette 2.

4. Complete the setup

Click OK.
When you execute print, the printer uses the specified paper source to print the data.

> Note

+ If the paper settings on the printer driver differ from the cassette paper information registered on
the printer, an error may occur. For instructions on what to do if an error occurs, see "Paper
To check the current printer settings or to apply the printer settings to the printer driver, click
Printer Media Information... from the Quick Setup tab, and specify the settings in the dialog box
that appears.
For details about the cassette paper information to be registered on the printer, see the following:
» Paper Settings on the Printer Driver and the Printer (Media Type)
 Paper Settings on the Printer Driver and the Printer (Paper Size)

494



Displaying the Print Results before Printing

If you are using the XPS printer driver, replace "Canon IJ Preview" with "Canon IJ XPS Preview" when

reading this information.

You can display and check the print result before printing.

The procedure for displaying the print result before printing is as follows:

You can also set the print results display on the Quick Setup tab.

1. Open the printer driver setup window

2. Set the preview

Check the Preview before printing check box on the Main tab.
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3. Complete the setup
Click OK.
When you execute print, the Canon IJ Preview opens and displays the print results.
22 Important

+ In the Manual Color Adjustment dialog box, the Color Adjustment tab contains the Print a pattern
for color adjustment check box. When this check box is selected, the Preview before printing
appears grayed out and is unavailable.

Related Topic

= Canon |J Preview
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Setting Paper Dimensions (Custom Size)

You can specify the height and width of paper when its size cannot be selected from the Page Size. Such a
paper size is called "custom size."

The procedure for specifying a custom size is as follows:

You can also set a custom size in Printer Paper Size on the Quick Setup tab.

1. Open the printer driver setup window

2. Select the paper size

Select Custom... for Page Size on the Page Setup tab.
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3. Set the custom paper size

Specify Units, and enter the Width and Height of the paper to be used. Then click OK.

4. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified paper size.
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3% Important

« If the application software that created the document has a function for specifying height and width
values, use the application software to set the values. If the application software does not have such a
function or if the document does not print correctly, perform the above procedure from the printer driver
to set the values.

 Printing may be disabled depending on the size of the specified user-defined media.

For information about printable sizes for user-defined media, see "Supported Media Types."

»» Note

+ If the paper settings on the printer driver differ from the cassette paper information registered on the
printer, an error may occur. For instructions on what to do if an error occurs, see "Paper Settings."
To check the current printer settings or to apply the printer settings to the printer driver, click Printer
Media Information... from the Quick Setup tab, and specify the settings in the dialog box that appears.
For details about the cassette paper information to be registered on the printer, see the following:
» Paper Settings on the Printer Driver and the Printer (Media Type)
» Paper Settings on the Printer Driver and the Printer (Paper Size)
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Editing the Print Document or Reprinting from the Print History

This function is unavailable when the standard IJ printer driver is used.

In the Canon IJ XPS preview window, you can edit the print document or retrieve the document print history
to print the document.

The procedure for using the Canon IJ XPS Preview is as follows:
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= Print
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@ Delete Document
|:' Reset Documents
== View Thumbnails
C/ T L | Move Document
EED Undo
4 4 » M Move Page
Cde Delete Page
222 Note

» By clicking l% View Thumbnails, you can display or hide thumbnails of the print documents selected
in the Document Name list.
* Clicking 3 Undo reverses the change that just performed.
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Editing and Printing a Print Document

When printing multiple documents or pages, you can combine documents, change the print sequence of
the documents or pages, or delete documents or pages.

1. Open the printer driver setup window

2. Set the preview

Check the Preview before printing check box on the Main tab.

3. Complete the setup

Click OK.
The Canon IJ XPS Preview will start and the print result will be displayed before printing.

4. Editing print documents and print pages

Combining print documents

You can combine multiple print documents to form a single document. By combining print
documents, you can prevent blank pages from being inserted when you execute duplex printing
or page layout printing.

From the Document Name list, select the documents to be combined. On the Edit menu, select
Combine Documents from Documents to combine the documents in the listed sequence.

To select multiple print documents, hold down the Ctrl key and click the documents to be
merged, or hold down the Shift key and press the upper arrow or lower arrow key. You can also
click a blank area in the document list and drag the mouse to select multiple documents.

When you combine documents, the documents selected before the combining are deleted from
the list and the combined document is added to the list.

Changing the sequence of print documents or print pages

> To change the sequence of the print documents, go to the Document Name list, and select
the print document to be moved. Next, on the Edit menu, select Move Document from
Documents, and select the appropriate item. You can also click and drag a print document
to change the print sequence.

> To change the sequence of the print pages, click View Thumbnails from the Option menu,
and select the print page to be moved. Next, on the Edit menu, select Move Page from
Pages, and select the appropriate item. You can also click and drag a print page to change
the print sequence.

Deleting print documents and print pages

o To delete a print document, select the target document from the Document Name list, and
on the Edit menu, choose Documents and then Delete Document.

> To delete a print page, click View Thumbnails from the Option menu, and select the print
page to be deleted. Next, on the Edit menu, select Delete Page from Pages.

Print page recovery

You can recover pages that were deleted with Delete Page.
To recover pages, select the View Deleted Pages check box from the Option menu, and select
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the pages to be recovered from among the displayed thumbnail pages. Then from the Edit menu
chose Pages and then Restore Page.

After editing the print documents or print pages, you can change the print settings on the Page
Information, Layout and Manual Color Adjustment tabs as necessary.

32 Important

» To display the multiple documents in the list, open the preview and execute print again.

« To return the print documents to their original condition before they were edited in the preview,
on the Edit menu, select Reset Documents from Documents.

« If the documents to be combined have different print settings, a message may be displayed.
Check the contents of the displayed message before combining the documents.

« |If the documents to be combined have different output paper sizes and duplex printing or page
layout printing is to be performed, the printer may not produce the expected print results for
certain print pages.

Check the preview before printing.

» Depending on the print settings of the print document, some functions may not be available in

the Canon IJ XPS preview.

»» Note

* You can rename Document Name to any name.

5. Executing print

Click Print.
When you execute print, the printer uses the specified settings to print the data.

Reprinting from the Print History

When you click Save Print History on the File menu to enable the setting, the document printed from the
preview is saved, and you can reprint the document with the same settings.

1. Displaying the print history

Open the printer driver setup window. Then on the Maintenance tab, select View Print History.
The saved print document is displayed in the preview.

32 Important

+ To limit the number of print history registrations, click History Entry Limit on the File menu.
« If the limit on the number of registration is exceeded, the print history registrations are deleted
starting from the oldest one.

2. Selecting a print document

From the Document Name list, select the document to be printed.

3. Executing print
Click Print.
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Related Topic

= Displaying the Print Results before Printing
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Changing the Print Quality and Correcting Image Data
» Printing a Color Document in Monochrome
» Specifying Color Correction
» Optimal Photo Printing of Image Data
» Adjusting Colors with the Printer Driver
» Printing with ICC Profiles
» Adjusting Color Balance
» Adjusting Color Balance Using Sample Patterns (Printer Driver)
» Adjusting Brightness
» Adjusting Intensity
» Adjusting Contrast

» Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
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Printing a Color Document in Monochrome

The procedure for printing a color document in monochrome is as follows:

You can also set a grayscale printing in Additional Features on the Quick Setup tab.

1. Open the printer driver setup window

2. Set grayscale printing

Check the Grayscale Printing check box on the Main tab.

Canon ‘series Printer Printing Preferences

Plam Paper
Lemer 8570117 2262 Bom

.

3. Complete the setup

Click OK.
When you execute print, the document is converted to grayscale data. It allows you to print the color
document in monochrome.

32 Important

* When the Grayscale Printing check box is checked, the printer driver processes image data as sRGB
data. In this case, actual colors printed may differ from those in the original image data.
When using the grayscale printing function to print Adobe RGB data, convert the data to sSRGB data
using an application software.
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»» Note

» During Grayscale Printing, inks other than black ink may be used as well.
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Specifying Color Correction

You can specify the color correction method suited to the type of document to be printed.
Normally, the printer driver adjusts the colors by using Canon Digital Photo Color so that data is printed with
color tints that most people prefer. This method is suitable for printing sRGB data.

When you want to print by using the color space (sRGB) of the image data effectively, select ICM (ICC
Profile Matching). When you want to use an application software to specify a printing ICC profile, select
None.

The procedure for specifying color correction is as follows:

You can also set color correction on the Quick Setup tab by choosing Photo Printing under Commonly
Used Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
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3. Select color correction

Click Matching tab, select Color Correction setting that matches your purpose from the following, and
click OK.

505



Manual Color Adjustment “
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Driver Matching
With Canon Digital Photo Color, you can print sSRGB data with color tints that most people prefer.

ICM (ICC Profile Matching)
Adjusts the colors by using an ICC profile when printing.

None
The printer driver does not perform color correction. Select this value when you are specifying an
individually created printing ICC profile or a printing ICC profile for special Canon paper in an
application software to print data.

4. Complete the setup

Click OK on the Main tab.
When you execute print, the document data is printed with the specified color correction.

3% Important

» When ICM is disabled in the application software, ICM is unavailable for Color Correction and the
printer may not be able to print the image data properly.

* When the Grayscale Printing check box on the Main tab is checked, Color Correction appears
grayed out and is unavailable.

Related Topics

= Optimal Photo Printing of Image Data
= Adjusting Colors with the Printer Driver
= Printing with ICC Profiles
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Optimal Photo Printing of Image Data

When people print images taken with digital cameras, they sometimes feel that the printed color tones differ
from those of actual image or those displayed on the monitor.

To get the print results as close as possible to the desired color tones, you must select a printing method
that is best suited to the application software used or to your purpose.

Color Management

Devices such as digital cameras, scanners, monitors, and printers handle color differently. Color
management (color matching) is a method that manages device-dependent "colors" as a common color
space.

For Windows, a color management system called "ICM" is built into the operating system.
sRGB is one of the common color spaces that is frequently used.

ICC profiles convert device-dependent "colors" into a common color space. By using an ICC profile and
carrying out color management, you can draw out the color space of the image data within the color
reproduction area that the printer can express.

Selecting a Printing Method Suited to the Image Data

The recommended printing method depends on the color space (sRGB) of the image data or the
application software to be used.

There are two typical printing methods.
Check the color space (sRGB) of the image data and the application software to be used, and then select
the printing method suited to your purpose.

Adjusting Colors with the Printer Driver
Describes the procedure for printing sRGB data by using the color correction function of the printer
driver.
* To print using Canon Digital Photo Color

The printer prints data with color tints that most people prefer, reproducing colors of the original
image data and producing three-dimensional effects and high, sharp contrasts.
+ To print by directly applying editing and touch-up results of an application software

When printing the data, the printer brings out subtle color difference between dark and light
areas, while leaving the darkest and lightest areas intact.

When printing the data, the printer applies fine adjustment results, such as brightness
adjustments made with an application software.

Printing with ICC Profiles
Describes the procedure for printing by using the color space of sRGB effectively.
You can print with a common color space by setting up the application software and the printer driver
so that the color management matches the input ICC profile of the image data.
The method for setting up the printer driver differs depending on the application software to be used.
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Adjusting Colors with the Printer Driver

You can specify the color correction function of the printer driver to print SRGB data with color tints that most
people prefer through the use of Canon Digital Photo Color.

When printing from an application software that can identify ICC profiles and allows you to specify them, use
a printing ICC profile in the application software, and select settings for color management.

The procedure for adjusting colors with the printer driver is as follows:

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
The Manual Color Adjustment dialog box opens.

3. Select color correction

Click Matching tab, and select Driver Matching for Color Correction.
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4. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, Intensity, and Contrast settings, and then click OK.

5. Complete the setup

Click OK on the Main tab.
When you execute print, the printer driver adjusts the colors when printing the data.

Related Topics

= Specifying Color Correction
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= Adjusting Color Balance
= Adjusting Brightness

= Adjusting Intensity

= Adjusting Contrast
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Printing with ICC Profiles

When the image data has a specified input ICC profile, you can print by using the color space (sRGB) of the
data effectively.

The printer driver setting procedure varies depending on the application software used to print.

Specify an ICC Profile from the Application Software and Print the Data

When you print the editing and touch-up results of Adobe Photoshop, Canon Digital Photo Professional,
or any application software that allows you to specify input and printing ICC profiles, you print by
effectively using the color space of the input ICC profile specified in the image data.

To use this printing method, use your application software to select color management items and specify
an input ICC profile and a printing ICC profile in the image data.

Even if you print using a printing ICC profile that you created yourself from your application software, be
sure to select color management items from your application software.

For instructions, refer to the manual of the application software you are using.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
The Manual Color Adjustment dialog box opens.

3. Select color correction

Click Matching tab, and select None for Color Correction.
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4. Set the other items

510



If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, Intensity, and Contrast settings, and then click OK.

5. Complete the setup

Click OK on the Main tab.
When you execute print, the printer uses the color space of the image data.

Specify an ICC Profile with the Printer Driver, and then Print

Print from an application software that cannot identify input ICC profiles or does allow you to specify one
by using the color space of the input ICC profile (sRGB) found in the data.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
The Manual Color Adjustment dialog box opens.

3. Select color correction

Click Matching tab, and select ICM (ICC Profile Matching) for Color Correction.

Manual Color Adjustment
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4. Set the other items

If necessary, click Color Adjustment tab, and adjust Cyan, Magenta, Yellow, Brightness, Intensity,
and Contrast settings, and then click OK.

5. Complete the setup
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Click OK on the Main tab.
When you execute print, the printer uses the color space of the image data.

Related Topics

= Specifying Color Correction
= Adjusting Color Balance

= Adjusting Brightness

= Adjusting Intensity

= Adjusting Contrast
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Adjusting Color Balance

You can adjust the color tints when printing.

Since this function adjusts color balance of the output by changing the ink ratios of each color, it changes
the total color balance of the document. Use the application software when you want to change the color
balance significantly. Use the printer driver only when you want to adjust the color balance slightly.

The following sample shows the case when color balance is used to intensify cyan and to diminish yellow so
that the overall colors are more uniform.

"

No adjustment  Adjust color balance

The procedure for adjusting color balance is as follows:

You can also set color balance on the Quick Setup tab by choosing Photo Printing under Commonly
Used Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment
On the Main tab, select Manual for Color/Intensity, and click Set....
Printing Preferences

RS

Masds Tupes

The Manual Color Adjustment dialog box opens.
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3. Adjust color balance

There are individual sliders for Cyan, Magenta, and Yellow. Each color becomes stronger when the
corresponding slider is moved to the right, and becomes weaker when the corresponding slider is moved
to the left. For example, when cyan becomes weaker, the color red becomes stronger.

You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.
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4. Complete the setup

Click OK on the Main tab.
When you execute print, the document is printed with the adjusted color balance.

22 Important

» When the Grayscale Printing check box on the Main tab is checked, the color balance (Cyan,
Magenta, Yellow) appear grayed out and are unavailable.

Related Topics

= Specifying Color Correction

= Adjusting Color Balance Using Sample Patterns (Printer Driver)
= Adjusting Brightness

= Adjusting Intensity
[
=

Adjusting Contrast
Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
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Adjusting Color Balance Using Sample Patterns (Printer Driver)

You can look at the print results of pattern print and adjust the color balance.
When you change the color balance or intensity/contrast of a document, the pattern print function prints the
adjustment results in a list, together with the adjustment values.

Described below is the procedure for adjusting the color balance while looking at the pattern.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
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The Manual Color Adjustment dialog box opens.

3. Selecting pattern print

On the Color Adjustment tab, select the Print a pattern for color adjustment check box, and click
Pattern Print preferences....
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4. Setting pattern print
When the Pattern Print dialog box opens, set the following items, and then click OK.

() lrtenaity Contrast
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Parameters to Adjust
Select Cyan/Magenta/Yellow.

32 Important

» When the Grayscale Printing check box on the Main tab is checked, Cyan/Magenta/Yellow
appear grayed out and are unavailable.

Printer Paper Size
Select the paper size to be used for pattern printing.

23> Note

» Depending on the paper size selected on the Page Setup tab, there may be sizes that cannot
be selected.

Amount of Pattern Instances
Select Largest, Large, or Small to set the number of patterns to be printed.

23> Note

» Largest and Large cannot be selected when certain paper sizes or output paper sizes are
selected.
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Color Variation Between Instances
Set the amount of color change between neighboring patterns.

»» Note

* Large is about double the size of Medium, and Small is about half the size of Medium.

5. Checking the print results of pattern print

On the Color Adjustment tab, select OK to close the Manual Color Adjustment dialog box.
On the Main tab, select OK, and then execute printing. The printer then prints a pattern in which the
color balance that you set is the center value.
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6. Adjusting the color balance

Look at the print results and select the image that you like best. Then enter the color balance numbers
indicated at the bottom of that image into the Cyan, Magenta, and Yellow fields on the Color
Adjustment tab.

Clear the Print a pattern for color adjustment check box, and click OK.
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> Note

* You can also set color balance on the Quick Setup tab by choosing Photo Printing under
Commonly Used Settings, and then choosing Color/intensity Manual Adjustment under
Additional Features.

7. Complete the setup

Click OK on the Main tab.
Then when you execute printing, the document is printed with the color balance that was adjusted by the
pattern print function.

32 Important

* When Print a pattern for color adjustment is selected on the Color Adjustment tab, the following
items are grayed out and cannot be set:
» Preview before printing on the Main tab
+ Stapling Side and Specify Margin... on the Page Setup tab (When Duplex Printing is set, only
Stapling Side can be set.)

* When the Print a pattern for color adjustment on the Color Adjustment tab is checked, the Page
Layout on the Page Setup tab is set to Normal-size.

* When the Grayscale Printing check box on the Main tab is checked, Cyan, Magenta, and Yellow
appear grayed out and are unavailable.

» Depending on your application software, this function may not be available.

Related Topics

= Adjusting Color Balance

= Adjusting Intensity

= Adjusting Contrast

= Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
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Adjusting Brightness

You can change the brightness of the overall image data during printing.

This function does not change pure white or pure black but it changes the brightness of the intermediate
colors.

The following sample shows the print result when the brightness setting is changed.

Light is selected Normal is selected Dark is selected

The procedure for adjusting brightness is as follows:

You can also set brightness on the Quick Setup tab by choosing Photo Printing under Commonly Used
Settings, and then choosing Color/intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
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The Manual Color Adjustment dialog box opens.

3. Specify the brightness
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Select Light, Normal, or Dark for Brightness, and click OK. The current settings are displayed in the
settings preview on the left side of the printer driver.
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4. Complete the setup

Click OK on the Main tab.
When you execute print, the data is printed at the specified brightness.

Related Topics

= Specifying Color Correction
= Adjusting Color Balance

= Adjusting Intensity

= Adjusting Contrast
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Adjusting Intensity

You can dilute (brighten) or intensify (darken) the colors of the overall image data during printing.
The following sample shows the case when the intensity is increased so that all colors become more intense
when the image data is printed.

No adjustment Higher intensity

The procedure for adjusting intensity is as follows:

You can also set intensity on the Quick Setup tab by choosing Photo Printing under Commonly Used
Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
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The Manual Color Adjustment dialog box opens.

3. Adjust intensity

Moving the Intensity slider to the right intensifies (darkens) the colors, and moving the slider to the left
dilutes (brightens) the colors.
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You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.
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4. Complete the setup

Click OK on the Main tab.
When you execute print, the image data is printed with the adjusted intensity.

Related Topics

= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Color Balance Using Sample Patterns (Printer Driver)
= Adjusting Brightness
=
=

Adjusting Contrast
Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
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Adjusting Contrast

You can adjust the image contrast during printing.

To make the differences between the light and dark portions of images greater and more distinct, increase
the contrast. On the other hand, to make the differences between the light and dark portions of images
smaller and less distinct, reduce the contrast.

No adjustment Adjust the contrast

The procedure for adjusting contrast is as follows:

You can also set contrast on the Quick Setup tab by choosing Photo Printing under Commonly Used
Settings, and then choosing Color/intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....

Pl Paper
Lemar 852117 2262 Bem

-

The Manual Color Adjustment dialog box opens.

3. Adjust the contrast
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Moving the Contrast slider to the right increases the contrast, and moving the slider to the left decreases
the contrast.

You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.
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4. Complete the setup

Click OK on the Main tab.
When you execute print, the image is printed with the adjusted contrast.

Related Topics

= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Color Balance Using Sample Patterns (Printer Driver)
= Adjusting Brightness
=
(=Y

Adjusting Intensity
Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
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Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)

You can look at the print results of pattern print and adjust the intensity/contrast.
When you change the color balance or intensity/contrast of a document, the pattern print function prints the
adjustment results in a list, together with the adjustment values.

Described below is the procedure for adjusting the intensity/contrast while looking at the pattern.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
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The Manual Color Adjustment dialog box opens.

3. Selecting pattern print

On the Color Adjustment tab, select the Print a pattern for color adjustment check box, and click
Pattern Print preferences....
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4. Setting pattern print

When the Pattern Print dialog box opens, set the following items, and then click OK.
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Parameters to Adjust
Select Intensity/Contrast.

Printer Paper Size
Select the paper size to be used for pattern printing.

23> Note

» Depending on the paper size selected on the Page Setup tab, there may be sizes that cannot
be selected.

Amount of Pattern Instances
Select Largest, Large, or Small to set the number of patterns to be printed.

23> Note

 Largest and Large cannot be selected when certain paper sizes or output paper sizes are
selected.

Color Variation Between Instances
Set the amount of color change between neighboring patterns.

23> Note

» Large is about double the size of Medium, and Small is about half the size of Medium.
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5. Checking the print results of pattern print

On the Color Adjustment tab, select OK to close the Manual Color Adjustment dialog box.
On the Main tab, select OK, and then execute printing. The printer then prints a pattern in which the
intensity/contrast that you set is the center value.
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6. Adjusting the intensity/contrast

Look at the print results and select the image that you like best. Then enter the intensity/contrast
numbers indicated at the bottom of that image into the Intensity and Contrast fields on the Color
Adjustment tab.

Clear the Print a pattern for color adjustment check box, and click OK.

527



Manual Color Adjustment “
Coler Adhpsinest | Mygchng
-‘mm-l__ Cvar i} - .
Lives High
! Em . ) . .
Lirssr High
e — Yol o . .
h Lot Highy
&% ABCDEF
"wb 1234567 | ST e -
[T e Cobor Pastem] [ T o] [ ]
Light Dk
ot E 1 ] o
Litem Heg
Pricd i s o Solin? o ca vl
[ Cetoas |
o || Cance Yo
> Note

* You can also set intensity/contrast on the Quick Setup tab by choosing Photo Printing under
Commonly Used Settings, and then choosing Color/intensity Manual Adjustment under
Additional Features.

7. Complete the setup

Click OK on the Main tab.
Then when you execute printing, the document is printed with the intensity/contrast that was adjusted by

the pattern print function.

32 Important

* When Print a pattern for color adjustment is selected on the Color Adjustment tab, the following
items are grayed out and cannot be set:
» Preview before printing on the Main tab
+ Stapling Side and Specify Margin... on the Page Setup tab (When Duplex Printing is set, only
Stapling Side can be set.)

* You can print a pattern only if Normal-size is selected for Page Layout on the Page Setup tab.
» Depending on your application software, this function may not be available.

Related Topics

= Adjusting Color Balance

= Adjusting Color Balance Using Sample Patterns (Printer Driver)
= Adjusting Intensity

= Adjusting Contrast
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Overview of the Printer Driver

>

>

Canon lJ Printer Driver

How to Open the Printer Driver Setup Window
Canon |J Status Monitor

Checking the Ink Status from Your Computer
Canon IJ Preview

Deleting the Undesired Print Job

Instructions for Use (Printer Driver)
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Canon |IJ Printer Driver

The Canon IJ printer driver (called printer driver below) is a software that is installed on your computer for
printing data with this printer.

The printer driver converts the print data created by your application software into data that your printer can
understand, and sends the converted data to the printer.

Because different models support different print data formats, you need a printer driver for the specific model
you are using.

Printer Driver Types

On Windows Vista SP1 or later, you can install the XPS printer driver in addition to the regular printer
driver.
The XPS printer driver is suited to print from an application software that supports XPS printing.

2% Important

» To use the XPS printer driver, the standard printer driver must already be installed on your computer.

Installing the Printer Driver

 To install the regular printer driver, load the Setup CD-ROM that comes with the printer, and then
install the driver from Start Setup Again.

* To install the XPS printer driver, load the Setup CD-ROM that comes with the printer, and then select
XPS Driver from Add Software.

Specifying the Printer Driver

To specify the printer driver, open the Print dialog box of the application software you are using, and
select "XXX Printer" (where "XXX" is your model name) to specify the regular printer driver or select "XXX
Printer XPS" (where "XXX" is your model name) to specify the XPS printer driver.

Displaying the Manual from the Printer Driver

To display a description of a tab in the printer driver setup window, click the Help button found on the tab.

Related Topic

= How to Open the Printer Driver Setup Window
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How to Open the Printer Driver Setup Window

You can display the printer driver setup window from the application software in use or from the printer icon.

Open the Printer Driver Setup Window through the Application Software

Follow the procedure below to configure printing profile when printing.

1. Select the command that you perform printing on the application software

In general, select Print on the File menu to open the Print dialog box.

2. Select your model name and click Preferences (or Properties)

The printer driver setup window appears.

»» Note

» Depending on application software you use, command names or menu names may vary and
there may be more steps. For details, refer to the user's manual of your application software.

Opening the Printer Driver Setup Window from the Printer Icon

Follow the procedure below to perform printer maintenance operations such as print head cleaning, or to
configure a printing profile that is common to all application software.

1. Select as described below:

« If you are using Windows 10, Windows 8.1 or Windows 8, select Control Panel -> Hardware
and Sound -> Devices and Printers.

* If you are using Windows 7, select the Start menu -> Devices and Printers.

* If you are using Windows Vista, select the Control Panel -> Hardware and Sound -> Printers.

2. Right-click your model name icon, and then select Printing preferences from the

displayed menu
The printer driver setup window appears.

32 Important

» Opening the printer driver setup window through Printer properties (Windows 10, Windows
8.1, Windows 8, Windows 7) or Properties (Windows Vista) displays such tabs regarding the
Windows functions as the Ports (or Advanced) tab. Those tabs do not appear when opening
through Printing preferences or application software. For tabs regarding Windows functions,
refer to the user's manual for the Windows.
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Canon IJ Status Monitor

The Canon IJ Status Monitor is an application software that shows the status of the printer and the progress
of printing. You will know the status of the printer with graphics, icons, and messages.

Launching the Canon IJ Status Monitor

The Canon IJ Status Monitor launches automatically when print data is sent to the printer. When
launched, the Canon IJ Status Monitor appears as a button on the task bar.

{pticn  Igk Details  Help
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13» Note

» To open the Canon |J Status Monitor when the printer is not printing, open the printer driver setup
window and click View Printer Status on the Maintenance tab.

» The information displayed on the Canon IJ Status Monitor may differ depending on the country or
region where you are using your printer.

When Errors Occur

The Canon IJ Status Monitor is automatically displayed if an error occurs (e.g., if the printer runs out of
paper or if the ink is low).

1, FE paper milo the casene 1, 2. Tap [OK] on the penter.

T Erer Parmta

In such cases, take the appropriate action as described.
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Checking the Ink Status from Your Computer

You can check the remaining ink level and the ink tank types for your model.

1. Open the printer driver setup window

2. Launching the Canon IJ Status Monitor

On the Maintenance tab, click View Printer Status.
The Canon |J Status Monitor opens and displays an image of the ink status.
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»» Note

» The information displayed on the Canon IJ Status Monitor may differ depending on the country or

region where you are using your printer.

3. If necessary, click Ink Details

You can check the ink-related information.

If a warning or error related to the remaining ink amount occurs, a notification icon is displayed at the top

of the image in the Ink Details dialog box.
In such cases, take the appropriate action as described on the screen.

> Note

* You can also display the Ink Details dialog box by selecting the ink icon on the Canon IJ Status

Monitor.
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Canon |IJ Preview

The Canon IJ Preview is an application software that displays what the print result will look like before a
document is actually printed.

The preview reflects the information that is set within the printer driver and allows you to check the
document layout, print order, and number of pages. You can also change the media type and paper source
settings.

When you want to display a preview before printing, open the printer driver setup window, click the Main
tab, and check the Preview before printing check box.

When you do not want to display a preview before printing, uncheck the check box.

32 Important

+ If you are using the XPS printer driver, see "Editing the Print Document or Reprinting from the Print
History."

Related Topic

= Displaying the Print Results before Printing
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Deleting the Undesired Print Job

If you are using the XPS printer driver, replace "Canon |J Status Monitor" with "Canon IJ XPS Status
Monitor" when reading this information.

If the printer does not start printing, canceled or failed print job data may be remaining.
Delete the undesired print job by using the Canon IJ Status Monitor.

1. Display the Canon IJ Status Monitor

Click the icon of the Canon |J Status Monitor displayed on the task bar.
The Canon |J Status Monitor appears.

2. Display the print jobs

Click Display Print Queue.
The print queue window opens.

3. Delete the print jobs

Select Cancel All Documents from the Printer menu.
When the confirmation message appears, click Yes.

The deletion of the print job is complete.

22 Important

» Users who have not been granted access permission for printer management cannot delete the print
job of another user.

»» Note

* When you perform this operation, all print jobs are deleted. If the print queue list contained a necessary
print job, start the printing process over from the beginning.
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Instructions for Use (Printer Driver)

This printer driver is subject to the following restrictions. Keep the following points in mind when using the
printer driver.

Restrictions on the Printer Driver

Depending on the document type to be printed, the paper feed method specified in the printer driver
may not operate correctly.
If this happens, open the printer driver setup window from the Print dialog box of the application
software, and check the setting in the Paper Source field on the Main tab.
With some applications, the Copies setting in the Page Setup tab of the printer driver may not be
enabled.
In this case, use the copies setting in the Print dialog box of the application software.
If the selected Language in the About dialog box of the Maintenance tab does not match the
operating system interface language, the printer driver setup window may not be displayed properly.
Do not change the Advanced tab items of the printer properties. If you change any of the items, you
will not be able to use the following functions correctly.
Also, if Print to file is selected in the Print dialog box of the application software and with applications
that prohibit EMF spooling, such as Adobe Photoshop LE and MS Photo Editor, the following
functions will not operate.

o Preview before printing on the Main tab

> Prevention of Print Data Loss in the Print Options dialog box on the Page Setup tab

o Page Layout, Tiling/Poster, Booklet, Duplex Printing, Specify Margin..., Print from Last

Page, Collate, and Stamp/Background... (Stamp...) on the Page Setup tab
o Print a pattern for color adjustment on the Color Adjustment tab in the Manual Color
Adjustment dialog box

Since the resolution in the preview display differs from the printing resolution, text and lines in the
preview display may appear different from the actual print result.

With some applications, the printing is divided into multiple print jobs.

To cancel printing, delete all divided print jobs.

If image data is not printed correctly, display the Print Options dialog box from the Page Setup tab
and change the setting of Disable ICM required from the application software. This may solve the
problem.

> Note

» Disable ICM required from the application software cannot be used when the XPS printer
driver is used.

Do not start up the Canon IJ Network Tool while printing.
Do not print when the Canon IJ Network Tool is running.

Points to Note About Applications with Restrictions

» There are following restrictions in Microsoft Word (Microsoft Corporation).

o When Microsoft Word has the same printing functions as the printer driver, use Word to specify
them.
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o When Fit-to-Page, Scaled, or Page Layout is used for Page Layout on the Page Setup tab of
the printer driver, the document may not print normally in certain versions of Word.

o When Page Size in Word is set to "XXX Enlarge/Reduce", the document may not print normally in
certain versions of Word.
If this happens, follow the procedure below.

1.
2.

o g R

7.

Open Word's Print dialog box.

Open the printer driver setup window, and on the Page Setup tab, set Page Size to the same
paper size that you specified in Word.

Set the Page Layout that you want, and then click OK to close the window.

Without starting printing, close the Print dialog box.

Open Word's Print dialog box again.

Open the printer driver setup window and click OK.

Start printing.

« If bitmap printing is enabled in Adobe lllustrator (Adobe Systems Incorporated), printing may take time
or some data may not be printed. Print after unchecking the Bitmap Printing check box in the Print
dialog box.
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Printer Driver Description

¥

Quick Setup tab Description

¥

Main tab Description

¥

Page Setup tab Description

¥

Maintenance tab Description

¥

Canon IJ Preview Description

¥

Canon IJ XPS Preview Description

¥

Canon IJ Status Monitor Description
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Quick Setup tab Description

The Quick Setup tab is for registering commonly used print settings. When you select a registered setting,
the printer automatically switches to the preset items.
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Commonly Used Settings

The names and icons of frequently used printing profiles are registered. When you select a printing
profile according to the purpose of the document, settings that match the purpose are applied.
In addition, functions that are thought to be useful for the selected printing profile are displayed in
Additional Features.
You can also change a printing profile and register it under a new name. You can delete the registered
printing profile.
You can rearrange the profiles either by dragging the individual profiles or by holding down the Ctrl key
and pressing the up or down arrow keys.
Standard
These are the factory settings.
If Page Size, Orientation, and Copies were set from the application software, those settings have
priority.

Business Document
Select this setting when printing a general document.
If Page Size, Orientation, and Copies were set from the application software, those settings have
priority.

Paper Saving
Select this setting to save paper when printing a general document. The 2-on-1 Printing and
Duplex Printing check boxes are checked automatically.

If Page Size, Orientation, and Copies were set from the application software, those settings have
priority.
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Photo Printing
If you select this setting when printing a photo, the photo paper and photo size generally used are
set.
If Orientation and Copies were set from the application software, those settings have priority.

Envelope
If you select this setting for printing an envelope, Media Type is set automatically to Envelope. In
the Envelope Size Setting dialog box, select the size of the envelope to be used.

»» Note

» The combination of the Additional Features that was displayed for the printing profile that had
been selected when the added printing profile was saved is also displayed when that added
printing profile is selected.

Save...
Displays the Save Commonly Used Settings dialog box.
Click this button when you want to save the information that you set on the Quick Setup, Main, and
Page Setup tabs to Commonly Used Settings.

Delete
Deletes a registered printing profile.
Select the name of the setting to be deleted from Commonly Used Settings, and click Delete. When a
confirmation message is displayed, click OK to delete the specified printing profile.

»» Note

+ Printing profiles that are registered in the initial settings cannot be deleted.

Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.

Preview before printing
Shows what the print result will look like before you actually print the data.
Check this check box to display a preview before printing.
Uncheck this check box if you do not want to display a preview.
32 Important

» To use the Canon IJ XPS Preview, you must have Microsoft .NET Framework 4 Client Profile
installed on your computer.

Additional Features
Displays the frequently used, convenient functions for the printing profile that you selected for
Commonly Used Settings on the Quick Setup tab.
When you move the mouse pointer near a function that can be changed, a description of that function is
displayed.
To enable a function, check the corresponding check box.
For some functions, you can set detailed settings from the Main and Page Setup tabs.
32 Important

» Depending on the printing profiles, certain function may be grayed out and you will not be able to
change them.
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2-on-1 Printing
Prints two pages of the document, side by side, on one sheet of paper.
To change the page sequence, click the Page Setup tab, select Page Layout for Page Layout,
and click Specify.... Then in the Page Layout Printing dialog box that appears, specify the Page
Order.

4-on-1 Printing
Prints four pages of the document, side by side, on one sheet of paper.
To change the page sequence, click the Page Setup tab, select Page Layout for Page Layout,
and click Specify.... Then in the Page Layout Printing dialog box that appears, specify the Page
Order.

Duplex Printing
Selects whether to print the document on both sides or one side of a sheet of paper.
To change the staple side or the margins, set the new values from the Page Setup tab.

Grayscale Printing
This function converts the data to monochrome data when printing your document.

Rotate 180 degrees
Prints the document by rotating it 180 degrees against the paper feed direction.
The width of print area and the amount of extension that are configured in other application
software will be reversed vertically and horizontally.

Color/Intensity Manual Adjustment
Select when you set the Color Correction method and individual settings such as Cyan, Magenta,
Yellow, Brightness, Intensity, and Contrast, etc.

Media Type
Selects a type of printing paper.
Select a media type that matches the paper that is loaded in the printer. This ensures that printing is
carried out properly for the specified paper.

Printer Paper Size
Selects the size of paper actually loaded into the printer.
Normally, the paper size is set automatically according to the output paper size setting, and the
document is printed with no scaling.
When you set 2-on-1 Printing or 4-on-1 Printing in Additional Features, you can manually set the
paper size with Page Size on the Page Setup tab.
If you select a paper size that is smaller than the Page Size, the document size will be reduced. If you
select a paper size that is larger, the document size will be enlarged.
Also if you select Custom..., the Custom Paper Size dialog box opens and allows you to specify any
vertical and horizontal dimensions for the paper size.

Orientation
Selects the printing orientation.
If the application used to create your document has a similar function, select the same orientation that
you selected in that application.
Portrait
Prints the document so that its top and bottom positions are unchanged relative to the paper feed
direction. This is the default setting.
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Landscape
Prints the document by rotating it 90 degrees relative to the paper feed direction.
You can change the rotation direction by going to the Maintenance tab, opening the Custom
Settings dialog box, and then using Rotate 90 degrees left when orientation is [Landscape]
check box.
To rotate the document 90 degrees to the left when printing, select the Rotate 90 degrees left
when orientation is [Landscape] check box.

Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.
High
Gives priority to print quality over printing speed.
Standard
Prints with average speed and quality.

Paper Source
Select the source from which paper is supplied.
Cassette (Auto Select)
Based on the paper settings on the printer driver and the cassette paper information registered on
the printer, the printer automatically determines which cassette to use and feeds paper from that
cassette.

Cassette 1
Paper is fed from the cassette 1.

Cassette 2
Paper is fed from the cassette 2.

32 Important

» Depending on the media type and size, the Paper Source settings that can be selected may differ.

Copies
Specifies the number of copies you want to print. You can specify a value from 1 to 999.

3» Important

* When the application software that you used to create the document has the same function,
specify the settings on the printer driver. However, if the print results are not acceptable, specify the
function settings on the application software.

Always Print with Current Settings
Prints documents with the current settings starting from the next print execution.
When you select this function and then close the printer driver setup window, the information that you
set on the Quick Setup, Main, and Page Setup tabs are saved and printing with the same settings is

possible starting from the next print execution.
32 Important

+ If you log on with a different user name, the settings that were set when this function was enabled
are not reflected in the print settings.
« If a setting was specified on the application software, it has priority.
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Printer Media Information...
Displays Printer Media Information dialog box.
You can check the printer settings and apply the checked settings to the printer driver.

Defaults
Restores all the settings you have changed to their default values.
Click this button to return all settings on the Quick Setup, Main, and Page Setup tabs to their default
values (factory settings).

Save Commonly Used Settings dialog box

This dialog box allows you to save the information that you set on the Quick Setup, Main, and Page
Setup tabs and add the information to the Commonly Used Settings list on the Quick Setup tab.

Name
Enter the name for the printing profile you wish to save.
Up to 255 characters can be entered.
The name appears, with its associated icon, in the Commonly Used Settings list on the Quick
Setup tab.

Options...
Opens the Save Commonly Used Settings dialog box.
Changes the details of printing profile to be saved.

Save Commonly Used Settings dialog box

Select the icons of the printing profiles to be registered to Commonly Used Settings, and change the
items to be saved in the printing profiles.

Icon
Select the icon for the printing profile you wish to save.
The selected icon appears, with its name, in the Commonly Used Settings list on the Quick
Setup tab.

Save the paper size setting
Saves the paper size to the printing profile in Commonly Used Settings.
To apply the saved paper size when the printing profile is selected, check this check box.
If this check box is unchecked, the paper size is not saved, and consequently the paper size setting
is not applied when the printing profile is selected. Instead the printer prints with the paper size
specified with the application software.

Save the orientation setting
Saves the Orientation to the printing profile in Commonly Used Settings.
To apply the saved print orientation when the printing profile is selected, check this check box.
If this check box is unchecked, the print orientation is not saved, and consequently the Orientation
setting is not applied when the printing profile is selected. Instead the printer prints with the print
orientation specified with the application software.

Save the copies setting
Saves the Copies setting to the printing profile in Commonly Used Settings.
To apply the saved copies setting when the printing profile is selected, check this check box.
If this check box is unchecked, the copies setting is not saved, and consequently the Copies
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setting is not applied when the printing profile is selected. Instead the printer prints with the copies
setting specified with the application software.

Custom Paper Size dialog box

This dialog box allows you to specify the size (width and height) of the custom paper.

Units
Select the unit for entering a user-defined paper size.

Paper Size
Specifies the Width and the Height of the custom paper. Measurement is shown according to the
units specified in Units.

Printer Media Information dialog box

This dialog box allows you to check the printer settings and apply the checked settings to the printer
driver.

Paper Source
Check the setting or select a new paper source.

Media Type
Displays the Media Type that is currently set on the printer.
To apply the displayed setting to the printer driver, click Set.

Page Size
Displays the Page Size that is currently set on the printer.
To apply the displayed setting to the printer driver, click Set.

Related Topics

Printing with Easy Setup

Setting a Page Size and Orientation

Setting the Number of Copies and Printing Order

Duplex Printing

Setting Up Envelope Printing

Printing on Postcards

Switching the Paper Source to Match the Purpose

Displaying the Print Results before Printing

Setting Paper Dimensions (Custom Size)

Printing a Color Document in Monochrome

Specifying Color Correction

Adjusting Color Balance

Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Brightness

Adjusting Intensity

Adjusting Contrast

Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
Registering a Frequently Used Printing Profile

$F4 3333333000000
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Main tab Description

The Main tab allows you to create a basic print setup in accordance with the media type. Unless special
printing is required, normal printing can be performed just by setting the items on this tab.
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Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.
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Check whether the printer is set up correctly by looking at the illustration before you start printing.
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Media Type
Selects a type of printing paper.
Select a media type that matches the paper that is loaded in the printer. This ensures that printing is
carried out properly for the specified paper.

Paper Source
Shows the source from which paper is supplied.
You may be able to switch the paper source with the printer driver.
Cassette (Auto Select)
Based on the paper settings on the printer driver and the cassette paper information registered on
the printer, the printer automatically determines which cassette to use and feeds paper from that
cassette.

Cassette 1
Paper is fed from the cassette 1.

Cassette 2
Paper is fed from the cassette 2.

32 Important

» Depending on the media type and size, the Paper Source settings that can be selected may differ.
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Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.

32 Important

» Depending on the Media Type settings, the same print results may be produced even if the Print
Quality is changed.

High

Gives priority to print quality over printing speed.
Standard

Prints with average speed and quality.

Color/intensity
Selects color adjustment method.

Auto
Cyan, Magenta, Yellow, Brightness, Intensity, and Contrast, and so on are adjusted

automatically.

Manual
Select when you set the individual settings such as Cyan, Magenta, Yellow, Brightness,

Intensity, and Contrast, etc. and Color Correction method.

Set...
Select Manual for Color/Intensity to enable this button.
In the Manual Color Adjustment dialog box, you can adjust individual color settings such as
Cyan, Magenta, Yellow, Brightness, Intensity, and Contrast on the Color Adjustment tab, and
select the Color Correction method on the Matching tab.

»>» Note

+ If you want to use an ICC profile to adjust colors, use the Manual Color Adjustment dialog

box to set the profile.

Grayscale Printing
This function converts the data to monochrome data when printing your document.

Check this check box to print a color document in monochrome.

Preview before printing
Shows what the print result will look like before you actually print the data.

Check this check box to display a preview before printing.
3» Important

» To use the Canon |J XPS Preview, you must have Microsoft .NET Framework 4 Client Profile
installed on your computer.

Defaults
Restores all the settings you have changed to their default values.
Clicking this button restores all the settings on the current screen to their default values (factory

settings).
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Color Adjustment Tab

This tab allows you to adjust the color balance by changing the settings of the Cyan, Magenta, Yellow,
Brightness, Intensity, and Contrast options.

Preview
Shows the effect of color adjustment.
The color and brightness change when each item is adjusted.

»» Note

» The graphic is in monochrome when the Grayscale Printing check box is checked.

View Color Pattern
Displays a pattern for checking color changes produced by color adjustment.
If you want to display the preview image with a color pattern, check this check box.

Cyan / Magenta / Yellow
Adjusts the strengths of Cyan, Magenta, and Yellow.
Moving the slider to the right makes a color stronger, and moving the slider to the left makes a color
weaker.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.
This adjustment changes the relative amount of ink of each color used, which alters the total color
balance of the document. Use your application if you want to change the total color balance
significantly. Use the printer driver only if you want to adjust the color balance slightly.

22 Important

* When Grayscale Printing is checked on the Main tab, Cyan, Magenta, and Yellow appear
grayed out and are unavailable.

Brightness
Selects the brightness of your print.
You cannot change the levels of pure white and black. However, the brightness of the colors between
white and black can be changed.

Intensity
Adjusts the overall intensity of your print.
Moving the slider to the right increases the intensity, and moving the slider to the left decreases the
intensity.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.

Contrast
Adjusts the contrast between light and dark in the image to be printed.
Moving the slider to the right increases the contrast, moving the slider to the left decreases the
contrast.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.

Print a pattern for color adjustment
When the color balance or intensity/contrast is changed, the pattern printing function prints a list of
the adjustment results along with the adjustment values.
Select this function when printing a pattern for color adjustment.
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Pattern Print preferences...
Check Print a pattern for color adjustment to enable this button.

The Pattern Print dialog box opens and allows you to set pattern printing settings.

Pattern Print dialog box

Performs the setup for printing of patterns that allow you to check the color balance and intensity/

contrast of documents.

Parameters to Adjust
Select the item to be checked by pattern printing.
Cyan/Magenta/Yellow
Prints a pattern that allows you to check the cyan/magenta/yellow balance.

22 Important

* When Grayscale Printing is checked on the Main tab, Cyan/Magenta/Yellow appear
grayed out and are unavailable.

Intensity/Contrast
Prints a pattern that allows you to check the intensity/contrast balance.

Printer Paper Size
Selects the paper size to be used for pattern printing.
This setting is linked to Printer Paper Size on the Page Setup tab.

»>» Note

» Depending on the paper size selected on the Page Setup tab, there may be sizes that cannot

be selected.

Amount of Pattern Instances
Sets the number of patterns to be printed.
You can select from Largest, Large, and Small. When you select a pattern size, the number of

patterns that can be printed is as follows:

> Note

» Largest and Large cannot be selected when certain paper sizes or output paper sizes are

selected.
* The setting preview on the Main tab displays an image that allows you to check the overall

layout.

Largest
Cyan/Magenta/Yellow 37
Intensity/Contrast 49

Large
Cyan/Magenta/Yellow 19
Intensity/Contrast 25

Small
Cyan/Magenta/Yellow 7
Intensity/Contrast 9
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Color Variation Between Instances
Sets the amount of color change between neighboring patterns.
Select from Large, Medium, and Small. Large produces a large amount of change, and Small
produces a small amount of change.

> Note

» Large is about double the size of Medium, and Small is about half the size of Medium.

Matching Tab

Allows you to select the method for adjusting colors to match the type of document to be printed.

Color Correction
Allows you to select Driver Matching, ICM (ICC Profile Matching), or None to match the purpose of
the print operation.

22 Important

* When Grayscale Printing is checked on the Main tab, Color Correction appears grayed out
and is unavailable.

Driver Matching
With Canon Digital Photo Color, you can print sSRGB data with color tints that most people prefer.

ICM (ICC Profile Matching)
Adjusts the colors by using an ICC profile when printing.

22 Important

« If the application software is set so that ICM is disabled, ICM (ICC Profile Matching) is
unavailable for Color Correction and the printer may not be able to print the image data

properly.

None
Disables color adjustment with the printer driver.

3> Note
* In the XPS printer driver, ICM has become ICC Profile Matching.

Related Topics

Adjusting Color Balance

Adjusting Brightness

Adjusting Intensity

Adjusting Contrast

Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
Specifying Color Correction

Adjusting Colors with the Printer Driver

Printing with ICC Profiles

Printing a Color Document in Monochrome

Displaying the Print Results before Printing

LR 2R 3R B SR 35 B SR 2R AR
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Page Setup tab Description

The Page Setup tab allows you to determine how a document is to be arranged on the paper. Also, this tab
allows you to set the number of copies and the order of printing. If the application which created the
document has a similar function, set them with the application.
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Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.
The printer illustration shows how to load paper to match the printer driver settings.
Check whether the printer is set up correctly by looking at the illustration before you start printing.
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Page Size
Selects a page size.
Ensure that you select the same page size as you selected within the application.
If you select Custom..., the Custom Paper Size dialog box opens and allows you to specify any
vertical and horizontal dimensions for the paper size.

Orientation
Selects the printing orientation.
If the application used to create your document has a similar function, select the same orientation that
you selected in that application.
Portrait
Prints the document so that its top and bottom positions are unchanged relative to the paper feed
direction. This is the default setting.

Landscape
Prints the document by rotating it 90 degrees relative to the paper feed direction.
You can change the rotation direction by going to the Maintenance tab, opening the Custom
Settings dialog box, and then using Rotate 90 degrees left when orientation is [Landscape]
check box.
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To rotate the document 90 degrees to the left when printing, select the Rotate 90 degrees left
when orientation is [Landscape] check box.

Rotate 180 degrees
Prints the document by rotating it 180 degrees against the paper feed direction.
The width of print area and the amount of extension that are configured in other application software will
be reversed vertically and horizontally.

Printer Paper Size
Selects the size of paper actually loaded into the printer.
The default setting is Same as Page Size to perform normal-sized printing.
You can select a printer paper size when you select Fit-to-Page, Scaled, Page Layout, Tiling/Poster,
or Booklet for Page Layout.
If you select a paper size that is smaller than the Page Size, the document size will be reduced. If you
select a paper size that is larger, the document size will be enlarged.
Also if you select Custom..., the Custom Paper Size dialog box opens and allows you to specify any
vertical and horizontal dimensions for the paper size.

Page Layout
Selects the size of the document you want to print and the type of printing.
Normal-size
This is the normal printing method. Select this when you do not specify any page layout.
Automatically reduce large document that the printer cannot output
If the printer cannot print the paper size of a document, the printer can automatically reduce
the size when it prints the document.
Check this check box to reduce the size when printing the document.

Fit-to-Page
This function enables you to automatically enlarge or reduce documents to fit to the paper size
loaded in the printer without changing the paper size you specified in your application software.

Scaled
Documents can be enlarged or reduced to be printed.
Specify the size in Printer Paper Size, or enter the scaling ratio in the Scaling box.
Scaling
Specifies an enlargement or reduction ratio for the document you want to print.

Page Layout
Multiple pages of document can be printed on one sheet of paper.
Specify...
Opens the Page Layout Printing dialog box.
Click this button to set details on page layout printing.

Tiling/Poster
This function enables you to enlarge the image data and divide the enlarged data into several
pages to be printed. You can also glue together these sheets of paper to create large printed
matter, such as a poster.
Specify...
Opens the Tiling/Poster Printing dialog box.
Click this button to set details on tiling/poster printing.
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Booklet
The booklet printing function allows you to print data for a booklet. Data is printed on both sides of
the paper. This type of printing ensures that pages can be collated properly, in page number order,
when the printed sheets are folded and stapled at the center.
Specify...
Opens the Booklet Printing dialog box.
Click this button to set details on booklet printing.

Duplex Printing
Selects whether to print the document automatically on both sides or one side of a sheet of paper.
Check this check box to print the document on both sides.
This function can be used only when Plain Paper is selected for Media Type and one of Normal-size,
Fit-to-Page, Scaled, or Page Layout is selected.
Automatic
Selects whether duplex printing is to be performed automatically or manually.
This check box will be enabled if Booklet is selected from the Page Layout list or the Duplex
Printing check box is checked.
To perform duplex printing automatically, check this check box.
To perform duplex printing manually, uncheck this check box.

Print Area Setup...
Opens the Print Area Setup dialog box in which you can configure the print area for automatic
duplex printing.

Stapling Side
Selects the stapling margin position.
The printer analyzes the Orientation and Page Layout settings, and automatically selects the best
stapling margin position. Check Stapling Side, and select from the list to change it.

Specify Margin...
Opens the Specify Margin dialog box.
You can specify the width of the margin.

Copies
Specifies the number of copies you want to print. You can specify a value from 1 to 999.
32 Important

« If the application used to create your document has a similar function, specify the number of copies
with the application without specifying it here.

Print from Last Page
Check this check box when you want to print from the last page in order. If you do this, you do not need
to sort the pages into their correct order after printing.
Uncheck this check box to print your document in normal order, starting from the first page.

Collate
Check this check box to group together the pages of each copy when you want to print multiple copies.
Uncheck this check box when you want to print with all pages of the same page number grouped
together.
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3» Important

+ When the application software that you used to create the document has the same function, give
priority to the printer driver settings. However, if the print results are not acceptable, specify the
function settings on the application software. When you specify the number of copies and the
printing order with both the application and this printer driver, the number of copies may be
multiplied numbers of the two settings or the specified printing order may not be enabled.

Print Options...
Opens the Print Options dialog box.
Changes detailed printer driver settings for print data that is sent from applications.

Stamp/Background... (Stamp...)
Opens the Stamp/Background (Stamp) dialog box.
The Stamp function allows you to print a stamp text or a bitmap over or behind document data. It also
allows you to print date, time and user name. The Background function allows you to print a light
illustration behind the document data.

»» Note

» With the XPS printer driver, the Stamp/Background... button has become the Stamp... button and
only the stamp function can be used.

Depending on the type of printer driver you are using and the environment, Stamp and Background
may not be available.

Custom Paper Size dialog box
This dialog box allows you to specify the size (width and height) of the custom paper.
Units

Select the unit for entering a user-defined paper size.

Paper Size
Specifies the Width and the Height of the custom paper. Measurement is shown according to the
units specified in Units.

Page Layout Printing dialog box

This dialog box allows you to select the number of document pages to be placed on one sheet of paper,
the page order, and whether a page border line is to be printed around each document page.
The settings specified in this dialog box can be confirmed in the settings preview on the printer driver.

Preview Icon
Shows the settings made on the Page Layout Printing dialog box.
You can check what the print result will look like before you actually print the data.

Page Layout
Specifies the number of document pages to fit on one sheet.

Page Order
Specifies the document orientation to be printed on a sheet of paper.
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Page Border
Prints a page border line around each document page.
Check this check box to print the page border line.

Tiling/Poster Printing dialog box

This dialog box allows you to select the size of the image to be printed. You can also make settings for cut
lines and paste markers which are convenient for pasting together the pages into a poster.
The settings specified in this dialog box can be confirmed in the settings preview on the printer driver.

Preview Icon
Shows the settings of the Tiling/Poster Printing dialog box.
You can check what the print result will look like.

Image Divisions
Select the number of divisions (vertical x horizontal).
As the number of divisions increases, the number of sheets used for printing increases. If you are
pasting pages together to create a poster, increasing the number of divisions allows you to create a
larger poster.

Print "Cut/Paste" in margins
Specifies whether to print the words "Cut" and "Paste" in the margins. These words serve as
guidelines for pasting together the pages into a poster.
Check this check box to print the words.

»>» Note

» Depending on the type of printer driver you are using and the environment, this function may not
be available.

Print "Cut/Paste” lines in margins
Specifies whether to print cut lines that serve as guidelines for pasting together the pages into a
poster.
Check this check box to print the cut lines.

Print page range
Specifies the printing range. Select All under normal circumstances.
Select Pages to specify a specific page or range.

»» Note

+ If some of the pages have not been printed well, specify the pages that do not need to be printed
by clicking them in the settings preview of the Page Setup tab. Only the pages shown on the
screen will be printed this time.

Booklet Printing dialog box

This dialog box allows you to set how to bind the document as a booklet. Printing only on one side and
printing a page border, can also be set in this dialog box.
The settings specified in this dialog box can be confirmed in the settings preview on the printer driver.
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Preview Icon
Shows the settings made on the Booklet Printing dialog box.
You can check what the document will look like when printed as a booklet.

Margin for stapling
Specifies which side of the booklet is to be stapled.

Insert blank page
Selects whether to print the document on one side or both sides of the booklet.
Check this check box to print the document on one side of the booklet and select the side to be left
blank from the list.

Margin
Specifies the width of the stapling margin.
The specified width becomes the stapling margin from the center of the sheet.

Page Border
Prints a page border line around each document page.
Check this check box to print the page border line.

Print Area Setup dialog box

When you perform duplex printing, the print area of the document becomes slightly narrower than usual.
Therefore when a document that has small margins is printed, the document may not fit on one page.
This dialog box allows you to set whether the page is to be reduced when printed so that the document
fits in one page.

Use normal-size printing
Prints the document pages without reducing them. This is the default setting.

Use reduced printing
Slightly reduces each document page so that it fits on one sheet of paper during printing.
Select this setting when using automatic duplex printing to print a document with small margins.

Specify Margin dialog box
This dialog box allows you to specify the margin width for the side to be stapled. If a document does not fit

on one page, the document is reduced when printed.

Margin
Specifies the width of the stapling margin.
The width of the side specified by Stapling Side becomes the stapling margin.

Print Options dialog box
Makes changes to print data that is sent to the printer.
Depending on the type of printer driver you are using and the environment, this function may not be

available.

Disable ICM required from the application software
Disables the ICM function required from the application software.
When an application software uses Windows ICM to print data, unexpected colors may be produced
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or the printing speed may decrease. If these problems occur, checking this check box may resolve
the problems.

32 Important

* Uncheck this check box under normal circumstances.
+ This function does not work when ICM is selected for Color Correction on the Matching tab of
the Manual Color Adjustment dialog box.

»» Note

* Disable ICM required from the application software tab cannot be used with the XPS printer
driver.

Disable the color profile setting of the application software
Checking this check box disables information in the color profile that was set on the application
software.
When the information in the color profile set on the application software is output to the printer driver,
the print result may contain unexpected colors. If this happens, checking this check box may resolve
the problem.

32 Important

» Even when this check box is checked, only some of the information in the color profile is
disabled, and the color profile can still be used for printing.
» Uncheck this check box under normal circumstances.

Disable the paper source setting of the application software
Disables the paper feeding method that is set by the application.
With some applications such as Microsoft Word, the data may be printed with a feeding method that
differs from the printer driver setting. In this case, check this function.

3% Important

* When this function is enabled, normally the paper feeding method cannot be changed from the
Canon |J Preview.
However, if you are using the XPS printer driver, you will be able to change the paper feeding
method from the Canon IJ XPS Preview.

Ungroup Papers
Sets the display method of Media Type, Page Size, and Printer Paper Size.
To display the items separately, select the check box.
To display the items as a group, clear the check box.

Do not allow application software to compress print data
Compression of the application software print data is prohibited.
If the print result has missing image data or unintended colors, selecting this check box may improve
the condition.

22 Important

* Uncheck this check box under normal circumstances.
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»» Note

* Do not allow application software to compress print data tab cannot be used with the XPS
printer driver.

Print after creating print data by page

The print data is created in page units, and printing starts after the processing of one page of print
data is complete.

If a printed document contains unintended results such as streaks, selecting this check box may
improve the results.

3% Important

» Uncheck this check box under normal circumstances.

Scale images using nearest-neighbor interpolation

When an image is to be enlarged or reduced when printed, the printer uses a simple interpolation
process to enlarge or reduce the image.

If the image data in a printed document is not printed clearly, selecting this check box may improve
the results.

32 Important

* Uncheck this check box under normal circumstances.

»» Note

» Scale images using nearest-neighbor interpolation can be used only with the XPS printer
driver.

Prevention of Print Data Loss

You can reduce the size of the print data that was created with the application software and then print
the data.
Depending on the application software being used, the image data may be cut off or may not be
printed properly. In such cases, select On. If you will not be using this function, select Off.

3% Important

» When using this function, the print quality may drop depending on the print data.

Unit of Print Data Processing

Selects the processing unit of the print data to be sent to the printer.
Select Recommended under normal circumstances.

22 Important

A large amount of memory may be used for certain settings.
Do not change the setting if your computer has a small amount of memory.

»» Note

* Unit of Print Data Processing tab cannot be used with the XPS printer driver.
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Stamp/Background (Stamp...) dialog box

The Stamp/Background (Stamp...) dialog box allows you to print a stamp and/or background over or
behind the document pages. In addition to the pre-registered ones, you can register and use your original
stamp or background.

»>» Note

» With the XPS printer driver, the Stamp/Background... button has become the Stamp... button and
only the stamp function can be used.

Stamp
Stamp printing is a function that prints a stamp over a document.
Check this check box and select a title from the list to print a stamp.

Define Stamp...
Opens the Stamp Settings dialog box.
You can check the details of a selected stamp or save a new stamp.

Place stamp over text
Sets how the stamp is to be printed over the document.
Check the Stamp check box to enable this.
Check this check box to print a stamp over the printed document page. The printed data may be
hidden behind the stamp.
Uncheck this check box to print the document data over the stamp. The printed data will not be
hidden behind the stamp. However, the sections of the stamp that are overlapped by the document
may be hidden.

Print semitransparent stamp
Sets how the stamp is to be printed over the document.
Check the Stamp check box to enable this.
Check this check box to print a semi-transparent stamp over the printed document page.
Uncheck this check box to print the stamp over the document data. The printed data may be hidden
behind the stamp.

»» Note

* You can use Print semitransparent stamp only with the XPS printer driver.

Stamp first page only
Selects whether the stamp is to be printed on the first page only or on all pages when the document
has two or more pages.
Check the Stamp check box to enable this.
Check this check box to print a stamp on the first page only.

Background
Background printing is a function that allows you to print an illustration or a similar object (bitmap)
behind the document.
Check this check box to print a background and select a title from the list.

Select Background...
Opens the Background Settings dialog box.
You can register a bitmap as a background, and change layout method and intensity of the selected
background.
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Background first page only
Selects whether to print the background on the first page only or print on all pages when the
document has two or more pages.
Check the Background check box to enable this.
Check this check box to print a background on the first page only.

Stamp Tab

The Stamp tab allows you to set the text and bitmap file (.bmp) to be used for a stamp.

Preview Window
Shows the status of the stamp configured in each tab.

Stamp Type
Specifies the stamp type.
Select Text to create a stamp with characters. Select Bitmap to create with a bitmap file. Select
Date/Time/User Name to display the creation date/time and user name of the printed document.
The setting items in the Stamp tab change depending on the selected type.

When Stamp Type is Text or Date/Time/User Name

Stamp Text
Specifies the stamp text string.
Up to 64 characters can be entered.
For Date/Time/User Name, the creation date/time and user name of the printed object are
displayed in Stamp Text.

32 Important

» Stamp Text appears grayed out and is unavailable if Date/Time/User Name is selected.

TrueType Font
Selects the font for the stamp text string.

Style

Selects the font style for the stamp text string.
Size

Selects the font size for the stamp text string.
Outline

Selects a frame that encloses the stamp text string.
If a large font size is selected for Size, characters may extend outside of the stamp border.

Color/Select Color...
Shows the current color for the stamp.
To select a different color, click Select Color... to open the Color dialog box, and select or create a
color you wish to use as a stamp.

When Stamp Type is Bitmap

File
Specifies the name of the bitmap file to be used as the stamp.

Select File...
Opens the dialog box to open a file.
Click this button to select a bitmap file to be used as a stamp.
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Size
Adjusts the size of the bitmap file to be used as a stamp.
Moving the slider to the right increases the size, moving the slider to the left decreases the size.

Transparent white area
Specifies whether to make white-filled areas of the bitmap transparent.
Check this check box to make white-filled areas of the bitmap transparent.

»» Note

* Click Defaults to set Stamp Type to text, Stamp Text to blank, TrueType Font to Arial, Style to
Regular, Size to 36 points, Outline unchecked, and Color to gray with the RGB values (192, 192,
192).

Placement Tab

The Placement tab allows you to set the position where the stamp is to be printed.

Preview Window
Shows the status of the stamp configured in each tab.

Position
Specifies the stamp position on the page.
Selecting Custom from the list allows you to enter values for the X-Position and Y-Position
coordinates directly.

Orientation
Specifies the angle of rotation for the stamp. The angle can be set by entering the number of
degrees.
Negative values rotate the stamp clockwise.

»>» Note

 Orientation is enabled only when Text or Date/Time/User Name is selected for Stamp Type
on the Stamp tab.

»» Note

* Click Defaults to set the stamp position to Center and the orientation to 0.

Save settings Tab

The Save settings tab allows you to register a new stamp or delete an unnecessary stamp.

Title
Enter the title to save the stamp you created.
Up to 64 characters can be entered.

»>» Note

» Spaces, tabs, and returns cannot be entered at the beginning or end of a title.

Stamps
Shows a list of saved stamp titles.
Specify a title to display the corresponding stamp in Title.
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Save/Save overwrite
Saves the stamp.
Enter a title in Title, and then click this button.

Delete
Deletes an unnecessary stamp.
Specify the title of an unnecessary stamp from the Stamps list, and click this button.

Background Tab

The Background tab allows you to select a bitmap file (.bmp) to be used as a background or determine
how to print the selected background.

Preview Window
Shows the status of the bitmap set on the Background tab.

File
Specifies the name of the bitmap file to be used as the background.
Select File...

Opens the dialog box to open a file.
Click this button to select a bitmap file (.bmp) to be used as the background.

Layout Method
Specifies how the background image is to be placed on the paper.
When Custom is selected, you can set coordinates for X-Position and Y-Position.

Intensity
Adjusts the intensity of the bitmap to be used as a background.
Moving the slider to the right increases the intensity, and moving the slider to the left decreases the
intensity. To print the background at the original bitmap intensity, move the slider to the rightmost
position.

»» Note

» Depending on the type of printer driver you are using and the environment, this function may not be
available.

+ Click Defaults to set File to blank, Layout Method to Fill page, and the Intensity slider to the
middle.

Save settings Tab

The Save settings tab allows you to register a new background or delete an unnecessary background.

Title
Enter the title to save the background image you specified.
Up to 64 characters can be entered.

»>» Note

» Spaces, tabs, and returns cannot be entered at the beginning or end of a title.

Backgrounds
Shows a list of registered background titles.
Specify a title to display the corresponding background in Title.
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Save/Save overwrite
Saves the image data as a background.
After inserting the Title, click this button.

Delete
Deletes an unnecessary background.
Specify the title of an unnecessary background from the Backgrounds list, and then click this
button.
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Maintenance tab Description

The Maintenance tab allows you to perform printer maintenance or change the settings of the printer.
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\ Cleaning

Performs print head cleaning.
Print head cleaning removes any blockage in the print head nozzles.

Perform cleaning when printing becomes faint, or a specific color fails to print, even though all ink levels
are sufficiently high.

Deep Cleaning
Performs deep cleaning.

Perform deep cleaning when two cleaning attempts do not resolve the print head problem.

»» Note

» Deep Cleaning consumes a larger amount of ink than Cleaning.

Cleaning the print heads frequently will rapidly deplete your printer's ink supply. Therefore, perform
cleaning only when necessary.

Ink Group
When you click Cleaning or Deep Cleaning, the Ink Group window is displayed.
Selects the ink group that you want to clean the print head for.

Click Initial Check Items to display the items that you need to check before you execute cleaning
or deep cleaning.
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Print Head Alignment
Print head alignment corrects the installation positions of the print head and improves deviated colors
and lines.
Align the print head immediately after installing the print head.
When you click Print Head Alignment, the Start Print Head Alignment dialog box is displayed.

Nozzle Check

Prints a nozzle check pattern.
Perform this function if printing becomes faint or a specific color fails to print. Print a nozzle check
pattern, and check whether the print head is working properly.
If the print result for a specific color is fainted, or if there are any unprinted sections, click Cleaning to
clean the print head.
To display a list of items that you should check before printing the nozzle check pattern, click Initial
Check Items.
Print Check Pattern

This function prints a pattern that allows you to check whether the any of the ink nozzles are

clogged.

Click Print Check Pattern. When the confirmation message is displayed, click OK. The Pattern

Check dialog box is then displayed.

Left-side bitmap (good)

The print head nozzles are not clogged.

Right-side bitmap (bad)
The print head nozzles may be clogged.

Exit
Closes the Pattern Check dialog box, and returns to the Maintenance tab.

Cleaning
Performs print head cleaning.
Print head cleaning removes any blockage in the print head nozzles.
Perform cleaning when printing becomes faint, or if a specific color fails to print, even though
all ink levels are sufficiently high.

Power Off
Turns off the printer from the printer driver.
Perform this function to turn off the printer when you cannot press the ON button (POWER button) on
the printer because the printer is out of your reach.
You must press the ON button (POWER button) on the printer to turn the printer on again after clicking
this button. When you use this function, you will not be able to turn the printer on from the printer driver.

Quiet Settings
Opens the Quiet Settings dialog box.
Quiet Settings dialog box allows you to specify a setting that reduces the operating noise of the printer.
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This mode comes in handy when the operating noise of the printer becomes a concern, such when
printing at night. Perform this operation when you want to change the quiet mode setting.

»» Note

* If the printer is off or if communication between the printer and the computer is disabled, an error
message may appear because the computer cannot collect the printer status.

Custom Settings
Opens the Custom Settings dialog box.
Perform this function to change the settings of this printer.

»» Note

« |If the printer is off or if communication between the printer and the computer is disabled, an error
message may appear because the computer cannot collect the printer status.
If this happens, click OK to display the most recent settings specified on your computer.

View Print History
This function starts the Canon IJ XPS preview, and displays the print history.

»» Note

* You can use this function only with the XPS printer driver.

View Printer Status
Starts the Canon IJ Status Monitor.
Perform this function when you want to check the printer status and how a print job is proceeding.

»» Note

+ If you are using the XPS printer driver, the "Canon |J Status Monitor" becomes the "Canon IJ XPS
Status Monitor".

About
Opens the About dialog box.
The version of the printer driver, plus a copyright notice, can be checked.
In addition, the language to be used can be switched.

Initial Check Items (Cleaning / Deep Cleaning)

Before running Cleaning or Deep Cleaning, check that the printer power is on, and open the cover of the
printer.
Check the following items for each ink.

» Check the amount of ink remaining in the tank.
* Make sure that you push in the ink tank completely until you hear a clicking sound.
« If an orange tape is adhered to the ink tank, peel it off completely.
Any remaining tape will hinder ink output.
» Check that the ink tanks are installed in their correct positions.
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Start Print Head Alignment dialog box

This dialog box allows you to adjust the attachment position for the print head, or to print the current
setting value for the print head position.

Align Print Head
Aligns the print head.
Print head alignment corrects the installation positions of the print head and improves deviated colors
and lines.
Align the print head immediately after installing the print head.

Print Alignment Value
Click this button to check the current setting value of the print head position.
Prints the current setting value for the print head position.

Print Head Alignment dialog box

To adjust the print head position manually, click Align Print Head in the Start Print Head Alignment
dialog box, and perform the operations instructed in the messages. The Print Head Alignment dialog
box is then displayed.

This dialog box allows you to check the printed pattern and adjust the print head position.

Preview Window
Displays the pattern of Print Head Alignment, and checks the position of the selected pattern.
You can also change the setting by clicking the pattern on the screen directly.

Select the Pattern Number
Compare the printed adjustment patterns, and enter the pattern number of the pattern with the
least visible streaks or horizontal stripes into the corresponding box.

»» Note

+ If you do not know how to analyze the printed pattern, see Aligning the Print Head Position.

Initial Check Items (Nozzle Check)

Before running Nozzle Check, check that the printer power is on, and open the cover of the printer.
Check the following items for each ink.

» Check the amount of ink remaining in the tank.
* Make sure that you push in the ink tank completely until you hear a clicking sound.
* If an orange tape is adhered to the ink tank, peel it off completely.
Any remaining tape will hinder ink output.
» Check that the ink tanks are installed in their correct positions.

Quiet Settings dialog box

When you click Quiet Settings, the Quiet Settings dialog box is displayed.

Quiet Settings dialog box allows you to specify a setting that reduces the operating noise of the printer.
Select when you wish to reduce the operating noise of the printer at night, etc.

Using this function may lower the print speed.
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Do not use quiet mode
Select this option when you wish to use the printer with volume of normal operating noise.

Always use quiet mode
Select this option when you wish to reduce the operating noise of the printer.

Use quiet mode during specified hours
Select this option when you wish to reduce the operating noise of the printer during a specified period
of time.
Set the Start time and the End time of the quiet mode you wish to be activated. If both are set to the
same time, the quiet mode will not function.

32 Important

* You can set the quiet mode from the operation panel of the printer, the printer driver, or ScanGear
(scanner driver).
No matter how you use to set the quiet mode, the mode is applied when you perform operations from
the operation panel of the printer or printing and scanning from the computer.

Custom Settings dialog box

When you click Custom Settings, the Custom Settings dialog box is displayed.
If necessary, switch between various modes of printer operation.

Prevent paper abrasion
The printer can increase the gap between the print head and the paper during high-density printing to
prevent paper abrasion.
Check this check box to enable this function.

Align heads manually
Usually, the Print Head Alignment function on the Maintenance tab is set to automatic head
alignment, but you can change it to manual head alignment.
If the printing results of automatic print head alignment are not satisfactory, perform manual head

alignment.
Check this check box to perform the manual head alignment.

Rotate 90 degrees left when orientation is [Landscape]
On the Page Setup tab, you can change the rotation direction of the Landscape in the Orientation.
To rotate the document 90 degrees to the left when printing, select the check box.

»» Note

* If Yougata 4 4.13"x9.25", Yougata 6 3.86"x7.48", Envelope Com 10, Envelope DL, Envelope
C5, or Envelope Monarch 3.88"x7.5" 98.4x190.5mm is selected for Page Size on the Page
Setup tab, the printer rotates the paper 90 degrees to the left to print, regardless of the Rotate
90 degrees left when orientation is [Landscape] setting for Custom Settings on the
Maintenance tab.

Don't detect mismatch of paper settings when printing from computer
When you print documents from your computer and the paper settings on the printer driver and the
cassette paper information registered on the printer do not match, this setting disables the message
display and allows you to continue printing.
To disable detection of paper setting mismatches, select this check box.
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Ink Drying Wait Time
The printer can pause before printing a subsequent page. Moving the slider to the right increases the
pause time, and moving the slider to the left decreases the time.
If the paper gets stained because the next page is ejected before the ink on the printed page dries,
increase the ink drying wait time.
Reducing the ink drying wait time speeds up printing.

About dialog box

When you click About, the About dialog box is displayed.
This dialog box displays the version, copyright, and module list of the printer driver. You can select the
language to be used and switch the language displayed in the setup window.

Modules
Lists the printer driver modules.
Language
Specifies the language you wish to use in the printer driver setup window.
32 Important

« If the font for displaying the language of your choice is not installed in your system, the
characters will be garbled.

Related Topics

Cleaning the Print Heads

Aligning the Print Head Position
Printing a Nozzle Check Pattern
Managing the Printer Power
Reducing the Printer Noise

Changing the Printer Operation Mode

LR 2R 2% 2B 2 4
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Canon IJ Preview Description

Canon |J Preview is an application software that displays what the print result will look like before a
document is actually printed.

The preview reflects the information that is set within the printer driver and allows you to check the
document layout, print order, and number of pages. You can also change the media type and paper source
settings.

When you want to display a preview before printing, open the printer driver setup window, and check the
Preview before printing check box on the Main tab.
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File Menu
Selects the print operation.
Start Printing
Ends the Canon |J Preview and then starts printing the document that is displayed on the preview
screen.
This command has the same function as the Start Printing on the toolbar.

Cancel Printing
Ends the Canon IJ Preview and cancels the printing of the document that is displayed on the
preview screen.
This command has the same function as the Cancel Printing on the toolbar.

Exit
Ends the Canon |J Preview.
Page Menu

This menu includes the following commands to select page to be displayed.
All of these commands except Page Selection... can also be selected from the toolbar.

»» Note

« If the pages are being spooled, the last spooled page becomes the last page.
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« If the Page Layout setting on the Page Setup tab is specified to Page Layout, Tiling/Poster, or
Booklet, the number of pages is the number of sheets to be used for printing, and not the number
of pages in the original document created with the application software.

« If duplex printing manually has been set, the front pages which will be printed first are all displayed
together, and then the back pages are displayed.

First Page
Displays the first page of the document.
If the currently displayed page is the first page, this command is grayed out and cannot be
selected.

Previous Page
Displays the page located before the currently displayed page.
If the currently displayed page is the first page, this command is grayed out and cannot be
selected.

Next Page
Displays the page located after the currently displayed page.
If the currently displayed page is the last page, this command is grayed out and cannot be
selected.

Last Page
Displays the last page of the document.
If the currently displayed page is the last page, this command is grayed out and cannot be
selected.

Page Selection...
Displays the Page Selection dialog box.
This command allows you to specify the page number of the page to be displayed.

Zoom Menu
Selects the ratio of the actual size printed on the paper to the preview display size.
You can also select the ratio from the drop-down list box located on the toolbar.
Whole
Displays the entire page of data as one page.

50%
Reduces the displayed data to 50% of the actual size to be printed.

100%
Displays the data at the actual size to be printed.

200%
Enlarges the displayed data to 200% of the actual size to be printed.

400%
Enlarges the displayed data to 400% of the actual size to be printed.

Option Menu
This menu includes the following command:
Displays Print Page Information
Displays print setup information (including printer paper size, media type, and page layout) for each
page at the left side of the preview screen.
This screen also allows you to change the media type and paper source settings.
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Help Menu
When you select this menu item, the Help window for Canon IJ Preview is displayed, and you can
check the version and copyright information.

Start Printing button
Prints the documents selected in the document list.
The printed documents are deleted from the list, and when all documents are printed, the Canon IJ XPS
Preview closes.

Cancel Printing button
Ends the Canon IJ Preview, and cancels the printing of the document that is displayed on the preview
screen.
You can click this button while spooling.

Print Page Information Screen
Displays print setup information for each page at the left side of the preview screen.
This screen also allows you to change the media type and paper source settings.

32 Important

« If the media type and paper source are set from the application software, those settings have
priority and the changed settings may become ineffective.

Printer Paper Size
Displays the paper size of the document to be printed.

Media Type
You can select the media type of the document to be printed.

Paper Source
You can select the paper source of the document to be printed.

Page Layout
Displays the page layout of the document to be printed.
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Canon IJ XPS Preview Description

Canon IJ XPS Preview is an application software that displays what the print result will look like before a
document is actually printed.

The preview reflects the information which is set within the printer driver and allows you to check the
document layout, print order, and number of pages. The preview also allows you to edit the print document,
edit the print pages, change the print settings, and perform other functions.

When you want to display a preview before printing, open the printer driver setup window, and check the
Preview before printing check box on the Main tab.

3% Important

» To use the Canon IJ XPS Preview, you must have Microsoft .NET Framework 4 Client Profile installed
on your computer.
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File Menu
Selects print operation and print history settings:
Print

Prints the documents selected in the document list.
The printed documents are deleted from the list, and when all documents are printed, the Canon IJ
XPS Preview closes.

This command has the same function as @ (Print) on the toolbar and the Print in the print
settings area.

Print All Documents
Prints all documents in the document list and closes the Canon IJ XPS Preview.

Save Print History
Switches whether the documents printed from the Canon IJ XPS Preview are to be saved as print
history entries.
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History Entry Limit
Switches the maximum number of print history registrations.
Select 10 Entries, 30 Entries, or 100 Entries.

32 Important

« If the limit on the number of registration is exceeded, the print history registrations are deleted
starting from the oldest one.

Add documents from history to the list
Adds the document saved in the print history to the document list.

Exit
Ends the Canon IJ XPS Preview. The documents remaining in the document list will be deleted
from the list.
This command has the same function as the Exit in the print settings area.

Edit Menu

Selects the method for editing multiple documents or pages.

Undo
Reverses the previous change.
If the change cannot be reversed, this function is grayed out and cannot be selected.
This command has the same function as the @(Undo) on the toolbar.

Documents

Selects the method for editing print documents.
Combine Documents
Combines the documents selected in the document list into one document.
If only one document is selected, this command is grayed out and cannot be selected.

This command has the same function as the *J(Combine Documents) on the toolbar.

Reset Documents
Returns the document selected in the document list to their status before they were added to
the Canon IJ XPS Preview.
The combined documents are separated, and the original documents are restored.

This command has the same function as the E (Reset Documents) on the toolbar.

Move Document
Use the following command to change the order of the documents selected in the document
list.

Move to First
Moves the selected print document to the beginning of the document list.
If the currently selected document is the first document, this command is grayed out and
cannot be selected.

Move Up One
Moves the selected print document one up from its current position.
If the currently selected document is the first document, this command is grayed out and
cannot be selected.
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Move Down One
Moves the selected print document one down from its current position.
If the currently selected document is the last document, this command is grayed out and
cannot be selected.

Move to Last
Moves the selected print document to the end of the document list.
If the currently selected document is the last document, this command is grayed out and
cannot be selected.

Delete Document
Deletes the selected document from the document list.
If the document list contains only one document, the document is grayed out and cannot be
selected.

This command has the same function as the 1s;h((Delete Document) on the toolbar.

Grayscale Printing
Allows you to change the monochrome print settings.
This command has the same functionality as the Grayscale Printing check box in the print
settings area.

Page Layout Printing...
Opens the Page Layout Printing dialog box.
This dialog box allows you to set Page Layout Printing, Page Layout, Page Order, and
Page Border.

Duplex Printing...
Opens the Duplex Printing dialog box.
This dialog box allows you to set Duplex Printing, Automatic, Stapling Side, and Margin.

Copies...
Opens the Copies dialog box.
This dialog box allows you to set Copies, Collate, and Print from Last Page.

Pages
Selects the method for editing print pages.
Delete Page
Deletes the currently selected page.
If page layout printing is set, the pages enclosed with red frame will be deleted.

This command has the same function as the *(Delete Page) on the toolbar.

Restore Page
Restores pages that were deleted with the Delete Page function.
To restore pages, you must select the View Deleted Pages check box on the Option menu
and display the deleted pages as thumbnails.

Move Page
Use the following command to change the order of the currently selected pages.

Move to First
Moves the currently selected page to the beginning of the document.
If the currently selected page is the first page, this command is grayed out and cannot be
selected.
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Move Forward One
Moves the currently selected page one position in front of its current position.
If the currently selected page is the first page, this command is grayed out and cannot be
selected.

Move Backward One
Moves the currently selected page one position after its current position.
If the currently selected page is the last page, this command is grayed out and cannot be
selected.

Move to Last
Moves the currently selected page to the end of the document.
If the currently selected page is the last page, this command is grayed out and cannot be
selected.

View Menu
Selects the documents and pages to be displayed.
Documents
Use the following command to select the document to display.
First Document
Displays the first document in the document list.
If the currently selected document is the first document, this command is grayed out and
cannot be selected.

Previous Document
Displays the document located before the currently displayed document.
If the currently selected document is the first document, this command is grayed out and
cannot be selected.

Next Document
Displays the document located after the currently displayed document.
If the currently selected document is the last document, this command is grayed out and
cannot be selected.

Last Document
Displays the last document in the document list.
If the currently selected document is the last document, this command is grayed out and
cannot be selected.

Pages
Use the following command to select the page to be displayed.

»» Note

« If the Page Layout setting in the printer driver is specified to Tiling/Poster, or Booklet, the
number of pages is the number of sheets to be used for printing, and not the number of pages
in the original document created with the application software.

First Page
Displays the first page of the document.
If the currently displayed page is the first page, this command is grayed out and cannot be
selected.
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Previous Page
Displays the page located before the currently displayed page.
If the currently displayed page is the first page, this command is grayed out and cannot be
selected.

Next Page
Displays the page located after the currently displayed page.
If the currently displayed page is the last page, this command is grayed out and cannot be
selected.

Last Page
Displays the last page of the document.
If the currently displayed page is the last page, this command is grayed out and cannot be
selected.

Page Selection...
Displays the Page Selection dialog box.
This command allows you to specify the page number of the page to be displayed.

Zoom Menu
Selects the ratio of the actual size printed on the paper to the preview display size.
You can also select the ratio from the drop-down list box located on the toolbar.
Whole
Displays the entire page of data as one page.

50%
Reduces the displayed data to 50% of the actual size to be printed.

100%
Displays the data at the actual size to be printed.

200%
Enlarges the displayed data to 200% of the actual size to be printed.

400%
Enlarges the displayed data to 400% of the actual size to be printed.

Option Menu
Toggles the show / hide status of the following information.
View Thumbnails
Reduces all pages in the document selected in the document list and displays them at the bottom
of the preview window.

This command has the same function as the ll;ln(View Thumbnails) on the toolbar.

View Document List
Displays the print document list at the top of the preview window.

View Print Settings Area
Displays the print settings area at the right side of the preview window.

View Deleted Pages
When the thumbnails are displayed, this function displays pages that were deleted with the Delete
Page function.
To check deleted pages, you must first select the View Thumbnails check box.
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Keep printed documents on the list
Leaves the printed document in the document list.

Print Settings Displayed at Startup
Switches the tab of the print settings area to be displayed when the Canon IJ XPS Preview is
started.
Select Page Information, Layout, or Manual Color Adjustment.

Help Menu
When you select this menu item, the Help window for Canon IJ XPS Preview is displayed, and you can
check the version and copyright information.

@ (Print)

Prints the documents selected in the document list.
The printed documents are deleted from the list, and when all documents are printed, the Canon IJ XPS
Preview closes.

'ﬂ_'](Combine Documents)
Combines the documents selected in the document list into one document.
If only one document is selected, this command is grayed out and cannot be selected.

1=3‘E(Delete Document)
Deletes the selected document from the document list.
If the document list contains only one document, the document is grayed out and cannot be selected.

E (Reset Documents)
Returns the document selected in the document list to their status before they were added to the Canon
IJ XPS Preview.
The combined documents are separated, and the original documents are restored.

%(View Thumbnails)
Reduces all pages in the document selected in the document list and displays them at the bottom of the
preview window.
To hide the print pages, click View Thumbnails again.

!r(Move to First)
Moves the selected print document to the beginning of the document list.
If the currently selected document is the first document, this command is grayed out and cannot be
selected.

El‘(Move Up One)
Moves the selected print document one up from its current position.
If the currently selected document is the first document, this command is grayed out and cannot be
selected.

é’(Move Down One)
Moves the selected print document one down from its current position.
If the currently selected document is the last document, this command is grayed out and cannot be
selected.
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EiL(Move to Last)
Moves the selected print document to the end of the document list.
If the currently selected document is the last document, this command is grayed out and cannot be
selected.

£3(Undo)
Reverses the previous change.
If the change cannot be reversed, this function is grayed out and cannot be selected.

- k(Delete Page)
Deletes the currently selected page.
If page layout printing is set, the pages enclosed with red frame will be deleted.

Document list
Displays the list of the print documents.
The document selected in the document list becomes the target for preview display and editing.
Document Name
Displays the name of the print document.
If you click the name of the selected print document, a text box is displayed, and you can rename
the document to any name.

Pages
Displays the number of pages in the print document.

22 Important

» The number displayed in Pages and the output page count are different.
» To check the output page count, check the status bar at the bottom of the preview window.

Status
Displays the status of the print documents.
Documents that are undergoing data processing are displayed as Processing data.

2% Important

* Documents showing Processing data cannot be printed or edited.
Wait until the data processing ends.

Print Settings Area Screen
Allows you to check and change the print settings of the documents selected in the document list.
Print Settings Area is displayed on the right side of the preview window.
Page Information tab
The print settings are displayed for each page.
You can change the media type and paper source settings.
Printer Paper Size
Displays the paper size of the document to be printed.

Media Type
Allows you to select the media type of the document to be printed.

Paper Source
Allows you to select the paper source of the document to be printed.

Page Layout
Displays the page layout of the document to be printed.
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Layout tab
You can specify settings for page layout printing.
To apply the specified settings, click Apply.
If the page layout print settings cannot be changed for the print document, the individual items are
grayed out and cannot be selected.

Manual Color Adjustment tab

This tab allows you to adjust the color balance by changing the settings of the Cyan, Magenta,

Yellow, Brightness, Intensity, and Contrast options.

Cyan/Magenta/Yellow
Adjusts the strengths of Cyan, Magenta, and Yellow.
Moving the slider to the right makes a color stronger, and moving the slider to the left makes a
color weaker.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to
50.
This adjustment changes the relative amount of ink of each color used, which alters the total
color balance of the document.
Use your application software if you want to change the total color balance significantly. Use
the printer driver only if you want to adjust the color balance slightly.

22 Important

* When Grayscale Printing is checked, Cyan, Magenta, and Yellow appear grayed out
and are unavailable.

Brightness
Selects the brightness of your print.
Pure white and black will not change, but colors between white and black will change.

Intensity
Adjusts the overall intensity of your print.
Moving the slider to the right increases the intensity, and moving the slider to the left
decreases the intensity.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to
50.

Contrast
Adjusts the contrast between light and dark in the image to be printed.
Moving the slider to the right increases the contrast, moving the slider to the left decreases the
contrast.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to
50.

Defaults
Restores all the settings you have changed to their default values.
Clicking this button restores all the settings on this tab to their default values (factory settings).

Grayscale Printing
Allows you to change the monochrome print settings.
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Duplex Printing
Selects whether to print the document on both sides or one side of a sheet of paper.
If the duplex print settings cannot be changed for the print document, this item is grayed out and is
unavailable.

32 Important

* When you select Booklet for Page Layout, Duplex Printing of the print settings area will be
set automatically. In this case, Duplex Printing is grayed out and is unavailable.

Copies
Specifies the number of copies you want to print. You can specify a value from 1 to 999.
If the numbers of copies cannot be changed for the print document, this item is grayed out and is
unavailable.

Exit
Ends the Canon IJ XPS Preview.
The documents remaining in the document list will be deleted from the list.

Print
Prints the documents selected in the document list.
The printed documents are deleted from the list, and when all documents are printed, the Canon IJ
XPS Preview closes.
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Canon |J Status Monitor Description

The Canon IJ Status Monitor displays the status of the printer and the printing progress. The monitor uses
graphics, icons, and messages to let you know the printer status.
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Canon |J Status Monitor Features
The Canon IJ Status Monitor offers the following advantages:

You can check the status of the printer on the screen.
The status of the printer is shown on the screen in real time.
You can check the printing progress of each printing document (print job).

Error types and solutions are shown on the screen.
Shown when a printer error occurs.
You can immediately check how to respond.

You can check the ink status.
This function displays graphics showing the ink tank type and the estimated ink levels.
Icons and messages are displayed when ink is running low (ink level warning).

Canon |J Status Monitor Overview

Canon |J Status Monitor allows you to check the status of the printer and ink with graphics and messages.
You can check the information on the printing document and the printing progress during printing.
When a printer error occurs, it shows the cause and solution. Follow the instruction in the message.

Printer
Canon |J Status Monitor shows an icon when a warning or error occurs to the printer.
1 Indicates that a warning (operator call error) has occurred or the printer is working.

@ : There has been an error which requires a service.

Ink Tank
Canon |J Status Monitor shows an icon when a low ink warning or a no ink error occurs.
In addition, this function displays graphics showing the estimated ink levels of the ink tank.
In this case, click the graphics to open the Ink Details dialog box. You can check the detail
information such as the remaining ink level and the ink tank types for your printer.

Document Name
Shows the name of the document to be printed.

Owner
Shows the owner's name of the document to be printed.
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Printing Page
Shows the number of printing page and total printing pages.
Display Print Queue
Shows the print window used to manage the print job that is being printed or being in the print
queue.
Cancel Printing
Cancels the current print job.
32 Important

» The Cancel Printing button is enabled only while print data is being sent to the printer.
Once the print data has been sent, the button is grayed out and becomes unavailable.

Option Menu
If you select Enable Status Monitor, when a printer related message is generated the Canon |J
Status Monitor starts.
When Enable Status Monitor is selected, following commands are available.
Always Display Current Job
Displays the Canon IJ Status Monitor during printing.

Always Display on Top
Displays the Canon IJ Status Monitor in front of other windows.

Display Guide Message
Displays the guide for operations in which how to set paper is complicated.
Envelope Printing
Displays the guide message when envelope printing starts.
To hide this guide message, select the Do not show this message again check box.
To display the guide messages again, click Envelope Printing on the Display Guide
Message in the Option menu and enable this setting.

Hagaki Printing
Displays the guide message before the printer begins hagaki printing.
To hide this guide message, select the Do not show this message again check box.
To display the guide messages again, click Hagaki Printing on the Display Guide
Message in the Option menu and enable this setting.

Display Warning Automatically
When a Low Ink Warning Occurs
Starts the Canon IJ Status Monitor window automatically and displays it in front of the
other windows when a low ink warning occurs.

Start when Windows is Started
Starts the Canon IJ Status Monitor automatically when you start Windows.

Ink Details Menu
Select this menu to display the Ink Details dialog box. Check the detail information such as the

remaining ink level and the ink tank types for your printer.
Ink Details dialog box
This function displays graphics and messages showing the ink tank type and the estimated

ink levels.
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Ink Informati